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		Introduction

								

	
				This textbook is really overdue. It’s been planned for years, but as an undertaking without a deadline and a project without deliverables, it could be postponed till later. That’s still the case, but now is the time, deliverables or no deliverables, time to just drop everything and write.
 With the textbook, we provide a basis for courses in ecosystem modelling based on the Ecopath with Ecosim (EwE) modelling framework and software. EwE is a versatile approach with a low but very long (and gradually steeping) learning curve.
 We have been involved in the development of EwE for more than thirty years, and during that time the simple Ecopath mass-balance approach it started with has through the addition of time and spatial-dynamic models, among others, been expanded to become a dynamic toolbox that can be used to address anything from simple fundamental research questions to very complex management and policy questions related to ecosystem-based management.
 It’s been a guiding principle throughout the development of EwE to provide an easy-to-access approach that does not require extensive mathematical or programming capabilities to get started. Model first, ask later is the philosophy. We think by just getting started with modelling, you gain insight and can start asking fundamental questions about how components of ecosystems interplay. Diving deeper is important, but we have sought to make the initial getting-started as simple and accessible as possible.
 The textbook reflects our dedication to accessibility. We have chosen to develop an “open textbook”, i.e. a textbook that is freely available on the web, that can be downloaded as a pdf, and also obtained as a printed textbook from booksellers in many countries. We are using the open book creation platform, PressBooks as implemented by BCcampus, which has several advantages.  It is not only freely available, but also that it is straightforward to update the materials as new developments occur. Compared to printed, traditional textbooks, this is indeed one of the major advantages. We can also include media and interactive materials to liven up things a bit (in the online and pdf versions).
 It’s also important to us that the textbook is distributed with a Creative Commons (CC-BY-NC-SA) license. This makes it straightforward to adapt copies of the textbook, e.g., for you to use in your own courses. We indeed invite you to do so.
 We have organized the textbook to focus on background, modelling aspects and to include tutorials with hands-on that illustrate many of the aspects (the “what” and “why”). The textbook is, however, not intended to be an in-depth description of everything in EwE. To supplement the textbook, with the “how”, we refer to an accompanying publication, the EwE User Guide, which has been updated, overhauled, and also made accessible through BCcampus.
 We have heard on many occasions that there is a strong, unfilled demand for training courses in ecosystem modelling with EwE. There are so many projects in progress around the world that includes EwE modelling, but there are very few instructors. While we have developed and shared course materials for years, there has never been a concerted action as represented by this textbook and the accompanying User Guide.
 We hope both will be useful.
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		How to access and use this textbook

								

	
				 Citing this textbook:
 Christensen, V. and Walters, C.J. (2024). Ecosystem Modelling with EwE. Vancouver, BC: The University of British Columbia. Available from https://pressbooks.bccampus.ca/ewemodel. https://doi.org/10.14288/24d7-ab68
 
 This textbook is available in the following formats:
 	Online webbook. You can read this textbook online on a computer or mobile device in one of the following browsers: Chrome, Firefox, Edge, and Safari.
 	PDF. You can download this book as a PDF to read on a computer (Digital PDF) or print it out (Print PDF).
 	Mobile. If you want to read this textbook on your phone or tablet, you can use the EPUB (eReader) file.
 	On demand printed: We are setting up an online system where you can order a printed version of the book, and have it shipped to you. More about that to follow
 
 For more information about the accessibility of this textbook, see the Accessibility Statement in the Front Matter.
 You can access the online webbook and download any of the formats for free here: https://pressbooks.bccampus.ca/ewemodel/. To download the book in a different format, look for the “Download this book” drop-down menu and select the file type you want.
 How can I use the different formats? 	Format 	Internet required? 	Device 	Required apps 	Accessibility Features 	Screen reader compatible 
 	Online webbook 	Yes 	Computer, tablet, phone 	An Internet browser (Chrome, Firefox, Edge, or Safari) 	WCAG 2.0 AA compliant, option to enlarge text, and compatible with browser text-to-speech tools 	Yes 
 	PDF 	No 	Computer, print copy 	Adobe Reader (for reading on a computer) or a printer 	Ability to highlight and annotate the text. If reading on the computer, you can zoom in. 	Unsure 
 	EPUB 	No 	Computer, tablet, phone 	An eReader app 	Option to enlarge text, change font style, size, and colour. 	Unsure 
 	HTML 	No 	Computer, tablet, phone 	An Internet browser (Chrome, Firefox, Edge, or Safari) 	WCAG 2.0 AA compliant and compatible with browser text-to-speech tools. 	Yes 
  
 Tips for Using This Textbook
 	Search the textbook. 	If using the online webbook, you can use the search bar in the top right corner to search the entire book for a key word or phrase. To search a specific chapter, open that chapter and use your browser’s search feature by hitting [Cntr] + [f] on your keyboard if using a Windows computer or [Command] + [f] if using a Mac computer.
 	The [Cntr] + [f] and [Command] + [f] keys will also allow you to search a PDF, HTML, and EPUB files if you are reading them on a computer.
 	If using an eBook app to read this textbook, the app should have a built-in search tool.
 
 
 	Navigate the textbook. 	This textbook has a table of contents to help you navigate through the book easier. If using the online webbook, you can find the full table of contents on the book’s homepage or by selecting “Contents” from the top menu when you are in a chapter.
 
 
 	Annotate the textbook. 	If you like to highlight or write on your textbooks, you can do that by getting a print copy, using the Digital PDF in Adobe Reader, or using the highlighting tools in eReader apps.
 
 
 
 Web version vs. other formats
 The web version of this textbook includes a number of interactive and multimedia components. If you are not using the web version to access this textbook, these elements will not be included. Instead, your copy of the text will provide a link to where you can access those interactive elements.
 On demand printed copies of this textbook includes the numbered chapters from the web version only.  This notably excludes all tutorials as well as the Spatial Applications part of the web version from the printed version.
 Attribution 
 This section was copied and edited from BCCampus outlines made available under under a Creative Commons Attribution 4.0 International License,
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		Foreword

					Jeffrey Polovina

			

	
				French Frigate Shoals (FFS) is a coral reef atoll located in the remote region of the Hawaiian Islands Archipelago. In the late 1970s it was the focus of marine scientists studying all components of the marine ecosystem from phytoplankton to seabirds and tiger sharks. In 1978 I was hired to model the energy flow for this coral reef ecosystem based on the findings from this research. While this was the age of single species models, I was aware of two efforts in temperate regions developing ecosystem models for well-studied systems. Unfortunately for us these models were very parameter-intensive, far beyond what we could estimate at FFS. Thus, I developed an approach termed as Ecopath to estimate the biomasses and the energy flow for the species groups that comprised the atoll ecosystem in our data-limited situation. The Ecopath model and its application to FFS was published in Coral Reefs in 1984.
 While I was developing this model I received enthusiastic encouragement from Dr. Daniel Pauly. Where some critics noted that Ecopath was too simplistic to realistically model the complexity of a coral reef ecosystem, Dr. Pauly saw its simplicity as a strength that would allow it to be applied to many ecosystems around the world and he began doing just that. It wasn’t long before Dr. Pauly had the good fortune to develop a collaboration with the two co-authors of this book, Dr. Villy Christensen and Dr. Carl Walters, to build a much more user-friendly and temporally and spatially dynamic version of the model that became known as Ecopath with Ecosim (EwE). Over the years, Dr. Christensen has been a leader in working to continually improve EwE and develop a global community of EwE users and developers. Due to his efforts and the utility of this modeling approach, the number of scientists that have received training in EwE exceeds 3200 coming from more than 100 countries – it’s truly a global initiative.
 Not long ago, I had the opportunity to explore the ecosystem and fisheries impacts from both climate change and fishing strategy by driving an EwE model for the central Pacific with the output of an earth system model. It was very impressive to see what a versatile and powerful tool EwE has become. This book, written by lead EwE developers, is a timely and comprehensive presentation of this versatile modeling approach and its many applications for the benefit of current and future ecologists, resource managers, and policy makers.
 Jeffrey Polovina, Ph.D.
 Kailua, HI 96734
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		Foreword

					Sheila JJ Heymans

			

	
				Ecopath with Ecosim (EwE) has been a constant in my life for nearly 30 years. I first became aware of it as a PhD student in South Africa, where I was in the depths of building a model using the labour- and data-intensive software, NETWRK, an ecological network analysis (ENA) tool written in FORTRAN by Bob Ulanowicz. I was working on a model of the northern Benguela current, and my PhD supervisor, Dan Baird, came back from the USA with this new software, Ecopath – on two discs with no manual. Luckily NETWRK had been included into the Ecopath software by Villy Christensen. Long story short, I spent quite some time trying to get the same results from Ecopath as we got in NETWRK, and in that process realized that Ecopath is much more forgiving of data gaps. It is also much more logical to an ecologist, which is why it has been so successful over the past four decades.
 The theories behind network analysis and Ecopath has influenced my view of the world in everything from understanding the behaviour of seagulls on garbage day, to politics: human systems become brittle when you reduce diversity, just like ecosystems do, so reduced redundancy in political viewpoints creates two party systems that flip-flops from one extreme to the other, or in the worse-case one party systems that become dictatorships – just like lack of predators changes the dynamics of coral reefs.  Similarly, the foraging arena theory explains why the seagulls in Oostende will always peck at my garbage bags until the municipality starts using garbage cans, reducing the vulnerability of the garbage to the predation by seagulls, similar to the small fish under Carl’s boat in Figure 6 of the On Modelling chapter were not predated on by the larger fish, or how the planktivores that stay closer to the corals avoid predation in Figure 7, and explained more mathematically by Figure 4 in the Density Dependence chapter. So, if you study the networks of fisheries, or the networks of fishers, as you will be able to do after reading this book and following the tutorials, you too will be able to understand some of the crazy things happening in the world.
 Seriously though, to address the very real problems that we face both in the Ocean and on land, we need all the scientists and tools we can get, and EwE is one of the few tools that translate easily to people with limited programming skills. The software has been taken up by policy makers in the USA, Australia and South Africa more quickly than in Europe, but even this bastion of academic conservatism is realizing that we need all the tools we can get to help with the large problems we have created. In the past decade EwE has been used in at least 15 large scale projects in Europe, through both National, Regional and European funding. This has created a suite of models that is ready to be plugged into the EU new Destination Earth architecture: the European Digital Twin of the Ocean (EDITO). As part of the EU’s Mission to Restore our Ocean and Waters, EDITO must make Ocean knowledge available to all and be usable to address what-if questions asked by policy makers not just in the Ocean but also on land, where most of the problems originate. EwE is the most comprehensive and understandable tool to achieve those aims, and these models will be critical to ensure that EDITO achieve those aims.
 The EU is also currently reviewing its Marine Strategy Framework Directive, which needs better indicators for food web descriptors, and under the EU’s Biodiversity Strategy for 2030 should dovetail more closely with other legislation such as the Water Framework Directive, Nitrates Directive, the Maritime Spatial Planning Directive and the Common Fisheries Policy. I do not know of any other tool that will be able to address this better than an EwE-enabled EDITO.
 Sheila JJ Heymans
 Executive Director, European Marine Board
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		On modelling and making predictions

					Villy Christensen

			

	
				[image: ]
 Figure 1. Raymond Lindeman (1915-1942).
 Food web analyses (and with them ecological networks), as we know them, dates back to the pioneering studies of Raymond Lindeman around 1940 (Figure 1). He studied Cedar Creek Bog in Minnesota and made a detailed model of nutrient cycling expressed as energy flows[1] (Lindeman 1942). For this, he used thermodynamic principles to evaluate and understand ecosystem functioning, and through this he established the field of trophic dynamics. The study of energy flows and concepts he introduced, such as food chains, food webs, ecological transfer efficiency, and energy pyramids, now provides core elements of community and ecosystem ecology.
 Lindeman received a fellowship to work with G. Evelyn Hutchinson at Yale University, managed to publish his PhD studies on Cedar Creek Bog though ill, but unfortunately died soon after, only 27 years old. He was a brilliant mind, and we can only guess how he would have shaped our research world had his days been more numerous.
 Lindeman’s studies, however, inspired research for decades to follow.  Most notably, the International Biological Program (IBP), a major international initiative that during 1964-1974 conducted studies of biological productivity in ecosystems throughout the world. Incidentally, this was also where I first participated in ecological research as a first-year student joining the tail end of the study, sampling fish in a lake in Denmark.
 [image: ]
 Figure 2. Study sites of the International Biological Program (IBP).
 The IBP was mainly descriptive in its nature, and had numerous modelling activities including some dynamic ecosystem modelling – a topic to which we return later.  A lasting legacy of the IBP was that it brought focus to ecosystem research. There were also numerous follow-up studies to the IBP. Methodologies had been developed and coordinated through the IBP, and many researchers had been introduced to the field. The time had come for ecosystem research.
 Among the follow-up studies was an extensive five-year study conducted around 1980, of the French Frigate Shoals in the Northwestern Hawaiian Islands. Researchers quantified energy flows and biomasses ranging from plankton through to marine mammals, and over the five years gathered an impressive amount of data. Realizing the need to make sense of the mountain of data, NOAA hired a newly graduated oceanographer, Jeff Polovina, to construct an ecosystem model of the French Frigate Shoals.
 At this time there were two major activities on ecosystem modelling with a fisheries perspective. Taivo Laevastu and colleagues at the NMFS Alaska Fisheries Science Centre worked on a complex multispecies model of the Bering Sea[2] (Laevastu and Larkins 1981) while K.P. Andersen and Erik Ursin, at the Charlottenlund Castle, Danish Institute for Fisheries and Marine Research, were constructing an equally complex model of the North Sea[3]. Polovina evaluated these modelling efforts and realized the impossibility of constructing species-based dynamic models for biologically diverse areas such as a tropical coral reef ecosystem. From the Laevastu model, he adopted the principle of mass-balance, and used this to construct a simple ecological accounting system, which he termed Ecopath.[4]
 Mass-balance here means that energy input has to balance energy output (including storage) for each species (or functional group) that is being modeled. If we can mass-balance one species, we can balance the whole ecosystem. For this, we use information about how much food predators require to compare to how much production is available from their prey. It has to match. And what is important, this adds constraints to the modelling.  Adding constraints is fundamental for all modelling, and is one reason that mass-balance modelling has shown successful. Along with the ease of application this, in 2009 led to the Ecopath modelling approach, (see Figure 3) being recognized by NOAA as one of the ten biggest scientific breakthroughs in the organization’s 200-year history.
 [image: ]
 Figure 3. The basic Ecopath model creates a snapshot of an ecosystem at a given point in time: who eats who and how much? Mass balance links predator and prey: there has to be enough food for the predators
 I have worked with development of the Ecopath with Ecosim (EwE) approach and software for more than three decades, starting off with Daniel Pauly in the Philippines[5]. Daniel had the idea of merging Polovina’s Ecopath model with ecological network analysis such as developed by Robert Ulanowicz[6] and others. Finding out how and seeing it through became my PhD work, which was focused on network analysis of trophic interactions based on meta-analysis of aquatic ecosystems.
 [image: ]Figure 4. Eugene P. Odum (1913-2002).
 From this work, let me highlight ecosystem development. One of the greatest ecologists of all times, EP Odum (Figure 4) described a set of ecosystem attributes, and how these would change as ecosystems develop[7]. I quantified most of Odum’s 24 attributes based on some forty Ecopath models, and ranked the models based on maturity[8]. It worked really well, and since then a number of colleagues have repeated the analysis with the same result. We can rank ecosystems.
 It’s typical indicator work. You set a number of criteria, extract the numbers, and out comes a ranking. But what attributes and indicators should we use and how do we obtain the overall ranking? I was really fascinated by this during my PhD: that one could extract a few indicators from food webs and use that to characterize the state of ecosystems.
 There are, however, very many indicators and properties in ecological network analysis – you can get the impression that any ecologist doing research in the field in order to be noticed must develop their own way to capture the essence of ecosystems. This, aggravated by very little attempt at evaluating methods and approaches across studies, seems to characterize the field: consensus building has not been an integral part of the development. The big challenge after half a century of ecological network analysis is still to explain what the seemingly endless suite of indicators tells us.
 Yet I do not intend to compare network analysis to the “Emperor’s New Clothes” (Figure 5) – though it is a challenge to interpret the many concepts and indicators. I have worked enough with network analysis to see clear patterns, some of which are consistent and rather straightforward to explain, while others are much more elusive. As an example of where I still have unfulfilled expectations of network analysis, let me point to identification of critical species in ecosystems – the canaries in the coal mine, and as part of this, what makes an ecosystem vulnerable to perturbations?
 [image: ]
 Figure 5. Food web representations can be beautiful, but what do they tell us?
 I come to think of the Hitchhiker’s Guide to the Galaxy, especially the third of five volumes in the trilogy[9]  If you don’t remember it: our planet was really a giant super computer operated by mice. It tolled away for millions of years to answer the biggest and most fundamental question about Life, The Universe and Everything. Eventually the answer came: 42, but by then no one remembered the question. I’ve often been in that situation with network analysis and indicators: It gives the answer, but what was the question? What do the indicators tell us? How do we interpret them? And importantly, can we use this for making prediction?
 Making predictions and evaluating “what if” questions remain elusive, however, as ecological network analysis has demonstrated very little predictive capabilities, such as we are craving for in fisheries management. Rather, network analysis tends to be static, almost without exception – it’s the study and interpretation of snapshots such as mentioned earlier.
 Dynamic considerations have, however, entered from a different route. There was a productivity sub-group of IBP that focused on modelling, including dynamic modelling of ecosystems. For this, they created a new field in ecology, systems analysis, and recruited a cohort of bright, quantitative young scientists that used the emerging computers to make models and analysis never imagined before.
 In essence, what they did was turning the snapshot from the static food web studies into the movie version. And somehow a movie is less open to interpretations than a photo: it adds constraints. But the modelling had problems. All predator-prey modelling is in essence built on Lotka-Volterra dynamics. This means that the consumption by predators is estimated from the product of the number of predators, the number of prey, and a search rate. More predators more consumption; more prey more consumption. Behind this is a thermodynamic principle called mass-action, and this works absolutely fine when mixing reagents and wanting to predict the products. There are, however, problems when using it in ecology.
 The systems analysts in the IBP found that their dynamic models were unstable, and commonly experienced cycles and model self-simplification. Cycles are fine when modelling for instance snowshoe hare – lynx interactions in boreal systems[10], but they are not regular features of more diverse ecosystems. What presented a bigger problem was self-simplification: Lotka-Volterra models are inherently unstable, and it is not possible to maintain ecologically similar groups in models with top-down, mass-action control. The poorer competitors will die out.  This was a problem that marred the modelling of ecosystems, and eventually most or all of the IBP modellers left the field to pursue other avenues.
 [image: ]
 Figure 6. The birth of the foraging arena theory.
 One of the bright young fellows in the IBP was my colleague Carl Walters. He had struggled to make ecosystem models behave and given up[11]. Then one day in the early 90s he was out fishing on a lake in BC with his 9-year-old son, Will. When you fish with Carl you don’t often catch anything, so Will got bored, looked over the side, and saw a lot of nice big Daphnia in the water (Figure 6). He asked: “Why don’t the fish eat them all, Dad?”
 Carl went on to give the obvious explanation, one that any fish biologist could have given. “We are fishing for big trout, they are out here in the open and deep part of the lake. The small trout hide along the shore where the big ones don’t come, and it’s the small ones that eat Daphnia. If the small trout come out here, they will be eaten by the big ones”. A simple straightforward explanation, and only afterwards did the profound implications of the reply dawn on him.
 The fundamental aspect missing in predator-prey modelling was behavior. Organisms are not randomly moving particles as thermodynamics and mass-action terms tell us. Think of a coral reef with its swarms of planktivores. The small stay close to the safety of the reef, the larger stray a bit further away, but only a safe distance. The moment a roaming piscivore, such as a barracuda, comes patrolling by, they all take cover.
 The implication of this is that the prey concentration the piscivores sees is different from the total planktivore abundance, just like the plankton concentration we may measure with nets around the reef is different from what the planktivores actually experience when their foraging is restricted to the immediate safe surroundings of the reef. It takes three to tango: the planktivore (dancer one) restricts its activities in response to the piscivore (dancer two), and this in turn restricts its own access to plankton (dancer three)[12].
 From a modelling perspective, Walters developed an elegant way of adding behavior to the predator-prey modelling through the foraging arena theory[13]. Organisms change between two behavioral states, being available or unavailable for predation, and including this only calls for adding one additional parameter to the Lotka-Volterra equation, a behavioral exchange coefficient (that relates to carrying capacity).
 [image: ]Figure 7. Coral reef representation of the foraging arena – the fish are planktivores and stay close to the reef, alert and ready to dive for cover.
 One small step of logic, but a giant step for modelling – suddenly the ecosystem models started behaving. Where it had been virtually impossible to get models to maintain diversity, incorporation of the foraging arena considerations opened for replicating the known history of ecosystems. This started in earnest a decade ago when fitting ecosystem modelling to time series data started proliferating, and we have since witness a virtual explosion of case studies to the effect that there now probably are more than a hundred of the kind (Figure 8).[image: ]
 Figure 8. Case studies where Ecosim models have been fitted to time series data. The figure was made in 2011, and the number has by now probably tripled or more.
 The case studies are based on the Ecosim module of the Ecopath with Ecosim (EwE) approach and software[14], and we have drawn a number of lessons from them[15], including what you’ll read in this textbook. As a rule, to explain historic changes in ecosystems we have to consider,
 	Food web effects,
 	Environmental change, and
 	Human impact, (see Figure 9).
 
 [image: The figure shows fish in a simple ocean food web, and also that the juvenile and small fish feed on plankton, which in turn feeds on phytoplankton, which in turn is impacted by the sun and the weather, both of which is illustrated. There are also boats fishing. Overall the figure is saying that in order to replicate the ecosystem history we need to understand the food web, and how it has been, is, and will be impacted by the environment and by humans.]Figure 9. Replicating the history of ecosystems calls for inclusion of food web, environmental, and human impact.
 An implication of this is that environmental productivity patterns can be identified throughout the food web. There are variable time delays linked to turnover rates and food web constellations, but we can see environmental signals propagate through the food web. We have also seen evidence that environmental productivity can be amplified through the food web.  The biological explanation for this may be that more food results in more excess beyond maintenance, freeing resources to be allocated to growth and reproduction.
 Fitting-wise, the models tend to work well for species or groups with strong fisheries impacts, i.e. we generally find good agreements with single-species assessment models. Where there are divergences, they can often be explained from model assumptions related to food web effects. It is also clear that while trends for some species can be explained, there can be others for which the models are unable to offer insight – often because we have no reliable information about what the important drivers of change may be for such species. There is, however, nothing to indicate that such model failures have implications for the overall model fit – here one rotten apple doesn’t spoil the bunch.
 [image: ]Figure 10. The butler did it: humans are the usual suspects when evaluating fish population trends, but ecosystem models can now be used to evaluate the relative contribution of food web, environmental, and human impact.
 We see impacts of changes in predator abundance on forage species (prey release), and in some cases the opposite effect; where prey abundance impacts predators. Also, there are cases where fisheries seemingly outcompete predators as increased fishing mortality on a forage species is accompanied by decline in predation mortality[16] (Walters et al. 2008).
 Where ecological networks currently have their biggest potential for contribution in fisheries is for evaluating trade-offs for management. We have reached the point where we with some authority can evaluate trade-offs between alternative uses of fisheries resources[17].
 Summing up, ecosystem models can now replicate historic changes in ecosystems and be used to evaluate the relative impact of fisheries, food web dynamics, and environmental change (Figure 10), and notably use this to evaluate trade-offs. With models that behave well enough to replicate the past, we can start thinking of using them to predict the future, to ask “what-if” questions.
 [image: ]Figure 11. Will there be seafood and healthy oceans for future generations to enjoy?
 The key question we have to ask is “will there be seafood and healthy oceans for future generations to enjoy?” (Figure 11). To answer the question, we have to make predictions. There will be uncertainty and unexpected events, but we need to provide  guidelines and options – to ensure that there will be seafood for future generations. What choices must we make for this?
 Given that the seafood market is an international one, it is a global question, and we have to tackle the question through modelling scaled accordingly. There is, however, no tradition for global modelling in fisheries, and while the Intergovernmental Panel for Climate Change, IPCC, has done the necessary job on predicting how our physical environment will be impacted by climate change, it is only in recent years that the consequences of climate change on life on earth has gained attention.[18]
 [image: ]Figure 12. When making predictions, expect the unexpected. The vampire in the basement will bite you.
 The Intergovernmental Science-Policy Platform on Biodiversity and Ecosystem Services (IPBES) has taken on this task, and from an aquatic modelling perspective this work is supported by the Fisheries and Marine Ecosystem Model Intercomparison project, Fish-MIP), which works to develop a global ocean-modelling framework that incorporates modelling of the physical environment, of lower and higher trophic levels, and of human activities including governance. Fish-MIP provides a framework with alternative modelling components in order to consider uncertainty through an ensemble approach, following the lead for how the IPCC has tackled global environmental modelling.
 Uncertainty indeed has to be a major factor in making predictions. While ecosystem models now offer some predictive capabilities for evaluating major human impacts and making predictions, we cannot make beautiful orchestrated symphonies or detailed predictions, and we will never be able to do that for complex ecosystems. There are notably two factors that prevent this. One is Walter’s “vampires in the basement” (Figure 12), the other is incomplete knowledge of how systems will react to management interventions.
 We must expect the unexpected; there will be events we cannot predict. Invasive species is a case in point, and more generally, behavioral responses in ecosystems are no more predictive than they are for human systems. Let me illustrate with an example; seals have been increasing in the Strait of Georgia since culling ceased in the 1970s. For about 30 years thereafter, mammal-eating transient killer whales were rarely observed in the Strait. Then one summer, a small pod came in and found plenty of prey – the next summer the whale watching boats counted a hundred transient killer whales coming in, and transients have been regular visitors since then. From a modelling perspective, such behavioural events are unpredictable, and they have repercussions through the ecosystems.
 [image: ]Figure 13. Monitor, experiment, and adapt. The fundamental aspects of adaptive management rely on modelling as the guiding factor.
 There is also considerable uncertainty about how ecosystems will react to many management interventions, especially where our knowledge about drivers and impact is very incomplete. Our best option wherever this is the case is represented by adaptive management with carefully planned monitoring, experimentation, and adaptation[19]. Modelling is an integral part of this, needed to guide the entire process and limit the risk of making bad, preventable mistakes.
 [image: ]
 Figure 14. Alice: “Would you tell me, please, which way I ought to go from here?”  Cheshire Cat: “That depends a good deal on where you want to get to”. Policy makers need to set clear objectives for management, and scientists need to evaluate alternative options for managers.
 So, though we cannot make detailed predictions for how ecosystems will develop, we as a society need to carefully choose what direction to take and we need to avoid the preventable mistakes.  For this, it is crucial that fisheries policy makers and managers set clear objectives for management, and that fishery scientists in turn define and evaluate alternative policy options (Figure 14). We need to manage our ecosystems with a strong commitment to moving in a sustainable direction if there indeed is to be seafood and healthy oceans for future generations to enjoy.
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		Modelling predator-prey interactions

								

	
				On the path to ecosystem-based management: species interactions
 Let there be no doubt, single species assessment is a necessary factor for management of fisheries, notably for tactical management. “How do we manage this species in this bay this year?” type of questions.  What we need to ask, however, is if it is sufficient?
 Views on this question go back a long time as expressed by the two pioneers that more than any established fisheries science as a quantitative discipline, Ray Beverton and Sidney Holt. In their 1957 Magnus Opus, “On the Dynamics of Exploited Fish Populations”[1] they wrote (p.24):
 “Elton (1949) has suggested that the goal of ecological survey is ‘…to discover the main dynamic relations between populations living in an area’. This is a generalization of what is now perhaps the central problem of fisheries research: the investigation not merely of the reactions of particular populations to fishing, but also of interactions between them and the extent to which it is possible and practicable to derive laws describing the behavior of the community from those concerning the properties of component populations”
 
 Ray Beverton and Sidney Holt with their book set the vast part of the agenda that fisheries scientists have worked on ever since. And that includes the case for species interactions, as the quote above illustrates.  If the assessments are short-term, as single species assessments tend to be, we can get by assuming “business as usual“, but when we move away from the initial state, e.g., when we address questions at the ecosystem-level, we have no choice.
 “Fish eat fish“, Erik Ursin – who along with K.P. Andersen created one of the first end-to-end ecosystem models[2] – often said. And yes, fish eat fish, and that has implications for management. If we are to successfully manage ecosystems, then species interactions is part of the foundation.
 The foundation for this was laid a century ago, when Lotka[3] and Volterra[4][5] both and independently formulated a theory for predator-prey interactions. Models based on these sources are called Lotka-Volterra models and they are in essence the foundation for all predator-prey models, including the dynamic models in EwE.
 The basis is that with no resource limitations and no predators, prey populations (N) will change over time with an exponential growth rate (r),
 [image: dN/dt=rN \tag{1}]
 and predator populations (P) will decrease with a mortality rate (m, due to e.g., starvation or old age),
 [image: dP/dt=-mP \tag{2}]
 In a simple predator-prey system with no resource limitations for prey, the equations can be coupled. For the prey population, we describe the change over time with the differential equation,
 [image: dN/dt=rN-aNP\tag{3}]
 where the factor a is called the search rate. For the predator,
 [image: dP/dt=gaNP-mP\tag{4}]
 where g is the growth efficiency with which the predator converts consumption to production.
 If you examine the last equation, you’ll notice that the predator’s consumption (Q) of this prey is calculated as
 [image: Q=aNP\tag{5}]
 which means that more predators (P) lead to more predation, and more prey (N) means more predation – the consumption is the product of the two and the search rate constant.
 Systems modelled with such assumptions are unstable, initially the predator population may grow if there are plenty of prey around, but as it grows, the prey population gets more impacted and at some point the prey will collapse. The slower-growing predators will survive for a while, but in a simple two species systems, they will eventually collapse as well. That in turn releases predation mortality from the minuscule prey populations, which will have great conditions and start growing exponentially – after which history repeats itself, the predator will increase, the prey collapse, the predator collapse. The system becomes cyclic and unstable.
 Volterra (1928) summarized the properties of predator-prey interactions in three “laws”
 Law of the periodical cycle: The fluctuations of two species populations, where one feeds on the other, are periodic, and the period depends entirely on the coefficients of growth (r) and decay (m) and initial conditions (No and Po).
 Law of the conservation of averages: The averages of population numbers of the two species remain constant and independent of the initial values of both populations if and only if the coefficients of growth and decay and the conditions of predation (prey losses, predator gains, i.e. the four coefficients r,a,e,m) remain constant.
 Law of perturbation of averages: If individuals of both species are removed, (e.g., by predation or fishery) uniformly and in proportion with their total population, the average population of the prey increases, while the average population of the predator decreases. On the other hand, increased protection of the prey species will lead to growth of both populations.
 
 
 The cyclic and unstable nature of Lotka-Volterra systems is not what we see in most ecosystems, and for that reason there have been numerous modifications proposed, notably after C.S. Holling[6]  added predator handling time (h) through his disk equation where the consumption by a predator is estimated as,
 [image: Q=aNP/(1+hN)\tag{6}]
 recognizing that the time a predator spends handling a prey it will not be searching for new prey. That limits the predator consumption rate at high prey densities – and leads immediately to unstable dynamics (exploding cycles) in the predictions unless some other factor(s) are included in the model to limit variation in prey and/or predator abundances and predation rates.
 [image: Population growth rate (dN/dt) as a function of population size (N) for the logistic growth model. The figure showed a dome-shaped parabola with maximum growth rate of half of the population carrying capacity, and zero growth when the population is a zero as well as when it is at its carrying capacity.]
 Figure 1. Population growth as a function of population size for the logistic (Verhulst) model. Carrying capacity for the population is set at 2.
 Lotka-Volterra models can be defined without (as above) or with resource limitation, i.e. carrying capacity (K). The “standard” way of implanting resource limitation is to express prey population change using the logistic equation for population growth (Verhulst),
 [image: dN/dt=rN(1-N/K)\tag{7}]
 Foraging arena
 The foraging arena theory was developed by Carl Walters, and serves as the foundation for the dynamic modules of EwE, i.e. of Ecosim and Ecospace. The basic assumption in foraging arena theory is that spatial and temporal restrictions in predator and prey activity cause partitioning of prey populations into vulnerable and invulnerable population components, such that predation rates are dependent on (and limited by) exchange rates between these prey components[7].
 Foraging arena models (such as Ecosim[8]) are based on Lotka-Volterra modelling but the interaction terms only include the vulnerable part (V) of the total prey population (N). So, where we for Lotka-Volterra models have the predator consumption (Q) estimated from,
 [image: Q=aNP\tag{5}]
 the similar equation for foraging arena models is,
 [image: Q=aVP\tag{8}]
 Further, the prey exchange between vulnerable and in vulnerable states can be described with the rate equation,
 [image: dV/dt=v(N-V)-v'V-aVP\tag{9}]
 from which V is predicted to the moving equilibrium (for N and V), setting dV/dt to 0,
 [image: V=vN/(v+v'+aP)\tag{10}]
 Changes in the predator and prey populations over time can then be predicted from the Lotka-Volterra model equations, substituting the total prey populations (N) with the vulnerable population (V).
 Associated tutorial
 There is a tutorial to accompany this section in the next chapter of the web version of this book. You can either develop a Lotta-Volterra model based on the equations above or use the R-code that is included in the tutorial (or do both).
 Quiz
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/ewemodel/?p=394#h5p-1 
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		Tutorial: Predator-prey models

								

	
				We will work with two versions of a simple predator-prey model based on Lotka-Volterra[1][2][3] and foraging arena assumptions[4]. The models can be developed using the equations in the previous section, but to simplify it, we have made R-code for the two versions of the predator-prey model. You can download this code from this link, and, e.g., use it in R-Studio.
 In these models (both included in the R file), we have for clarity here separated the components of the predator prey models, e.g., so that the addition terms for prey and predators are called births, and the subtraction terms are called deaths.
 Lotka-Volterra models have stable equilibrium points for the predator and prey, which can be calculated as follows,
 	For the prey: Eq.prey = predator death rate / (predator search rate * predator growth efficiency)
 	For the predator: Eq.pred = prey birth rate / predator search rate
 	Eq.prey and Eq.pred are calculated in the R code, check the Environment > Values window once you have the code running.
 
 We suggest you try the following,
 	Run the code
 	Does the Lotka-Volterra model (“mass action” in code) and the foraging arena model give the same results?
 	Look through the code, find out what it is doing
 	Note the differences between the two model formulations, including the settings for the vulnerability (vone, vtwo)
 	Try different levels of carrying capacity (CC), including setting CC to 0 	What does the code do when CC==0?
 
 
 	What is the effect of setting handling time >0? 	Check the code for handling time (ht). What impact does handling time have on the number of prey eaten?
 
 
 	Try changing all of the input parameters, and reflect on the impact and why 	Do this one by one, so you can go back to the original state
 
 
 	The foraging arena model can be invoked by changing the vulnerability (vone) setting to a low value (≥1), e.g., 2 	High settings for vone implies “top-down” control, and will make the model behave like a Lotka-Volterra mass action model. Low settings (≥1) implies “bottom-up” control. Much more about this in the Ecosim parts of this textbook.
 
 
 	Change input parameters as above to see the difference between the mass action and the foraging arena model formulations.
 	Paradox of Enrichment: Rosenzweig described the Paradox of Enrichment where increased prey productivity may cause instability for predators. This is one of the unexplained issues with mass-action models. Simulate this in the predator-prey model by increasing prey productivity (birth rate, br) along with carrying capacity (K). Compare the results in the mass-action and foraging arena formulations of the predator prey model.
 	Play!
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		Your research question?

								

	
				 The simplest model that can address your research question is the best model
 
 So you want to build an ecosystem model. It should be very capable, it should be able to address any policy, management, environmental, population dynamic or ecological question about the resources in your ecosystem. If so, it has to be complex, it has to be end-to-end, include everything important from nutrients over whales to how society works. Right?
 No, that thinking leads to Frankenstein models, models that take on a life of their own where no-one really knows why they behave the way they do. Instead the rule is: the simplest model that can address a given question is the best model to use. Best, because it’s the model with most predictive power[1].
 
 [image: The plots shows model prediction uncertainty versus model complexity. With higher complexity the prediction error variance decreases, but the parameter uncertainty increases. The combination (that is sum) of the two is the policy parameter uncertainty, which has a parabola form with the lowest uncertainty at intermediate complexity. That is at the "sweet spot" for model complexity.]
 Figure 1. Uncertainty about a policy parameters U (as expressed through its variance [image: \sigma _U^2] is likely to be minimized at an intermediate complexity.[2]). 
 That rule also holds for working with EwE. Don’t spend years building a complex ecosystem model in order to address any question that may arise. Instead, close doors as you move ahead, build something simpler, as simple as you can get away with – you can always add details and see if it makes a difference. Make new doors when and where needed. The model building process is a continuum you may never finish, recognize that and focus your effort. Make it a simple as you can in order to address the one thing that should be your guiding star: What is your research question?
 Descriptive or predictive model? If descriptive you want to be inclusive, if predictive, be selective. See Defining the ecosystem.
 
 
 Keeping it simple has several advantages, faster development and run times are just part of the picture. Equally as important is that keeping it as simple as possible makes it much more realistic to develop alternative models to address the research question that guides the work. It also makes it easier for you, the modeller to grasp what your model is doing and why.
 Models are not like religion
 – you can have more than one
 – and you shouldn’t believe them
 
 
 Proponents of this principle have long advocated the use of Minimum Realistic Models[3] and Models of Intermediate Complexity for Ecosystem assessments[4], and this is indeed an approach that can go hand-in-hand with EwE model development and application.
 Part of this is that models are not like religion, you can have more than one (and you shouldn’t believe them). So, if you find that a model can answer your question, should you believe the answer?  No, evaluate how robust your findings are, don’t take them at face value. Examine your model and explore what it takes to make the answer go away. That doesn’t mean they are always wrong, but if you keep your model relatively simple, you can use alternative model formulation to explore the same or different questions. Consider and test if there are alternative hypotheses (and with it model formulations) that may be used to address the questions that drive your research.
 If you are thinking of a management intervention, and you can’t make it work in a simple model, what’s the chance it may work in reality?
 Keith Sainsbury
 
 
 Consider where we would be with climate change, if the IPCC had decided years ago to build one-model-that-rules-them-all to evaluate the mechanisms and impacts of climate change. We would still be arguing if what we are experiencing is climate change or natural variations. The approach that IPCC have taken by using an ensemble model approach represents the best way forward. IPBES has picked it up, and are using an ensemble approach to evaluate among other the impact of climate on fisheries and marine ecosystem through the Fish-MIP model intercomparison approach – of which EwE models are an integral part.
 There may be an apparent conflict between keeping it as simple as possible and using an ensemble approach of perhaps more complex models, but that conflict is indeed only apparent.[5]
 Holden et al.[6] provides a cost-benefit analysis of ecosystem modelling to support fisheries management. As part of this they evaluate not just benefit but model costs as well for models ranging from single-species models to complex ecosystem models. They found that costs varied by two orders of magnitude with cost increasing with model complexity. There are trade-offs and no “correct” way or “best” model. What matters is what is needed to answer the research/policy questions. That has to be defined from the very onset.
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		Defining the ecosystem

								

	
				The ecosystems to be modelled using EwE can be of nearly any kind: the modeller sets the limits. The general rule for descriptive network analysis is to define the system so that the interactions within the system add up to a larger flow than the interactions between it and the adjacent system(s). In practice, this means that the import to and export from a system should not exceed the sum of the transfer between the groups of the system. If necessary, one or more groups originally left outside the system should be included in order to achieve this.
 For predictive models, it’s a bit simpler or at least different. You formulate your research question, identify the key species and include the groups of importance for the key species. That would typically be the predators and prey of the key species along with fisheries that impacts these groups. Given that this indeed is much simpler, we’ll focus the rest of this chapter on descriptive models.
 What should  you include in your model?  There is no clear answer to that, it really depends on what your research or policy question is.  For this, there are basically two major categories, descriptive vs. predictive.
 For descriptive models, you want to be complete, to include as much of the ecosystem components as practically possible. We’ve often initially erred on the side of being inclusive, adding groups even if they probably had low biomasses, flows and potential impact. Then as the model took shape and it became clear that certain groups were unimportant, we’d aggregate those groups to make things more manageable.  The strength of descriptive models is that they can be used to characterize the form and functioning of ecosystem, including notably for network analysis, e.g. about the ecosystem stage of development[1]. But their ability to address ‘what-if’ questions is severely limited or non-existent – one can use the mixed trophic impact analysis to give indications for what would happen as a result of a change in abundance or fisheries impact, but it will only be indications, not actual predictions.
 To make predictions, we need predictive models, which means dynamic models that can be used to address more targeted research or policy questions than those posed to descriptive models. While descriptive models can be used as the foundation for predictive models, they come with a ballast of long development time, longer run time, and a flurry of detailed output that can make it difficult to actually get to addressing the policy / research questions that should drive the effort.
 Instead the best advice is to develop predictive models with what is needed to address the questions at hand. Focus on the target species, add important predators and fisheries, and include key prey groups and lower trophic level groups. Start off with a simple model, get to address the questions, then explore what happens if you add more details. So, don’t try to make a model that perhaps someday may be useful for addressing a variety of questions, you’ll spend so much time and energy doing that that you may never get to actually addressing the questions that were to drive the research.
 Descriptive or predictive?
 Let’s illustrate the difference between descriptive and predictive studies with an example. First, clearly define your research or policy question. Say your task is to understand the importance of the fisheries of the Azores Islands. For that you would build a model of the EEZ and include the commercially important species along with their predators, prey and production system, and you would include the various Azorean fisheries in the model. Given your task, you would include the important skipjack tuna in your model. But skipjack is a highly migratory species with an ocean-wide distribution, not confined to the Azorean EEZ, so while it’s important to include skipjack in your model, the skipjack population area is much wider than the EEZ. How do you handle that?
 The simple way is to recognize that your model is restricted to the EEZ. You include skipjack tuna with both immigration and emigration. If in the Ecosim model runs, you increase the tuna fisheries, more skipjack will be caught, fewer skipjack will leave the EEZ, and the following year the same number of skipjack will immigrate to the EEZ. Your model will have skipjack included, it can fish them more or less, but it will not impact the overall skipjack population.
 Is that OK?
 To answer that you have to consider your research question. If you are indeed describing the fisheries of the Azores Islands, all seems good with this approach. But if what you really want is to evaluate skipjack population dynamics, you need to define a model area that encompasses the skipjack distribution area and all-important fisheries. That would not be a model of the Azores Islands, but a dedicated MICE type model, i.e. a simpler predictive model focused on the key species of relevance for your research question.
 Define your model question(s), that’s your focus!
 
 For descriptive models
 The groups of a system may be (ecologically or taxonomically) related species, single species, or size/age groups, i.e., they must correspond to what is called “functional groups.” Using single species as the basic units has clear advantages, especially as one then can use estimated or published consumption and mortality rates without having to average between species. On the other hand, averaging is straightforward and should lead to unbiased estimates if there is information about all the components of the group. The input parameters of the combined groups should simply be the means of the component parameters, weighted by the relative contribution of the species in the group. Often one does not, however, have all the data needed for weighting the means. In such cases, try to aggregate species that have similar sizes, growth and mortality rates, and which have similar diet compositions.
 There is a facility in FishBase (www.fishbase.org) that assembles, for any country and many ecosystems, a list of the freshwater and marine fish occurring in different habitat types, and other information useful for Ecopath models (maximum size, growth parameters, diet compositions, etc.)
 
 For tropical applications, grouping of species is always needed: there are simply too many species for a single-species approach to be appropriate for more than a few important populations. It is difficult to provide specific guidelines on how to make the groupings, as this may differ among ecosystems. Generally however, one should consider the whole ecosystem, e.g., for an aquatic model, one or two types of detritus (e.g., one to include mainly marine snow, the other discarded bycatch, if any), phytoplankton, benthic producers, herbivorous and carnivorous zooplankton, micro- and macrobenthos, herbivorous fish, planktivorous fish, predatory fish, etc., and that at least 12 groups are included, including the fishery (any number of fleets/gears), if any. But most important is the personal judgment of what is appropriate for your system.
 The recommendation of including at least 12 groups is based on Christensen (1994),[2] and is based on impact of number of groups on network indicators. If your model is predictive and you’re not comparing network indicators with other models, you can safely ignore this recommendation.
 
 Special consideration needs to be given to the bacteria associated with the detritus. One option, applicable in cases where no special emphasis needs to be given to bacterial biomass, production and respiration, is to disregard the flows associated with these processes, which are, in any case, hard to estimate reliably, and which tend to completely overshadow the other flows in a system. (In such cases, one assumes that the bacteria belong to a different, adjacent ecosystem linked to yours only through detritus export). Alternatively, bacteria can be attached to one or all of the detritus boxes included in a system. To do this, create a “box” for the bacteria, and have them feed on one or several of the detritus boxes. (This is required because detritus, in the Ecopath model is assumed not to respire). Consider, finally, that there is no point including bacteria in your model if nothing feeds on them.
 
 For an overview of the ecosystem concept in ecology, we suggest you consult the book by Golley[3].
 
 Open system problems
 For almost every defined ecosystem study area, there will be some species that have life cycles that take them outside the defined area for at least part of each year.  Movements (exchange) of biomass across the area boundary can be of two types: dispersal, involving unidirectional movement of organisms to and from sink and source populations outside the study area; and migration, involving regular, repeated movements into and out of the area by the same individuals.  These are fundamentally different processes, with very different policy consequences.  Dispersal acts as an extra mortality-agent and recruitment-source independent of fisheries and other impacts in the study area, while migration exposes organisms from the study area to particular risks and opportunities for part of the time, without acting as a “permanent” drain or source of those organisms.
 Dispersal can (as described in the Azores Islands example above) be represented in both Ecopath and Ecosim by setting immigration and emigration rates in the Ecopath > input > Other production form. These rates are used in the Ecopath mass balance and are treated in Ecosim as unidirectional (non-migratory) dispersal rates. True migration is more complex to deal with, but Ecospace can handle it – see the Migration chapter.
 There are two broad options for dealing with directed migration to and from the Ecopath study area so as to avoid misleading predictions in Ecosim and Ecospace:
 	The “diet import” approach: for species that migrate to/from the study area for part of each year, include all fisheries/catches that impact the species, independent of whether these are taken within the study area. In the Diet composition form, set the diet import proportion to the proportion of time spent outside the system, and set remaining diet proportions to the diet proportions while in the system times the proportion of time spent in the system. Using this convention, Ecosim then will allow policy exploration of all fisheries that may impact the migratory species, and will treat the food intake rate (per biomass) as constant over time for the time spent feeding outside the system. Ecopath and Ecosim will “automatically” account for reductions in prey impacts caused by the species for the proportion of time that the species spends feeding in outside areas. Note that the list of fisheries impacting migratory species can involve splitting fleets into “inside” and “outside” fishing components (which can be varied or “managed” separately in Ecosim), to represent possible policy changes in where/when the migratory fish are harvested.
 	The “model expansion” approach: If it is considered unrealistic to assume that food consumption rates obtained while outside the system (by migratory species) will remain constant over time, then Ecosim must be provided information on possible changes in food organism populations in those outside areas. That is, the outside areas must be “internalized” as part of the modelled system, by adding functional groups representing the outside food web structure. Often, adding such groups may simply mean replicating the initial Ecopath group structure, with the second set of groups labelled “outside species X” and with diet matrix entries set so that the added groups feed on one another but not on the “inside” groups.
 
 A good modelling tactic is to try both approaches and see whether they give different answers. However, note that the first approach can lead to misleading answers upon entry to Ecospace, if the Ecospace mapped area includes the ‘outside’ system: in that case, the model will continue to “import” part of the diet and food consumption of migratory species. Thus when the model development plan includes use of Ecospace to represent a larger spatial system, the functional group organization for that larger system needs to be included in the initial Ecopath/Ecosim model definition (approach 2).
 It is possible to incorporate migration in Ecospace by defining which groups migrate and where their concentration is by month, see Representing seasonal migration in Ecospace for further information.
 
 Attribution
  This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
 
 
	Christensen, V., 1995. Ecosystem maturity — towards quantification. Ecological Modelling 77, 3–32. https://doi.org/10.1016/0304-3800(93)E0073-C ↵
	Christensen, V. 1994. Emergy-based ascendency. Ecological Modelling 72:129-144. https://doi.org/10.1016/0304-3800(94)90148-1 ↵
	Golley, F.B. 1993. A History of the Ecosystem Concept in Ecology: More Than the Sum of the Parts. Yale University Press, New Haven, CT. ↵
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		The energy balance of a box

								

	
				[image: This is a fairly complex figure illustrating how Ecopath obtains mass balance. The focus is an intermediate predator for whom the consumption "pie" is illustrated. The predator eats two prey, small pelagics and benthos, and it is emphasized that the area of the predator "pie" has to match the area that the predator takes out of the two prey "pies". This means that we can use information about the predator (i.e. consumption and diet composition) to tell us how much the predator must eat of the two prey types. All of the "pies" are divided into components illustrating the two Ecopath master equations. First that Consumption = production + unassimilated food + respiration. And the second production = predation + catches + other mortality + net migration and biomass accumulation (though the last two terms are not shown on the figure). The production term for the two prey types restricts how much food the predator may be able to get. It adds constraints, and that's the key to mass balance, indeed to modelling overall. It means we can use information about prey productivity to constrain the possible consumption by the predator and vice versa we can use predator demand to set constraints for how big the prey production must be.]
 Figure 1. Representation of Ecopath mass-balance (Ecopath “pies”[1]) depicting how the consumption of an intermediary predator can be linked to the production of two prey groups. 
 Mass balance
 Take a close look at Figure 1, it is key to understanding how Ecopath mass balance works. For three of the groups in the system, the intermediary predator, small pelagics and benthos their consumption is represented by a “pie”, which size is proportional to the consumption of the group. The predators consumption includes small pelagics and benthos in the proportion dictated by the diet composition of the predator – here that’s perhaps 55% for small pelagics and 45% for benthos. Within each of the three groups the consumption is broken into pieces of the pie, using Equation 1,
 If the model currency is a nutrient, there is no respiration, and Eq. 1 becomes consumption = production + unassimilated part. In that case, the unassimilated part = consumption – production.
 Master Equation 1:
 [image: \text{Consumption = production + respiration + unassimilated part} \tag{1}]
 where on Figure 1, Resp represents respiration and U the unassimilated food. This equation is in line with Winberg[2] who defined consumption as the sum of somatic and gonadal growth, metabolic costs and waste products. The main differences are that Winberg (along with many other bioenergeticists) focused on measuring growth, where we focus on estimating losses, and that the Ecopath formulation does not explicitly include gonadal growth.  How about predation then? On Figure 1, predation is split into its components, i.e.,
 Master Equation 2:
 [image: \text{Production =  predation mortality  + fishing mortality  + biomass accumulation  + net migration  + other mortality}\tag{2}]
 These two equations are so fundamental for understanding Ecopath that we call them “Master Equations”. Check out Figure 1, and consider what would happen if we don’t know the biomass of the intermediary predator? We would still know its diet composition, and the production of each of the two prey groups, we could then estimate a biomass for the predator, and see how much they would consume of the two prey groups, and if this was feasible. In that case, production of the prey set constraints for how much the predator potentially can eat. Alternatively, if we didn’t know the biomass of one (or both) of the prey groups, the consumption of the predator sets a demand for how much prey there has to be in order to meet the predators’ requirements. So, consumption by the predator sets constraints for how prey production. In summary, we use information about the predator consumption to provide constraints for prey production, and information about the prey production to set constraints for predator consumption. The process is called “mass balance”, and is conducted throughout the food web, see Figure 2.
 [image: The figure shows mass balance as an old-fashion balance scale where one side says "Energy In" and the other "Energy out". The two sides must balance, that's in the Laws of Thermodynamics. There is such a balance illustrated for a number of groups, in Ecopath for each functional group in a model. The idea is that energy out for a prey relates to energy in for its predators. That is, we can use information about prey production to constrain predator consumption, and vice versa.]
 Figure 2. Ecopath is a mass balance model where energy in has to equal energy out for each groups in the system. Energy out for a prey relates to energy in for its predators, which links groups in the system and provides constraints for the mass balance. 
  
  
  
 Does the mass balance process add parameter constraints?
 
 Essington[3] evaluated Ecopath sensitivity to imprecise data inputs, and found that the mass balancing did not have any noticeable effect. The study used nine balanced Ecopath models, added parameter uncertainty and evaluated the degree to which the mass balance could retrieve the “true” parameters values. The study, however, did not recognize that the strength of mass balance is to weed out impossible parameter combinations, so when starting with balanced models those parameter combinations had already been excluded, and minor prediction errors (CV of 0.05 to 0.3) will not make the models sufficiently “unbalanced” compared to models developed from raw data, (which often have conversion errors that the mass balancing is good at pointing to). Our experience is clear, mass balance constrains the parameter space. The mass balance constraint implemented in the two master equations of Ecopath (Eq. 1 and Eq. 2) should not be seen as questionable assumptions, but rather as filters for mutually incompatible estimates of flow.  One gathers all possible information about the components of an ecosystem, of their exploitation and interaction and passes them through the mass balance filter of Ecopath. The result is a possible (even plausible) representation of the energetic flows, the biomasses and their utilization. The more information used in the process and the more reliable the information, the more constrained and realistic the outcome will be. The possible representation of state variables and flows is all the Ecopath aims for.  Once in the dynamic simulation modules, we can use routines to generate thousands of possible Ecopath models to evaluate impact of uncertainty on policy and research questions.
 Parameters
 The first Ecopath Master Equation (Eq. 1) can formally be expressed and values estimated from,
 [image: Q_i=P_i+R_i+U_i\tag{3}]
 where the parameters are explained in Tables 2 and 3.
 Notice that Eq. 3 uses absolute flow rates (t km-2 year-1), but in the actual implementation, we estimate the production and consumption as Qi=Bi (Q/B)i and Pi=Bi (P/B)i, respectively. The main reason for this is that the standing stocks (Bi) and instantaneous flow rates (Q/B) and (P/B) are those usually estimated, they are system size independent and therefore comparable between systems, and one can relate to them. That’s much more difficult for absolute values. Once inside Ecopath, it is, however, the absolute flow rates that are used in the calculations, but that’s a different story.
 The production equation, aka Master Equation 2 (Eq. 2) can similarly be expressed as,
 [image: P_i=M2_i \cdot B_i+C_i+BA_i+E_i+M0_i \cdot B_i\tag{4}]
 where M2i is the predation mortality (year-1), and M0i is an “other mortality” instantaneous rate (year-1), both of which becomes flow rates (t km-2 year-1) when multiplied with biomass (t km-2). The parameters are again explained in Tables 1 and 2.
 “Other mortality” is often called M0 in some models – dating back to the MSVPA (and probably Andersen and Ursin’s North Sea model),  and we have adopted this convention.
 Other mortality includes mortality due to diseases, starvation, etc. The animals or plants concerned will become flow to detritus. In addition, mortality caused by predator groups not explicitly included in the model are included in the M0 term. This mortality term is in the MSVPA called M1, while in EwE it is included in M0 as Ecopath models traditionally would be descriptive and inclusive (and hence M1 is likely to be small). But, it’s really just a convention.
 For MICE type models, one should be aware that the M1-part of the M0 flow doesn’t actually go to detritus, but is being consumed by predators not included in the model. Given that MICE models are focused on specific research questions this is not likely to be of concern.
 
 The “other mortality” is the difference between total production and the sum of export, biomass accumulation, net migration, and predation mortality.
 The “other mortality” thus expresses the mortality terms that the Ecopath model does not include, it could for instance be fish dying of diseases or old age, or mortality due to predators not considered in the model. It follows that 1-M0i expresses the proportion of the production for which the fate is described in the model. We call that entity the “ecotrophic efficiency” (EEi) in tradition with Polovina’s first Ecopath model[4], and it can be expressed,
 [image: EE_i=\frac {M2_i \cdot B_i+C_i+BA_i+E_i}{P_i}\tag{5}]
 In Eq. 4 and Eq. 5 all terms are expressed as flow rates (t km-2 year-1). If these flow terms are made relative to biomass (t km-2), and considering that Fi=Ci/Bi, they become rates (year-1), and as Fi=Ci/Bi, Eq. 4 can be re-expressed as,
 [image: (\frac PB)_i =M2_i +F_i+\frac{BA_i}{B_i}+ \frac {E_i}{B_i}+ M0_i\tag{6}]
 An interesting twist to Eq. 6 is that the Ecopath mortality form (at Ecopath > Output > Mortality) actually shows this equation.
 
 This equation is important, study it carefully. We describe production as the sum of predation mortality plus fishing mortality plus net migration plus biomass accumulation plus “other mortality”.
 Oh, that’s actually the second Master Equation (Eq. 2), we’re back where we started, neat.
 The following table provides an overview of the input parameters for Ecopath models.
 Table 1.  Basic input parameters for Ecopath models
 	Input parameter 	Name 	Default value 	Unit 
  	Bi 	Biomass 	 	t km-2 
 	(P/B)i 	Production/biomass ratio 	 	year-1 
 	(Q/B)i 	Consumption/biomass ratio 	 	year-1 
 	EEi 	Ecotrophic efficiency (EEi = 1 - M0i) 	 	(proportion) 
 	BAi 	Biomass accumulation 	0 	t km-2 year-1 
 	Ei 	Net migration (immigration - emigration) 	0 	t km-2 year-1 
  
 Table 2.  Other input parameters for Ecopath models
 	Input parameter 	Name 	Default value 	Unit 
  	DCji 	Proportion of prey i in diet of predator j 	0 	(proportion) 
 	Ui 	Unassimilated part (excretion + egestion) 	0.2 	(proportion) 
 	Ci 	Catches by fleet 	0 	t km-2 year-1 
  
 Table 3. Estimated parameters for Ecopath models
 	Parameter 	Name 	Unit 
  	Pi 	Production (Pi=Bi (P/B)i) 	t km-2year-1 
 	Qi 	Consumption (Qi=Bi (Q/B)i) 	t km-2year-1 
 	gi 	Gross food conversion efficiency gi = Pi / Qi, can be an input in which case either (P/B)i or (Q/B)i is estimated 	(proportion) 
 	Ri 	Respiration (= Qi - Pi - unassimilated food) 	(proportion) 
 	Fi 	Fishing mortality (Fi = Ci / Bi) 	year-1 
 	M0i 	Other mortality (M0i = 1 - EEi) 	year-1 
 	M2i 	Predation mortality (M2i=∑Bj DCji) 	year-1 
  
 Parameter estimation
 Not all parameters used to construct a model need to be entered. The Ecopath model “links” the production of each group with the consumption of all groups, and uses the linkages to estimate missing parameters, based on the mass-balance requirement of the second Ecopath Master Equation Eq. 2 and Eq. 4, that production from any of the groups has to end somewhere else in the system. Ecopath balances the system using one production equation for each group in the system. For a system with n groups, n production equations as in Eq. 4 are used,
 [image: \begin{eqnarray} B_1(\frac PB)_1 EE_1-B_1 (\frac QB)_1 DC_{11}-B_2(\frac QB)_2 DC_{21} \ldots -B_n (\frac QB)_n DC_{n1} - Y_1 - E_1 - BA_1=0 \\ B_2(\frac PB)_2 EE_2-B_1 (\frac QB)_1 DC_{12}-B_2(\frac QB)_2 DC_{22} \ldots -B_n (\frac QB)_n DC_{n2} - Y_2 - E_2 - BA_2=0 \\ B_3(\frac PB)_3 EE_3-B_1 (\frac QB)_1 DC_{13}-B_2(\frac QB)_2 DC_{23} \ldots -B_n (\frac QB)_n DC_{n3} - Y_3 - E_3 - BA_3=0 \\ \vdots \\ \vdots \\ B_n(\frac PB)_n EE_n-B_1 (\frac QB)_1 DC_{1n}-B_2(\frac QB)_2 DC_{2n} \ldots -B_n (\frac QB)_n DC_{nn} - Y_n - E_n - BA_n=0 \end{eqnarray}\tag{7}]
 where the parameters are as in Tables 1 and 2. A system of linear equation as in Eq. 7 can be solved using standard matrix algebra – you may have learned that in precalculus or algebra classes. If, however, the determinant of a matrix is zero or if the matrix is not square, it has no ordinary inverse. Still, a generalized inverse can be found in most cases. For Ecopath, we have adopted an approach described by McKay[5] to estimate the generalized inverse. If the system of linear equations is overdetermined (more equations than unknowns), and the equations are not mutually consistent, the generalized inverse method provides least square estimates to minimize discrepancies[6].  While the generalized inverse in principle is a great way of solving a system of linear equations, it is in practice not used much in the Ecopath mass-balance routine. By iteration through the system, it is usually possible to solve many of the equations. Those equations are eliminated and the inversion is only used where and if needed.
 An important implication of the mass-balance equation Eq. 7 is that information about predator consumption rates and diets concerning a given prey can be used to estimate the predation mortality term for the group, or, alternatively, that if the predation mortality for a given prey is known the equation can be used to estimate the consumption rates for one or more predators instead.
 
 The gross food conversion efficiency, gi, is estimated using
 [image: g_i=\frac{(P/B)_i}{(Q/B)_i}\tag{8}]
 while Q/B are attempted solved by inverting the same equation. The P/B ratio is then estimated (if possible) from
 [image: (\frac PB)_i=\frac{\sum \limits_{j=1}^{n} Q_j \cdot DC_{ji}+ C_i+E_i+BA_i}{B_i \cdot EE_i} \tag{9}]
 This expression can be solved if both the catch, biomass and ecotrophic efficiency of group i, and the biomasses and consumption rates of all predators on group i are known (including group i if a zero order cycle, i.e., “cannibalism” exists). The catch, net migration and biomass accumulation rates are required input, and hence always known;
 The EE is estimated from
 [image: EE_i=\frac{M2_i\cdot B_i+C_i+E_i+BA_i}{P_i}\tag{10}]
 where the predation mortality M2i is estimated as in Table 3 (= the first term of the numerator in Eq. 9.
 In cases where all input parameters have been estimated for all prey for a given predator group it is possible to estimate both the biomass and consumption/biomass ratio for such a predator. The details of this are described in the original Ecopath II User Guide Appendix 4, Algorithm 3.
 If for a group the total predation can be estimated it is possible to calculate the biomass for the group as described in detail in the original Ecopath II User Guide, Appendix 4, Algorithm 4.
 In cases where for a given predator j the P/B, B, and EE are known for all prey, and where all predation on these prey apart from that caused by predator j is known the B or Q/B for the predator may be estimated directly.
 In cases where for a given prey the P/B, B, EE are known and where the only unknown predation is due to one predator whose B or Q/B is unknown, it may be possible to estimate the B or Q/B of the prey in question.
 Once the loop no longer results in estimate of any missing parameters a set of linear equations is set up including the groups for which parameters are still missing. The set of linear equations is then solved using a generalized inverse method for matrix inversion described by Mackay[7]. It is usually possible to estimate P/B and EE values for groups without resorting to including such groups in the set of linear equations.
 
 The loop above serves to minimize the computations associated with establishing mass-balance in Ecopath. The desired situation is, however, that the biomasses, production/biomass and consumption/biomass ratios are entered for all groups and that only the ecotrophic efficiency is estimated, given that no procedure exists for its field estimation.
 
 
 Indeed, the central point in this is that the system of linear equations in Eq. 7 can be solved for one unknown parameters for each equation. So, the advice is to leave one input parameter unknown for each group in the model, and that one parameters is preferably EE, unless no biomass estimated is available. More about that next.
 Guidelines for parameter estimation
 The parameters in Table 2, i.e. the diets (DC), the unassimilated part (U) and the catches (C) must always be entered as Ecopath input along with one of the six parameters in Table 1, i.e. biomass (B), production/consumption ratio (P/B), consumption/biomass ratio (Q/B), ecotrophic efficiency (EE), biomass accumulation (BA), and net migration (E).  When running the Ecopath parameterization, the program will if all four basic input parameters, (B, P/B, Q/B, and EE) are entered, ask if you want to estimate biomass accumulation (BA)? If you answer no, it will ask if you want to estimate net migration (E)?
 While the matrix inversion used for solving for missing parameters in Eq. 7 is flexible, it is a flexibility that should be used carefully. so a few guidelines.
 
 Guidelines
 Unless you have reason for doing it differently, leave the biomass accumulation and net migration at the default value (0).
 We have a good idea of Q/B ratios (year-1) for basically all kinds of organisms, so don’t let the program estimate Q/B.
 P/B values (year-1) relates to the average longevity (B/P, year) and to standard assessment outputs (Z, year-1), so should not need to be estimated.
 If biomass estimates are available use them, and estimate EE.
 If you don’t have biomass estimates, guess a reasonable EE value.
 
 Note that it is generally not possible to estimate B or P/B for apex predators from which there are no predators or catches. The tutorial about mass balance can give you some hands-on experience to get started.
 Attribution
 This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
 
	This figure was made in the early 1990s, and we haven't updated it for sentimental reasons (even though it would look much better with current technology). It tells the story to be told. ↵
	Winberg, G. G., 1956. Ratę of metabolism and food requirements of fishes. Nauchnye Trudy Belorusskogo Gosudarst- vennogo Universiteta. Mińsk., 253 pp. (Transl. from Russian by J. Fish. Res. Bd Can. Transl. Ser. 194, 1960). https://waves-vagues.dfo-mpo.gc.ca/library-bibliotheque/38248.pdf ↵
	Essington TE. 2007. Evaluating the sensitivity of a trophic mass balance model (Ecopath) to imprecise data inputs. CJFAS 64: 628-637 https://doi.org/10.1139/f07-04 ↵
	Polovina, J.J., 1984. Model of a coral reef ecosystem. Coral Reefs 3, 1–11. https://doi.org/10.1007/BF00306135 ↵
	Mackay A. 1981. The generalized inverse. Practical Computing, September p. 108-110 ↵
	Christensen, V., Pauly, D., 1992. ECOPATH II — a software for balancing steady-state ecosystem models and calculating network characteristics. Ecological Modelling 61, 169–185. href="https://doi.org/10.1016/0304-3800(92)90016-8">https://doi.org/10.1016/0304-3800(92)90016-8 ↵
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		Biomasses, energy and units

								

	
				Though biomasses to some extent can relate to “real estate” the issue is not “location, location, location”, but “units, units, units”. When you work with ecosystem models, you’ll have to obtain information for a multitude of sources and they will be using different units that need to be converted – and that often leads to conversion errors.
 Units are important, and an aspect where Ecopath has made a contribution has been to force (or maybe entice is a nicer word) modellers to standardize biomasses to a per unit area basis. So, for biomasses, the standard unit is ton per square kilometre in Ecopath. That makes it straightforward to compare abundances between ecosystems, whereas total amounts are difficult to compare as ecosystems vary areawise .
 How do you then get biomasses for your model?  Fortunately, biomasses are standard output from surveys and assessments, and we will refer to that literature without being much more specific about how to obtain biomasses. As a rough classification, note that there are “direct” estimation methods such as trawl swept area, acoustic target expansion, visual census, plankton sampling, and “indirect” methods where biomass are output from assessments that use multiple sources of information to estimate biomasses. The biomasses add constraints to your model, and constraints make the model outputs appear to be less uncertain.
 If at all possible, get biomasses from local sources (i.e. for your ecosystem), and be aware that biomasses “don’t travel well”. It helps that we are using per unit area biomasses, but conditions really vary from system to system due notably to differences in productivity and fishing pressure over time.
  
 There is an ongoing controversy about whether one can or should use output from one model (assessment) as input for another model (ecosystem) where the sentiment from assessment scientists may be a No! and that we should instead use the same input (surveys) as used for assessments.
 This argument ignores the fact that all biomass estimates are in fact based on models, i.e. on various aggregation, transformation, and calibration scaling operations applied to raw data.  So working with the raw data as inputs would mean not just repeating one assessment but all estimations done for the ecosystem, including estimates of primary productivity and other supposedly “direct” measurements. Primary productivity (phytoplankton biomass) estimates for marine systems in particular are typically based on complex models evaluating satellite information, with calculations so specialized that it would make no sense to try to repeat them.  Acoustic abundance estimates are similarly complex expansions of raw target data.  Even simple swept area or volume conversions from nets are fraught with uncertainties about conversion factors. The same uncertainties more obviously hold true for assessment models, for which we have to at least initially hope that the panels reviewing the models have weeded out really bad estimates.
 But thankfully, the Ecopath biomass estimates are not carved in stone; just as we typically do with single species assessment models, we can vary the Ecopath input values and examine how that variation affects dynamics, policy responses, and likelihood measures of goodness of fit to available time series data on relative abundance trends and outputs (like catches).
 There are at least two good reasons to use most recent biomass estimates from single species models as the Ecopath input biomass estimates.  First, those Ecopath estimates are used to initialize time simulations with Ecosim, providing a capability to predict forward from the most recent assessment estimates using a model that is initially consistent with the assessment model but explicitly represents trophic interactions evident in the Ecopath inputs when looking forward over time.  Second, Ecopath can provide a credibility check on the single-species model estimate, in particular whether the estimate is high enough to support estimated predation rates on it (Ecotrophic efficiency less than 1.0), and whether prey abundance is high enough to support its estimated food consumption.  But be warned: it is not so easy to defend the use of estimated biomasses for early years from single species assessments to set Ecopath base biomasses for such early years, because of uncertainties in the single species results about cumulative net depletion of stock size over time due to historical removals and other factors.
 
 Units and energy
  
 The million dollar question
 
 How do you convert from t km-2 to g m-2? The answer is: they are equal.
 So, when you evaluate model parameters, think t km-2 for the big things, and g m-2 for the small.
 For instance, this bay is around 100 km2 and there are some 100 seals each with a weight of 50 kg. That’s 50·100 kg = 5 t in 100 km2 = 0.05 t km-2.  Or, if we assume there’s 3 shrimps per m2, each weighing 2 g; then the biomass is 6 g m-2 = 6 t km-2 as we know now.
 That simple conversion between t km-2 and g m-2 really makes it simple and elegant to relate to biomass estimates for all kind of critters in an ecosystem.  But watch out because biomasses for smaller critters (zooplankters, benthic invertebrates, insect larvae) are often reported in “dry weight” units without information on the drying protocol, and must be converted to the wet weight units typically used for larger critters like fish.  The wet/dry weight ratio can vary from as low as 5 to over 10.
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		Production/biomass

								

	
				Production refers to the elaboration of tissue (whether it survives or not) by a group over the period considered, expressed in whatever currency that has been selected. Total mortality, under the condition assumed for the construction of mass-balance models, equal to production over biomass (Allen, 1971[1]). Therefore, one can generally[2] use estimates of total mortality (Z) as input values for the production over biomass ratio (P/B) in Ecopath models. Some examples of how to obtain P/B values are given below.
 Total mortality catch curves
 
 Total mortalities can be estimated from catch curves, i.e., from catch composition data, either in terms of age-structured or of length-converted catch curves. The estimation can be carried out using appropriate software for analysis, but require careful consideration of how representative the samples are of the entire population, and the impact of related bias on the estimated mortality parameters.
 
 Total mortality from sum of components
 
 The term “natural mortality” is generally used for mortality occurring “naturally” in an ecosystem. As such, it is in contrast to fishing mortality (F) and other human-caused mortality.  Natural mortality (M) is traditionally[3] separated in to components,
 M0: Other mortality (mortality not included elsewhere, e.g, due to diseases or old age)
 M1:  Mortality by predators not included in the model
 M2:  Mortality by predators included in the model
 As the P/B rate corresponds to the total mortality rate (Z), it can be estimated as the sum of natural mortality (M = M0 + M2, assuming that the M1 term is included in M0) and fishing mortality (F), i.e., P/B = Z = M + F ignoring here potential migration and biomass accumulation. In the absence of catch-at-age data from an unexploited population, natural mortality for finfish can be estimated from an empirical relationship (Pauly, 1980[4]) linking M, two parameters of the von Bertalanffy Growth Function (VBGF) and mean environmental temperature, i.e.,
 [image: M = K^{0.65} \cdot L_{\infty}^{-0.279} \cdot T_c^{0.462}\tag{1}]
 
 where, M is the natural mortality (year-1), K is the curvature parameter of the VBGF (year-1), L∞ is the asymptotic length (total length, cm), and Tc is the mean habitat (water) temperature, in °C .
 
 In equilibrium situations, fishing mortality (F, year-1) can be estimated directly from the catch (C, including discards, t km-2 year-1) and biomass (B, t km-2)
 [image: F = C/B \tag{2}]
 
 Total mortality from average length
 
 Beverton and Holt (1957[5]) showed that total mortality (Z = P/B, year-1), in fish population whose individuals grow according to the von Bertalanffy Growth Function (VBGF), can be expressed as
 [image: Z=P/B=\frac{K \cdot (L_{\infty}-\bar L)}{\bar L-L^{'}}\tag{3}]
 
 where K is the VBGF curvature parameter (year-1, expressing the rate at which L∞ is approached), L∞ is the asymptotic length, i.e., the mean size the individuals in the population would reach if they were to live and grow indefinitely, L̅ is the mean length in catches, and L’ represents the mean length at entry into the fishery, assuming knife-edge selection. Note that the L̅–L’ denominator must be positive.
 
 Total mortality and longevity
 Mortality rates (P/B = Z) are not just nuisance parameters, they really mean something that one can relate to. How much does a population produce relative to its biomass?  A lot for plankton and not very much for whales, right?
 Mortality rates thus relates to size, e.g., for a small (1-2 mm) zooplankton like Acartia tonsa, the P/B is up around 45 year-1. The much larger Calanus finmarchicus can live for several years and may have a P/B closer to 7 or 8 year-1. Whales? P/B will be below 0.1 year-1.
 A good way to relate to such numbers is to turn them on their head. That is, think of the B/P ratio (year) to get a sense for the P/B (year-1) ratio.  So if a blue whale has a P/B of 0.025 year-1, the inverse B/P is 40 years – that’s then the average longevity of blue whales (if P/B indeed is 0.025 year-1).  Seals with P/B of 0.14 year-1 would have an average longevity of 7 years, cod with a P/B of 0.25 year-1 an average longevity of 4 years, and anchovy with P/B of 2.0 year-1 would on average live half a year.
 It makes sense, and longevity provides a good handle for evaluating what reasonable estimates of P/B may be.
 There is a Quick guide on how to calculate P/B and Q/B for EwE models by Daniel Vilas, Marta Coll, Chiara Piroddi, Jeroen Steenbeek, developed for the EC Safenet Project, available for download.
 
 Attribution
 This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
 
 
	Allen, K. R. 1971. Relation between production and biomass. J. Fish. Res. Board Can., 28:1573-1581. doi 10.1139/f71-236 ↵
	For multi-stanza groups, the production term is actually the total mortality term, Z for each stanza. So, if as an example, you have a juvenile stanza group and use a bioenergetic model to calculate the production, you should subtract the amount that is recruited to the next (older) stanza from the production in order to get the actual mortality, which is what Ecosim needs to work with. ↵
	From Multispecies Virtual Population Analysis (MSVPA) ↵
	Pauly, D. 1980. On the interrelationships between natural mortality, growth parameters, and mean environmental temperature in 175 fish stocks. J. Cons. int. Explor. Mer, 39:175-192. https://doi.org/10.1093/icesjms/39.2.175 ↵
	Beverton, R. J. H., and Holt, S. J., 1957. On the Dynamics of Exploited Fish Populations. Chapman and Hall, Facsimile reprint 1993, London. 533 pp. ↵
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		Consumption/biomass

								

	
				 Consumption (Q, t km-2 year-1) is the annual intake of food by a consumer group, and it is in EwE estimated as the product of the group’s biomass (B, t km-2) and consumption/biomass ratio (Q/B, year-1). To estimate consumption, we thus need to obtain estimates of B and Q/B for the consumer groups in models.
 
 There are various approaches for estimating Q/B, and they can be split in (i) analytical methods and (ii) empirical methods:
 
 (i) The analytical methods involve estimation of ration, pertaining to one or several size/age classes, and their subsequent extrapolation to a wide range of size/age classes, representing an age-structured population exposed to a constant or variable mortality. The required estimates of ration can be obtained from laboratory experiments, from studies of the dynamics of stomach contents in nature, or by combining laboratory and field data. There is an expanse of literature on this, to which we refer.
 Characteristic for these methods is that they are resource- and time-consuming, and it is indeed not practical to set up laboratory or field experiment to estimate Q/B for all species or functional groups in an ecosystem model. Instead we rely on the second avenue, empirical combinations – along with estimates from analytical studies, where available.

 
 (ii) There are a number of empirical regressions for prediction of Q/B from some easy-to-quantify characteristics of the animals for which the Q/B values are required.
 
 
 Palomares and Pauly (1989[1]; 1998[2]) described based on a data set of relative food-consumption estimates (Q/B ) of marine and freshwater population (n=108 populations, 38 species) a predictive model for Q/B using asymptotic weight, habitat temperature, a morphological variable and food type as independent variables. Salinity was not found to affect Q/B in fish well adapted to fresh or saltwater (other things being equal). In contrast the total mortality (Z, per year) showed a strong, positive effect on Q/B and also on the gross food-conversion efficiency (defined by GE = Z/ (Q/B)), by affecting the ratio of small to large fish.
 
 The authors presented three related models:
 [image: \log(Q/B)=7.964 - 0.204 \log W_{\infty}-1.965 \ T^{'}+0.083 \ A+0.532 \ h+0.398 \ d \tag{1}]
 
 where, W∞ is the asymptotic weight (g), T’ is an expression for the mean annual temperature of the water body, expressed using T’ = 1000/Kelvin (Kelvin = °C + 273.15), A is the aspect ratio (see Figure 2.1), h expresses food type (1 for herbivores, and 0 for detritivores and carnivores), and d is also expressing food type (1 for detritivores, and 0 for herbivores and carnivores)
 
 The equation can be modified to investigate the effect on mortality on Q/B, and to derive predictive models of Q/B taking explicit account of different mortalities, values ofQ/B were calculated using the equation above for mortalities corresponding to f · M, where f is a multiplicative factor with value of 0.5, 1, 2 or 4, and M is the natural mortality rate that is estimated from Pauly’s (1980) empirical relationship.
 [image: \log(Q/B)=8.056+0.300\log f - 0.201 \log W_{\infty}-1.989 \ T^{'}+0.081 \ A+0.532 \ h+0.393 \ d\tag{2}]
 where f is the multiplicative factor introduced above, and the rest of the variables are as defined earlier.
 
 For cases where estimated of total mortality, Z, (year-1) are available, the following relation may be used:
 [image: \log(Q/B)=5.847+0.280\log Z - 0.152 \log W_{\infty}-1.360 \ T^{'}+0.062 \ A+0.510 \ h+0.390 \ d \tag{3}]
 These relationships can be used only for fish groups that use their caudal fin as the (main) organ of propulsion.
 
 [image: ]
 
  
 Figure 1 Schematic representation of method to estimate the aspect ratio (Ar = h2/s) of the caudal fin of fish, given fin height (h) and surface area (s, in black).
 Consumption/biomass ratios for fish are available in FishBase at the Life History tables for many species. Where analytical estimates are available those are included, while for species without such, there instead is an empirical relationship based on the equations above, see Figure 2.
 [image: A screenshot from FishBase that illustrates the "tail" food consumption for a given fish species. One has to enter average water temperature, and select the tail type and feeding mode. The underlying empirical relationship will then be used to predict food consumption rate (as consumption relative to biomass)]
 Figure 2. FishBase Life History Tool for estimating Q/B from empirical relationship.   
  
 There is a Quick guide on how to calculate P/B and Q/B for EwE models by Daniel Vilas, Marta Coll, Chiara Piroddi, Jeroen Steenbeek, developed for the EC Safenet Project, available for download.
 
 Attribution
 This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
 Media Attributions
	www.fishbase.org 
	www.fishbase.org Life history tool 



	Palomares, M. L. D., and Pauly, D. 1989. A multiple regression model for predicting the food consumption of marine fish populations. Aust. J. Mar. Freshwat. Res., 40:259-273. https://doi.org/10.1071/MF9890259 ↵
	Palomares, M. L. D., and Pauly, D. 1998. Predicting food consumption of fish populations as functions of mortality, food type, morphometrics, temperature and salinity. Marine & Freshwater Research, 49(5):447- 453.https://doi.org/10.1071/MF98015 ↵
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		Ecotrophic efficiency

								

	
				Ecotrophic efficiency (EE) was defined by Ricker[1] as the proportion of a prey’s production that is consumed by predators. Polovina used the term for the original Ecopath model of the unexploited French Frigate Shoals.[2]
 Subsequently, we have for EwE modified the term to include exports from the system, (which notably are due to fisheries). Based on the second Ecopath Master Equation (See The energy balance of a box chapter) we have,
 [image: EE_i=\frac {M2_i \cdot B_i+C_i+BA_i+E_i}{P_i}\tag{1}]
 so, EE can be estimated as the ratio between the summed predation M2, catch C, biomass accumulation BA and net migration E relative to the production P for any group i.
 If your model is descriptive (as Polovina’s model was), your aim likely is to describe the energy flow in the entire ecosystem. If that’s the case, the EE indeed is an “ecotrophic efficiency” that describes the proportion of the energy produced by a group that it passed on through the trophic web or exported (e.g., through fisheries). So, if EE is 0.95 then 95% of the production of the group is passed on to predators or fisheries.
 But what about predictive (or MICE) models? Such models tend to be focused on the specific policy/research questions they are built to address, and as such may not give a complete picture of the food web interactions in the given ecosystem. That boils down to there being a considerable amount of unexplained mortality (M1) in the model. In such cases the EE isn’t really an “ecotrophic efficiency”. Hence, the following may be a better way to grasp EE.
 EE expresses the proportion of the mortality for which the model describes the fate.
 
 
 Estimating EE
 It is difficult to estimate EE independently, and few, if any, direct estimates appear to exist. Recognizing this, an EE of 0.95, based on Ricker (1968) was used for many groups in Polovina’s original model[3] and in a number of later models.
 Evaluating EE
 Intuitively one would expect EE to be very close to 1 for small prey organisms, diseases and starvation probably being, for such groups, much less frequent than predation. For some groups, EE, may however, be low.
 It is often seen that phytoplankton simply die off (as “snow”) in systems where blooms occur (EE of 0.5 or less). Also, kelps and seagrasses are hardly consumed when alive (EE of 0.1 or so), and apex predators have very low EEs when fishing intensity is low. There are indeed many incidences of tunas or cetaceans simply dying and sinking reported from open oceans, with abyssal organisms (e.g., ratfishes) specialized in feeding on such carcasses.
 If EEs are estimated it is often because of lack of biomasses. It should not be because of lack of P/B or Q/B values – it is better to guess those than to let them be estimated from the Ecopath mass balance.  When biomasses are estimated, one needs to carefully examine how realistic those biomasses are. We’ve seen examples where there were biomasses entered for only unexploited high trophic level groups, and everything else being estimated from guessed EEs. So, if you have to used EEs as input, check out PreBal[4] and compare the estimated biomasses to estimates from similar ecosystems.
 
 
	Ricker WE. 1969. Food from the Sea. pp 87-108 in: Cloud P (chair) Resources and man, a study and recommendations. Report of the Committee on Resources and Man. US Natl Acad Sci. Freeman, San Francisco, California ↵
	Polovina, J.J. 1984. Model of a coral reef ecosystem. Coral Reefs 3, 1–11. https://doi.org/10.1007/BF00306135 ↵
	Polovina, J.J. (1984) op. cit.  https://doi.org/10.1007/BF00306135 ↵
	Link JS. 2010. Adding rigor to ecological network models by evaluating a set of pre-balance diagnostics: A plea for PREBAL, Ecological Modelling, 221(2): 1580-1591, https://doi.org/10.1016/j.ecolmodel.2010.03.012. ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Welcome to Anchovy Bay

								

	
				 Learning Objectives
  The objectives are,
 	Take you through the practical and typical steps that are included in building an Ecopath model
 	Provide examples of where and how to get data for an Ecopath model
 	Give a first introduction to using the EwE software
 
 
 
 [image: This figure is for illustration only. It shows a rough map of Anchovy Bay with a colour scale that indicates water depth. The land is grey and there are three black circles that indicate location of ports.]
 Figure 1. Simplified basemap of Anchovy Bay from a spatial ecosystem model.
 Colour gradient indicates depth and the black dots harbours.
 The purpose of this tutorial is to introduce you to the Ecopath with Ecosim (EwE) software, explore what data is required, give examples of where you can get such data, and go through the steps that typically are required when constructing a model.
 We acknowledge that if you are new to the subject area, you will struggle with this tutorial, but we’ve built is so that it takes you through it step by step with explanations as you go along, and we expect that you, with a bit of effort, will be able to work your way through it. Please take it as an introduction, when we later introduce and describe all the bits and pieces in detail, you’ll have a better idea of how they fit together when you’ve done this tutorial.
 Introduction to Anchovy Bay
 Anchovy Bay is a popular tourist attraction with an its century-old fishing port and its newer whale-watching industry. Fisheries have traditionally been the main stay of the area, but catches have been in decline for decades, and have shifted from having focus on groundfish to being dominated by shrimp and pelagic fisheries.
 In recent years a whale-watching industry has developed linked with growing interest in eco-tourism and recovery of marine mammal populations after earlier periods of whaling and culling.
 We will use Anchovy Bay as a ‘model ecosystem’ throughout this textbook. Anchovy Bay is in many ways ideal for this as it is is well-studied – to the degree where we have excellent information about the resources in the bay, about how the environment has changed, and of how fisheries and other factors impacting the ecosystem have developed in recent history. The exercises will use variable amounts of information, starting simple (and thereby illustrating the impact of, e.g., missing important drivers) for gradually to include more and more data. This is to simplify the presentation and analysis, but also to illustrate that one can still work with incomplete information – even if it makes conclusions less reliable and leave questions open for interpretation.
 Build an ecosystem model
 Anchovy bay covers an area of 10,000 km2 and for this exercise, we assume that it is rather isolated from other marine systems, and that the populations stay in the bay year-round.
 About navigation in EwE:
 Ecopath > Input > Fishery > Landings indicates that you should find Ecopath in the Navigator, then Input, then Fishery, then the Landings tab.
 
 We want to create a model of the bay in 1970, with the following 11 groups:
 Whales, seals, cod, whiting, mackerel, anchovy, shrimp, benthos, zooplankton, phytoplankton, detritus. [Hint: make a spreadsheet with these group names in rows, you’ll need to do more calculations later]
 Start by opening EwE6, select Menu > File > New model. Browse to your preferred file location, and enter a name for the model. For instance, “Anchovy Bay”.  Now navigate on the Navigator (left panel) to Input data > Basic Input. The model will have one group, Detritus. All models must have a detritus group, so we have entered it for you. Why? We need to be sure there is a group where we can send flows of excreted and egested material as well as dead organism. By default, they go to the detritus group.
 On the Basic input form, select Define groups (also available from the menu on top: Ecopath > Define groups). Click Edit > Insert on the right side of the form that pops up. Continue clicking till you have 11 groups; then enter the group names, i.e., Whales in first row, Seals in second, etc. [Hint: you can cut and paste the names in one go from Excel, using Ctrl-C Ctrl-V]. When you have entered all, define that phytoplankton is a primary producer by clicking the Producer check mark in the phytoplankton row. On the right panel, you may also want to click the Colors > Alternate all, to get a better distribution of group colors (more distinguishable in Ecosim). Click OK.
 You can often cut/paste values to EwE (Ctrl-C, Ctrl-V). It may not work with the diets, if so you can download a spreadsheet with the diets from this link.
 
 We also need to define the fishing fleets. Click Ecopath > Input > Fishery on the Navigator to the left. Then click Fleets, and then Define fleets above the spreadsheet (or go Menu >Ecopath >Define fleets). We want five fleets: sealers, trawlers, seiners, bait boats, and shrimpers. We can enter catches at Ecopath > Input > Fishery > Landings; unit has to be t km-2 year-1. The sealers caught 1,500 seals in 1970 with an average weight of 30 kg. The fisheries catches were 4,500 t of cod and 2,000 t of whiting for the trawlers, 4,000 t of mackerel and 12,000 t of anchovy for the seiners, 2,000 t of anchovy for the bait boats, and 5,000 t of shrimp for the shrimpers. Calculate catches using the appropriate unit (t km-2 year-1), and enter in EwE.
 The off-vessel landing prices (Ecopath > Input > Fishery > Off-vessel price) are seals $6 kg-1; cod: $10 kg-1; whiting $6 kg-1; mackerel: $4 kg-1; anchovy from seiners $2 kg-1, and $3 kg-1 for bait boats. Shrimps are $20 kg-1. [While landings are in t, it is fine for now to enter landing prices in $/kg to avoid the extra ‘000s]. Prices are current prices (hence “are” instead of “were”) as we later will be using these for forward projections. If you lack catch or price information for your own models later, then search, check www.seaaroundus.org, ask around, or guess!
 We now should enter the basic input parameters. Fortunately, there has been monitoring in the bay for decades, and we have some biomass survey estimates from 1970. The biomasses must be entered with the unit t km-2. Whales: 50 individuals with an average weight of 16,000 kg. Seals: 20,300 individuals with an average weight of 30 kg. Cod: 30,000 t. Whiting 18,000 t. Mackerel: 12,000 t. Anchovy: 70,000 t. Shrimp: 0.8 t km-2. Zooplankton: 14.8 t km-2, detritus 10 t km-2.
 Next are production/biomass (P/B) ratios, which with certain assumptions (that we won’t worry about now) correspond to the total mortality, Z. The P/B are annual rates, so the unit is year-1. We often can get Z from assessments, or, alternatively, we have Z = F + M (i.e. we can estimate total mortality as the sum of fishing mortality, F and natural (predation) mortality, M). So, if we have the catch (C) and the biomass (B), we can estimate F = C/B and add the total natural mortality, M, to get Z.
 For fish, we can get estimates of M and Q/B from FishBase. On the FishBase landings page, search for the species, (Gadus morhua, Scomber scombrus, Engraulis encrasicolus), one by one. From the species info screen for each, go to Tools > Life-history tool, and extract the Q/B and M values for each. Estimate Z = F + M. For whiting (Merlangius merlangus), we have local estimates of P/B = 0.58 year-1 and Q/B = 3.1 year-1.
 For estimating Z for exploited species, it is also an option to use an equation that was developed by Ray Beverton and Sidney Holt[1]. It is implemented in the life-history tool table in FishBase. It relies on estimates of length at first capture (Lc), average length in the catch (Lmean), and asymptotic length (Linf) to estimate Z. Try it for the three species here. Here are the lengths from the fishery in Anchovy Bay:
 	 	Lc (cm) 	Lmean (cm) 
 	Cod 	52 	72 
 	Mackerel 	18.9 	26 
 	Anchovy 	6.8 	10 
  
 Compare the Z estimates from the two methods (and consider = decide what to use).
 There is a close relationship between size and P/B; the bigger animals are, the lower the P/B. Here we have: Whales: P/B = 0.05 year-1; seals: get F from catch, and M is 0.09 year-1; shrimp P/B = 3 year-1; benthos P/B = 3 year-1; zooplankton: it is mainly small Acartia-sized plankton, with P/B = 35 year-1.
 The inverse of P/B (year-1), i.e. B/P has the unit year and expresses average longevity. As an example, whales with P/B = 0.05 year-1, have a B/P ratio (and hence average longevity) of 20 years.
  
 We can get P/B for many invertebrates from Tom Brey’s work (but don’t need to for this tutorial). Check out: http://www.thomas-brey.de/science/virtualhandbook/. There is a neat collection of empirical relationships and conversion factors.
 Consumption/biomass ratios for the non-fish groups: for whales use 9 year-1, and for seals 15 year-1. For the invertebrates enter a P/Q ratio of 0.25 instead of entering a Q/B. Finally, there is phytoplankton. We can often get primary production estimates from SeaWiFS satellite data. Here we have PP = 240 gC m-2 year-1. The conversion factor from gC to gWW is 9, so the total production, P, is 9 * 240 t km-2 year-1. You can set P/B to 120 year-1, and calculate B. The 120 year-1 is a guess, assuming that phytoplankton divides once per day in the productive part of the year (so less than 360/year), and is not very important as only the production, P = P/B * B is actually used in calculations. (Very high P/B values may, however, make Ecospace runs dizzy).
 Next parameter is Ecotrophic Efficiency (EE), this is the part of the production that is used in the system (or rather, for which the model explains the fate of the production). In this model, we are missing a biomass estimate for benthos. We do not explain much of the mortality for this group, so we guess an EE = 0.6. For the other groups, we let Ecopath estimate the EEs, but bear in mind the definition of EE when you evaluate the estimated parameters.
 In the Ecopath baseline year, the whale population had started to recover after whaling, but the seal population was still declining, so the Ecopath baseline model is not in steady state. We specify this on the Input data > Other production form by entering a biomass accumulation rate of 0.02 year-1 for whales, and –0.05 year-1 for seals.
 Now it’s time for diets:
 	# 	Prey \ predator 	1 	2 	3 	4 	5 	6 	7 	8 	9 
  	1 	Whales 	0 	0 	0 	0 	0 	0 	0 	0 	0 
 	2 	Seals 	0 	0 	0 	0 	0 	0 	0 	0 	0 
 	3 	Cod 	0.1 	0.04 	0 	0.05 	0 	0 	0 	0 	0 
 	4 	Whiting 	0.1 	0.05 	0.05 	0.05 	0 	0 	0 	0 	0 
 	5 	Mackerel 	0.2 	0 	0 	0 	0.05 	0 	0 	0 	0 
 	6 	Anchovy 	0.5 	0 	0.1 	0.45 	0.5 	0 	0 	0 	0 
 	7 	Shrimp 	0 	0.01 	0.01 	0.01 	0 	0 	0 	0 	0 
 	8 	Benthos 	0.1 	0.9 	0.84 	0.44 	0 	0 	1 	0.1 	0 
 	9 	Zooplankton 	0 	0 	0 	0 	0.45 	1 	0 	0.1 	0 
 	10 	Phytoplankton 	0 	0 	0 	0 	0 	0 	0 	0.1 	0.9 
 	11 	Detritus 	0 	0 	0 	0 	0 	0 	0 	0.7 	0.1 
  
 
 We now have the information that is needed to do mass-balance on this model. Select Output > Basic estimates, and check out the outcome. Save the model.
 Try changing some of the input and see what happens. Don’t save afterwards.
 Check out Network analysis (Ecopath > Output > Tools > Network analysis), especially, see the Mixed Trophic Impact plot
 Go to Ecosim > Output > Run Ecosim > Run, and see what happens.
 Explore the software.
 
 
 If need be, you can download the database for the present tutorial at this link
 Media Attributions
	Ecospace > Input > Maps 



	Beverton, R.J.H. and Holt, S.J. 1957. On the dynamics of exploited fish populations. Fisheries Investigations, 19, 1-533. ↵
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		Mass balance

								

	
				Mass balance is performed using a number of algorithms and a routine for matrix inversion, see the energy balance of a box for a description of these.  Once the program has estimated the missing parameters, the system balances the input and output of each group, using respiration for adjustments. The relationship used is
 Master Equation 1:
 [image: Consumption = production + respiration + unassimilated \ part\tag{1}]
 where, consumption is the total consumption for a group, i.e., biomass · (consumption / biomass). Respiration is the part of the consumption that is not used for production or recycled as egestion or excretion. Respiration is nonusable currency, i.e., it cannot be used by the other groups in the system. Autotrophs with Q/B = 0[1] and detritus have zero respiration. Unassimilated food is an input parameter expressing the fraction of food that is not assimilated, (i.e., is egested or excreted). For models whose currency is energy, the default is 0.20, i.e. 20% of consumption for all groups, though this is most applicable for finfish groups following Winberg[2]. The non-assimilated food is directed to the detritus.
 If the model currency is a nutrient, there is no respiration. Instead, the model is balanced such that the non- assimilated food equals the difference between consumption and production.
 Some consumers are also producers, e.g., coral reefs can be a bit of both. We accommodate that by noting that production in the first Master Equation does not include primary production, i.e., it is defined as biomass · (production / biomass) · (1 – PP), where PP is the proportion of total production that can be attributed to primary production. We thus have that (1 – PP) = 0 in plants, 1 in heterotrophic consumers, and intermediate in the 0 to 1 range for e.g., corals or tridacnid clams.
 To illustrate some of the basic rules and options for mass balance, see Figure 1.
  
 [image: ]
 Figure 1. Options for mass balancing.
 An exhaustive set of guidelines for how a model should be balanced cannot be given. However, if it existed, such a set would include the following general guidelines
 	Make sure to document what is done in the balancing process by entering remarks for all parameters and to extract these subsequently. A model where the balancing process is not appropriately documented is not likely to be publishable;
 	Remember which data that are the more reliable and avoid changing these;
 	Formulate assumptions and argumentation for changes: the ones easy to explain are likely to be the better assumptions;
 	Start by looking at the estimated values. Are the EE values possible (less than 1)? Are the g (= P/Q) values physiologically realistic (0.1-0.3 for most groups, perhaps lower for top predators and higher for very small organisms, (e.g., up to 0.5 for bacteria). If not decide from where the problem is the biggest if you want to balance your model starting from the bottom (producers) or from the top down;
 	Search out one group with a bigger problem and try to solve this. Are the P/B, Q/B and B values appropriate for this group? What would happen to, e.g., the g and the EE if you changed the parameters? If the problem is the consumption by predators, look at the Predation mortality form, and identify the quantitatively most important predators. Check the diet compositions and B and Q/B values for these predators;
 	Continue for as long as necessary, documenting carefully what changes are made. It may be a good idea to save the data file under a new name before/after making the set of changes;
 	You may get warnings that the “Respiration cannot be negative”. If this happens the second master equation of Ecopath has been violated. We have:
 Consumption = production + respiration + unassimilated food
 or
 Q = P + R + U
 Expressing this relative to consumption we have:
 1 = P/Q + R/Q + U/Q
 Of these P/Q is entered as the gross food conversion efficiency (g) (or estimated from entered P and Q) and U/Q is the proportion of food that is not assimilated. If g + U/Q exceeds unity, then R/Q and hence the respiration, R, has to be negative. You will need to reduce the production/consumption (g) ratio by lowering the production/biomass (P/B) ratio or increasing the consumption/biomass (Q/B) ratio, and/or reduce the proportion of unassimilated food;
 
 	Examine the respiration/biomass (R/B) ratios for each group. Generally this ratio reflects activity level. For fish it should as a rule be in the range 1-10 year-1, for copepods perhaps around 50-100 year-1. Please consult physiology texts for more information. If the ratio seems high it may be necessary to change the (assumed) proportion of the food that is not assimilated on the basic input form;
 	Examine the Electivity form. Do the preferences seem reasonable?
 	Examine the predation mortalities at Ecopath > Output > Mortality rates > Mortalities, along with the predation mortality spreadsheet (Ecopath > Output > Mortality rates > Predation mortality rates) to identify how important the various predators are for any group. Does this show what you expect? Are the predators shown to be the most important predators in accordance with what you expect? If not, re-evaluate your model’s diet compositions. The information on the mortality forms is very important!
 	Noting how the energy balance of a group is formulated, it is clear that, for instance, increasing the proportion of the consumption that is not assimilated will leave less energy to respiration (production being unaffected). This will result in a lower R/B ratio and a larger flow to the detritus. The latter may be necessary to balance the model if there is only little system surplus production.
 
 Fixed Selectivity Principle for diets
  When balancing a model there are often groups for which the information about diet has less detail than required in the model or is qualitative rather than quantitative. You may for instance have a predator that feeds on “small fish”; blue heron could be an example.
 A common assumption when defining the diet composition for such predators is to use a seemingly parsimonious assumption of “all equal”, i.e. for a start set the, e.g., “20% small fish” to 5% for each of the four potential prey groups.  Such an assumption will very likely lead to the model not balancing.
 For such predators, it is more reasonable to assume that they take prey in proportion to how common the prey is in the environment. We can quantify this using what we call the ‘fixed selectivity’ principle, assuming the prey preference for such predators when feeding on suitable prey should be comparable across species or functional groups.  
 When setting this up, consider that it’s not the biomass of a group that is eaten by a predator, it’s the production. Therefore, to use this principle, estimate the production (B x P/B) for each (i) of the potential prey groups (n) for a predator (j). Then assume that the proportion each contribute to the predator diet (DCji) is proportional to their production. We have, 
 [image: DC_{ji} = \frac{B_i \cdot (P/B)_i}{\sum_{k=1}^n B_k \cdot (P/B)_k} \tag{1}]
 We first used this principle for the Roberts Bank Terminal 2 ecosystem model[3] to adjust the diet composition of pinnipeds, diving waterbirds, great blue heron, shorebirds, chinook adult, chinook juvenile, chum juvenile, dogfish, flatfish, large demersals, lingcod, rockfish, salmon juvenile, skate, and starry flounder. The total contribution of “small fish” in the diet of these predators was maintained, but the distribution among potential prey groups was estimated relative to prey productivity. In that model, the ‘fixed selectivity’ principle was also used to adjust the contribution of invertebrates in the diets of diving waterbirds, waterfowl, forage fish, herring, carnivorous zooplankton, jellyfish, macrofauna, and polychaetes. Contribution of vegetation was also adjusted in a similar way in the diets of American wigeon, waterfowl, epifaunal grazer, epifauna.
 
 
 Parameter evaluation
 What was that warning, again?
 You can find warnings and messages in the Status panel at the lower left of the EwE form
 The program estimates the missing parameters and a number of indices without further input. Your model will probably not look very convincing the first time you run it. Keep an eye open for warning messages while you make your way through the forms. In the more serious cases, the parameter estimation will be aborted, and you will have to edit your data. To improve your chances of identifying problems, you will in some cases only get a warning and the program will continue.
 The following sections may help you evaluate the results of a run.
 Are the EE’s between 0 and 1?
 Ecotrophic Efficiencies (EE) represents the proportion of the production that is “used” in the system, or to be more precise, the proportion of the production that the model describes the “fate” of – see the EE chapter. This is a parameter that is difficult to measure empirically, but it is one we can relate to. If your model is detailed with lots of predators and fisheries impacting, e.g., small pelagics, we’d expect that the EE for that group should be close to 1. A top predator with only low fishing pressure should have a low EE, and in a system with seasonal plankton blooms the EE for phytoplankton should be intermediate, maybe 0.5, to give a few examples.
 EE should as proportion be between 0 and 1 (inclusive). A value of zero indicates that no other group or fishery consume the given group. Conversely, a value close to 1 indicates that the group is being heavily preyed upon or grazed and/or that fishing pressure is high, thus describing almost fully what happens to the group’s production.
 If, in a first run, any of the EEs are larger than 1, something is wrong: it is not possible for more to be eaten or caught than is produced. The problem can of course be due to the equilibrium assumption not being met, e.g., when the model includes a new fishery on a previously unexploited stock – in that case include a negative biomass accumulation term. So, you should have a closer look at the input parameters.
 It may be worthwhile to check the food consumption of the predators, and the production estimates of the group. Compare the food intake of the predators with the production of their prey. Most often, the diet compositions will have to be changed – often the diets are more “pointers” to, than reliable estimates of the real values.
 When checking for mass-balance, the first step is to go to the Ecopath > Output > Mortality rates > Mortalities. This screen shows the second Master Equation, Production =  predation mortality  + fishing mortality  + biomass accumulation + net migration + other mortality. Systematically check for groups with EE problems, and especially note if the issue is due to fishing or predation. If the fishing mortality (F = catch/biomass) is too high, check your catches for the fleet(s) causing this. If the predation mortality (M2=total predation/biomass) is too high, check Ecopath > Output > Mortality rates > Predation mortality rates, look across the row for each of the groups with too high EE, and identify the predators that are causing too high EE. For those groups, check their diet compositions – often, a very low diet proportion for a common predator eating a rare prey causes excessive predation mortalities for that prey.
 “Cannibalism” in the sense of within-group predation often causes problems. If a group contributes 10% or more to its own diet, this alone may result in consumption being higher than the production of the group. The solution to this is to split the group into juveniles and adults, with the adults acting as predator on the juveniles. The juveniles must then have a higher production rate than the adults, as production is almost always inversely related to size.
 It is advisable to make one change at the time when editing input parameters. Make that one change, note down what you did, rerun the Basic estimates routine, re-examine the run, and if necessary re-edit the data, etc. Continue with one change at a time until you get a run you consider acceptable. Make sure, through the entry of remarks in the Remarks window, to record en route what you do and why.
 Ecotrophic efficiency of detritus
 The ecotrophic efficiency, EE, of a detritus group is defined as the ratio between what flows out of that group and what flows into it. Under steady-state assumption, this ratio should be equal to 1.
 Estimates of EE of less than 1 indicate that more is entering a detritus group than is leaving it.
 Estimates of EE of more than 1 for a detritus group also require attention. They indicate that the primary production and/or the inputs to the lower parts of the food web are too small to support consumption from that group. It will be necessary to examine the basic inputs that define production and consumption of the lower parts of the food web closely, and to examine whether more detritus should be directed to the detritus group.
 Of importance for the flow to detritus is the parameter for non-assimilated food. The default value of 0.2 often underestimates egestion, especially for herbivores and detritivores. For zooplankton eating phytoplankton a value of 0.4 results in more detritus being produced and also often leads to more reasonable respiration/biomass ratios than obtained with the default excretion rate of  0.2. Higher parameter values means that a greater flow is directed to detritus and less to respiration for a given group.
 Are the efficiencies possible?
 Recall that the gross food conversion efficiency, g, is defined as the ratio between production and consumption. In most cases, production/consumption ratios will range from 0.1 to 0.3, but exceptions may occur, (e.g., bacteria, nauplii, fish larvae and other small, fast-growing organisms). If the g values are unrealistic, check the input parameters, especially for groups whose production has been estimated. In such cases, carefully editing the diet composition of the predators of the problem groups will generally help.
 Next are some notes about some common causes of problems during balancing.
 Problem 1: Loops
 As a rule, don’t estimate P/B or Q/B, you can provide better estimates than the mass-balance routine!
 In cases where P/B is to be estimated for groups that feed on each other (cycles) the program may first estimate a P/B for one group based on the consumption by the other groups. Subsequently it may estimate the P/B for the second group based on the consumption by the first, and then it may continue with the P/B for the first again, and so on in a loop. The result may be completely unrealistic parameter estimates.
 It is necessary to break such loops, e.g., by entering the P/B for one of the groups. If all ecotrophic efficiencies are low it indicates that the trophic transfer efficiencies are low. This may be OK for a system with high production and low abundance of organisms. It may however also indicate that the estimates of the biomasses in the system are too low.
 [image: Loop in a food web with two consumers that eat each other and for which the P/B is unknown for both groups. It is not possible to estimate P/B for both groups as described in the text.]
 Problem 2: Cannibalism (0-order cycles)
 Groups where 0-order cycles (cannibalism) are important should be broken into two or more groups. Such cases occur, for example, when a predatory fish feeds on fish of the same species or functional group. The prey fish will, however, be smaller fish, and often the P/B value for the group is based on the recruited part of the population only, and thus does not cover the dynamics of the juveniles, (which generally have much higher P/B values than the recruited part of the population). The solution may be to split the group in an adult and a juvenile fish group. This will also be an advantage for subsequent Ecosim simulations.
 Remember that the gross food conversion efficiency (g) is the P/Q ratio. Typically, this ratio is in the range of 10-30%. If the proportion of the 0-order cycle is in the same range there may not be any production left over for other purposes (predation and export). As a guideline if a 0-order cycle includes more than say 5% of the diet composition it is necessary to consider if it would be better to split the group in two.
 Problem 3: Estimation of predator consumption and prey production
 No need to go there. Don’t let Ecopath estimate P/B or Q/B.
 [image: Another example where it is not possible to estimate missing parameters. The details are explained in the text.]
  
  
  
  
 In this example it is assumed that the consumption is unknown for the predator and the (used part of the) production, (i.e., the B, P/B or EE) unknown for all of the prey groups. In this case, it will not be possible for the program to calculate meaningful parameters and it will (probably) resort to the trivial solution: set the Q/B for the predator to zero, and see what can be estimated for the other groups. The problem is easily identified from an examination of the estimated parameters and statistics. The solution may be to either input a gross efficiency for the predator or one of the missing input parameters for one of the prey groups.
 Automatic mass balance?
 Earlier versions of EwE (5) had an automatic mass-balance routine.[4], but we have not migrated that utility to later versions. The reason for this is GIGO = Garbage in, Garbage out. Input parameters have to checked carefully before doing mass-balance, one has to weed out error, such as notably unit conversion errors. Our experience is that that process cannot be automated. (But it was a nice and elegant routine).
 
  
  
 Attribution: This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
	Primary producers actually have respiration, the difference between total and net productivity. We tend to ignore this in Ecopath modelling as it only relates to the efficiency with which producers convert nutrients. ↵
	Winberg, G. G., 1956. Rate of metabolism and food requirements of fishes. In: Transl. Fish. Res. Board Can., Translation Series 194. pp. 1-253. https://waves-vagues.dfo-mpo.gc.ca/library-bibliotheque/38248.pdf ↵
	Impact Assessment Agency of Canada, Roberts Bank Terminal 2 Project, Appendix 10-B Roberts Bank Ecopath with Ecosim and Ecospace Model Parameter Estimates. https://iaac-aeic.gc.ca/050/evaluations/proj/80054 ↵
	Kavanagh, P., N. Newlands, V. Christensen and D. Pauly. 2004. Automated parameter optimization for Ecopath ecosystem models. Ecol. Model. 172:141-149. https://doi.org/10.1016/j.ecolmodel.2003.09.004 ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Mass-balance

								

	
				 We’ll use the Anchovy Bay model, but special versions that have been made unbalanced by changing one or a few things. In total, the tutorial has five models, each of which you should try to balance on your own. Download the Anchovy Bay mass balance models.zip file from this link. 
 The errors that make the models unbalanced are very typical errors often made during model  construction. First and foremost among such are unit conversion errors. Always be very careful with units!
 
 Mass-balance cheat sheet
  There is a Mass balance cheat sheet.pdf file included in the zip-file download, but don’t just read that file, it’s for checking what you did afterwards. Still, here’s the content of the cheat sheet.
 	Seal biomass was increased an order of magnitude, and this resulted in too high predation mortality on seals’ prey, cod and whiting.
 	The Q/B for cod was increased from 2.58 year-1 to 12.58 year-1. This made the consumption of whiting so high that this group wouldn’t balance, and it’s clear from the predation mortalities (M2) that the cod predation is too high, M2 exceeds the P/B. For anchovy, the increase makes cod the most important predator on anchovy. That’s not credible, mackerel should be more important.
 Check the P/Q ratio for cod: it is very low, and this points to a problem with either the P/B or Q/B for cod. The P/B is reasonable (average life span of cod ~ 3 years), but the Q/B is not.
 	The Q/B for seal was to be estimated – which at first glance seems feasible as B, P/B and EE are given for the group. There is however a cycle, cod > whiting > cod, so when the consumption of cod isn’t known, it becomes impossible to calculate the EE for whiting, and without the EE, predation on whiting isn’t quantified, so we cannot estimate Q/B for cod. In this case the cycle leads to Catch 22.
 Main lesson: stick to estimating EE or if needed B. There is no good reason for estimating P/B or Q/B based on mass balance: we have expectations for those parameters.
 	Here, the model has been changed to estimate biomasses for all but marine mammals. No errors when doing basic parametrization, so all good? No, look through the estimated biomasses, they are quite high, and the primary production (B x P/B = 45 t km-2 x 120 year-1 = 5400 t km-2 year-1 makes Anchovy Bay a very productive system, almost twice as productive as the North Sea. That’s not right. The warning is: if you have nothing to constrain the model from below, you risk “blowing up” your model. One good primary production estimate would have made that clear, or, as we did here, a comparison to other areas.
 	Problem: EE is high for cod and anchovy 	Check Mortalities: it is because of predation mortality
 	Check Predation Mortality Rates: It is due to high predation by whiting on cod and anchovy.
 Also notice the high cannibalism mortality rate for whiting.
 	Whiting P/Q ratio is 0.187
 	So, for each unit that whiting eats, they produce 0.187
 	But cannibalism is 0.15 – that is 80% of the whiting production
 	So, to meet other demands for production (i.e. predation and catches), Ecopath
 increases the biomass for whiting until the “consumption pie” is big enough to meet
 all demands
 	This in turn causes the high EE for cod and anchovy
 	The best solution here is to lower the cannibalism rate for whiting; go to diet
 composition and lower it by 0.1, e.g., to 0.05, then increase the whiting diet for benthos by 0.1.
 Main lesson: Be careful with cannibalism, it’s often because (slow turnover) old fish eat some (fast turnover) young fish, and the model is parameterized based on the older fish. Breaking it into stanza (can be done in Excel), the calculated weighted parameters will usually solve the cannibalism dilemma.
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		Multi-stanza life histories

								

	
				Biomass-dynamics or multi-stanza?
 In EwE, you can create a set of biomass groups representing life history stages or stanzas for species that have complex trophic ontogeny. Mortality rates (predation, fishing, other) and diet composition are assumed to be similar for individuals within each stanza. For instance, larvae having high mortality and feeding on zooplankton, juveniles having lower mortality and feeding on benthic insects, adults having still lower mortality and feeding on fish. To enable this feature, you must enter baseline estimates of total mortality rate Z and diet composition for each stanza, then biomass, Q/B, and BA for one “leading” stanza only.
 For Ecopath mass balance calculations, the total mortality rate Z entered for each stanza-group is used to replace the Ecopath P/B for that group. That is, the second Ecopath master equation is interpreted as mass balance accounting for the mortality rate for the group (EE x Z). Further, the B and Q/B for all stanza-groups besides the leading (entry) stanza are calculated before entry to Ecopath, using the assumptions that:
 	body growth for the species as a whole follows the von Bertalanffy growth curve with weight proportional to length-cubed; and
 	the species population as a whole has had relatively stable mortality and relative recruitment rate for at least a few years, and so has reached a stable age-size distribution.
 
 Under the stable age distribution assumption, the relative number of age a animals is given by la/∑la where the sum is over all ages, and la is the population growth rate-corrected survivorship,
 [image: l_a=\exp(-\sum (Z_a-aBA/B))\tag{1}]
 where the sum of Z’s is over all ages up to a and the BA/B term represents effect on the numbers at age of the population growth rate (e.g., the cohort born one year ago should be smaller by the exp(-aBA/B) factor than the cohort born a years ago, if the relative population growth rate has been BA/B for at least a years). Further, the relative biomass, b, of animals in stanza s should be
 [image: b_s=(\sum \limits_{a \ in \ s}l_a \ w_a)/(\sum\limits_{all \ a}l_a \ w_a)\tag{2}]
 where wa = (1 – exp(-ka3)) is the von Bertalanffy[1] prediction of relative body weight at age a.
 Knowing the biomass, B, for one leading stanza, and the bs for each stanza s, the biomasses for the other stanzas can be calculated by first calculating population biomass
 [image: B=B_{leading}/B_{leading \ s} \tag{3}]
 then setting Bs = bsB for the other stanzas.
 Q/B estimates for non-leading stanzas are calculated with a similar approach, assuming that feeding rates vary with age as the ⅔ power of body weight (a “hidden” assumption in the von Bertalanffy growth model).  The internal calculations of survivorship and biomass are actually done in monthly age steps, so as to allow finer resolution than one year in the stanza biomass and mortality structure (e.g., larval and juvenile stanzas that last only one or a few months).
 Here are a few implementation issues for considerations when building models with multi-stanza capability:
 How many stanzas?
 The main computational burden of the full representation is in Ecosim, and this burden depends on the number of age classes accounted for (calculated from K, Z for adult stanza) rather than the number of stanzas with distinct mortality/feeding patterns within the age structure. So, the best advice we can give is to err on the high side. Add stanzas for each major ontogenetic shift in habitat use and diet (though larval stages can often be ignored due to low biomass, low impact on prey, and unlikely to show density-dependent effects). If necessary additional stanzas for size-age ranges that are subject to selective fishing impacts that might cause growth overfishing under some policy scenarios (growth overfishing can be a problem whenever juvenile fish are harvested over age ranges where they display accelerating growth in body weight, so cohort biomass is still increasing over the age range being fished).
 Representation of seasonality?
 It is common for early juvenile stanzas to be completed within a short season each year. Yet Ecopath mass balance is based on annual average mass transfers. The initialization described above is based on “spreading” the seasonal effects evenly over the annual cycle (in monthly steps), and in practice this does not cause serious problems for the mass-balance calculation/Ecopath estimation. On entry to Ecosim, users can specify seasonal recruitment patterns and represent seasonal interaction dynamics in detail, but this often forces care in all aspects of seasonality, (e.g., in prey productivity and availability as well as juvenile abundance). Generally, we find that these more detailed calculations give about the same long term population dynamics as when recruitment is treated as seasonal, except in scenarios that involve match-mismatch variation from year to year in the timing of food availability relative to the timing of recruitment (so unless you specifically want to examine match-mismatch hypotheses, consider not bothering to include seasonality in the simulations).
 Representation of stanzas that occur outside the modelled system?
 It is common, especially in models for coastal ecosystems, to have species that spend only part (or none) of their time in the given system. For example, juvenile rearing may be in the modelled ecosystem, but adult foraging and harvest impacts may occur in outside areas. The preferred way to handle trophic/fishery impacts for such species in EwE is to treat part (or all) of the diet for outside-migrant stanzas as imported, rather than to model the movement into and out of the system as immigration/emigration rates. With the diet import convention, EwE will still handle overall fishery impacts at the population scale whether or not these impacts occur within the modelled system; all that will be “lost” is dynamic change in food availability (and feeding rates) and predation mortality of organisms during times when they are outside the modelled system (outside world treated as having constant trophic conditions). Often, the stanzas that reside outside the modelled system may be older fish, for which the assumption of constant resource availability and natural mortality risk may be quite reasonable. When it appears that using the diet-import convention is inappropriate due to changing trophic conditions outside the modelled system, then the modelled system should be extended to include the “outside” trophic interactions of concern.
 The multi-stanza representation is quite flexible, and you may find other ways to use it for effectively representing “problem processes” in ecological systems.
 Attribution This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
	Von Bertalanffy, L. (1938) A quantitative theory of organic growth (inquiries on growth laws II). Human Biology, 10, 181- 213. https://www.jstor.org/stable/41447359 ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Adding multi-stanza groups (edit to only add multi-stanza)

								

	
				The purpose of this exercise is to demonstrate how to add multi-stanza groups to an EwE model.
 The model as defined for previous tutorials in this text book had these functional groups:
 Whales, seals, cod, whiting, mackerel, anchovy, shrimp, benthos, zooplankton, phytoplankton, detritus.
 Start by opening EwE6, select File > New model. Browse to your preferred file location, and enter a name for the model. For instance, “Anchovy Bay”.  Now navigate to Ecopath > Input > Basic input. The model will have one group, Detritus. All models must have a detritus group, so we have entered it for you. Why? We need to be sure there is a group where we can send excreted and egested material as well as dead organism. By default they go to the detritus group.
 On Ecopath > Input > Basic input select Define groups (also available from the menu on top: Ecopath > Define groups). Click Edit > Insert on the right side of the form that pops up. Continue clicking till you have 12 groups; then enter the group names, i.e., Whales in first row, Seals in second, etc. [Hint: you can cut and paste the names from Excel, using Ctrl-C and Ctrl-V]. We will make mackerel an age-structured (‘multi-stanza’) group, therefore enter “Mackerel” under the “Multi-stanza group name” for Mackerel juv., then use the down arrow in the row for Mackerel ad. and select “Mackerel” from the drop-down menu (this is to make sure that the stanza name is spelled the same way). Also set the Stanza age to 0 months for the juveniles, and 3 months for the older stanza, (here called “adults”). When you have entered all, click the Producer check mark in the phytoplankton row. On the right panel, you may also want to click the Colors, Alternate all, to change the group colors to your liking. Click OK.
 We also need to define our fishing fleets. Click Fishery on the Navigator to the left. Then click Definition of fleets, and then Edit fleets above the spreadsheet (or click Ecopath on the top menu, and then Edit fleets). We need four fleets: sealers, trawlers, seiners, foragers, and shrimpers. We can enter catches while we are here; unit should be t km2 year-1. The sealers caught 15 seals in 1970 with an average weight of 30 kg. The fisheries catches were 45 t of cod and 20 to of whiting for the trawlers, 40 t of mackerel ad. for the seiners, and 140 t of anchovy for the foragers, and 3 t of shrimp for the shrimpers. Calculate catches using the appropriate unit, and enter in EwE.
 The off-vessel landing prices are seals 6 $/kg; cod: 10 $/kg; whiting $6/kg; mackerel ad: 4 $/kg; anchovy is 3 $/kg for foragers. Shrimps are 20 $/kg. Prices are current prices (hence “are” instead of “were”) as we later will be using these for forward projections.
 If you lack catch or price information for your own models later, then check www.seaaroundus.org.
 We now should enter the basic input parameters. Fortunately, the biologists have been busy, and we have some survey estimates from 1970 of biomasses in the bay. The biomasses must be entered with the unit: t/km2.
 Whales: 10 individuals with an average weight of 800 kg. Seals: 203 individuals with an average weight of 30 kg. Cod: 300 t. Whiting 180 t. Mackerel ad.: 120 t. Anchovy: 640 t. Shrimp: .16 t/km2. Zooplankton: 14.8 t/km2.
 Next are production/biomass ratios, which with certain assumptions (that we don’t worry about now) correspond to the total mortality, Z. The unit is year-1, and we can often get Z from assessments. Alternatively, we have Z = F + M, so if we have the catch and the biomass, we can estimate F = C/B and add the total natural mortality to get Z.
 We do this for the fish where we can get an estimate of M and Q/B from FishBase.org. Search for the species, (Gadus morhua, Merlangius merlangus, Scomber scombrus, Engraulis encrasicolus), and extract the values. Estimate Z = F + M.
 It is also an option for exploited species to use an equation for estimation of Z that was developed by Beverton and Holt (1957). It is implemented in the life-history table in FishBase. It relies on estimates of length at first capture (Lc), average length in the catch (Lmean), and asymptotic length (Linf) to estimate Z. Try it for the four species here. Here are the lengths from the fishery in Anchovy Bay:
 	 	Lc (cm) 	Lmean (cm) 
 	Cod 	52 	72 
 	Whiting 	17.1 	26.5 
 	Mackerel 	18.9 	26 
 	Anchovy 	6.8 	10 
  
  Compare the Z estimates from the two methods (and consider).
 There is a close relationship between size and P/B; the bigger animals are, the lower the P/B. Here we have: Whales: P/B = .05 year-1; seals: get F from catch, and M is .09 year-1; shrimp P/B = 3 year-1; benthos P/B = 3 year-1; zooplankton: it is mainly small Acartia-sized plankton, with P/B = 35 year-1.
 We can get P/B for many invertebrates from Tom Brey’s work (but don’t need to for this tutorial). Check out: http://www.thomas-brey.de/science/virtualhandbook/. There is a neat collection of empirical relationships and conversion factors.
 Consumption/biomass ratios for the non-fish groups: for whales use 9 year-1, and for seals 15 year-1. For the invertebrates enter a P/Q ratio of .25 instead of entering a Q/B. Finally, there is phytoplankton. We can often get primary production estimates from SeaWiFS satellite data. Here we have PP = 240 gC m2 year-1. The conversion factor from gC to gWW is 9, so an easy way to parameterize this is to enter a biomass of 18 t km-2 for phytoplankton and a P/B of 120 year-1. EwE only uses the product of these, so it doesn’t really matter how they are distributed, but the P/B indicates a turnover of less than once per day, which is reasonable. [You could also use B=9 t km-2 for phytoplankton and a P/B of 240 year-1, but such a high P/B can make Ecospace run unstable[
 Next parameter is Ecotrophic Efficiency (EE), this is the part of the production that is used in the system (or rather for which the model explains the fate of the production). In this model, we are missing a biomass estimate for benthos. We do not explain much of the mortality for this group, so we guess an EE = 0.6. For the other groups, we let Ecopath estimate the EEs, but bear in mind the definition of EE when you evaluate the estimated parameters.
 In the Ecopath baseline year, the whale population had started to recover after whaling, but the seal population was still declining, so the Ecopath baseline model is not in steady state. We specify this on the Input data; Other production form by entering a biomass accumulation rate of 0.2 year-1 for whales, and -0.05 year-1 for seals.
 Next we parameterize the age-structured model for mackerel. For this click the baby pram / Edit multi-stanza Ecopath > input > Basic input form. Set the growth curvature parameter to 0.3 year-1 for mackerel (= the average k value from FishBase); total mortality for Mackerel juv. should be 4 year-1, and “leading” should be checked for Mackerel ad. for both biomass and consumption/biomass. Click Calculate, and the model should parameterize the age structured model.
 Now it’s time for diets:
 	 	Prey \ predator 	1 	2 	3 	4 	5 	6 	7 	8 	9 	10 
 	1 	Whales 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 
 	2 	Seals 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 
 	3 	Cod 	 0.10 	 0.04 	 – 	 0.05 	 – 	 – 	 – 	 – 	 – 	 – 
 	4 	Whiting 	 0.10 	 0.05 	 0.05 	 0.05 	 – 	 – 	 – 	 – 	 – 	 – 
 	5 	Mackerel juv. 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 
 	6 	Mackerel ad. 	 0.20 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 
 	7 	Anchovy 	 0.50 	 – 	 0.10 	 0.45 	 – 	 0.55 	 – 	 – 	 – 	 – 
 	8 	Shrimp 	 – 	 0.01 	 0.10 	 0.10 	 – 	 – 	 – 	 – 	 – 	 – 
 	9 	Benthos 	 0.10 	 0.90 	 0.75 	 0.35 	 – 	 – 	 – 	 1.00 	 0.10 	 – 
 	10 	Zooplankton 	 – 	 – 	 – 	 – 	 1.00 	 0.45 	 1.00 	 – 	 0.10 	 – 
 	11 	Phytoplankton 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 0.10 	 0.90 
 	12 	Detritus 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 – 	 0.70 	 0.10 
  
 With this we have the information that is needed to mass-balance the model. Select Parameterization, Basic estimates, and check out the outcome. Save the model.
 Try changing some of the input and see what happens. Don’t save afterwards.
 Go to Ecosim > Output > Run Ecosim  Click Run, and see what happens.
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				EwE has extensive ways of treating uncertainty – but it is important to first discuss types of uncertainty.
 	Background ecological variation or “noise” 	This is variation in ecological processes that is apparently random and not strongly autocorrelated over time. In single-species dynamics and assessment, recruitment in particular typically has such variation due to unmodelled environmental factors that influence survival rate; so we may seek to predict recruitment relationships in EwE, but there will almost always be environmentally-driven variation that EwE (or any other model) does not capture.
 
 
 	Parameter uncertainty 	This is the focus for treating uncertainty in EwE – and by extension the focus of this chapter.
 
 
 	Structural uncertainty 	This can for instance be model bias: how well does the model describe the system? Typically, this can be addressed by using alternative models to make predictions about the specific management/policy question(s) that are being addressed. Within the EwE framework, this can be done by using a suite of model formulations, e.g., spanning from MICE-type models to complex formulations with a large number of functional groups and forcing functions.  Structural uncertainty can come both from how interactions are represented in the system and from “external” (the larger world within which the model is embedded) forcing factors that may or may not be recognized during model development. See also the discussion about alternative models in the research question chapter.
 
 
 	Observation error 	This, e.g., includes errors in sampling surveys that result in uncertainty in biomass estimates. Very few ecosystem models incorporate raw data such as for instance from trawl surveys. Most are processed through other models, e.g., single-species assessments, or converting satellite images to chlorophyll and primary productivity – as discussed in the Biomasses and units chapter. For this reason, very few EwE models deal directly with observation errors – though the effects of this uncertainty become evident in measures of uncertainty about parameter values derived by examining how much the parameter values can be changed without degrading the fit to the data (likelihood functions measure this).
 
 
 	Implementation error 	In Management Strategy Evaluation (MSE) this includes errors due for example to variation in catchability coefficients and uncontrolled variation in fishing effort. See the MSE chapter for details.
 
 
 
 Most EwE models have focused on parameter uncertainty – but how does one assign uncertainty ranges to the many parameters in an ecosystem model? Consider a typical model with 30 functional groups and 5 fisheries exploiting 5 groups each. Such a model will have over 200 input parameters in the Ecopath base model alone.  That is too many to estimate individual parameter uncertainties for, and if done it would not be transparent. Assigning uncertainty based on parameter type, e.g., ±20% for biomasses, is not a realistic option. Instead, we have developed an alternative approach based on parameter “pedigree”. Pedigree can be defined as “a register recording a line of ancestors”. It is something that for instance a horse or dog may have, and it means we know where it came from. We use it to describe how well rooted a model is in local data, and with it, how uncertain the data are. The assumption is that local data are more reliable than regional or global data, guessed data are even less reliable, but the most uncertain are estimates that are derived from another model – notably those estimated by Ecopath mass-balance.
 The EwE pedigree can be defined for the key Ecopath input parameters, that is biomass, production/biomass, consumption/biomass, diets and catches, see Figure 1. Each parameter has a set of classifications following the logic described above (the range from local data to model estimates), and a default parameter uncertainty is associated with each parameter-classification type. The default parameter uncertainties can be overwritten, but given that they are reasonable and that one will have to explain why one has changed them, most models for which users have defined pedigree for input parameters have used the default values.
 There are two neat aspects to defining pedigree. By assigned pedigree index [0,1] for each parameter-classification type, we can estimate an overall pedigree [0,1] for a model, which describes how well rooted the model is in local data, and which can be compared to other ecosystem models. See Morisette (2007)[1] for a neat analysis of how the quality of input data relates to complexity and stability in ecosystems.  The second aspect is that the pedigree table (see Figure 1) from the colour scale gradient directly gives an overview of how well rooted the data that are used for a model are in local data. This is a great tool for communicating what data is available from a given ecosystem. It also makes it quite clear when models feed models, i.e. when a model relies heavily on data from other models. That is generally to be avoided when possible.
 [image: ]
 Figure 1. Input screen for defining pedigree (Ecopath > Input > Tools > Pedigree) for Anchovy Bay. Colours (gradient in grey scale) in the assignment table indicates classifications, such as shown in the Classification table, which is for the production/biomass ratio. There are similar classification tables for the other input parameters, all with defined default uncertainty associated. 
 Earlier versions of EwE (5) had an EcoRanger routine, which varied each of the basic Ecopath input parameters and evaluated what impact such changes had on output parameters. We have not ported that routine to later version (6+) for the simple reason that the output wasn’t interesting or credible. EcoRanger produced pages and pages of tables, but didn’t answer any questions. Questions about uncertainty have to be related to research and policy questions (see Your research question? chapter) for uncertainty analysis to be interesting and worthwhile. Beth Fulton has illustrated this by estimating that to evaluate parameter uncertainty for all input parameters for an Atlantis model[2] would take the biggest super-computer on Earth longer than the age of the Universe. And it wouldn’t be interesting! Uncertainty has to be focused on the research/policy questions that the given model is built to address.
 With this in mind, it should be clear that there are no direct uncertainty analyses in the Ecopath section of EwE. That is not because there is no uncertainty associated with Ecopath parameters (as discussed above), but because Ecopath serves as a base model for other analyses, especially Ecosim. The intention with the Ecopath model is to provide one possible parameter realization for a given ecosystem. Once we have such a one, we can throw uncertainty at it by sampling, including by generating not just one, but many Ecopath and Ecosim models, thereby providing the foundation for addressing questions about uncertainty.
 Sampling of parameter values can be based on Monte Carlo (MC) techniques, which is used to estimate properties of a distribution from random sampling. As an example, a MC approach can be used to draw a large number of random samples from an unknown distribution, and calculate the sample mean of those. A major benefit of MC is thus that calculating parameters for a random sample is often much easier than calculating the parameters directly from the distribution (if at all known, that is).  Expanding on this, Markov Chain MC (MCMC) is a Bayesian approach that uses random samples to generate new random samples (hence “chain”) within a probability space. Each new sample depends only on the previous sample, with an incremental change (that’s the “Markov property”), and the more such samples, the more the final samples will resemble the original (perhaps unknown) distribution.  We refer (without specifics) to the statistics literature for details about MC and MCMC, both of which procedures are used extensively in EwE.
 Ecosim includes a MC routine (Ecosim > Tools > Monte Carlo simulation), which can be used to run Ecosim in an attempt to find a model that improves fit to time series with given parameter uncertainty for biomasses, production/biomass ratios, consumption/biomass ratios, ecotrophic efficiencies, diets, biomass accumulation or biomass accumulation rates, landings and discards.  Parameter uncertainty can be defined for each group-parameter combination, and is often populated from pedigree. The routine will draw an Ecopath input parameter combination, evaluate the derived model based on mass-balance criteria, and if the model passes these criteria, the MC routine will run Ecosim and evaluate the fit to time series data. If a model produces a better fit to the time series data than previously obtained, the model will be retained. At the end of the run, the best fit model parameter combination can then be used as an Ecopath base model, if so desired. The output from the model runs can also be used to evaluate the overall trajectories for Ecosim runs with the given parameter uncertainty.
 Where the MC routine as described above evaluates one possible Ecopath model realization at the time, the CEFAS MSE plug-in for EwE (see Management strategy evaluation chapter), provides a method for developing a suite of possible Ecopath models, which subsequently can be used for resampling in comparison of policy options.
 The possibility of creating multiple Ecopath base models has also been included in the EwE Ecosampler routine, which is a very versatile approach for addressing uncertainty for any routine in Ecosim and Ecospace. Ecosampler records alternative mass-balanced Ecopath models from MC, and replays these “samples” through EwE main modules and plug-ins, including Ecopath, Ecosim, Ecotracer, EcoIndicators, value chain and others). The routine captures output variation due to base input parameter uncertainty. We here refer to the Ecosampler chapter in the EwE User Guide for details.
 Uncertainty in time series (e.g., environmental forcing functions, fishing effort, or biomass series) can be addressed with the Multi-sim plug-in described in the EwE User Guide, to which we refer to details. There is a tutorial in (the web and online pdf versions of) this book, that can used to get experience with the approach (see the Uncertainty in time series data tutorial).
 When it comes to Ecospace, there are only few routines and examples of explicitly evaluating uncertainty. One notable example, however, was for the Roberts Bank Terminal 2 expansion project (see the Environmental impact assessment chapter of the online version of this textbook for details) where the research question related to uncertainty was how model structure and parameterization impact predictions about ecological impact of a proposed container terminal. For this analysis we ran a complex ecosystem model 5,000 times several times over as part of very comprehensive analyses of model prediction uncertainty. The Ecospace MC approach was implemented as a plug-in and will be made available for a coming release of EwE.
 As a closing point, note that EwE users need to beware of what we call the “bad apple” problem, i.e. the idea that just one bad apple can cause a whole barrel to go rotten. It doesn’t always happen, it’s more of an exception, but it can happen. That is, just because most parameters are well estimated does not mean that just one or two bad ones cannot cause the whole model to make hugely incorrect predictions – especially if used to address questions that the original model wasn’t designed to answer.  For example, an early model of the Georgia Strait ecosystem fit historical data very well, but had large overestimates of Q/B and P/B for Pacific hake.  This went unnoticed until a later model developer “borrowed” those two parameter values and ran a scenario where harbour seal populations were reduced through harvesting.  That policy test resulted (because of the bad hake parameters) in a substantial hake increase, which in turn caused the simulated herring (and two salmon) populations to be driven to extinction.  To make matters worse, yet another scientist then used the bad model predictions as evidence that reducing seal populations would have counter-productive results because of the value of the seals for controlling impacts of other species like hake.  The lessons from this example include (1) test your models not just to fit data, but for their specific policy predictions, (2) use pedigrees to check for possible bad parameter estimates, and (3) do not assume that effects of multiple parameters are additive so that a few errors will not have major impact on model performance.
 
	Morissette L. 2007. Complexity, cost and quality of ecosystem models and their impact on resilience: a comparative analysis, with emphasis on marine mammals and the Gulf of St. Lawrence. PhD dissertation, University of British Columbia. Available at https://open.library.ubc.ca/soa/cIRcle/collections/ubctheses/831/items/1.0074903?o=12 ↵
	See https://research.csiro.au/atlantis/ ↵
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		Network analysis

								

	
				EwE links concepts developed by theoretical ecologists, especially the network analysis theory of Ulanowicz[1], with those used by biologists involved with fisheries, aquaculture and farming systems research. The Network analysis component of Ecopath is included as a plugin (Ecopath > Output > Tools > Network analysis).
 The output forms included in the plug-in include: Trophic level decomposition, Flows and biomasses, Primary production required, Mixed trophic impact, Ascendancy, Flow from detritus, Cycles and pathways, Network analysis indices in Ecosim.
 Trophic level decomposition
 In addition to the routine for calculation of fractional trophic levels, a routine is included in Ecopath which aggregates the entire system into discrete trophic levels sensu Lindeman. This routine, based on an approach suggested by Ulanowicz[2] (1995), reverses the routine for calculation of fractional trophic levels. Thus, for the example when a group obtains 40% of its food as a herbivore and 60% as a first-order carnivore, the corresponding fractions of the flow through the group are attributed to the herbivore level and the first consumer level.
 The results of this analysis are presented in the Relative flows table under the Trophic level decomposition node (these are proportions adding up to 1). These proportions are converted to absolute amounts, presented in the Absolute flows table (t km-2 year-1 or grams of carbon m-2 year-1), thus enabling the flows to be aggregated by trophic level and summarized in different ways.
 Flows from detritus to the different model groups are calculated when you select the Flow from detritus menu item.
 Transfer efficiency
 Based on the trophic aggregation tables, the transfer efficiencies between successive discrete trophic levels can be calculated as the ratio between the sum of the exports from a given trophic level, plus the flow that is transferred from trophic level to the next, and the throughput on the trophic level. This is presented in a table with transfer efficiencies (%) by trophic levels.
 Flows and biomasses
 The absolute flows calculated in the Trophic level decomposition and Flow from detritus analyses can be aggregated to produce useful summaries by trophic level.
 Primary production required
 For terrestrial systems, it has been shown by Vitousek et al.[3] based on a detailed analysis of agriculture, industry and other activities, that nearly 40% of potential net primary production is used directly or indirectly by these activities. Comparable estimates for aquatic systems were not available until recently, though a rough estimate, of 2% was presented in the same publication. This figure, much lower than that for terrestrial systems, was based on the assumptions that an “average fish” feeds two trophic levels above the primary producers, and has been since revised upward.[4] The crudeness of Vitousek et al.’s approach for the aquatic systems was due mainly to lack of information on marine food webs, especially on the trophic positions of the various organisms harvested by humans. Models of trophic interactions may however help overcome this situation, and an alternative approach, based on network analysis, may be suggested for quantification of the primary productivity required to sustain harvest by humans (or by analogy by any other group that extracts production from an ecosystem).
 To estimate the primary production required (PPR)[5] to sustain the catches and the consumption by the trophic groups in an ecosystem, the following procedure has been implemented in Ecopath: First, all cycles are removed from the diet compositions, and all paths in the flow network are identified using the method suggested by Ulanowicz.[6] For each path, the flows are then raised to primary production equivalents using the product of the catch, the consumption/production ratio of each path element times the proportion the next element of the path contributes to the diet of the given path element. For a simple path from trophic level (TL) I (primary producers and detritus), over TL II and III, and on to the fishery,
 [image: TL_I \xrightarrow{Q_{II}} TL_{II} \xrightarrow{Q_{III}} TL_{III} \xrightarrow{Q_{IV}} \text{Fishery}\tag{1}]
 
 the primary production (or detritus) equivalents, PPR, corresponding to the catch of Y is:
 [image: PPR_C=Y \cdot \frac{Q_{III}}{Y} \cdot \frac{Q_{II}}{Q_{III}} = Q_{II} \tag{2}]
 For the general (and more realistic) case where the pathways include branching the PPR corresponding to a catch Y of a given group can be quantified by summing over all pathways leading to the given group the PPR’s
 [image: PPR_C=\sum\limits_{\text{Paths}}(Y \cdot \prod\limits_{\text{Pred,prey}}\frac{Q_{\text{Pred}}}{P_{\text{Pred}}} \cdot DC'_{\text{Pred,prey}} ) \tag{3}]
 where P is production, Q consumption, and DC’ is the diet composition for each predator/prey constellation in each path (with cycles removed from the diet compositions).
 Further, the PPR for sustaining the consumption of each trophic group in a system can be estimated from the same equation as above by substituting the catch, Y, with the production term, P, calculated as the production/biomass ration, P/B, times the biomass, B.
 PPR should actually be interpreted as flow from TL I as it includes primary production as well as detritus uptake. The denominator, PP, thus actually includes all “new” flow to the detritus groups, i.e. flow from primary producers and import of detritus.
 The PPR is closely related to the “emergy” concept of H. T. Odum,[7] and is proportional to the “ecological footprint” of Wackernagel and Rees.[8]
 Mixed trophic impact
 Leontief [9] developed a method to assess the direct and indirect interactions in the economy of the USA, using what has since been called the “Leontief matrix”. This approach was introduced to ecology by Hannon[10] and Hannon and Joiris.[11] Using this, it becomes possible to evaluate the potential effect that a small change in the biomass of a group may have on the biomass of the other groups in a system. Ulanowicz and Puccia[12] developed a similar approach, and a routine based on their method has been implemented in the Ecopath system. The “mixed trophic impact” (MTI) for living groups is calculated by constructing an n x n matrix, where the i,jth element representing the interaction between the impacting group i and the impacted group j is
 [image: MTI_{i,j}=DC_{i,j} - FC_{ji} \tag{4}]
 where DCi,j is the diet composition term expressing how much j contributes to the diet of i, and FCj,i is a host composition term giving the proportion of the predation on j that is due to i as a predator. When calculating the host compositions the fishing fleets are included as ‘predators’.
 For detritus groups the DCi,j terms are set to 0. For each fishing fleet a “diet composition” is calculated representing how much each group contributes to the catches, while the host composition term as mentioned above includes both predation and catches.
 The diagonal elements of the MTI are further increased by 1, i.e.,
 [image: MTI_{i,i}= MTI_{i,i}+1 \tag{5}]
 The matrix is inversed using a standard matrix inversion routine.
 [image: ]
 Figure 1. Mixed trophic impacts for Anchovy Bay showing the combined direct and indirect trophic impacts that an infinitesimal increase of any of the groups in the rows (to the right) is predicted to have on the groups in the columns (on top). The open bars pointing upwards indicate positive impacts, while the filled bars pointing downwards show negative impacts. The bars should not be interpreted in an absolute sense: the impacts are relative, but comparable between groups.
 Note in Figure 1 that most groups have a negative impact on themselves, interpreted here as reflecting increased within-group competition for resources. Exceptions exist; thus, if a group cannibalizes itself (0-order cycle), the impact of a group on itself may be positive. In figure 1 the impact of whales on whales is negligible indicating that whales very far from their carrying capacity in the model base year.
 The mixed trophic impact routine can also be regarded as a form of “ordinary” sensitivity analysis.[13] In this system, it can be concluded, e.g., that the impact of the bathypelagics on any other group is negligible: these fishes are too scarce to have any quantitative impacts. This can be seen to indicate that one need not allocate much effort in refining one’s parameter estimates for this group; it may be better to concentrate on other groups.
 One should regard the mixed trophic impact routine as a tool for indicating the possible impact of direct and indirect interactions (including competition) in a steady-state system, not as an instrument for making predictions of what will happen in the future if certain interaction terms are changed. The major reason for this is that changes in abundance may lead to changes in diet compositions, and this cannot be accommodated with the mixed trophic impact analysis.
 Ascendancy
 “Ascendency” is a measure of the average mutual information in a system, scaled by system throughput, and is derived from information theory.[14] If one knows the location of a unit of energy the uncertainty about where it will next flow to is reduced by an amount known as the average mutual information’,
 [image: I= \sum\limits_{i=1,j=1}^n f_{}ij Q_i \log(f_{ij}/\sum\limits_{k=1}^n) f_{kj}Q_k \tag{6}]
 where, if Tij is a measure of the energy flow from j to i, fij is the fraction of the total flow from j that is represented by Tij, or,
 [image: f_{ij}=T_{ij}/\sum\limits_{k=1}^n T_{kj} \tag{7}]
 Qi is the probability that a unit of energy passes through i, or
 [image: Q_i=\sum\limits_{k=1}^n / \sum\limits_{l=1,m=1}^n T_{lm} \tag{8}]
 Qi is a probability and is scaled by multiplication with the total throughput of the system, T, where
 [image: T=\sum\limits_{i=1,j=1}^n T_{i,j} \tag{9}]
 Further
 [image: A=T \cdot I \tag{10}]
 where A is called “ascendency”. The ascendency is symmetrical and will have the same value whether calculated from input or output.
 There is an upper limit for the size of the ascendency. This upper limit is called the “development capacity” and is estimated from
 [image: C = H \cdot T \tag{11}]
 where H is called the ‘statistical entropy’, and is estimated from
 [image: H=\sum\limits_{i=1}^n Q_i \log Q_i \tag{12}]
 The difference between the capacity and the ascendency is called “system overhead”. The overheads provide limits on how much the ascendency can increase and reflect the system’s “strength in reserve” from which it can draw to meet unexpected perturbations.[15] As an example, the part of the ascendency that is due to imports, A0, can increase at the expense of the overheads due to imports, Q0. This can be done by either diminishing the imports or by importing from a few major sources only. The first solution would imply that the system should starve, while the latter would render the system more dependent on a few sources of imports. The system thus does not benefit from reducing Q0 below a certain system-specific critical level (Ulanowicz and Norden, 1990).
 The ascendency, overheads and capacity can all be split into contributions from imports, internal flow, exports and dissipation (respiration). These contributions are additive.
 The unit for these measures is “flowbits”, or the product of flow (e.g., t km-2 year-1) and bits. Here the “bit” is an information unit, corresponding to the amount of uncertainty associated with a single binary decision.
 The overheads on imports and internal flows (redundancy) may be seen as a measure of system stability sensu Odum, and the ascendency / system throughput ratio as a measure of information, as included in Odum’s attributes of ecosystem maturity. For a study of ecosystem maturity using Ecopath see Christensen 1995.[16]
 Flow from detritus
 The Trophic level decomposition analysis calculated the fractions of the flow from each trophic level through each model group. The Flow from detritus analysis is equivalent, but calculates the flow from detritus through each group and converts it to absolute flows (t km-2 year-1).
 Cycles and pathways
 A routine based on an approach suggested by Ulanowicz[17] has been implemented to describe the numerous cycles and pathways that are implied by the food web representing an ecosystem.[18]
 Each routine below has two forms: Pathway and Summary of pathways. The summary routine counts the number of all pathways leading from the prey to the selected consumer. The mean path length will be calculated and displayed on the form. It is calculated as the total number of trophic links divided by the number of pathways.
 Consumer <- TL1
 This routine lists all pathways leading from all groups on Trophic Level I (primary producers and detritus) to any selected consumer. A list of all consumers in the system will be displayed, and one can select from this. The program then searches through the diet compositions, finds all the pathways from the primary producers to the specified consumer, and then presents these pathways. Further, a summary presents the total number of pathways and the mean length of the pathways (under the Summary of pathways menu item). The latter is calculated as the total number of trophic links divided by the number of pathways.
 Consumer <- prey <- TL1
 This routine lists all pathways leading from all groups on Trophic Level I (primary producers and detritus) to any selected consumer via a selected prey. A pull-down list of all consumers in the system will be displayed after the heading “Pathways leading to:”. Select the consumer of interest from this list then choose a specific prey from the right-hand pull-down list. The program searches through the diet compositions, finds all the pathways from the primary producers, via the selected prey, to the specified consumer, and then presents the pathways. A summary presents the total number of pathways and the mean length of the pathways (under the Summary of pathways menu item).
 Top predator <- prey
 Here, one enters a prey group, and the program will find all pathways leading from this prey to all top predators. A summary presents the total number of pathways and the mean length of the pathways (under the Summary of pathways menu item).
 Cycles (living)
 The routine identifies all cycles in the system excluding detritus and displays these, in ascending order, starting with “zero order” cycles (“cannibalism”). In addition, the total number and the mean length of the cycles will be displayed.
 Cycles (all)
 The routine identifies all cycles in the system and displays these, in ascending order, starting with “zero order” cycles (“cannibalism”). In addition, the total number and the mean length of the cycles will be displayed.
 Cycling and path length
 The “cycling index” is the fraction of an ecosystem’s throughput that is recycled. This index, developed by Finn[19] (1976), is expressed here as a percentage, and quantifies one of Odum’s[20] 24 properties of system maturity.[21] Recent work shows this index to strongly correlate with system maturity, resilience and stability.
 In addition to Finn’s cycling index, Ecopath includes a slightly modified “predatory cycling index”, computed after cycles involving detritus groups have been removed.
 The path length is defined as the average number of groups that an inflow or outflow passes through.[22]. It is calculated as
 Path length = Total System Throughput / (∑Export + ∑Respiration)
 As diversity of flows and recycling is expected to increase with maturity, so is the path length. The effects of changes in the ecosystem on the network analysis indices (such as total systems throughput, Finn and predatory cycling indices, ascendency, overhead and their breakdown into various components) can then be plotted over time and compared for various scenarios of Ecosim.
 Attribution: This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
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		Foraging arena theory

					Robert NM Ahrens; Villy Christensen; and Carl J. Walters

			

	
				There’s a story about the birth of the foraging arena theory in the On modelling chapter of this book.
 Foraging arena theory is the driving machinery in EwE, and it represents a development that has had profound implications for making ecosystem models behave, be able to replicate the ecosystem history and make plausible predictions. Without the foraging arena theory there would be no EwE.
 The foraging arena theory emerged through a series of studies during the 1990s[1] [2] [3]. The general predictions of foraging arena theory have been fairly widely used by fisheries scientists, mainly through the application of EwE-Ecosim, to explain and model responses of harvested ecosystems[4]. The potential for the underlying ecological theory upon which foraging arena theory is based to help to understand a broad range of aquatic ecosystem behaviours has apparently not been widely recognized.
 Here we describe the basic models of foraging arena theory. We review the various mechanisms that can lead to these models, list the main predictions they imply, and give an overview of the practical difficulties that have been encountered in estimating critical vulnerability exchange rate parameters that appear to limit trophic interaction rates. The present chapter is an adapted extract from Ahrens et al.[5] to which we refer for a fuller presentation and notably examples with references.
 Basic models of foraging arena theory
 The basic assertion of foraging arena theory is that spatial and temporal restrictions in predator and prey activity cause partitioning of each prey population into vulnerable and invulnerable population components, such that predation rates are dependent on (and limited by) exchange rates between these prey components. Trophic interactions take place in the restricted “foraging arenas” where vulnerable prey can be found (Figure 1 and 2).
 That is, if the total prey population is Bi, and Vi of these are vulnerable to predation at any moment (i.e. are in the foraging arena for interaction with some predator whose abundance is Bj), total prey consumption rate Qj should be predictable as the mass action product
 [image: Q_j=a_{ij} \ V \ B_j \tag{1}]
 where the predator rate of effective search aij has units of area or volume per time searched by the predator divided by the area or volume (A) of the foraging arena. Note here that Qj is predictable as Qj=aij Bi Bj only when Vi=Bi, i.e. when all Bi prey and Bj predators are randomly distributed or well-mixed.
 [image: ]
 Figure 1. Aquatic organisms have evolved a diversity of behaviours that limit their exposure to predation risk. The use of spatial refuges from predation is likely to restrict foraging to limited volumes (V) nearby and limit predator-prey interaction. 
 This argument remains the same if the predator exhibits type II behaviour, i.e. if aij is reduced when search time is lost due to prey handling[6] [7]. We might represent such effects for example with the multispecies disc equation[8].
 [image: ]
 Figure 2. Simulation of flow between available (Vi) and unavailable (Bi– Vi) prey biomass in Ecosim. aij is the predator search rate for prey i, v is the exchange rate between the vulnerable and invulnerable state. Fast equilibrium between the two prey states implies Vi= vBi/ (2v + aBj).[9]
  
 Two specific models have been proposed for predicting changes in vulnerable prey densities V in foraging arenas[10]. The first or “continuous exchange” model[11] proposes that prey exchange between the vulnerable and invulnerable states at instantaneous rates v and v′, so that Vi gains individuals at rate v(Bi-Vi) and loses them at rates v′Vi and aViBj. This results in the rate equation
 [image: dV_i/dt=v(B_i-V_i)-v' \ V_i - a_{ij}V_i \ B_j\tag{2}]
 If the vulnerability exchange and predation rates are high compared to overall rates of change of Bi and Bj, Vi is predicted to remain close to the moving equilibrium (with Bi and Bj) given by solving Eq. 2 with dVi/dt=0:
 [image: V_i=vB_i/(v+v'+a_{ij}B_j)\tag{3}]
 The second or “bout feeding” model proposes that prey (or predators) regularly (e.g., daily at dawn and dusk) enter the foraging arena for short temporal feeding bouts, depleting Vi exponentially during each bout such that the mean prey density seen by the predator during each bout of duration T is given by
 [image: V_i=vB_i(1-e^{-aB_jT}/a_{ij} B_j )\tag{4}]
 and initial vulnerable prey abundance vBi is some fraction of the total prey population Bi. Note that both of these models imply two alternative ways to precisely define the phrase “limited food supply”, found in ecological arguments[12], but generally lacks a formal definition. The supply of food may be defined as a temporal rate vN of food delivery to foraging arenas, or alternatively as the limited food density V that results from the balance of supply rate and removal processes.
 An immediate and crucial prediction of models represented by Eq. 3 and Eq. 4 is that there can be strong negative effect of predator abundance Bj on vulnerable prey density Vi and feeding rate per predator Q/Bj, whether or not predators have any substantial impact on total prey abundance Bi[13]. Substituting Eq. 2 into Eq. 1 results in the “functional response” prediction
 [image: Q/B_j = a \ v \ B_i/(v+v'+a B_j)\tag{5}]
 That is, the basic foraging arena models predict strong “ratio dependence” in the predation rate Qj, with attendant consequences for predator-prey stability. Further, these models do not depend on specific assumptions about predator behaviour, such as interference or contest competition. Unlike models based on substituting Bj/Bi (prey per predator) ratios into functional response models they can be derived from fine-scale arguments about behaviour and spatial organization of interactions, and so are not subject to Abrams[14] very valid criticisms about the simplistic ratio formulations. Foraging arena models assert that competition between predators is intensified from the spatial restriction of interactions into arenas, however there is no one factor that restricts foraging activity, and restriction may arise result from factors such as prey and/or predator behaviours, or specific habitat requirements. Another basic prediction is that interaction rates Qj can vary between “bottom-up” controlled and “top-down” controlled depending on v and aij. This is easiest to see with Eq. 2: If v is small and aij is large, Qj approaches the “donor controlled” limiting rate vBi as Bj increases; but as v increases, Qj approaches the mass action rate aijBiBj.
 The predictions from the foraging arena equations extend across a wide range of scales. Before describing these predictions in more detail, we find it important to demonstrate that the fundamental assumption of partitioning of prey into Vi and Bi-Vi components, with attendant exchange processes that can limit trophic interactions, is very widespread or potentially universal at least in aquatic ecosystems. Partitioning resulting from exchange processes implies a basic reversal of the idea that small proportions of prey may be in safe refuges so as to cause predation rates to have type III functional response form. Under the foraging arena assumption, it is far more common for the bulk of prey to be in refuges at any moment, particularly when exchange rates are low. Intense completion for resources within the foraging arena potentially results in increased foraging times by prey[15] as prey density increases, resulting in the type III form of the functional response due to changes in prey behaviour rather than predator behaviour.
 Mechanisms that cause prey population partitioning and vulnerability exchange processes
 It takes three to tango
 If a small fish restricts its foraging to near hiding places, most become invulnerable at any moment to their predators.
 A critical point about vulnerability exchange structures is that restriction in activity by any one species is likely to induce the exchange structure represented by Eq. 1 for at least two trophic linkages, between the species and its prey and between the species and its predator(s).  Consider for example the simple food chain zooplankton [image: \rightarrow] small fish [image: \rightarrow] piscivore.  If the small fish “chooses” to restrict its activities so as to forage only near hiding places, most of the small fish become invulnerable at any moment to piscivores.  Likewise, then most of its zooplankton prey population becomes invulnerable to it at any moment.  This “cascade” of foraging arena structures results in spatially limited interactions between predator and prey occurring on time scales of minutes/hours and at the spatial scale of meters (Figure 3), intensifying competition between predators when exchange processes limit the rate at which prey are replenished.
  
 [image: A complex figure with 11 sub plots. The figure legend provides an explanation of the figure]Figure 3. Foraging arena predictions across a range of space/time scales. The restriction of predator-prey interaction to “foraging arenas” results in a decreasing hyperbolic relationship between available prey density (Vi) and predator density (Pj) at fine space/time scales. Intra-specific competition within these arenas leads to the commonly observed Beverton-Holt recruitment relationship. For inter-specific interactions, the exchange of prey into and out of these arenas limits predation mortality resulting in community stability. Bi is total prey biomass.
 In the following section, we present a simple classification of behaviours that can lead to vulnerability exchange dynamics is presented.  This classification is not complete or exhaustive, but it does cover a wide variety of trophic interactions in aquatic systems and demonstrates the broad applicability of foraging arena theory, (for relevant examples in the literature, see the source publication).
 1. Arena structure caused by restricted spatial distribution of predators relative to prey
 This category includes the original situation mentioned above, where the predator distribution covers only a small proportion of the area or volume occupied by prey organisms.  But such restricted overlap can be caused by a variety of factors of which two appear to be particularly common.  In all such cases, the vulnerability exchange rates v and v′ are likely to have values determined mainly by physical transport (advection, diffusion) and random movement processes of the prey, and can be extremely low proportions of the overall prey population in physically large systems.
 1.a. Restricted predator distribution in response to predation risk caused by its predators
 The behaviour of post-larval juvenile fish is likely dominated by a need to reduce predation risk, and this is likely also the case for juveniles of mobile invertebrates.  So far as we know from many examples, post-larvae move into highly restricted habitats (e.g., structure, schools) and spend relatively little time foraging.  For most fish, increase in body size is associated with ontogenetic habitat shifts to use much larger foraging arenas and multiple habitat types.
 Many mobile aquatic invertebrates exhibit strong vertical migration behaviours, apparently in response to predation risk but perhaps also as a way to manage metabolic costs or gain a horizontal transport advantage.  Such behaviours result in temporally limited periods of overlap with prey, leading to diurnal foraging bouts and possibly localized prey depletion as represented by Eq. 4.
 1.b.  Restricted predator distribution caused by limited predator mobility or habitat requirements
 Many “predators” have limited or no mobility, for example sessile invertebrates that filter-feed the water column above their resting site.  Such restriction in vertical access to prey obviously creates a foraging arena exchange structure with algal and detritus “prey” distributed over the whole water column.
 In some cases, apparently mobile predators still concentrate their activities in particular habitats even when not faced with obvious predation risk, perhaps as a way to manage energetic costs and/or places for ambushing prey.  Many reef and demersal fish tend to hold and forage near bottom structure, even while taking mainly planktonic prey; one reason for this is that the ocean bottom acts as a trap to concentrate vertically migrating prey species.  Such behaviour may be optimal under certain conditions and establishes an arena type structure.
 2. Restricted prey distribution and/or activity
 This category represents situations where predators may be widely distributed, but their prey show possibly severe restriction in spatial distribution and activity.  Predators that exhibit type 1.a. behaviour above with respect to their prey are in turn expected to exhibit type 2 behaviour with respect to interactions with the species that prey on them.
 2.a.  Time allocation to safe/resting sites
 This is the interesting case from an evolutionary perspective, where the same behaviours used to acquire resources (movement into foraging arenas to feed) cause some creatures to be the resources of other species (predation risk concentrated in the same arenas).  Obviously such situations create trade-off relationships for which we can expect strong natural selection for optimized time allocation. It is difficult to generalize about the amount of time spent individuals under predation threat spend in refuge habitats. There is an indication that for juvenile fish, the optimum appears to typically be a small-time allocations to foraging particularly when foraging is restricted to crepuscular periods.
 2.b. Vulnerability exchange associated with dispersal behaviours
 The acquisition of resources is not the only behaviour that can expose organisms periodically to predation risk.  Dispersal behaviours are also dangerous, and can occur for a wide variety of reasons (ontogenetic changes in habitat requirements or opportunities, response to locally high densities of competitors, movement to reproductive sites, etc.)  Perhaps the most obvious example in aquatic systems is drift of benthic stream insects that spend most of their time in interstitial microhabitats where they are safe from most fish predation, but occasionally leave such sites to drift downstream.  In this case, the V of Eq. 1 is literally the concentration of drifting (and emerging) insects, and the drift entry rate v can be limiting to potential abundance of stream predators like trout.
 2.c. Vulnerability exchange caused by agonistic behaviours 
 Many aquatic organisms defend restricted resting or mating sites, and exhibit strong aggressive behaviours toward nearby conspecifics.  In such cases, there can be strong density-dependent increase in agonistic activity with increasing density of conspecifics, leading to increased predation risk and density-dependent mortality at high densities.
 2.d. High proportion of individual mass not accessible or digestible
 Some predators take only parts of their prey without normally killing the prey. For example, browsing herbivores often select only particular plant parts that are physically accessible (not too high off the ground, not underground) or high in quality (seeds, leaves and active growth tips that are high in protein), leaving most of the prey growth/production system intact.  In such cases, the v process represents prey body growth.  Such dynamic structures are much more common in terrestrial than aquatic environments, but they do occur with grazers on macrophytes and macroalgae, and even with animal-animal interactions like fishes that nip at the siphons of buried molluscs or “graze” on parts of corals.
 3. Spatial displacement of predators and prey by physical transport processes
 It is common in aquatic ecosystems for production dynamics to be ordered in a physical flow pattern, where nutrient delivery at the head of the flow gives rise to primary production peaks downstream some distance (as primary producers are advected away from the nutrient source as they grow), and to secondary production peaks still further downstream as animals grow in response to the primary production as they are advected.
 In such flow structures, smaller organisms may be able to partially control their downstream positions through counter-current movements (vertical migration, emergence and flying upstream).  If these behaviours are not completely successful at bringing organisms to centers of prey abundance, such counter-current movements can result in organisms being concentrated in areas along the flow such that their food species appear to exhibit largely donor-controlled dynamics, i.e., to have concentration dynamics V with the same dominant terms (exchange in and out, predation loss) as in Eq. 1.
 A similar concentration dynamic is observed when physical flow processes concentrate organism at frontal zones. These areas of higher food concentrations appear to be important foraging areas for higher trophic level organism such as sea birds or whales. In these structures, the concentration of production from a much wider areas establishes a foraging arena as organism exchange into frontal areas either through physical transport or directed movement.
 Foraging arena predictions for a range of scales
 A fundamental assumption of foraging arena theory is that predator-prey interactions occur at the scale of hours and meters through various behavioural and physical mechanisms potentially restricting prey exposure to predation and intensify competition between predators.  This foraging arena formulation provides a structure that can be used to predicting observed states across a range of scale from the individual up to the ecosystem level.
 At the scale of the individual, foraging arena theory can be invoked to explain the failure of fishes at least to consume nearly as much food as we would predict to be possible based on large-scale sampling of prey abundances. Back calculation of food intake rates from observed growth in the field, using laboratory-based bioenergetics models, indicates that fish typically feed at much lower rates than predicted from laboratory estimates of maximum ration.  Fish biologists routinely encounter this phenomenon where a high proportion of the fish stomachs examined are empty.  Foraging arena theory argues that the phenomenon is a symptom of evolutionary adaptation to predation risk, and involves two distinct and possibly interacting causes: spatial restriction in activity that leads to local prey depletion (low V) where foraging does take place, and/or temporal restriction in foraging activity also so as to reduce predation risk.  Each of these causes can lead to empty stomachs or apparent reduced food intake. Suboptimal foraging has also been observed in the absence of predation though these observations have been for small individuals that may have restricted opportunity to select which areas to forage in. In addition individuals commonly stop or reduce feeding during spawning, brood rearing, and during migration, or may receive less than optimal ration due to territorial behaviours or dominance hierarchies.
 The theory makes two broad predictions about what we should find when short-term (seasonal, annual) observations are collected across a range of predator densities.  First, mean available food density per predator (Vi) should decrease in an inverse hyperbolic pattern as predator density Bj increases, with the first increments in predator abundance causing the greatest incremental decreases in available food density, whether or not there is any impact of Bj on the overall prey population Bi (Figure 3).  This prediction is dependent on the exchange rates (v) and approaches a linear decrease in Vi with increasing Bj at higher exchange.  Second, instantaneous prey mortality rate (Qj/Bi) should increase in a hyperbolic pattern toward a maximum rate (v) as Bj increases, rather than simply being proportional to predator abundance Bj (Figure 3).  When applied over longer time scales, this second prediction is the basic reason that predator-prey models based on foraging arena equations tend not to show cycles, even when handling time effects (reduction in predator search rate a with increasing Bi) are included in the predictions provided exchange rates (v) are low (right column of Figure 3).
 On time scales of one to a few years, Walters and Korman[16] argue that the hyperbolic relationship between Vi and Bj, along with predator behaviour and predation risk, is likely to lead to the most commonly observed form of stock-recruitment relationship in fish populations, namely the flat-topped curve called the Beverton-Holt relationship (left column of Figure 3).  Hundreds of empirical stock-recruitment relationships have been assembled for fish[17], and most of these show net recruitment to harvestable ages (typically 2-4 years) to be largely independent of parental spawning abundance or egg production.  Such independence implies strong density-dependence in survival rates from egg to recruitment (else recruitment would on average be proportional to egg production, not independent of it).  Beverton and Holt[18] showed that this pattern is expected if juveniles die off over time before recruitment according to a quadratic mortality model of the form dBj/dt = -(M0 + M1 Bj) Bj.  Further, Walters and Korman[19] showed that exactly this linear relationship between instantaneous mortality rate M0 +M1 Bj  is expected if (1) food density V available per Bj decreases as predicted by Eq. 2, juvenile fish adjust their daily foraging times so as to try and achieve a base growth rate needed to complete their ontogeny, and (3) mortality rate is proportional to time spent foraging.
 Such predictions about individual and population scale patterns may help in interpreting some patterns in field data, but the really interesting predictions from foraging arena theory arise when models are developed for predicting impacts of changing trophic interactions in multispecies fisheries and whole aquatic food webs.  Using the Ecopath mass-balance model to estimate initial abundances (Bi, Bj) and trophic flow rates (Qj) for a food web, changes in these abundances response to disturbances like fishing and changes in nutrient loading can be simulated over time.
 It is easy to demonstrate that if we predict the changes in Qj’s using simple mass action rules (Qj=aijBiBj, all species acting as though they were randomly mixed over the ecosystem), simulated competition and predation effects quickly result in substantial loss in food web structure.  Such model pathologies only become worse when we include more realistic, type II functional response effects representing limitation on predator feeding rates due to handling times and adjustments in foraging times to achieve target food consumption rates; the typical result is to predict at least some predator-prey oscillations, along with “paradox of enrichment” effects (increasing dynamic instability as simulated primary productivity is increased).
 When food web models like EwE-Ecosim are used to predict effects of dynamic changes in predator-prey interaction rates Qj using the foraging arena vulnerability exchange equations (Eq. 1 to Eq. 5), there is a dramatic reversal of the difficulties encountered with models based on simple mass action interaction rates.  Models with low vulnerability exchange rates (v’s) routinely make four key predictions that are difficult to obtain with simplified mass action models:
 	Predator-prey cycles should be rare in aquatic ecosystems, and no paradox of enrichment (instability at high productivity) should occur along spatial or temporal gradients in primary productivity.
 	Trophic cascades[20] should be common at least in simpler aquatic ecosystems
 	The Gauss “competitive exclusion principle”[21](Hardin, 1960) should fail.
 	In harvested systems, surplus production of predators should be created by immediate compensatory responses to increased per-capita food density (availability) in foraging arenas.
 
 Assessment of vulnerability exchange rates for ecosystem management models
 There is a clear need for quantitative models to evaluate the various trade-offs involved in aquatic ecosystem management, so as to provide advice that can at least rank the relative impact of management options and to expose critical uncertainties that may trigger precautionary or experimental management policies.  We doubt that any natural historian who has looked closely at spatial and temporal organization of aquatic trophic interactions would doubt the need to represent such interactions as being restricted to at least some degree to what we have called foraging arenas, whether or not such arenas can be precisely defined and measured under field conditions. It is likely that interactions between predators and prey are occurring at the scale of hours and meters. But in practice, there is a huge gulf between knowing that interaction rates are likely to be restricted to some degree by vulnerability exchange rates (v), versus being able to quantify such rates well enough to say whether they are low enough to require abandonment of simpler mass-action predictions of interaction rates, and to make useful predictions about compensatory responses (surplus production) to various disturbance regimes.
 A variety of approaches have been tried for estimating vulnerability exchange rates from field data.  None of these has been fully satisfactory, at least partly because arena structures in the field are spatially and temporally complex; indeed, one reason to call the foraging arena arguments a “theory” is that arena structures are “theoretical entities” that are practically difficult or impossible to directly observe[22].
 Three main methods have been used to provide estimates of apparent v’s using field data, and a fourth is under development.
 	Direct assessment of exchange rates for spatially simple arena structures
 	Empirical relationships between prey mortality rates and predator abundances
 	Fitting ecosystem models to time series data
 	Using complex individual-based spatial models
 
 See the source[23] for details about these.
 The main modeling argument for assuming mass action in predictions of predator-prey and food web interaction effects has never been that such a simplistic assumption is warranted based on field data; rather, the use of such models can be justified mainly because of analytical and computational tractability, i.e., the notion that robust and general predictions cannot be easily derived for more realistic models.  The models of foraging arena theory, and associated software like EwE-Ecosim for examining dynamic scenarios, largely eliminate such excuses.  We assert that the issue now for ecosystem modeling is not whether to bother including vulnerability exchange effects in trophic interaction predictions (it is plainly unwise to ignore them), but rather how to estimate exchange rates and their impacts.
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	Ahrens et al. 2012. op. cit. ↵
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		A primer on dynamic modelling

								

	
				Dynamic modelling is about prediction over time, for which there are two approaches,
 	Trend projections from past observations
 	Prediction based on “rules for change” (how variables interact)
 
 The dynamic modelling in EwE is based on rules for change of two types,
 	Tautologies that organize components of change, e.g., Next population = population new + births – deaths
 	Functional relationships that propose testable hypotheses about how the components vary, e.g., Births = constant x population size.
 
 The rules for change include two types of parameters,
 	“State variables” that change over time, e.g, Nt the number in a population at time t.
 	“Parameters” that are assumed constant over time, e.g., a birth rate.
 
 There are two basic ways to represent rules for change,
 	Difference equations, e.g., [image: N_{t+1} = N_t + bN_t - mN_t \tag{1}]where b = birth rate and m = death rate
 	Differential equations, e.g., [image: dN/dt = bN_t - mN_t \tag{2}]
 
 For complex continuous time models, such differential equations can be solved by simple numerical stepping approximations. For small time steps, we may use the one-step “Euler” method,
 [image: N_{t+dt}=N_t + X \cdot dt \tag{3}]
 where X = dN/dt at time t. The Euler method thus predicts change using only the rate at time t.  It can give very poor results for rate equations where there are strong positive feedbacks, i.e. when X can increase rapidly as N increases.
 For implementing dynamic model calculations in spreadsheets, it is better though to use the more precise, two-step “Adams-Bashforth” method,
 [image: N_{t+dt}=N_t+ [3X-Y]/2 \cdot dt \tag{4}]
 where X is as in Eq. 3 and Y = dN/dt for the previous time step, time t-dt.  The Adams-Bashforth is used for the tutorial on predator-prey models (included in the web and pdf-versions of this book).
 For numerical integration in computer languages like R and VB.Net, it is better though to use 4th order Runge-Kutta integration, especially if the model includes state variables that change at very different rates (both “fast” and “slow” dynamic change).  The dynamic rate equations in the EwE software are solved using this more accurate integration method, which approximates the curve between two points by at 4th degree polynomial.
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		An introduction to Ecosim

								

	
				Ecosim provides a dynamic simulation capability at the ecosystem level, with key initial parameters inherited from the base Ecopath model.
 The key computational aspects are in summary form,
 	Use of mass-balance results (from Ecopath) for parameter estimation;
 	Variable speed splitting enables efficient modelling of the dynamics of both “fast” (e.g., phytoplankton) and “slow” groups (e.g., whales);
 	Effects of micro-scale behaviours on macro-scale rates: top-down vs. bottom-up control incorporated explicitly.
 	Includes biomass and size structure dynamics for key ecosystem groups, using a mix of differential and difference equations. As part of this EwE incorporates:
 	Multi-stanza life stage structure by monthly cohorts, density- and risk-dependent growth – described in the Age-structured dynamics chapter;
 	Stock-recruitment relationship as “emergent” property of competition/predation interactions of juveniles.
 
 Ecosim uses a system of differential equations that expresses biomass flux rates among pools as a function of time varying biomass and harvest rates, (for equations see Walters et al., 1997[1]; Walters et al., 2000[2]; Christensen and Walters, 2004[3]). Predator prey interactions are moderated by prey behaviour to limit exposure to predation, such that biomass flux patterns can show either bottom-up or top down (trophic cascade) control. By doing repeated simulations, Ecosim allows for the fitting of predicted biomasses to time series data.
 The simplest, default version of Ecosim represents biomass dynamics using a series of coupled differential equations. The equations are of the basic form:
 [image: \frac{dB_i}{dt}=g_i\sum\limits_{j=1}^{n}Q_{ij}-\sum\limits_{j=1}^{n}Q_{ji}+I_i-(F_i+e_i+M0_i) B_i\tag{1}]
 where dBi/dt represents the growth rate during the time interval dt of group i in terms of its biomass, Bi, gi is the net growth efficiency (production/consumption ratio), M0i the non-predation (“other”) natural mortality rate, Fi is fishing mortality rate, ei is emigration rate, Ii is immigration rate, (and ei·Bi-Ii is the net migration rate). The two summations estimate consumption rates, the first expressing the total consumption by group i, and the second the predation by all predators j on the prey group.
 Ecopath is used to provide the initial (t=0) biomasses, and some of the rate parameters (like MO).  Ecosim parameters for the flow or consumption rates Qij are set partly from Ecopath base estimates of those flows, with addition information needed to represent how the flow rates vary with biomasses and other circumstances.
 The consumption rates, Qji and Qij, represent consumption by group j on i and by i on j, respectively, and are calculated based on foraging arena theory, where Bi’s are divided into vulnerable and invulnerable components[4], and it is the transfer rate (vij) between these two components that determines if control is top-down (i.e., Lotka-Volterra), bottom-up (i.e., donor-driven), or of an intermediate type. See the vulnerability multiplier chapter.
 The set of differential equations is solved in Ecosim using a 4th order Runge-Kutta routine (see the A primer on dynamic modelling chapter).  For groups like phytoplankton and small zooplankton that turn over (have P/B) greater than 10 and are likely to exhibit boom-bust dynamics on time scales shorter than one month, the numerical integration prediction is replaced with a prediction based on the equilibrium of the Ecosim rate equation of the likely average over the month.
 Attribution This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
	Walters, C., V. Christensen and D. Pauly. 1997. Structuring dynamic models of exploited ecosystems from trophic mass-balance assessments. Reviews in Fish Biology and Fisheries 7:139-172. ↵
	Walters, C.J., J.F. Kitchell, V. Christensen and D. Pauly. 2000. Representing density dependent consequences of life history strategies in aquatic ecosystems: Ecosim II. Ecosystems 3: 70-83. ↵
	Christensen, V. and C. J. Walters. 2004. Ecopath with Ecosim: methods, capabilities and limitations. Ecol. Model. 172:109-139 ↵
	Figure 1 in Walters, C., V. Christensen and D. Pauly. 1997. Structuring dynamic models of exploited ecosystems from trophic mass-balance assessments. Reviews in Fish Biology and Fisheries 7:139-172. https://doi.org/10.1023/A:1018479526149 ↵
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		Predicting consumption

								

	
				This is what Ecosim (and all other dynamic ecosystem models) really is about. If the number of consumers change over time, how much do they eat? How does consumption change with population density?
 All ecosystem models predict consumption (Qij) changes based on a variant of Lotka-Volterra dynamics (see chapter), including Ecosim which uses simple Lotka-Volterra or “mass action” assumptions for prediction of consumption rates. But importantly, the assumption is modified to consider “foraging arena” properties so that the flow rates depend on abundance of vulnerable prey rather than total prey abundance. In the foraging arena model structure, prey can be in states that are or are not vulnerable to predation, for instance by hiding, (e.g., in crevices in reefs, inside a school, where predators don’t go) when not feeding, and only being subject to predation when having left their shelter to feed. (see chapter).
 In the original Ecosim formulations[1]  [2]) the foraging arena consumption rate for a given predator i feeding on a prey j was predicted as,
 [image: Q_{ij}=\frac{a_{ij} \ v_{ij} \ B_i \ B_j}{2v_{ij}+a_{ij} \ B_j}\tag{1}]
 where, aij is the effective search rate for predator j feeding on a prey i, vij base vulnerability expressing the rate with which prey move between being vulnerable and not vulnerable, Bi prey biomass, and Bj predator abundance (for multi-stanza groups, Bj in this calculation is replaced by an estimate of the area swept by organisms of varying sizes, summed over ages within each stanza).
 For discussion about the relationship between top-down vs bottom-up and carrying capacity, see the Density dependence chapter.
 
 The model as implemented implies that “top-down vs. bottom-up” control is in fact a continuum, where low v’s implies bottom-up and high v’s top-down control.
 Experience with Ecosim has led to a more elaborate expression to describe how consumption may vary with a variety of factors:
 [image: Q_{ij}=\frac{v_{ij} \ a_{ij} \ B_i \ B_j \ T_i \ T_j \ S_{ij} M_{ij}/D_j }{v_{ij}+v_{ij} \ T_i \ M_{ij}+a_{ij} \ M_{ij} \ B_j \ S_{ij} \ T_j/D_j/A} \cdot f(Env_t)\tag{2}]
 where, Ti represents prey relative feeding time, Tj predator relative feeding time, Sij user-defined seasonal or long term forcing effects, Mij mediation forcing effects, A is foraging arena size, f(Envt) is an environmental response function that impacting the size of the foraging arena to account for external drivers, which may change over time[3], and Dj represents effects of handling time as a limit to consumption rate (1/Dj is proportion of time spent feeding):
 [image: D_j={1+h_j\sum_k a_{kj} V_k T_k M_{kj}}\tag{3}]
 where hj is the predator handling time and Vk is the vulnerable density of prey type k to predator j (Vk is estimated numerically in the Ecosim code).
 For multi-stanza groups, Bi is replaced by a sum over ages of numbers at age times body weights to the ⅔ power.
 
 The food consumption prediction relationship in the second equation above contains two parameters that directly influence the time spent feeding and the predation risk that feeding may entail: aij and v’ij. To model possible linked changes in these parameters with changes in food availability over time (t) as measured by per biomass food intake rate ci,t = Qi,t / Bi,t we need to specify how changes in ci,t will influence at least relative time spent foraging.
 Denoting the relative time spent foraging as Ti,t, measured such that the rate of effective search during any model time step t can be predicted as aji,t = Ti,t aij for each prey type i that j eats, we may (optionally) assume that time spent vulnerable to predation, as measured by v’ij for all predators j on i, is inversely related to Ti,t, i.e., v’ij,t = v’ij / Ti,t. An alternative structure that gives similar results is to leave the aij constant, while varying the vij by setting vij,t = Tj,t · vij in the numerator of Eq. 2 and vij,t = Ti,t · vij in the denominator.
 For convenience in estimating the aij and v’ij parameters, we scale Ti,t so that Ti,0 = 1, and v’ij= vij. Using these scaling conventions, the key issue then becomes how to functionally relate Ti,t to food intake rate ci,t so as to represent the hypothesis that animals with lots of food available will simply spend less time foraging, rather than increase food intake rates.
 In Ecosim, a simple functional form for Ti,t is implemented that will result in near constant feeding rates, but changing time at risk to predation, in situations where rate of effective search aij is the main factor limiting food consumption rather than prey behaviour as measured by vji. This is implemented in form of the relationship,
 [image: T_{i,t}=T_{i,t-1 }(1-α+α\frac{Q_{opt,i,t}}{Q_{i,t-1}}) \tag{5}]
 where, ⍺ is a feeding time adjustment rate [0, 1]and Qopt is the Ecopath base consumption rate per biomass (QB) for group j .  This calculation is subject to a user-defined maximum relative foraging time for each predator, and the result of that upper limit is for the predator functional response to be approximately the Holling Type I (rectilinear, see Holling functional response chapter) form with steepness proportional to the maximum relative foraging time.
 [image: Composite plot showing foraging time and consumption/biomass (Q/B) ratio as a function of biomass for a predator. To hold Q/B constant, a predator has to increase foraging time linearly. If foraging time is held constant, then Q/B decreases with increased predator abundance.]
 The relationship between foraging time, consumption and predator biomass (when adjustment rate a is assumed nonzero) is illustrated in Figure 1.
 Figure 1. Relationship between relative foraging time (T), Q/B and predator biomass. If Q/B is held constant the foraging time (and hence predation risk) is a linear function of the predator biomass (solid line). If T is held constant the Q/B will decrease asymptotically with predator biomass (stippled line). The predation risk is assumed proportional to the relative foraging time.
 Attribution: This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 Media Attributions
	Figure 1 from the 2008 EwE User Guide 



	Walters, C., V. Christensen and D. Pauly. 1997. Structuring dynamic models of exploited ecosystems from trophic mass-balance assessments. Reviews in Fish Biology and Fisheries 7:139-172. ↵
	Walters, C.J., J.F. Kitchell, V. Christensen and D. Pauly. 2000. Representing density dependent consequences of life history strategies in aquatic ecosystems: Ecosim II. Ecosystems 3: 70-83. ↵
	Christensen, V, M Coll, J Steenbeek, J Buszowski, D Chagaris, and CJ Walters. 2014. Representing variable habitat quality in a spatial food web model. Ecosystems 17(8): 1397-1412. http://www.jstor.org/stable/43678116 ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Food chain model

								

	
				Studies have indicated that fishing pressure on piscivores can have surprisingly small impact on prey planktivores.
 Construct a simple ecosystem model as a simplified version of the Anchovy Bay model to study this closer. The model can be a straight food chain, e.g., with the following functional groups and parameters.
 [image: ]
 Create a new model Menu > File > New model and name it (e.g., “Food chain”). The model will be saved as a database with .ewemdb extension. Go to Ecopath > Input > Basic input > Define groups and click Insert four times. In the Group name column, enter the first four group names from the table below. (Detritus will already be there).  Make Phytoplankton a Producer.  [While here, change the default colours to Random]. Click OK.
 Enter the following parameters on the Ecopath > Input > Basic input form, (cut/paste works from Excel to EwE, but probably not from the table below)
 	Group 	Biomass (t km-2) 	P/B (year-1) 	P/Q 
 	Mackerel 	0.5 	0.5 	0.2 
 	Anchovy 	2 	1 	0.25 
 	Zooplankton 	2 	10 	0.3 
 	Phytoplankton 	5 	100 	 
 	Detritus 	10 	 	 
  
 Diets: A straight chain as in the figure. Enter them at the Ecopath > Input > Diet composition form. 
 
 Fisheries: there’s already a fleet defined by default, so go to Ecopath > Fishery > Landings, and enter a landing of 0.1 t · km-2 · year-1 of mackerel.  [Yes, we give units, units are important and best left explicit!]
 Balance the model (Ecopath > Output > Basic estimates) and examine the outputs. Make sure the model is balanced! If not (check your input data), balance it!
 Open a new scenario in Ecosim by going to Ecosim > Output > Run Ecosim, and name it, (e.g, “Scene 1”). Click Run. What do you see? Why is it flatlining?
 The two principal ways of forcing Ecosim are through fishing effort (by fishing fleet) or through fishing mortality (by functional group).
 In this tutorial, we change fishing pressure over time. Internally, Ecosim read the fishing pressure from the effort time plot. It knows the Ecopath baseline fishing mortality = catch / biomass  – with symbols and units, F (year-1) = C (t km-2 year-1) / B (t km-2). When effort changes, Ecosim changes fishing mortality (F) proportionally for all the groups that are caught by the given fleet.
 First try to increase fishing for mackerel over time by doubling fishing effort for the fleet catching mackerel by drawing an increasing shape at Ecosim > Input > Fishing Effort. Run Ecosim again, what happens now. Who increases, who doesn’t, why? Discuss cascading effects, does it occur, and how does it propagate through the food chain?
 You can see the results in more detail if you go to Ecosim > Output > Ecosim results, and click Group, landed by. Here you can see how much the biomasses of mackerel and anchovy changed over time (by default it compares the first year of a run with the last year, though you can change that to get results for any time period). Does the increased catch of mackerel cause amplification or dampening through the food web?
 
 To easily compare different runs, you can click Show multiple runs on the Ecosim > Output > Run Ecosim form.  Also note that you have different options for what to display on this form (though the standard is what is most often used).
 You can study the results in more details if you go to Ecosim > Output > Group plots. These plots are very informative, showing time dynamics of what happens with fishing, predators and prey for each group.
 If you have a lot (maybe 13) of small plots when you open the Ecosim > Output > Group plots form, click the Show plots form and un-check the plots from Total discards on. You’ll then have nine plots in a 3 x 3 matrix.
 Ecosim predictions are especially sensitive to vulnerability multiplier settings (Ecosim > Input > Vulnerabilities). Vulnerability multipliers are the key foraging arena parameter, they capture density-dependent effects.  Think of it like this, the vulnerability multiplier expresses how many times a given predator can increase the predation mortality it is causing on its prey, if the predator abundance were to increase to its carrying capacity. A vulnerability multiplier of 1 thus tells us that the predator is at its carrying capacity – and hence can increase no more unless its prey becomes more abundant. That means “bottom-up” control. Conversely, high vulnerability multipliers (e.g., 100) tell us that the predator is far from carrying capacity  – that’s “top-down” control.
 With the default vulnerability of 2, a predator can at most double the predation mortality it’s causing on its prey.
 Go to the Ecosim > Input > Vulnerabilities form, and set the vulnerability multiplier for mackerel eating anchovy to 5, run the model again, what happens. Reset the vulnerability to 2.
 Try setting the vulnerability multiplier for anchovy eating zooplankton to 5. Run again. What happens now? Does anchovy behave much differently from when using the default vulnerability multiplier?
 Finally, try setting the vulnerability multipliers for all three interactions to 100. Run again. This setting turns the model into a Lotka-Volterra model, which tends to be unstable and produce cycles.  Lotka-Volterra models also tend to self-simplify where groups die out. Did that happen in your model?
 Reset your model to default vulnerabilities (2).
 As you can tell from the above, the vulnerability multipliers are important, and we will return to that later when discussing the foraging arena and time series fitting, which indeed has vulnerability multipliers and density-dependence as key factors.
 Now let’s try fishing some anchovy; do the following
 	Go to Ecopath > Input > Fishery > Fleets, Define fleets and add a second fleet, name it, e.g., gill netters.
 	Give the fleet a landing (Ecopath > Input > Fishery > Landings) of 0.4 t km-2 year-1 of anchovy.
 	On Ecosim > Input > Fishing effort, click Reset All
 	Run Ecosim. It should flatline.
 	Go back to Ecosim > Input > Fishing effort, and double the fishing effort for your new fleet
 
 Run Ecosim again, what happens?
 Examine the group plot (Ecosim > Output > Ecosim group plots for anchovy, and note how the anchovy catch of the second fleet doubled along with the fishing mortality for the anchovy. Then check the Mortality: total, fishing, predation plot. Here, from the baseline to the red line represents predation mortality, from the red to the blue line is fishing mortality, and from the blue to the black line is total mortality. What happened to predation mortality when fishing increased?
 Feeding time – variable or fixed?
  Fish tend to have diurnal patterns, often to reduce predation risk while still being able to feed. If you dive at a reef around dusk, you may see a flurry of activities, finely tuned to eat while not being eaten. This may be of less concern for top predators and marine birds who more likely will spend more time feeding when food abundance is low. We can consider this in Ecosim (and Ecospace) with the relative feeding time parameter at Ecosim > Input > Group info > Feeding time adjust. rate. The default setting for this parameter is 0.5 (range [0,1]), which will allow a predator to change feeding time as needed.
 Check that your model flatlines. The go to Ecosim > Input > Fishing effort, click on the first fleet at the bottom panel, then click Set to value and enter 1.1 to increase fishing effort for the fleet catching anchovy with 10%. Run Ecosim. What happens?  Is the model stable?
 Next, remove feeding time adjustment, go to Ecosim > Input > Group info > Feeding time adjust. rate and set this parameter to 0 for all groups. Run Ecosim again, what happens now?
 
 
 The general advice for feeding time adjustment rate  is to turn it off for all groups apart from marine mammals, birds, top predators and very young stanzas. When using foraging time adjustment, the max. relative feeding time may have to be set to more than the default of 2.
 
 Stable state?
  Reset the fishing mortality and any other parameters you may have changed in your model. Do an Ecosim run and check that it flatlines.
 
 Go back to Ecopath > Input > Other production and set the biomass accumulation rate to -0.1 for mackerel. Go back to Ecosim, and run it again, (you’ll be asked if you want to save your Ecopath model, just do that).
 The negative biomass accumulation term tells Ecosim that the fishing mortality on mackerel at the Ecopath baseline wasn’t sustainable. (You can zoom in on the Ecosim > Output > Run Ecosim plot to see the details for the first 15 years or so better). Notice the initial decline in mackerel, and the simple but clear cascading impacts through the food chain.
 Notice the initial cycling that occurs, and that the system after some years stabilizes to a new equilibrium that is different from the original. Which groups decreased, which increased?
 Does this make sense?
 A lesson is that if the baseline Ecopath model has a biomass accumulation term, the system is not in stable state and we may expect a new stable state to emerge
 
 
 In the more diverse food web of Anchovy Bay, the biomass accumulation term caused seals to decrease asymptotically and whales to increase asymptotically.
 
 Paradox of enrichment
  The term paradox of enrichment was coined and developed by Michael Rosenzweig in the early 1970s, and is used to describe how an increase in system productivity may cause a system to become unstable. In a simple system, it can be that food supply make a species like rabbit overabundant causing its population to increase, followed by an increase in its predator, e.g, lynx. The predator population may then overshoot, causing the prey to crash, and it can potentially lead to local extinctions.  The term is called a paradox as seems unreal that an increase in primary productivity should have such drastic effects.
 But standard Lotka-Volterra models indeed behave like that. The foraging arena theory provides us with an explanation why this paradox is not a reflection of reality.
 We can explore this with the model we just built.  Open your model, make an Ecosim run and check that the model flatlines and that the vulnerabilities are at default (2). Download a time series file (PP paradox.csv) from this link. Go to Ecosim > Input > Time series > Import and browse to import the PP paradox.csv file. This will import a forcing function with relative primary production values. Go to Ecosim > Input > Forcing functions > Apply forcing (producer) and click the box by the phytoplankton group. On the pop-up form, click 1: PP and the arrow pointing right to apply the forcing function. This will link the primary production anomaly from the time series file with the phytoplankton group, and force its productivity over time.
 Now go back and run Ecosim. Is it system stable? What does the enrichment do through the food web? Dampening or amplification?
 Next, change the vulnerability multipliers (Ecosim > Input > Vulnerabilities) for all groups to 10 (more top-down control, further from carrying capacity). Run Ecosim again. What happens?
 Next set the vulnerability multiplier for zooplankton to phytoplankton to 1. Run and study
 Then, also set planktivores to zooplankton multiplier to 1. What happens?
 You now probably have a stable system with some amplification through the food web, but stable! In this configuration, the lower trophic levels were at carrying capacity when the model run started (but mackerel were further from their carrying capacity). The primary production anomaly (+10%) we read in increased the productivity at the lower to intermediate trophic levels (+20%) while mackerel, which were further from their carrying capacity (multiplier of 10) increased even more (28%).
 
 
 
 You can download the Ecopath model for this tutorial from this link.
 Quiz
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/ewemodel/?p=2249#h5p-3 
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		Age-structured dynamics

								

	
				The default approach in EwE is to model functional groups as biomass pools that in Ecosim have very simple dynamics. For such, Ecosim – as described in previous chapters – solves a set of differential equations for biomass rate of change of the form,
 [image: dB_i / dt = eQ_i(t) - Z_i(t) \ B_i \tag{1}]
 This simple representation does not allow for modelling species with complex trophic ontogeny or size-age dependent fishery impacts. Such groups can, however, be designated age-structured life-history stanzas within single-species populations. In such cases, the Ecosim differential equation solution for biomass change (Eq. 1) is replaced by a monthly-difference equation system, with full monthly age-structured accounting for population age and size structure.
 With this approach, Ecosim can be used to simulate monthly changes in numbers and relative body weights of monthly age cohorts of species with complex trophic and fisheries impact ontogeny. For this, the start is to split any species into an arbitrary number of age (in months) “stanzas” as described earlier in the multi-stanza life history chapter. For such groups, prey preferences and vulnerability to predators (and fisheries) is then treated as constant over the months of age included within each stanza. Stanza age breaks can represent both ontogenetic shifts in habitat and diet and changes in vulnerability to bycatch and retention fisheries.
 Ecosim differential equation representation for biomass change is replaced by a monthly-difference equation system, with full age-structured accounting for population age and size structure at monthly age increments. The basic accounting relationships are
 [image: N_{a+1,t+1}=N_{a,t} \exp(-Z_{s,t}/12) \tag{4}]
 [image: W_{a+1,t+1}=\alpha_a q_{a,t}+ \rho W_{a,t} \tag{5}]
 [image: B_{s,t}=\sum\limits_{a=a1(s)}^{a2(s)} N_{a,t}W_{a,t} \tag{6}]
 Where, Na,t is the number of age a (in months) animals in calendar month t, Wa,t is the mean body weight of age a animals in month t, and Bs,t is the biomass of stanza s, defined as the mass (numbers × weight) of animals aged a1(s) through a2(s) months. Zs,t is the total mortality rate of stanza s animals, defined the same way on the basis of fishing and consumption as for other model biomass groups i as Zs,t = Mos + ΣfFsf + ΣjQsj/Bs. All animals in stanza s are treated as having the same predation risk and vulnerability to fishing. The aggregated bioenergetics parameters aa and r are calculated to make body growth follow a von Bertalanffy growth curve (with length-weight power 3.0) with user-defined metabolic parameter K. Exact von Bertalanffy growth occurs when predicted per-capita food intake qa,t is equal to a base food intake rate that is calculated from the consumption per biomass parameter (Qs/Bs) provided by the user for each stanza. The metabolic parameter r, which equals exp(–3K/12), is based on the assumption that metabolism is proportional to body weight[1]. Actual or realized food intake qs,t at each time step is calculated from the total predicted food-intake rate for the stanza (Qs,t) as qs,t = Qs,twa,t2/3/Ps,t, where Ps,t is the relative total area searched for food by stanza s animals and is computed as Ps,t = ΣaNa,twa,t2/3. For foraging-arena food-intake and predation-rate calculations involving stanzas, Ps,t is used instead of Bs as the predictor of total area or volume searched for food per unit time. The assumption that area searched and food intake vary as the ⅔ power of weight (i.e., as the square of body length) is a basic assumption that also underlies the derivation of the von Bertalanffy growth function.
 For notational simplicity, Eqs. 4–6 above are presented without a species index. Typical Ecosim models developed to date have included multistanza accounting for 2–10 species, each divided into 2–5 stanzas that capture basic ontogenetic changes in diet, predation risk, and vulnerability to fishing. The first age for stanza 1 is always set to a1(1) = 0 (hatching), and a2(1) is often set to 3–6 months of age to represent the larval and early juvenile periods separately. Then a2(2) is often set at 12–24 months (to represent older juveniles), and additional stanza breaks are set at key ages like maturity and first vulnerability to fishing.
 Initial numbers entering the first stanza for multistanza species s each month are assumed to be proportional to total egg production, and egg production is assumed to be proportional to body weight minus a weight at maturity Ws,mat. That is,
 [image: N_{1,t}= k_s \ \sum\limits_{a}N_{a,t}[W_{a,t}-W_{s,mat}] \tag{7}]
 The effective fecundity parameter, ks is calculated from initial numbers, N1,0, and these initial numbers are calculated in turn from Ecopath input values of biomass for one “leading” stanza for each species s, along with initial survivorships to age calculated from initial Ecopath input values of Za,0. For these calculations, relative body weights, Wa,0, are set initially to the von Bertalanffy prediction, and weight is assumed to vary as the cube of length, as Wa,0 = (1 – e–Ksa)3.
 Egg production is allowed to vary seasonally or over long-term through an input forcing function. If an egg production curve is defined, the egg production term is multiplied according to the forcing function. Note that this age-0 recruitment formulation for newly entering animals proportional to egg production does not explicitly account for density dependence in early mortality rates (i.e., an explicit stock-recruitment function is not used). Density-dependent effects occur through (1) impacts of animal density on food consumption, growth, and fecundity (a time-lagged effect that can result in violent population cycles) and, more importantly and commonly, (2) density dependence in Zs,t caused by foraging-time adjustments in the Ecosim foraging-arena model for Qs,t. Foraging-time adjustments typically result in emergent stock-recruitment relationships of Beverton-Holt form.[2] [3]
 The Ecosim multistanza model has been fitted to many time series of population abundances that were reconstructed from single-species age-structure data by methods like VPA[4] and stock-reduction analysis[5]. Species fitted range from tunas to groupers to small pelagics like menhaden. For large, relatively long-lived species (piscivores, benthivores), behavior of the multistanza population model is typically indistinguishable from those of other age-structured models commonly used for stock assessment. For small-bodied species subject to high and temporally varying predation-mortality rates (e.g., small tunas, herrings, menhaden), Ecosim can sometimes capture effects such as relative stability of Z as F increases (decreases in M with increasing F) that are typically missed by singlespecies models that assume stable natural mortality rate M[6].
 On entry to Ecosim from Ecopath, the stanza age-size distribution information (la, Wa) is passed along and is used to initialize a fully size-age structured simulation for the multi-stanza populations. That is, for each monthly time step in Ecosim, numbers at monthly ages Na,t and body weights Wa,t are updated for ages up to the 90% maximum body weight age (older, slow growing animals are accounted in an “accumulator” age group). The body growth Wa,t calculations (Eq 5) are parameterized so as to follow von Bertalanffy growth curves[7], with growth rates dependent on body size and (size- and time-varying) food consumption rates.
 Because a biomass-age pattern (and food consumption–age pattern proportional to w⅔) like that in Figure 1 must be satisfied once stanza-specific base Z’s have been specified for every stanza, initial biomass Bi0 and food consumption per biomass, Qi0/Bi0, can only be entered for one stanza (biomass pool i) for each multi-stanza species s. Then B and Q/B are calculated for the other stanzas from the relative (per recruit) biomass and food consumption rates summed over ages in those stanzas.
 At this point, the Ecosim age structured dynamics behave pretty much the same as standard age-structured models for single species assessments, but with the important exception that such models typically include an explicit stock-recruitment relationship.  Instead of using such a relationship, Ecosim generates an “emergent” compensatory relationship through assumptions related to the foraging arena equations; see the following Recruitment and compensation chapter for details.
 [image: ]
  
 Figure 1. Typical changes in individual biomass and population numbers and biomass with age for a multi-stanza population in Ecosim. In this example, von Bertalanffy K = 0.4 year–1, and the three stanzas marked by the outer vertical lines have the following total mortality rates, Z: 1.2 year–1 for age 0–5 months, 0.8 year–1 for age 6–47 months, and 6.0 year–1 for ages 48+ months (moribund salmon). The dotted vertical line indicates age-at-maturity, which can be overruled by setting a spawning/not-spawning variable for each stanza. 
 Attribution The chapter is in part adapted from Walters et al. 2008[8] and 2010[9] both in the Bulletin of Marine Science, which permits authors to use figures, tables, and brief excerpts in scientific and educational works provided that the source is acknowledged and the use is non-commercial.
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		Recruitment and compensation

								

	
				Compensatory mechanisms
 Sustaining fisheries yield when fishing reduces stock size depends on the existence of compensatory improvements in per capita recruitment, growth, and/or natural mortality rates. Ecosim allows users to represent a variety of specific hypotheses about compensatory mechanisms. Broadly, these mechanisms fall in two categories:
 	direct – changes caused over short time scales (order one year) by changes in behaviour of organisms, whether or not there is an ecosystem-scale change due to fishing; and
 	indirect – changes over longer time scales due to ecosystem-scale responses such as increased prey densities and/or reduced predator densities. Usually we find the direct effects to be most important in explaining historical response data. In the next three sections we describe how to generate alternative models or hypotheses about direct compensatory responses; these hypotheses fall in three obvious categories: recruitment, growth and natural mortality.
 
 Using Ecosim to study compensation in recruitment relationships
 The multi-stanza representation of juvenile and adult biomasses was originally included in Ecosim to allow representation of trophic ontogeny (big differences in diet between juveniles and adults). To implement this representation, we found that it was necessary to include population numbers and age structure, at least for juveniles, so as to prevent “impossible” dynamics such as elimination of juvenile biomass by competition/predation or fishing without attendant impact on adult abundance (graduation from juvenile to adult pools cannot be well represented just as a biomass “flow”).
 When we elected to include age-structured dynamics, we in effect created a requirement to think carefully about the dynamics of compensatory processes that have traditionally been studied in terms of the “stock-recruitment” concept and relationships. To credibly describe the dynamics of multi-stanza populations, Ecosim parameters for multi-stanza juvenile stages usually need to be set so as to produce an ’emergent” stock- recruitment relationship that is at least qualitatively similar to the many, many relationships for which we now have empirical data (see the RAM Legacy Stock Assessment Database). In most cases, these relationships are “flat” over a wide range of spawning stock size, implying there must generally be strong compensatory increase in juvenile survival rate as spawning stock declines (otherwise less eggs would mean less recruits on average, no matter how variable the survival rate might be).
 When creating multi-stanza dynamics, be careful in setting model parameters that define/create compensatory effects. This begins with the Ecopath input parameters; in order for the juvenile dynamics to display compensatory mortality changes, at least two conditions are needed or helpful:
 	the juvenile group(s) must have relatively high P/B, i.e. high total mortality rate (see Multi-stanza life history chapter);
 	the juvenile group(s) must have either relatively high EE (so that most mortality is accounted for as predation effects within the model) or else the user must specify a high (near 1.0) value in the Ecosim > Input > Group info form entry for the juvenile group’s Proportion of other mortality sensitive to changes in feeding time column.
 
 Compensatory effects can be increased (the recruitment relationship is flat over a wider range of adult stock sizes, with a steeper slope of recruitment curve near the origin) by:
 	Limiting the availability of prey to juveniles (forcing juveniles to use small foraging arenas for feeding) by setting all elements of the Ecosim vulnerability multiplier form column for the juveniles to a low value (1.1-2.0); or
 	Setting a higher value for the juvenile group’s Feeding time adjustment rate parameter  (Ecosim > Input > Group info form), which causes the effective time exposed to predation while feeding to drop directly with decreasing juvenile abundance (i.e., simulates the possibility that when juveniles are less abundant, remaining ones may be able to forage “safely” only in refuge sites without exposing themselves to predation risk). This option should preferably be used if you are fairly sure from field natural history observation that the juveniles do in fact restrict their distribution to safe habitats when at very low abundance.
 
 It is especially important to test alternative values for the vulnerability of prey to juveniles. If the vulnerability multiplier is too high, the Ecosim emergent stock-recruitment relationship is likely to look almost like a straight line out of the origin, i.e. without compensatory effect. If the vulnerability multiplier is too low, the relationship may develop a “spurious” dome-shape.
 In Ecosim multi-stanza groups, the group that is displayed on the Ecosim > Output > Stock recruitment plot (S/R) is always the oldest stanza. The stock-recruitment relationship between this stage and each of the younger stages separately is calculated and displayed on the S/R form.  This may cause issues when the oldest group is a “senescent” group as is often done for modelling Pacific salmon, (which die after spawning).
 Compensatory growth
 Compensatory growth rate responses are modelled by setting the feeding time adjustment rate (Ecosim > Input > Group info form) to zero, so that simulated Q/B is allowed to vary with the group biomass (non-zero feeding time adjustment results in simulated organisms trying to maintain Ecopath base Q/B by varying relative feeding time). Net production is assumed proportional (growth efficiency) to Q/B, whether or not this production is due to recruitment or growth. The Q/B increase with decreasing pool biomass is increased by decreasing vulnerability of prey to the pool (Ecosim > Input > Vulnerability multipliers form). In the extreme as vulnerability multipliers approaches unity (donor or bottom-up control indicative of a group being close to its carrying capacity), total food consumption rate Q approaches a constant (Ecopath base consumption), so Q/B becomes inversely proportional to B.
 Compensatory natural mortality
 Compensatory changes in natural mortality rate (M) can be simulated by combining two effects: non-zero Feeding time adjustment rate (set on Ecosim > Input > Group info form), and either high EE from Ecopath or high proportion of M0 due to predation (unexplained predation > 0). With these settings, especially when vulnerability multipliers of prey to a group are low, decreases in biomass lead to reduced feeding time, which leads to proportional reduction in natural mortality rate.
 Attribution This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
 
	

			
			


		
	
		
			
	
		

		Tutorial: Stock-recruitment

								

	
				Always check the stock-recruitment curve shape, and play with Group info and Stage parameters that may affect it, before proceeding to other policy analysis. The simplest way to check this shape while minimizing complicating and confounding effects of trophic interactions is to set up Ecosim for a fairly long time scenario (40+ yrs):
 	Go to the Run Ecosim form (Ecosim > Output > Run Ecosim), select Groups from the drop-down Target menu on and then the adult pool. Using the fishing rate sketch pad, set up a fishing rate time series pattern where fishing is first stopped for a decade or so then ramped up over the remaining years to a very high value relative to your baseline rate from Ecopath.
 	Open the S/R plot form, and select the same adult group (Ecosim > Output > S/R plot).
 	Then run a series of scenarios. If the stock “crashes” completely under heavy fishing, reshape the fishing rate to stop a few years after the crash, to check for a “multiple equilibrium” outcome: i.e., for some models, and especially for top predators, there may be “delayed depensation” effect where the predator fails to recover after heavy fishing, due to increases in species that it eats that are in turn competitors/predators on its juveniles—these species can cause “recruitment failure”.
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		Predator satiation and foraging time

								

	
				Predator satiation and handling time effects
 Ecosim and Ecospace allow you to represent two factors that may limit prey consumption rates per predator (Q/B):
 	foraging time adjustments related to predation risk and/or satiation; and
 	handling time effects.
 	Parameters for both are specified via the Ecosim Group info form.
 
 Satiation and/or choices to forage for short times in order to avoid higher predation risk are represented by setting non-zero values for the Ecosim > Input > Group info > Feeding time adjustment rate of a group: larger values of this rate represent more rapid adjustment of foraging time. Non-zero foraging time adjustment rates cause Ecosim/Ecospace to update relative foraging time during each simulation so as to represent predators as trying to maintain Q/B near the Ecopath input base rate. For some organisms (particularly marine mammals) this foraging time adjustment may represent animals always trying to feed to satiation (Q/B from Ecopath the satiation feeding rate) and taking more or less time to reach satiation depending on prey densities (and possibly also facing higher predation risk when foraging times are longer). For other organisms, the Ecopath base Q/B may represent a much lower feeding rate than the animal could achieve under “safe” laboratory conditions, and in this case we view the base Q/B as an evolutionary “target” rate representing results of natural selection for balancing benefits from feeding with predation risk costs of spending more time feeding.
 Handling time effects represent the notion that predators have limited time available for foraging and this time can be used up by “handling time” (pursuit/manipulation/ingestion time per prey captured) rather than searching for prey, when prey densities are high. The Ecosim > Input > Group info > QBmax/QB0 (for handling time) (>1) parameter allows you to set ratios of maximum to Ecopath base food consumption rates per individual (or per biomass). These ratios are set to large values (1000) by default, which allows predators to increase their feeding rates without limit as prey densities increase (i.e., not limited by time required to handle each prey). In most scenarios, limitation of prey vulnerability prevents this unreasonable assumption from having noticeable effect. But in scenarios where vulnerable prey densities of at least one type do increase greatly, setting a low value (e.g., 2 or 3) for the predator’s maximum/base feeding rate ratio allows you to represent limits on feeding rate associated with time needed to handle each prey. Without such limits, your predictions of increase in predator Q/B, and hence productivity, at low predator density (or high prey density) might be too optimistic and lead you to errors like overestimating sustainable harvest rate for the predator. Also, ignoring handling time effects when one prey type increases greatly can cause an underestimate of the ‘buffering’ effect that such increases can have on predation rates felt by other prey: if the predator consumes more of the abundant prey, and spends more time handling/resting because of this, predation rates on other prey species should decrease.
 Ecosim/Ecospace calculates feeding rates of predators using the “multispecies disc equation”, a generalization of Holling’s type II functional response model for multiple prey types (see the Holling functional response chapter). Using the maximum/base feeding rate ratio Rj from the Ecosim > Input > Group info form along with the Ecopath base food consumption rate per predator, the program calculates a maximum ration and effective handling time per prey biomass eaten (handling time = 1 / (maximum prey biomass eaten per time)). This handling time (Holling’s h parameter) is used to calculate the denominator in the disc equation formulation Qij/Bj , biomass of prey type i consumed per time per unit biomass of predator j, as Qij/Bj  = aij Vij / (1 + hj ∑k akj Vkj) where aij is the rate of effective search by predator j for type i prey, hj is the predator handling time parameter, Vij is the instantaneous density of prey type i vulnerable to predator j, and the sum in the denominator is over all prey types k taken by the predator. A useful fact about the multispecies disc equation is that Dj, the proportion of time spent feeding (reactive to prey rather than handling), is given by Dj=1/(1 + hj ∑k akj Vkj). For more information about how the disc equation Dj enters food consumption rate calculations along with other factors that influence feeding, see the Foraging arena chapter. The solution for vulnerable prey densities Vij needed in the disc equation calculation over time involves  a numerical procedure that can occasionally cause annoying “chatter” in the Ecosim results when handling times are large (ratio of maximum/base consumption rate small).
 A helpful fact about the Dj proportion of time spent feeding in the disc equation formulation is that it can be calculated simply from the user-provided ratio Rj of maximum to ecopath base ration, as just Dj=Rj/(Rj-1). This is used to initialize the Dj at the start of each Ecosim run.
 Bioenergetics models for fish most often indicate that feeding rates are low compared to maximum ration; typical ratios of estimated to maximum ration (Hewett-Johnson[1] P parameter) are around 0.3-0.4. These estimates imply Rj (maximum/Ecopath base ration) values of at least 2-4. If you choose to use such realistic values instead of the default 1000, and if this causes Ecosim/Ecospace to show oscillatory behaviour, you need to consider two possibilities:
 	The oscillatory behaviour may be a numerical artifact of the procedure used to update Dj; or
 	The model’s “correct” behaviour for the parameter combinations you have provided is indeed a predator-prey cycle.
 
 If the oscillation has a period of several time steps (months), it is very likely a predator-prey cycle. Persistent predator-prey cycles are commonly predicted by models that include handling time, along with strong top-down control (high vulnerability multipliers vij of prey to predators). If you think the cycle is unrealistic, you should adjust the prey vulnerabilities multipliers (Ecosim > Input > Vulnerabilities) to lower values (toward “bottom up”, prey vulnerability control) rather than just setting high Rj values. If you see very short cycles indicating numerical instability in the Dj adjustment procedure (usually happens for fast turnover groups like micro-zooplankton), you should set higher Rj values for the offending groups. This amounts to recognizing that Ecosim may be limited in its ability to represent very fast dynamic changes in groups that turn over very rapidly.
 
	Hewett SW and BL Johnson. 1992. Fish bioenergetics model 2. Univ. of Wisconsin Sea Grant Institute. https://repository.library.noaa.gov/view/noaa/35468 ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Results extractor

								

	
				If the Results extractor isn’t selectable when you try loading it: you need to run Ecosim before it can be selected.
 There is a Results Extractor plug-in in EwE developed by CEFAS, and you can use it to more easily extract results from Ecosim runs (compared to getting results from Ecosim > Output > Ecosim results). You’ll find it at Menu > Tools > Results extractor. The details of how the plug-in works are explained in the Results Extractor chapter of the EwE User Guide, here we’ll only show a simple example.
 Next open a version of EwE, e.g., the fitted version from this link (but any version will do).  Run Ecosim. Then load the Results Extractor (Menu > Tools > Results Extractor), and you should see the interface in Figure 1.
 [image: ]
 Figure 1. Results Extractor interface. You can decide where to Save Results by clicking the button so named, and browse to a folder of your preference. As soon as you have selected where to Save Results, Ecosim will run and save the requested. Rerunning Ecosim will save all files all options.
 From the interface, select the options that you would like to extract results for. A major advantage of the Results Extractor is that you can extract results for selected functional groups, predator-prey combinations or fleets as well as selected indicators (Figure 1). This is demonstrated in Figure 2, where only Anchovy has been selected – so results files will only store results for anchovy.
 [image: ]
 Figure 2. Change selection: Anchovy results will be selected.
 After you have selected what you want to save, Ecosim will run and save the selected (be careful not to run Ecosim again as this will result in all files/options being selected).
 Try it out.
 
 Media Attributions
	Menu > Tools > Results Extractor 
	Menu > Tools > Results Extractor > Change selection 
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		Holling functional response

								

	
				[image: ]
 Figure 1. Functional feeding responses as defined by CS Holling.
 The Ecosim equations for predicting consumption allow for classic predator-prey functional response types.
 	type I if foraging time adjustment is included,
 	type II if handling times limit per-capita food-consumption rates, and
 	type III if predator rates of search decrease when prey densities are low or prey spend less time foraging when their densities are low
 
 The foraging-arena equations in Ecosim depart from classical functional response predictions in calculating prey densities not as average total biomass in each cell but rather as effective biomass densities in the restricted arenas where foraging typically occurs and where such local densities can be strongly affected by densities of competing predators (ratio-dependence effect). Local depression of available prey biomass can occur whether or not predation affects overall grid-wide prey densities.
 Type III switching
 Predators are said to “switch” from one prey to another when predator diet proportion of each type changes more rapidly than the relative abundance of that type in the environment. Eating more of something when it becomes abundant does not imply switching, but rather just more frequent encounters with that type. The predator is said to switch if it takes disproportionately more of a prey type as that prey becomes more abundant.
 Three mechanisms that can lead to switching patterns in diet composition and prey mortality are represented in Ecosim:
 	Apparent switching away from prey that are declining in abundance, due to those prey seeing less intra-specific competition and hence spending less time at risk to predation; this effect occurs for any prey species (and impacts feeding on it by all of its predators) whenever Ecosim>Input>Group info>Feeding time adjust. rate is set >0.
 	Apparent switching in Ecospace, caused by fitness-sensitive movement; when Ecospace parameters are set to cause increased (and/or directional) movement from cells where “fitness” (per capita food intake minus instantaneous mortality rate) is lower, predators will appear (for the system as a whole) to switch to more abundant prey, and prey that are declining in abundance will see lower predation rates in the cells where they remain concentrated.
 	Explicit changes in Ecosim rates of effective search, representing fine-scale behavioural choices by predators to spend more or less foraging time in the arenas where specific prey is concentrated. In this case, the behavioural choice among arenas is predicted from Ideal Free Distribution (IFD) arguments that predators should allocate foraging time so as to minimize time needed to obtain normal food consumption rates.
 
 In the third of these approaches, the Ecosim rate of effective search aij for predator type j on prey type i is modified at each simulation time step in relation to changes in abundance of all prey types, using a “gravity model” approximation for the IFD allocation of predator foraging time among prey-specific foraging arenas. The equation used for this modification is
 [image: a_{ij}(t) = K_{ij}a_{ij}B_i(t)^{P_j} / \sum_{i’} a_{i’j} B_{i’}(t)^{P_j} \tag{1}]
 Here, aij is the base rate of effective search calculated from Ecopath and vulnerability exchange parameters, Kij is a scaling constant that makes the time-specific aij(t) equal aij when all prey biomasses Bi are at the Ecopath base values, and the “switching power parameter” Pj is a user-supplied (empirical, to be estimated from field data or model fitting) power parameter representing how strongly the predator responds to changes in prey availability (switching power parameter on the Group info form). In particular:
 	Pj = 0, no switching
 	Pj << 1, prey must become very rare before predator j stops searching for them
 	Pj >> 1, predator switches violently when any prey increases or decreases.
 
 Pj is limited to the range [0,2]. While it is derived by pretending that predators must allocate time among mutually exclusive foraging arenas for each of their prey types (a typically unrealistic assumption), it can still be used (with Pj <<1 values) to represent more general ideas about why and how predators switch among prey, e.g., formation and loss of search images for finding them.
 There is a tutorial about prey switching included in the Ecosim Group info tutorial (web and pdf versions only)
 
 Attribution The chapter is in part adapted from the unpublished 2008 EwE User Guide and from Walters et al. 2008, Bulletin of Marine Science[1] and 2010, which permits authors to use figures, tables, and brief excerpts in scientific and educational works provided that the source is acknowledged and the use is non-commercial.
 
  
  
 
	Walters, C, Martell, SJD, Christensen, V, and Mahmoudi, B. 2008. An Ecosim model for exploring ecosystem management options for the Gulf of Mexico: implications of including multistanza life history models for policy predictions. Bull. Mar. Sci. 83(1): 251-271 ↵
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		Dynamic instability and multiple stable states
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 Figure 1. Complex ontogenetic feeding relationship impacting predator-prey balance.  A predator may cultivate the environment for its juveniles by feeding on a prey that competes and perhaps prey on its own juveniles.  If the predator abundance is reduced, e.g., by fishing, the prey abundance may increase, potentially making it difficult for the predator to rebound. In models we often see alternate stable states occurring when a prey species feed on the young stages of its predators.   
  
 Dynamic instability in Ecosim and Ecospace
 We commonly see several types of dynamic instability following small perturbations in fishing mortality rates (to get away from initial Ecopath equilibrium):
 	Predator-prey cycles and related multi-trophic level patterns;
 	System simplification (loss of biomass pools due to competition/predation effects);
 
 	Stock-recruitment instabilities (cyclic or erratic changes in recruitment and stock size for split pool groups);
 	Numerical “chatter” in time solutions (mainly in Ecospace).
 
 Such patterns are not particularly common in fisheries time series, so unless you have data to support a cyclic prediction, it’s probably reasonable to adjust the model parameters to get rid of it.
 Predator-prey and simplification effects can usually be eliminated by reducing the predation vulnerability multipliers (Ecosim > Input > Vulnerability multipliers form, set values to 4 or less).
 We know of at least four common mechanisms that can decrease the vulnerability multipliers so as to create stabilizing and the appearance of “ratio-dependent” or “bottom-up” control of consumption rates:
 	Risk-sensitive prey behaviours: Prey may spend only a small proportion of their time in foraging arenas where they are subject to predation risk, otherwise taking refuge in schools, deep water, littoral refuge sites, etc.
 	Risk-sensitive predator behaviours (the “three to tango” argument): Especially if the predator is a small fish, it may severely restrict its own range relative to the range occupied by the prey, so that only a small proportion of the prey move or are mixed into the habitats used by it per unit time. In other words, its predators may drive it to behave in ways that make its own prey less vulnerable to it.
 	Size-dependent graduation effects: Typically a prey pool represents an aggregate of different prey sizes, and a predator can take only some limited range of sizes, limited vulnerability can represent a process of prey graduation into and out of the vulnerable size range due to growth. Size effects may of course be associated with distribution (predator-prey spatial overlap) shifts as well.
 	Passive, differential spatial depletion effects: Even if neither prey or predator shows active behaviours that create foraging arena patches, any physical or behavioural processes that create spatial variation in encounters between predator and prey will lead to local depletion of prey in high-risk areas and concentrations of prey in partial predation “refuges” represented by low-risk areas. “Flow” between low and high-risk areas (vij) is then created by any processes that move organisms.
 
 These mechanisms are so ubiquitous that any reader with aquatic natural history experience might wonder why anyone would ever assume a mass-action, random encounter model (high vulnerability multipliers (e.g., 100) in the Ecosim > Input > Vulnerability multipliers form) in the first place.
 Methods for dealing with stock-recruitment instability are discussed in the help section on using Ecosim to study compensation. Generally, the simplest solutions are to check (and reduce if needed) cannibalism rates, set higher foraging time adjustment rates (Ecosim > Input > Group info form) for juvenile pools and reduce vulnerabilities of prey to juvenile fishes (Ecosim > Input > Vulnerability multipliers form).
 Numerical instabilities (chatter, oscillations of growing amplitude) occur mainly in Ecospace. They are avoided in Ecosim by only doing time dynamic integration of change for pools that can change relatively slowly. In Ecospace, the only remedy for chatter is to reduce the prediction time step (from 12/year default value, sometimes very low values such as 0.05 year are required for stability). In extreme cases, it might be necessary to “fool” Ecosim and Ecospace by implicitly moving to a shorter time step for all dynamics, which you can do by dividing every Ecopath input time rate (P/B, Q/B) with the same factor.
 Multiple stable states
 With careful parameter choices, Ecosim can also represent Holling’s resilience concept of multiple stable states. In particular, so-called “cultivation-depensation”[1] or “trophic triangle” effects can lead to stable states dominated by large or small species, with the initial Ecosim equilibrium being an unstable or saddle-point between these states, (see Figure 1).  For example, suppose a dominant large species like cod is fished down, and that one or more of its prey species then increase.  If the prey species, then consume or compete with juveniles of the cod, cod  juvenile survival rates may be reduced enough to cause the cod to continue to collapse, leading to a stable equilibrium dominated by the smaller species.  As a historical note, the very first Ecosim model was developed by Alida Bundy for Manila Bay in the Philippines.  That model exhibited two stable states for two competing groups of small Leiognathid fishes, with small perturbations from the initial Ecosim state lead to dominance by one or other of the two groups.
 Attribution This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
 
 
 
	Walters C and Kitchell JF. 2001. Cultivation/depensation effects on juvenile survival and recruitment: implications for the theory of fishing. Can. J. Fish. Aquat. Sci. 58: 39–50. https://doi.org/10.1139/f00-160 ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Group info

								

	
				 Learning Objectives
  	Introduce the Ecosim Group Info parameters
 	Get an idea of what they do
 	See how their settings may impact results
 	Get an idea of when to change these parameters
 
 
 
 In this tutorial, we once again head to Anchovy Bay – If you don’t have the model at hand, you can download it from this link.
 The purpose of this tutorial is to take you through the parameters on the Ecosim > Input > Group info page, explain what they are, and play a bit with them.
 Max rel. P/B
 This parameter sets a cap for primary producers for how much P/B can relatively increase from the Ecopath level. It is rarely used as P/B for producers seldom changes much in Ecosim. Invoke if you have a primary producer where you can see on the Ecosim > Output > Ecosim group plots that its P/B reaches the ceiling specified by the Max rel. P/B setting.
 See also the User Guide system productivity chapter.
 Example 1: Max rel. P/B
  If you want to have a go, you can make a forcing function, go to Ecosim > Input > Forcing functions, and add a forcing function if you don’t have one, then sketch an increased level of around 3 for the function. Go to Ecosim > Input > Forcing Function > Apply forcing (producer) and apply the function to phytoplankton by clicking the field by the group, then applying the function of the pop-up form.
 Note that a 3 x increase in primary production is highly unlikely, this is just for demonstration.
 Run the model with the default Max rel. P/B setting (2), and you’ll probably see that the model has become unstable, that phytoplankton fluctuates wildly and overall have declined while zooplankton, also unstable, have increased.
 Then set Max rel. P/B to 5, and run again. You’ll probably see that the model still is unstable but phytoplankton now increases. They can increase production more before zooplankton builds up.
 Again, this is a highly unrealistic scenario, just for demonstration.
 
 
 Max rel. feeding time
 This parameter set how much the feeding time can increase (relative to the Ecopath baseline) if a predator becomes more abundant and/or its prey becomes more sparse. The parameter only takes effect if the feeding time adjustment rate is > 0.
 Feeding time adjust rate [0,1]
 The feeding time adjustment is used to model compensatory growth. Setting this parameter (> 0) allows Ecosim to vary Q/B as a function of the group biomass – organisms will seek to maintain Ecopath base Q/B by varying relative feeding time
 The key question is: how does a species react when its prey abundance change? Will it spend more time feeding to maintain the consumption rate when prey are sparse – being exposed to predation for longer – or does it have a fixed diurnal pattern, so that less prey means lower consumption?
 Many species indeed have fixed diurnal runs and we advise to keep feeding time constant for all groups apart from marine mammals, birds and maybe top predators. Also for very young stages of multi-stanza groups.
 We can examine what the setting does for cod in the Anchovy Bay model.  Run your model with default settings and you’ll probably see that cod declines because of the increase in trawler effort. Set Ecosim to display multiple runs at Ecosim > Output > Run Ecosim > Show multiple runs. Examine the Ecosim > Output > Ecosim group plots for cod, note how feeding time changes and how much Q/B (Consumption/biomass) increases – fewer cod means more food each of them, that’s why the cod doesn’t just decline in a straight line, there is compensation.
 Next, set the Ecosim < Input < Group info > Feeding time adjust rate to 0 (for no change in feeding time). Run again, and see what happens.
 Example 2: Feeding time adjust rate
  Figure 1 shows some results for illustration. You’ll notice that with the default setting (Feeding time adjust rate of 0.5) the cod declines strongly, but there is some compensation as can be seen from the top right plot with shows Q/B increase from ~2.6 to ~4 year-1. When feeding rate is kept constant  (Feeding time adjust rate of 0.0, center right plot) there is more compensation as seen from Q/B increasing to ~5 year-1, and the cod decline is less drastic.  
 The figures for comparison also shows the effect of setting the handling time parameter, QBmax/QBo, to 1.2, see the corresponding section later in this chapter. Note that here this parameter leads to even less compensation in consumption rate as biomass declines (lower right plot).
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 Figure 1. Ecosim trajectories (left) for cod in the Anchovy Bay model under three different configurations along with Q/B rates for cod for the same settings, which are Feeding time adjusmt rateat 0.5 (default, top right figure) and 0 (constant feeding time, center right figure), Qmax/Qo reduced to 1.2 (all other settings at default values, lower right figure).
 
 
 Fraction of other mortality sens(itive) to changes in feeding time
 This parameter decides what happens to the other mortality when feeding time changes. The general assumption is that if feeding time increases so will the other mortality – the underlying assumption being that the other mortality may be due to predators not included in the model. There may not be any such predators, so you have the option to set the parameter to 0.
 We can check what happens in Anchovy Bay. Run your model with default settings, and check the results (Ecosim > Output > Ecosim group plots) for shrimp. Next set the Fraction of other mortality sens. to changes in feeding time to 0, and run again. Compare the results.
 Example 3: Fraction of other mortality sens. to changes in feeding time
  Figure 2 shows the effect of the default setting for the Fraction of other mortality sens. to changes in feeding time (1) along with when the parameter is set to 0. When cod and whiting declines in the model, the predation rate on shrimp declines as well, but with default setting (right side top figure) the other mortality for shrimp increases as shrimp spends more time fitting as their population grows.  When the impact on other mortality is turned off (right side lower figure) the other mortality stays constant and the increase in shrimp biomass is greater than with the default settings (left hand side figure).
 [image: ]
 Figure 2. Effect of predator effect on feeding time for shrimp in the Anchovy Bay model.
 
 
 Predator effect on feeding time [0,1]
 Predators can be scary, it’s dangerous to be a fish. If there are predators around, prey fish tend to change behaviour. It’s better to not eat than be eaten, so predators can limit prey’s consumption rate.  We can include this effect through the Predator effect on feeding time parameter.
 In your Anchovy Bay model, make a run, check out the results for shrimps (Ecosim > Output > Ecosim group plots) . Next set the Predator effect on feeding time to 1, and run again. Compare the results.
 Example 4: Predator effect on feeding time
  Figure 3 shows the result of Predator effect on feeding time settings. With the default setting (0) predators do not impact the feeding time (top centre plot in Figure 3). The feeding time for shrimp here increase from 1 to >4 as there becomes more and more shrimp competing for their food resources.   The total mortality of shrimp decreases due to declining predation mortality (Figure 1, top right).
 Running the model again with Predator effect on feeding time on (set to 1), there are some changes (Figure 1, lower centre and right plots).  As the predation mortality on shrimp decreases, the shrimp feeding time increases, but much less than in the initial run. By the end, feeding time has just doubled (vs. >4 times in the first run) and shrimp biomass have increased much less. In essence, merely by predators being around they limit how much shrimp feeding time increases, and this constrains increase in shrimp biomass.  Indeed, the lower right plot shows that the total mortality for shrimp increases toward the end of the run, rather than decreases as in the top right plot.
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 Figure 3. Effect of the Predator impact on feeding time parameter for shrimp in Anchovy Bay.
 
 
 Density-dep. catchability, Qmax/Qo [>=1]
 Is catch per unit effort (CPUE) proportional to stock biomass? Well if it is, no worries, you can leave this parameter at its default value. Density-dependent catchability is used where catchability can increase relative to the Ecopath baseline. This could for instance be for pelagic species that are caught with purse seines. It may take at little longer to find a school of pelagics when abundance go down but the CPUE probably declines less than the stock. For demersal species the same effect can happen if there’s range contraction when abundance declines, that can lead to CPUE remain high even if stock declines. Let’s explore this in Anchovy Bay.
 In your model, go to Ecosim > Input > Fishing Effort, click on fleet 3 Seiners, and Set to value of 2 to double the effort of seiners (which catch mackerel). Run your model and set Ecosim to display multiple runs at Ecosim > Output > Run Ecosim > Show multiple runs. Next, go to Ecosim > Input > Group info and set the Density-dep. catchability, Qmax/Qo  parameter for mackerel to 2, repeat with 4, 8, 16, …  What’s the impact of this on mackerel?
 Density-dependent catchability parameters  are discussed in the User Guide’s chapter on catchability.
 Example 5: Density-dep. catchability, Qmax/Qo [>=1]
   
 Figure 4 shows how mackerel reacted to a doubling in the effort of seiners when the Density-dep. catchability, Qmax/Qo was increased in steps from 1 to 128. The top insert shows the mackerel fishing mortality (F) with the default setting (1) and with a setting of 128. At the default setting the F is constant through the run, with higher Qmax/Qo values F increases when the biomass is reduced, i.e. CPUE is not proportional to effort.
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 Figure 4. Impact of density dependent catchability for mackerel in Anchovy Bay. The Qmax/Qo parameter setting is indicated in the black markers.
 
 
 QBmax/QBo (for handling time) [>1]
 The handling time parameter limits consumption of prey at high prey densities, but can have a destabilizing effect at low densities. See Figure 1 for an example.
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 Figure 5. Functional responses indicating number of prey attacked as a function of prey density. These functional responses were defined and developed by CS Holling[1] [2]. Type 1 indicates a linear relationship and might, e.g., be used for a spider web, Type 2 is with handling time included (Disk Equation) and type III is with switching.
 Switching power parameter [0,2]
 Example 6: Switching power parameter
   
 [image: ]
 Figure 6. Output from runs with default settings and with the switching parameter for whiting set to 2. 
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		Hatchery production

								

	
				 Multi-stanza populations can be designated as hatchery populations, and hatchery production can be varied over time using time forcing functions. To turn off natural reproduction and replace it with a time series of hatchery stocking rates, open the Ecopath > Input > Edit multi-stanza groups form for a population, and enter a nonzero value for the hatchery forcing function number. Forcing functions can be sketched using the Ecosim > Input > Forcing function form or can be imported with time series (Ecosim > Input > Time series). Check the Forcing function form for the number allocated to your hatchery stocking time series. Forcing functions to represent historical changes in stocking rates can be entered via the same CSV files as used to set up historical fishing and model fitting scenarios. Enter stocking rates as values relative to the stocking rate of 1.0 assumed for the Ecopath base year.
 Then at each simulation time step, the base recruitment for the population (calculated from Ecopath input parameters) will be multiplied by the current time value for the designated forcing function. A forcing function value of 1.0 corresponds to the stocking rate that would result in the Ecopath base abundance (biomass) entered.
 If it is desired to simulate stocking of older fish at some age like 18 months, the first stanza for the population should be set to have this duration, the mortality rate (Z or P/B) for the stanza should be set to 0.001, and the diet for the stanza should be set to 1.0 imported (i.e., do not have fish in the stanza feeding in the modelled ecosystem).
 
 Attribution This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. Ecopath with Ecosim. User Guide. November 2008.
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		Non-additive mortality rates

								

	
				Consider how total mortality (Z, year-1) commonly is estimated in fisheries or ecosystem models,
 [image: Z = F + M0 + M2\tag{1}]
 where F (year-1) is fishing mortality, M2 (year-1) predation mortality, and M0 (year-1) “other mortality”, i.e. the total mortality rates not due to fisheries (included in the model) and predation (as included in the model). The question then is, what will happen if the predation mortality is decreased, e.g., due to targeted reduction in predator populations?
 Your immediate answer to that question could well be that if predation is reduced then the total mortality would be reduced as well. That would result in more of the species of interest surviving to recruitment and beyond. Indeed, ecosystem models typically assume additive effects of predation and other natural mortality rates in prediction of net production for small forage fishes in particular, resulting in prediction of substantial increase in forage fish production when predator abundances are reduced. But what if vulnerability to predation is affected by stress factors (e.g., hunger and parasite loads) that would result in higher mortality rates of vulnerable forage fish individuals even if predators were removed? In that case there may in fact be little decrease in forage fish natural mortality rates and hence little or no increase in net production rates.
 Ecosystem models that account for trophic interaction effects on prey (e.g. forage fish) mortality rates very typically represent mortality rates as a sum of independent or additive component rates, with a rate component for each predator type (species, size) that is determined by prey and predator abundances and with some constant non-predation or “other” mortality component.  Such formulations ignore that prey individuals taken by predators may be predominantly those vulnerable to predation because of behavioural or physiological stress factors (e.g. hunger, parasite or disease load, physiological effects of aging and/or spawning) that would kill a proportion of the vulnerable individuals even if predators did not take them.  The existence of such stress factors, and concentration of both predation and other mortality on individuals made vulnerable by them, implies that mortality rate components should not be treated as additive.  Parasites and pathogens in particular may exert strong regulatory effects on trophic interactions in general and predation mortality rates in particular[1] [2] [3].
 Another key stress factor leading to increased predation vulnerability may be contaminant loading[4].  Explicit representation of how such stress factors can lead to increased mortality could lead to more realistic and useful models in cases where such effects are now represented by ad hoc approaches, e.g. to starvation rates and quadratic mortality terms representing increasing mortality rate at higher abundances.
 The assumption of additive predation mortality rate impacts on forage fish in particular results in predictions of substantial increase in surplus production of these small fish when piscivore abundances are reduced through fishing or appropriation of forage fish production by fisheries, since a high proportion of the forage fish natural mortality rate is typically estimated to be due to predation (see, e.g.,[5] [6].  This increase in predicted net production (e.g.,[7] [8]) occurs in both simple biomass dynamics models like Ecosim[9] and in more detailed size spectrum models[10] [11] [12], and is a key reason for predicted increases in yield under balanced harvesting policies[13].
 Non-additivity of mortality rates can be represented very crudely in Ecosim as foraging arena limitations on predation rates[14] [15].  Surplus production rate predictions for forage fish under such circumstances can result in much weaker predicted responses of production rate to decreases in predator abundances than are now obtained with models like Ecosim or size spectrum models. We[16] developed one way to represent non-additivity hypotheses in Ecosim, and used an empirical example involving possible non-additive effects of pinniped predation on juvenile Chinook and coho salmon in the Georgia Strait, British Columbia to demonstrate how uncertain predictions of impact of changing predator abundance can be if measured predation rates are in fact limited by stress factors that would cause high mortality rates even if predator abundances were much reduced.
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 Figure 1. Alternative approaches to prediction of mass flow rate from any one prey biomass component B and predator component P.  See text for explanation and Table 1 for parameter definitions.
 Vulnerability exchange model
 There are at least two alternative approaches to prediction of biomass flow rate along any ecosystem model link between a prey biomass component (species, size) B and a predator biomass component (species, size) P (Figure 1).  In the mass-action or spatially mixed approach used in existing size spectrum models and other approaches like the Essington and Munch[17] equilibrium-perturbation model, flow to the predator (consumption rate as mass per time) is assumed proportional to prey biomass and predator biomass, with proportionality constant pa, where a is the predator rate of effective search and p is the proportion of time spent searching by the predator.
  
 Table 1. Parameter definitions. In the Units column, t = time
 	Parameter  	Definition 	Units 
  	a 	Predator rate of effective search 	area P-1 t-1 
 	B 	Prey biomass 	mass/area 
 	D 	Detritus biomass 	mass/area 
 	h 	Time lost from predator searching per unit prey biomass eaten 	t/mass 
 	Mx 	Instantaneous mortality rate due to factor x 	t-1 
 	M0 	Base instantaneous total mortality rate not due to predation (other mortality) 	t-1 
 	P  	Predator biomass 	mass/area 
 	p 	Proportion of time spent searching by predators 	dimensionless 
 	rmax 	Forage fish maximum production rate at high B 	mass/t 
 	v 	Rate at which prey become vulnerable to predation 	t-1 
 	v' 	Rate at which prey recover or move to safe areas 	t-1 
 	vs 	Rate at which vulnerable prey die due to stress factor(s) 	t-1 
  
 If the predator is assumed to have a type II functional response where handling time may limit its feeding rate[18], p is assumed to vary with the abundances Bi of all prey types taken by the predator type, as,
 [image: p=1/(1+h \sum_{i} a_i B_i) \tag{2}]
 where h is handling time lost from searching per unit of prey biomass consumed.
 In the foraging arena or vulnerability exchange model, prey are assumed to move or flow between invulnerable and vulnerable behavioral states at instantaneous rates v and v’, with predation and stress-related loss rates predicted to occur only from the vulnerable biomass component V.  The original Ecosim models assume this structure for all trophic links, with the stress-related mortality rate vs set to 0, and with the exchange process assumed to be created either by restricted predator activity (mixing of prey into and out of restricted spatial areas (foraging arenas) where predators forage) or by restricted prey activity where prey become vulnerable through foraging activities that force them to leave invulnerable refuge habitats[19] [20].
 In Figure 1, we have added a direct, stress-related mortality component vsV, to represent the possibility that the flow rate v(B-V) into vulnerable states represents prey and predator foraging restrictions and possibly also actions of stress agents, and flow rates from V back to B-V also include a loss rate vs representing mortality caused by those stress agents (like growing parasite loads and contraction of diseases).  When v arises at least partly from such stressors, v’ represents recovery rate due to processes like parasite shedding and recovery from disease.
 Whether or not there is a direct stress-related mortality rate component, dynamics of vulnerable biomass V can be represented by the continuous rate model
 [image: dV⁄dt=v(B-V)-(v'+paP+v_s )V\tag{3}]
 If the vulnerability exchange process is relatively rapid compared to rates of change in B, i.e. if the instantaneous loss rate v’+paP+vs is large, then predicted V will vary with B so as to remain near the moving equilibrium given by setting dV/dt = 0 and solving eq. (2) for V, i.e. by
 [image: V= vB⁄(v+v'+paP+v_s)\tag{4}]
 That is, V will be proportional to B and inversely proportional to v plus the total instantaneous loss rate.
 Note that Eq. 4 predicts a maximum total biomass flow rate to predation and stress mortality (paP+vs)V to have an upper bound vB, i.e. a maximum rate set by how rapidly the prey become vulnerable to P due to behavior and stress.  Further, it predicts that the flow rate to the predator, paPV, should be inversely related to the stress mortality rate vs, and the direct flow rate to stress mortality (vsV) should be inversely related to predator abundance P, i.e. the two mortality rate components should not be independent of one another.   This trade-off between mortality components can be very severe if both paP and vs are large (Figure 2).
 [image: ]
 Figure 2. Effect of varying predator biomass P on the total mortality rate M = flow/total biomass B due to predation and stress, for a case where both the instantaneous predation rate paP and stress rate vs are large. In this example, total mortality rate remains close to the vulnerability exchange rate v, even when predator biomass P is zero. See Table 1 for parameter definitions.
 If we compare instantaneous mortality rates MP due to predator P for the mass-action and vulnerability exchange formulations as in Figure 2, where MP = (mass eaten per time) / (total prey biomass), we obtain very different predictions about how MP should vary with predator abundance:
 Mass-action model:
 [image: M_p=paP\tag{5a}]
 Vulnerability exchange model:
 [image: M_p= \frac {paPV}{B} = \frac {paPv}{v+v'+paP+v_s}\tag{5b}]
 That is, we predict mortality rate to be additive to other mortality rate components and proportional to predator abundance only for cases where the prey are fully vulnerable to predation at all times and are not subject to stress-related mortality, i.e. for cases where v is very large and vs = 0.  For the vulnerability exchange case, we predict the total instantaneous mortality rate for the B–P flow link to vary as
 [image: M_{total}=\frac{(paP+v_s) V}{B} = \frac {(paP+v_s ) v}{v+v'+paP+v_s}\tag{6}]
 for which the mortality flow components paPV and vsV are very obviously not additive because of their joint, interacting effect on V.
 Predator abundances and forage fish surplus production
 To examine how forage fish surplus production rates should vary when Mtotal from Eq. 6 is used to predict the joint effects of predation and stress, suppose we now consider a simple case where there is only a single aggregate predator abundance P and/or all species-size components of the total predation rate are assumed to covary so as to generate a single overall rate that is proportional to the sum of the predator biomass components.  Suppose further that we assume the dynamics of B to be dominated by a production-recruitment component that can be adequately described by a Beverton-Holt recruitment function, minus a non-predation mortality rate M0 B minus the total rate MtotalB predicted by Eq. 7, below.  Here, M0 is the direct non-predation mortality rate as Mtotal include indirect effects of disease/stress contributions. Under these assumptions, the dynamics of B are given by
 [image: dB⁄dt=(r_{max} B) ⁄ (B_h+B) - (M0+M_{total} B)\tag{7}]
 where rmax is maximum production rate (mass/time), Bh is the forage fish biomass needed to achieve half of this maximum rate, and Mtotal is given for varying P by Eq. 6.  Note in Eq. 7 that dB/dt represents the surplus production rate of the forage fish population.
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 Figure 3.  Predicted patterns of variation in the relationship between prey (e.g., forage fish) surplus production rate (dB/dt of Eq. 7) and biomass for different approaches to prediction of predation rates and for varying predator abundances (P, black lines are for high P, light gray for P = 0.0). 
 Very different patterns of variation in the surplus production vs biomass relationship are predicted by Eq. 7 depending on how predation and stress mortality is represented (Figure 3).  For the mass action case (Mtotal = paP) and for vulnerability exchange dynamics without stress factor removal from the vulnerable biomass V, Eq. 7 predicts substantial increase in surplus production when P is reduced.  But when Mtotal includes a high mortality rate due to stress when P is low, as in Figure 2, there is almost no response of the predicted surplus production relationship due to reduction in predator abundance.
 Note that the patterns predicted in Figure 3 depend importantly on the assumption that foraging time proportion p is stable, i.e. that either there are no handling time effects or that B is a relatively small proportion of the total prey abundance that contributes to predator handling time.  When search time does increase substantially at low B, there can be severe depensatory effects that cause reduced or even negative surplus production rates when prey biomass is low.
 Simple approximation for non-additive mortality effects
 It would be a complex conceptual and programming task to fully represent non-additive mortality patterns like the example in Figure 1 in Ecosim models even for simple stress mortality rate assumptions like vsV with constant vs, because of issues about partitioning Ecopath base unexplained/ other mortality’ (M0), and whether to assume different stress-related vulnerability and mortality patterns for each of many predator-prey trophic links in typical Ecosim models.  However, the same basic effect as shown in the third panel of Figure 3 can be obtained simply by first calculating the Ecosim predicted predation mortality rate (summed over predator types) at each time step, then adding a component to M0 so as to prevent the total “apparent” predation mortality rate from decreasing to less than a user-defined minimum proportion of the Ecopath base predation mortality rate.  This simple convention allows exploration of alternative hypotheses about how much M0 would increase in scenarios where total predator abundance is reduced, using a single parameter (proportion of base predation mortality rate when predation rate is 0.0) to represent “hidden” non-additive (stress factor) effects.
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 Figure 4.  Effect of including a minimum mortality rate component representing non-additive stress mortality on Ecosim predictions of the surplus production vs biomass relationship.  Compare this prediction to those in the bottom two panels of Figure 3 – the simple mortality rate constraint causes the Ecosim prediction to be close to that obtained by explicitly modeling non-additive stress mortality.
 Effects of such a minimum mortality constraint on the predicted surplus production-biomass relationship for the same parameter values used in Figure 3 is shown in Figure 4.  Setting the minimum “hidden” predation rate to 0.8 times the Ecopath base rate causes the predicted surplus production pattern to look almost exactly like the full non-additive mortality pattern in the bottom panel of Figure 3, i.e. to predict very little increase in surplus production when predator abundance is low.
 As the ratio of minimum to Ecopath base apparent predation mortality rate is reduced (from 0.8 to lower values for the Figure 4 example), the predicted surplus production pattern shifts to equal the pattern predicted in the middle panel of Figure 3 as the ratio approaches zero.
 We caution against using this single-parameter approach just to generate multispecies scenarios where trophic interaction effects are omitted entirely (by setting the additive proportion very low), just to conform with single species modeling theory and experience.
 Discussion
 It is an old idea in ecology going back at least to Errington[21] that predators may take mainly weak, sick, and old animals, and that it therefore may be perilous to assume that predator control will increase productivity of valuable prey species.  In terms of current terminology about top-down (predation) versus bottom-up (prey productivity) control of trophic interactions, low values of the vulnerability exchange rate parameter v in the model presented above imply stronger bottom-up control of predator abundances, while high v values imply at least the possibility of strong top-down control but with the caveat that high vs values may invalidate predictions based just on v and on predator abundance.  Our models warn not to expect correct or reliable assessments of relative importance of top-down vs bottom-up effects from correlative studies of abundance variation over time (e.g.[22] [23] [24] because of possible interactive effects of predation and bottom-up “habitat” factors like temperature, as we estimate to be possible for the salmon example.
 In evaluation of evidence about the relative importance of top-down effects, we should focus mainly on cases where there have been deliberate manipulations of top-down effects (e.g.,[25] [26] that would reveal existence of vs effects if such effects are indeed present.  This warning holds as well for those rare cases where we have direct estimates of variation in natural mortality rates (M) over time from data such as survey relative abundances at age or tagging as in the salmon case; good correlations of M with predator abundance do not imply top-down control when stress factors have changed over time in patterns correlated with predator abundance.
 Modern molecular techniques offer considerable promise to screen for gene activation patterns (gene expression profiles) indicative of stress, and hence to directly measure v and V, i.e. whether the prey taken by predators are indeed mainly those that are stressed particularly by diseases (e.g.[27] [28] [29].  But unfortunately, such techniques do not provide direct measures of the virulence of the stress factors, i.e. of the direct stress mortality and recovery rate parameters vs and v’; predation impacts may still be essentially additive components of total M if vs is low.
 Another way to examine the credibility of hypotheses about non-additive predation impacts is to compare estimates of predator rates of effective search (a) implied by high vs-low V models with direct estimates of rates of search based on predator characteristics.  Such direct estimates can be obtained from basic information on predator movement speeds, reactive distances to prey, and proportions of time spent foraging, combined with information on the effective area or volume over which the search is distributed.  For the juvenile salmon-seal example in Walters and Christensen[30], such calculations suggest much lower a parameter values for seals than would be necessary to explain the data under high vs assumptions.
 As data sets accumulate with age-specific survey estimates of abundance (from which temporal variation in total natural mortality rate M can be estimated), we will also be able to directly compare observed changes in M with predictions from additive predation models (and direct estimates of search rates).  Seeing lower slopes in M vs predator abundance plots than predicted under additive predation would be evidence of high stress-dependent mortality rates (vs), as in the Figure 2 example.
 Continued climate change will quite possibility result in substantial changes in trophic interaction patterns[31] through “hidden” effects due to temperature-related changes in v and vs, (e.g., increases in disease expression or physiological impact).  But such changes may be “masked” when stressed individuals are rapidly removed by predators, so as to only exert increasing effects when various factors, like fishing, lead to predator abundance declines.  This means that climate change is quite likely to produce some very nasty surprises that we will not anticipate through ecosystem models built around simplistic assumptions about additivity of mortality components, nor can we be confident that simpler models based on statistical or correlative historical data will somehow give better predictions.
 Attribution Based on Walters and Christensen[32]. Excerpts and figures used with permission from Elsevier, License Numbers 5663220213981 and 5663220407849.
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		Shared foraging arenas

								

	
				 The basic Ecosim formulation for predation interactions assumes that each non-zero consumption of a prey type i by a predator type j takes place in a foraging arena unique to that interaction[1] [2] [3].  The rationale for this assumption is that each arena is defined by the combined behaviors of both the prey and the predator, and possibly also by selection of particular prey sub-types, (e.g., sizes), such that multiple predators can feed on the same prey type in different ways (at different depths, times of day, spatial microhabitats) without competing directly for prey within the typically very confined space represented by each arena.
 The general foraging arena assumption that predation typically is concentrated within restricted arenas, and hence at restricted rates, has profound implications for model predictions about ecosystem stability, and the further assumption that each predator-prey interaction takes place within a unique arena has equally profound implication for the maintenance of ecosystem structure and diversity[4].  It essentially represents the possibility of a distinct “feeding niche” for each of the predators that takes type i prey, hence allowing for the possibility that multiple predators can coexist while feeding on only that prey type.  A prototype example of this possibility is with rockfishes (Sebastes spp.) along the Pacific coast, where a diverse collection of species all feed on euphausids, but avoid direct competition for these euphausids by feeding at different depths and times of day.  An obvious evolutionary argument in favour of assuming such fine structure in feeding interactions is that if several predators were to feed within the same micro-scale foraging arena, the intense inter-specific competition caused by such behavior would result in very strong natural selection favouring differentiation of behaviors to avoid it, e.g., by feeding at different depths or times.
 While there are evolutionary arguments in favour of assuming a distinct foraging arena for every interaction, Aydin and Gaichas[5] emphasize that there are some situations where multiple predator types are likely to feed on exactly the same prey and at the same place and time.  An example could be where the predator types represent different life history stanzas (age-size classes) of the same predator species with very similar feeding modes (times and locations).
 We represent this possibility in Ecosim by entry of base proportions of each predator type’s diet that occurs in each of the possible foraging arenas defined by all non-zero predator-prey consumption linkages.  Vulnerable prey density in each arena is then represented as varying over time in response to abundances of all predator types that feed in the arena.
 In Ecosim, we define a list a = 1, … , Na of possible foraging arenas, where Na is the number of non-zero consumption interactions in the Ecopath diet matrix representing consumption of each prey type i by predator type j.  Each of these potential arenas has a defining prey type i(a) and defining predator type j(a).
 When only predator type j(a) feeds in arena a, vulnerable prey density Va is predicted by the basic foraging arena equation,
 [image: V_a=\frac{v_a \cdot B_{i(a)}}{v_a+v_a' +\alpha_a \cdot P_{j(a)}}\tag{1}]
 Here, va and va‘ are vulnerability exchange rates of prey to and from arena a, Bi(a) is prey biomass, Pj(a) is predator abundance (biomass or sum of numbers times search rates per  predator for multi-stanza predators), and αa is the predator rate of effective search (volume swept per time divided by foraging arena volume).  The predation flow rate (biomass of prey i(a) consumed per unit of time by predator j(a)) is then predicted as Qi(a),j(a) = αaVaPj(a).  The va and αa are parameterized by having model builders define va from maximum possible mortality rates expressed as multiples Ka of Ecopath base instantaneous predation rates Mij(0) = Qij(0) / Bi(0), simply by setting va = Ka where the superscript (0) designates Q’s and B’s estimated as base (initial) values of abundances and flows in the Ecopath baseline model.  The back-exchange parameter v’ is set equal to v since it cannot be estimated separately from the αa parameter.
 The shared-arena extension of Eq. 1 is straightforward,
 [image: V_a=\frac{v_a \cdot B_{i(a)}}{v_a+v_a'+ \sum \limits_k \alpha_{ak} \cdot P_k}\tag{2}]
 Here the predator impact on Va is represented by a sum over all possible predators k of arena-specific search rates αak times predator abundances Pk. [In the software-implementation of this, we do not actually sum over all k but instead construct a list of all non-zero αak flow combinations, and sum the αakPk denominator terms only over the elements of that list.]
 To parameterize Eq. 2 in a relatively simple way while assuring that it predicts predation rates equal to Ecopath base rates when the system is at its Ecopath base state, we need to specify base proportions pak of each predator k’s diet that is taken in arena a. These proportions are constrained to sum to Ecopath base consumption rates  over all a for which i(a) = i.  That is, we take the by-arena base flows  to be pak Qi(a),k(0).  These base flows then imply a base instantaneous mortality rate Ma(0) totaled over predators feeding in a, for prey i(a),
 [image: M_a^{(0)}=\frac{\sum \limits_k Q_{ak}^{(0)}}{B_{i(a)}}\tag{3}]
 Using this input or baseline estimate of M for each arena and an assumed vulnerability multiplier Ka for that arena, we simply set va = Ka (and va‘ = va).
 Next, note that to be consistent with Ecopath baseline inputs, we must require that Ecosim predict Qak(0) when all biomasses (and p’s) are at their Ecopath base values. The Ecosim prediction of rate Qak (flow rate of prey to predator k from feeding in arena a) at any time is Qak = αakVaPk, implying we must constrain the αak so that Qak(0) = αak Va(0) Pk(0), i.e. we must set αak = Qak(0) / (Va(0) Pk(0) ).  This means that to estimate the αak we must first estimate the base vulnerable abundances Va(0).
 This estimation turns out to be remarkably simple, when we note that the Ecopath base value of ∑k αak Pk must equal ∑k Qak(0) / Va(0), (simply sum Qak over k, which must equal Va = ∑k αak Pk, and solve for ∑k αak Pk). Substituting ∑k Qak(0) / Va(0) for ∑k αak Pk in Eq. 2, then solving for Va(0), we calculate the base vulnerable abundances to be simply,
 [image: V_a^{(0)}= v_a \cdot B_{i(a)} - \frac{\sum \limits_k Q_{ak}^{(0)}}{v_a+v_a'}\tag{4}]
 The αak are then calculated from these base vulnerable biomasses. Time-varying values of Qak are computed efficiently in Ecosim by setting up a list h = 1, … , Nh of all non-zero by-arena flows (Nh ≥ Na), where for each list element we store its associated prey type i(h), predator type k(h), and arena a(h).
 To calculate Qak, we sweep down this list repetitively.  On the first sweep, we accumulate the denominator sums ∑k αak Pk for Eq. 2.  We then sweep down the arena list and calculate Va for every a again using Eq. 2.  Then we sweep again down the h list, calculating Qak = αakVaPk and accumulating predictions of total predation rates on the prey i(a) and food consumption rates by predators k(a).
 As an added bit of model realism, one can specify a non-zero prey handling times for predator k (type II functional response[6]), and the Qak calculation is modified to be Qak = (αak/Hk) Va Pk, where Hk is the denominator of Holling’s multi-species disc equation for predator k feeding.  This handling time correction is also applied in the bout-feeding formulation described in the next chapter.
 To edit the pak diet proportions array, we display a matrix for each prey type i of the non-zero i-k consumption proportions, as shown schematically in Table 1. In this table, m is the number of non-zero flows from prey ito predators k where each such flow defines a potential foraging arena.  Note that each column of the table must sum to 1.0, i.e. all of the consumption by predator kj of prey type i must be accounted for by feeding in one of the m identifiable arenas for prey type i.  The Ecosim default proportions for this table imply that each predator takes all of its consumption of prey type i in a unique arena, i.e. the table is an identity matrix, (with values of 1 on the shaded diagonal in Table 1).
 [image: ]
 The opposite extreme of this default assumption would be that all consumption of prey type i by its predators occur in only one arena or behavioral state for prey i, as shown in Table 2. This case implies maximum possible impact of predators k on availability of prey i to one another, and will cause competitive exclusion of at least some predator types in Ecosim unless the predators are well-differentiated in terms of overall diet composition, i.e. where each predator “specializes” on a different prey type i, which dominates the diet composition, as for instance shown by Schmidt[7]. Studies rather tend to indicate resource partitioning between competing predator species, leading to non-additive mortality rates, see e.g., Griffen and Byers[8]. Separation where diet compositions indicate predator overlap may also be caused by temporal exclusion of prey based on availability to the predator[9].
 [image: ]
 In the special case where a set of predators feeds on only one prey type in a single arena (Table 2), and where there are no complications such as multistanza population dynamics where abundance of one or more predator types may be limited by recruitment rates from younger stanzas, the above formulation implies that there is not even a unique equilibrium point for predator abundances.  Rather, all predator abundance combinations that predict V=V(0) in Eq. 2 are neutral stable points provided predator mortality rates remain at Ecopath base values, such that any temporary pulse of differential mortality that causes one or more predators to decline will then be followed by persistence of the new predator abundance combination if mortality rates return to the base values.  Any predator that suffers a persistent differential increase in mortality rate is predicted to decline toward extinction.
 
 Attribution This chapter was inspired by Kerim Aydin’s work on a foraging arenas, and is based on Walters and Christensen. 2007.[10], used with permission from Elsevier, Licence Number 5663310244809.
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		Bout feeding

								

	
				Many predators do not feed continuously over time as assumed in derivation of the vulnerable abundance Va in the standard foraging arena equation (Eq. 1 below).  Rather, they obtain most of their food intake in short, intensive feeding “bouts”, typically at dawn and dusk when light levels are changing rapidly[1] [2].
 Basic foraging arena equation
 [image: V_a=\frac{v_a \cdot B_{i(a)}}{v_a+v_a' +\alpha_a \cdot P_{j(a)}}\tag{1}]
 Shared foraging arena extension (see preceding chapter)
 [image: V_a=\frac{v_a \cdot B_{i(a)}}{v_a+v_a'+ \sum \limits_k \alpha_{ak} \cdot P_k}\tag{2}]
 
 Particularly when predators such as juvenile fish have severely restricted habitat use as a tactic for managing predation risk (hiding, schooling), only a small fraction of the system-scale prey biomass is available to them in the foraging arenas that they use during each feeding bout. As an example, juvenile Atlantic salmon have been shown to restrict the time they spend feeding rather than maximizing their growth when food is abundant[3].
 Here, we show that overall trophic flow rates Qak (for predators k feeding in foraging arena a) over longer time scales can still be closely approximated by a continuous rate equation of the mass-action form Qak = αakVi(a)Pk(a), where the bout search rates α* and mean vulnerable prey densities per feeding bout are comparable to (but differ numerically from) the α,V predictions for continuous feeding.
 Consider a single feeding bout in arena a of duration d (d << one day), during which an initial prey density Va(0) is depleted by predators k(a).  Assume that d is short enough that prey renewal and loss during the bout, (e.g., due to prey spatial movement and other mortality sources) can be safely ignored.  Assume that Va(0) is a proportion fa of total prey biomass Bi(a) and that renewal mechanisms between bouts make Va(0) = fa Bi(a).  Note that when used over multiple bouts, this prediction of Va(0) for each bout requires that arena prey abundance be independent of predation effects in previous bouts except through effects on Bi(a), i.e. that there are no carryover effects from previous bouts (extreme opposite of continuous feeding assumption).  Then if predators k search randomly within the arena, vulnerable prey density Va(t) will change during the bout according to the simple rate equation,
 [image: \frac{dV_a(t)}{dt}=-V_a(t)\sum \limits_k\alpha_{ak}P_k\tag{3}]
 where the αak are predator rates of effective search with the same interpretation as for continuous feeding.
 Integrating Eq. 3 over the bout duration d leads to the familiar exponential exploitation equation Va(d) = Va(0) exp(-d ∑k αak Pk) and to predicted total prey consumption per bout Qakbout by each predator k,
 [image: Q_{ak}^{bout}=\frac{\alpha_{ak}P_k}{\sum\limits_k\alpha_{ak}P_k}\cdot f_aB_{i(a)}\cdot [1-\exp(-d\sum\limits_k\alpha_{ak}P_k)]\tag{4}]
 The first term of Eq. 4 simply apportions total prey consumption Va(0) – Va(d) over the bout among competing predators.  Further, the mean prey density Va* during the bout is given by the integral of V over the bout divided by bout duration d. This mean is just,
 [image: V_a^*=f_aB_{i(a)}\cdot \frac{1-\exp(-d\sum\limits_k\alpha_{ak}P_k)}{d\sum\limits_k\alpha_{ak}P_k}\tag{5}]
 Expressed in terms of this mean arena prey density, consumption per bout Eq. 4 can be expressed more simply as
 [image: Q_{ak}^{bout}=\alpha_{ak}P_kV_a^*\tag{6}]
 We could use this formula directly in a complex simulation model that steps forward in time by the interval Δt between feeding bouts, adding in other components of prey and predator abundance change over each such short interval.  Fortunately, such a tedious calculation is generally unnecessary.
 Consider the component of overall prey biomass change caused by each feeding bout, where there are nb = 1/Δt bouts per year.  That (typically small) change in Bi(a) per bout is given by the sum of Eq. 4 terms over predators k, i.e.,
 [image: \Delta B_{i(a)} = f_aB_{i(a)}\cdot[1-\exp(-d\sum\limits_k\alpha_{ak}P_k)]\tag{7}]
 Dividing this by the bout duration Δt gives a discrete-time component of the prey rate of change,
 [image: \frac {\Delta B_{i(a)}}{\Delta t}=\frac{1}{\Delta t}f_aB_{i(a)}\cdot [1-\exp(-d\sum\limits_k\alpha_{ak}P_k)] =n_bf_aB_{i(a)}\cdot [1-\exp(-d\sum\limits_k\alpha_{ak}P_k)]\tag{8}]
 Since the time Δt between bouts is typically very short (nb is typically of the order of several hundred bouts per year), we can approximate Eq. 8 very accurately by treating it as a continuous rate component dBi(a)/dt.  This approximation leads immediately to a continuous rate equation for Qak comparable to the continuous feeding case where Qak = αakPkVa, namely,
 [image: Q_{ak}=\alpha_{ak}^* \ P_k \ v_a^* \ B_{i(a)}\cdot \frac{1-\exp(-\sum\limits_k\alpha_{ak}^*P_k)}{\sum\limits_k\alpha_{ak}^*P_k}=\alpha_{ak}^* \ P_k \ V_a^*\tag{9}]
 Where αak* are the duration-weighted search rates αak* = αakd. va* = nb fa represents a total prey “fraction” that would become vulnerable over a one-year time scale, and  Va* (comparable to Eq 2) is given by
 [image: V_a^*=v_a^* \ B_{i(a)} \cdot \frac{1-\exp(-\sum\limits_k\alpha_{ak}^* \ P_k)}{\sum\limits_k\alpha_{ak}^* \ P_k}\tag{10}]
 This model for vulnerable prey density obviously exhibits the same “ratio dependence” of available prey density on predator abundance as does Eq 2, but with the ratio effect 1/(v+v’+∑k αak Pk) replaced by a negative exponential effect.   At high predator abundances it also implies an upper bound Bi(a) on total removal rate Qa and hence on total instantaneous predation mortality rate Qa/Bi(a).
 We can parameterize the continuous approximation to bout feeding from Ecopath inputs and assumed maximum predation rates in the same way as described in the previous section for continuous arena feeding.  That is, we set va* = Ka Ma(0) where Ka as above is a defined input ratio of maximum to Ecopath baseline predation rate.  We calculate base mean prey density per bout Va*(0) by substituting Ecopath base prey and predator abundances Bi(a)(0) and Pk(0) into Eq. 10 along with ∑k α Pk(0) = Qa(0) / Va(0), (where Qa(0) is the base total consumption rate summed over predators k), and solving for Va*, to give
 [image: V_{a}^*(0)=-\frac{Q_a(0)}{\ln(1-\frac{1}{K_a})}\tag{11}]
 Then we simply calculate the αak* as
 [image: \alpha_{ak}^*=-\frac{Q_{ak}(0)}{P_k(0)\cdot V_a^*(0)}\tag{12}]
 whereas above the arena-specific base consumption rate is calculated using assumed arena feeding proportions pak as Qak(0) = pakQi(a),k(0), and Qi(a),k(0) is the Ecopath base total consumption rate of prey i(a) by predator k.
 [image: ]
  
 Figure 1. Comparison of instantaneous mortality rates expressed relative to Ecopath baseline predation mortality rates for the original model formulation (“Continuous”) and compared to bout feeding with va* = va in case Bout A, and with va* < va set to give same limiting maximum consumption per predator, Q/P in case Bout B.
 It is instructive to compare the predictions of instantaneous prey mortality rate M = Qa/Bi(a) from Eq. 8 to those of the continuous model defined by Eq. 2  (and Qa = ∑k αak Pk Va), for varying predator abundances Pk while holding prey biomasses Bi(a) constant (Figure 1). If we set va* = va, i.e. use the same Ka to calculate va* as we would for va in the continuous case (Bout A in Figure 1), the exponential term in the bout feeding model generally predicts steeper variation in M than the continuous model, i.e., it predicts that M will drop off more rapidly if P decreases from P(0) than does the continuous model.  This leads to weaker “compensation” measured in terms of increase in potential Q/P as P declines.  But if we set va* smaller than va, so as to predict the same limiting maximum consumption per predator (Q/P) at very low predator densities (Bout B in Figure 1), the two arena models give predicted patterns of variation in M that are the opposite, i.e. bout feeding predicts saturation of M at lower P than the continuous case.  This means that in Ecosim cases where Ka has been estimated by fitting the continuous arena model to time series data (the only option before the inclusion of bout feeding in EwE), and where feeding in reality has been of the bout type, the fitted Ka estimates have probably been somewhat too large, i.e Ka is in reality closer to 1.0 and predators are already causing (in the Ecopath base situation) what may be close to their maximum possible predation rates from bout feeding.
 For Ecosim models that include multi-stanza population dynamics, a critically important capability is to represent adjustments in foraging time, particularly for juvenile stanzas.  Such adjustments allow juvenile fish to translate increases in potential feeding rate Q/P into reduced foraging time and predation risk when competitor abundance P decreases[4], leading to compensatory changes in juvenile mortality rates and emergent stock-recruitment relationships of the Beverton-Holt form[5].
 Foraging time adjustments are modeled in Ecosim by including a dynamic variable Ti for each biomass type, with Ti at time zero set to 1.0.  Then Ti is varied over time so as to try and maintain Ecopath base feeding rate per predator (Q/P), by multiplying all search rates of type i for its prey by Ti, and all vulnerability exchange rates of type i into arenas where predators take it by Ti.  In the bout foraging representation, this means simply that (1) search parameters for type i as a predator are adjusted by varying bout durations d in proportion to Ti (i.e. setting α*(t) = α*(0) Ti, with Ti defined as the relative bout duration d(t)/d(0)) and (2) the vulnerable fraction f that define v* of i to its predators are also treated as being proportional to d by setting v*(t) = v*(0) Ti.
 As a simple test of whether bout feeding is likely to make much difference to the ability of Ecosim models to fit historical time series data, we examined changes in a simple fitting criterion (sum of squared deviations, SS, from historical data, summed over all time series used in model fitting) for a collection of models that had been fitted to data using the continuous arena equations, when all trophic linkages were simply reset to assume bout feeding without correction or refitting of the Ka parameters (Figure 2,[6]). Ability of several of these models to fit historical data are reviewed in Walters and Martell (2004, Figure 12.6[7]), and these were mostly the same models used in single-species versus multispecies MSY comparisons by Walters et al.[8].
 [image: ]
 Figure 2. Changes in sum of squares goodness-of-fit criterion (SS) for an assortment of models that have been fit to historical data using the continuous feeding arena equations of Ecosim, when bout feeding is assumed instead for all trophic linkages initially without re-estimation of vulnerability exchange multipliers Ka.  (A): represents SS from original model.  (B): SS from original model but with bout feeding.  (C): SS for bout feeding, after fitting by varying 20 most important Ka.  (D): SS for continuous feeding after fitting. 
 Surprisingly, there was little change in the fitting criterion for many of the models, and one (Central North Pacific) even gave a better fit immediately.  For those models where there was a substantial increase in SS, it was easy to remedy the poor fits by re-estimating Ka under the global bout arena assumption.  When we refitted the models under both feeding assumptions (by nonlinear estimation search over the 20 Ka values with largest contributions to the sum of squares), we were easily able to find fits at least as good under the bout feeding assumption for most cases, and qualitatively as good for all cases.
 Discussion
 The equations introduced here obviously give considerable flexibility to represent trophic interactions in the Ecosim model more realistically than previously possible[9].  It is particularly comforting to see that the much more realistic assumption of bout rather than continuous feeding leads to very similar predictions of how prey mortality rates should vary with predator abundances as have been assumed in previous Ecosim models based on the unrealistic but mathematically convenient assumption of continuous feeding with rapid equilibration of vulnerable prey densities.
 We recommend extreme care in using either the continuous or bout feeding equations to represent feeding by multiple predators in a relatively small number of arenas.  As noted above, the intense inter-specific competition implied by such concentration of feeding has very likely driven natural selection for differentiation in feeding behavior (use of different fine-scale arenas) as well as in diet composition.  See for instance Berec et al. (2006) for an experiment illustrating this. If such differentiation is excluded from the model parameterization, the Ecosim user risks building a model that will not retain observed biodiversity over time.
 A few authors have referred to the basic Ecosim equation for predicting total flow rates Q =(α v B P) / (v + v’ + α P) as though it were a functional response equation comparable to assuming mass-action encounters and type II predation, e.g., Q =(α B P) / (1 + h B);[10].  Such comparisons reflect a misunderstanding about a basic proposition of foraging arena theory, namely that predators very generally encounter their prey in space-time restricted circumstances (foraging arenas), such that it is almost never appropriate to predict Q from the ecosystem-scale mean prey density B when trying to account for effects such as handling time and switching (changes in α).  We would argue that it is sometimes appropriate to account for handling time effects, but only if these are predicted using arena-scale vulnerable prey densities V, i.e. Q = α V P / (1 + hV), where V is adjusted away from the system-scale average B using assumptions about localization of foraging (effects of vulnerability exchanges v’s and/or available prey fractions per bout f’s in the arena equations). We explicitly allow switching in Ecosim, but again caution that it should be used in conjunction with predictions of vulnerable, rather than overall, prey densities.
 It would be ignorant to assert that the equations presented in this chapter are the only or best way to represent differentiation of vulnerable prey biomasses V from system-scale average prey biomasses B in prediction of trophic interaction rates.  They do not for example account explicitly for some very gross system-scale effects that occur in highly disturbed systems, such as changes in overall prey and predator distributions and overlap patterns, (e.g., due to range contractions), and changes in spatial arena structure due to obvious habitat changes like growth and destruction of biogenic spatial refuges[11].  Some such changes can be accounted for in Ecosim through trophic ‘mediation functions’ that link v’s and α’s to abundances of species besides those engaged directly as predators and prey, (e.g., one can make α’s and v’s for juvenile fish that hide in macrophyte beds dependent on macrophyte biomass).  But there is still a long way to go in development of fully-defensible predictions of V for systems that are massively disturbed.
 One option for dealing with the prediction of V would be to construct very detailed spatial models (with habitat and its use modelled at fine scale, maybe of a few m2) running on very short (bout) time scales (time steps of one hour or less).  But such models may be plagued by lack of detailed spatial data, lack of understanding of how organisms move and concentrate their activities at such fine scales, and risk of cumulative divergence of predictions from reality simply due to explosions over simulated time and space of small errors in behavioural movement predictions.
 A key advantage of the relatively simple foraging arena equations for Q prediction is that we can easily force them to agree with baseline “observations” or estimates of system-scale abundances (B’s, P’s), feeding rates, and diet compositions (Qji) as summarized in static (point-in-time) mass-balance assessments like Ecopath.  But this is also a disadvantage, in the sense that the rate parameter estimates then become dependent on the often incomplete and possibly biased estimates entered as Ecopath inputs.  It is clear that Ecosim-type dynamic predictions are sensitive to those baseline inputs, and that this represents an especially severe issue for interactions involving small fish as prey (where the small fish typically represent only trivial and often overlooked proportions of their predators’ diets).
 Even absent difficulties with Ecopath inputs, i.e. empirical knowledge of baseline ecosystem biomass flow rates and states, the most troublesome parameters for Ecosim users to specify have been the “vulnerability multipliers” Ka representing ratios of maximum to Ecopath base predation mortality rates.  One source of trouble is obviously that Ecopath inputs provide no information about the Ka, and such information can only come from either fine-scale analysis of spatial arena structures, from data collected at different times and/or places about how Q’s have varied with predator and prey abundances, or from assumptions about or estimates of where populations are relative to their carrying capacity.  Indeed, this is why we emphasize the importance of fitting Ecosim models to time series data by varying the Ka parameters.
 Another, and important aspect is that the Ka are not purely “behavioural” or ecological parameters; rather, they depend as well on how large the Ecopath initial predator abundances Pk are compared to what the ecosystem might naturally support (see Density dependence chapter).  So for example a model that includes Atlantic cod stocks off Newfoundland, and uses the current low stock size as the Ecopath base, must have very high Ka values (1000+) for interactions between cod and its prey, else the model will not make enough prey available to the simulated cod stock for it to recover to anywhere near its historical abundance when simulated fishing is removed.
 We can provide some guidance about reasonable ecological Ka values (corrected for effects of historical depletion on biomasses) from meta-analysis of Ka estimates for many fitted models.  One pattern that is becoming broadly evident from cases like those in Figure 2 is that fitted Ka values tend to be small (<2.0) for most trophic linkages in temperate and tropical systems, and for feeding by juvenile stanzas in all systems.  In contrast, fitted Ka values tend to be much larger for most interactions (except juvenile stanzas of demersal fish species) in high-latitude ecosystems like the Bering Sea.  The low Ka values are easily explained for juvenile fish and reef-associated older fish, as a consequence of severe spatial restriction in habitat use leading to low proportions of prey populations being available the fish at any time[12].  High Ka values in high-latitude systems likely reflect the wider spatial movement characteristic of northern fish, and tactics such as diel vertical migration that bring high proportions of widely distributed predators and prey into daily contact with one another, (i.e., high f’s for bout feeding during periods of diurnal contact[13]).
 The Ka vulnerability multipliers are discussed in details in the vulnerability multiplier chapter.
 Attribution This chapter is based on Walters and Christensen (2007)[14], used with permission from Elsevier, Licence Numbers 5663310244809 and 5663310474242.
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		Environmental impacts

								

	
				One of the clear lessons from time series fitting with Ecosim is that in order to fit models convincingly to time series data, we have to consider food web impacts, environmental change as well as human impacts, (see the On modelling chapter).
 The basic structure of EwE is designed so that trophic impacts (be they direct or indirect) and direct human impacts (notably through exploitation) are dealt with through the food web and exploitation parts as detailed in the baseline Ecopath and Ecosim chapters of this text book. Indirect food web effects of a behavioural character, such as when one group impacts the feeding interactions between two other groups can be handled with mediation – as described in more detail in the Mediation chapter.  This leaves us with describing how environmental impacts are represented in EwE, and that’s the topic of this chapter.
 As a starting point, environmental impacts are dynamic factors, i.e. they change over time, and they impact organisms in different ways. This in essence means that there are two steps to be considered for inclusion of environmental impacts: how they change and how they impact.
 The first factor, how an environmental factor changes over time, is modelled with forcing functions. In Ecosim, these are temporal while in Ecospace they have to be both temporal and spatial, so reading in a spatial map for each time step. Other than that aspect, Ecosim and Ecospace work the same way with incorporating environmental impacts.
 The second factor, how to model the direct impact of the forcing function on functional groups is done with environmental preference functions, The details of this are described in the Habitat Capacity chapter to which we refer.  That chapter describes the spatial implementation of habitat capacity, and this functionality was indeed developed for Ecospace initially, but it is now also implemented in Ecosim with the same approach and functionality as described in the chapter.
 For details of how to use the forcing functions and define the habitat capacity preference functions, see the tutorial on Incorporating environmental forcing (available online and in pdf version only).
 Scaling your forcing functions?
 When you have loaded a forcing function in Ecosim, you have two choices:
 	Use it for direct forcing, (Ecosim > Input > Forcing function), with the option of forcing  predator-prey interactions, primary production or detritus import.  For this option, the forcing functions should be scaled relative to the Ecopath baseline (so as a rule with the value of 1 as the first value);
 	Use it through environmental preference functions that impact foraging arena size, e.g., for temperature, salinity, pH, or O2.  Such preference functions should be used with the corresponding values, (e.g., 10oC as temperature value).
 
 
 Inner workings in Ecosim
 The description below of how forcing functions are considered in Ecosim is also applicable for mediation functions.
 The basic Ecosim prediction for consumption or flow rate (unit: biomass/time, e.g., t km-2 year-1) of type i prey biomass to type j predator is of the functional form
 [image: \text{flow rate} = a_{ij} V_{ij} B_j \tag{1}]
 where aij is a “rate of effective search” parameter, Vij is vulnerable prey biomass, and Bj is effective predator abundance[1]. If vulnerable prey were randomly distributed over the modelled area, and V, Bj were expressed per unit area, then aij can be interpreted as a volume (or area) swept per unit predator abundance per unit time, corrected for the proportion of time actually spent searching for food[2].
 To understand how effects of habitat changes may impact trophic flow rates, consider the aij parameter. For most trophic interactions, predators search for prey only over restricted spatial foraging arenas, and hence Vij is distributed only over such areas rather than at random over the whole system.
 Suppose the (practically unmeasurable) restricted area where foraging by j on prey i takes place is Aij per unit total model area. Suppose that while in this area, each unit of predator abundance searches an effective area aij* for prey. On average, each such area searched should result in capture of Vij/Aij prey, since this ratio is prey density in the arena area. In other words, the flow rate could be modelled more precisely (if we could measure Aij) as
 [image: \text{flow rate}=a_{ij}^{*} A_{ij} V_{ij} B_j \tag{2}]
 i.e., the aij in Eq. 1 Equation  can be interpreted as aij =  aij*/Aij. Expressed this way, we see that time forcing[3] can influence the flow rate in at least three quite distinct ways:
 	by altering the effective search rate aij* of the predator, for example by using a turbidity time forcing function[4] of algal biomass that reduces aij* at high algal biomass.
 	by altering the area Aij over which vulnerable prey and/or predators are distributed[5],
 	by altering the vulnerability exchange rates vij that determine (along with aij*/ Aij) Vij from total prey biomass Bi[6].[7]
 
 It is possible to apply multiple time forcing functions[8] to each trophic flow (i,j) rate prediction, and to specify whether each function multiplies aij*, Aij, and/or vij. Using these forms, one can choose the parameter that is multiplied by each forcing function[9], i.e. one of the following choices:
 	Multiply overall predator rate of effective search (ai,j), for example to represent time-varying turbidity changes that affect predator search efficiency[10].
 	Multiply vulnerability exchange rate (vij), for example to represent increased movement rates of prey into vulnerable behavioural state at times when water mixing rates are higher.
 	Multiply area of foraging arenas (divide Aij by multiplier), for example to represent increase in habitat area available for juvenile fish refuges.
 	Multiply area (divide Aij) and also multiply vij, for example to represent increase in safe foraging habitat available to a predator that feeds on prey that become available in foraging arenas through passive drift/mixing processes such that increasing area used by predator results in higher proportion of total prey population being available in foraging areas at any moment.
 
 How will you decide which of these options to use? Consider the description above or explore the impacts of the alternative settings.
 
	For biomass pool functional groups Bj is just predator biomass; for multi-stanza groups it is the sum over ages in that group of numbers at age times body weight to the 2/3 power, an index of per-predator search rate ↵
	Foraging time and handling time adjustments reduce aij from its theoretical maximum value for a predator that searched continuously for food ↵
	Or mediation effects ↵
	Or a mediation function ↵
	This mechanism is often used for mediation, for example a mediation effect where macrophyte or seagrass biomass limits the foraging area usable by small predatory fish, so increases in those plant biomasses should be represented as causing increases in Aij for all prey i of the small fish as predator j. Another example would be restriction of Aij for feeding on small fishes by pelagic birds caused by large pelagic fishes, which drive small fishes nearer to the surface where they re more available to the birds. ↵
	The basic equation for V from B is Vij = vij Bi / (vij + vij' + aij* /Aij Bj ↵
	Also used for mediation effects, for example if small fish respond to increased large plant biomass by occupying a larger area, the mixing rate (vij) of planktonic food organisms into that larger area will increase as well ↵
	And/or mediation functions ↵
	Or mediation function ↵
	Or mediation effects of algal biomass on search efficiency ↵
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				 For primary producers the production is estimated as a function of the producers’ biomass, Bi, from a simple saturating relationship
 
 [image: f(B_i)=\frac{r_i \cdot B_i}{1+B_i \cdot h_i} \tag{1}]
 where, ri is the maximum production/biomass ratio that can be realized (for low Bi’s), and ri/hi is the maximum net primary production when the biomass is not limiting to production (high Bi’s). For parameterization it is only necessary to provide an estimate of ri / (P/Bi),i.e., a factor expressing how much primary production can be increased compared to the base model state. If a Forcing function is applied to primary production, it multiplies the r parameter in the equation above.
 Nutrient cycling and nutrient limitation
 Ecosim uses a very simple strategy to represent nutrient cycling and potential nutrient limitation of primary production rates. It is assumed that at any instant in time the system has a total nutrient concentration NT, which is partitioned between nutrient ‘bound’ in biomass versus free in the environment (accessible to plants for nutrient uptake). That is, T is represented as the sum NT = ∑iŋiBi + Nf, where ŋi is (fixed) nutrient content per unit of pool i biomass, and Nf is free nutrient concentration. Then assuming that NT varies as dNT/dt = I – vNT, where I is total inflow rate to the system from all nutrient loading sources and v is total loss rate from the system due to all loss agents (volume exchange, sedimentation, export in harvests, etc.), and that v is relatively large, NT is approximated in Ecosim by the (possibly moving) equilibrium value NT =  I/v.
 Changes in nutrient loading can be simulated by assigning a time forcing function to NT, in which case NT is calculated as NT = ft NTo where NTo is the Ecopath base estimate of NT (at the start of each simulation) and ft is a time multiplier (ft = 1 implies Ecopath base value of NT). Under the moving equilibrium assumption, changes in ft can be viewed as caused by either changes in input rate I or nutrient loss rate v.
 The Ecopath base estimate NTo of total nutrient is entered by specifying the base free nutrient proportion pf = Nf / NTo (at: Time dynamic (Ecosim) >Input > Ecosim parameters), from which the Ecosim initialization can calculate NTo as simply NTo = ∑i ŋi Bi / (1-pf). The units of nutrient concentration are contained in the per-biomass relative nutrient concentrations ŋi, and these need not be specified in any particular absolute units. During each simulation, Nf is varied dynamically by setting it equal at any time to NT – ∑I ŋi Bi, so that accumulation of nutrient in any functional group can reduce free nutrient available to promote primary production.
 Primary production rates for producer functional groups j are linked to free nutrient concentration during each simulation through assumed Michaelis-Menten uptake relationships of the form P/Bj = P/Bmax,j Nf/(Kj+Nf), where the parameters P/Bmax,j and Kj are calculated as part of the Ecosim initialization using input estimates of the ratios P/Bmax,j / P/BEcopath,j (Ecosim > Input > Group info form). The Michaelis constant Kj is set so that P/Bj = P/BEcopath,j when Nf is at the initial concentration determined by NT – ∑I ŋi Bi when all Bi are at Ecopath base values). The sensitivity to changes in nutrient concentration can be increased by increasing the input P/Bmax,j / P/BEcopath,j ratio. This will make P/Bj more variable with changes in NT and Nf.
 The default free nutrient proportion pf is set at unity, which causes Nf to be virtually constant over time (and hence P/Bj’s to be virtually independent of nutrient concentration changes). To “turn on” nutrient limitation effects, pf must be set to a lower value, (e.g., 0.3 at Ecosim > Input > Ecosim parameters).
 Be aware that this simple approach to accounting for nutrient limitation can interact with the numerical method used to simulate very fast phytoplankton dynamics over time, to cause numerical instability or “chattering” in the values of phytoplankton biomass. This happens mainly in cases where pf is low, so that Nf is initially small. Then any biomass decline in the system, (e.g., due to decline in zooplankton biomass) results in a relatively large increase in Nf, which can cause an over-response in the calculated phytoplankton biomass(es) Bj, which then drives Nf to near zero, which in turn causes too large a decrease in calculated Bj for the next monthly Ecosim time step.
 The single free nutrient concentration Nf is linked to all primary producer groups in the model (through the uptake kinetics-P/B relationships), implying competition among all plant types in the model for free nutrients. This can cause major shifts in primary production structure over time, e.g. between benthic and pelagic primary production and between grazeable and non-grazeable algal types.
 
	

			
			


		
	
		
			
	
		

		Tutorial: Incorporating environmental forcing

								

	
				 Learning Objectives
  	Obtain experience with how to incorporate environmental preference functions in EwE
 
 
 
 
 We will, once again, use the ecosystem model of Anchovy Bay that we constructed in a previous tutorial (download). The purpose of this exercise is to incorporate environmental effects using environmental preference functions.
 In preparation for this tutorial, please read the section about incorporating environmental forcing as well as the paper describing the underlying habitat capacity model[1].
 Modelling impact of changing environmental conditions
 Ecosim and Ecospace both have a flexible way to incorporate environmental effects. One can define an environmental preference function and in essence let the productivity (or other factors) be impacted by for instance temperature, O2, or pH. To illustrate the capabilities, we:
 	Set up Ecosim to use the forcing function T bottom (bottom temperature) that is included in the Anchovy Bay time series file in Table 1 (below, or download) to force temperature over time.
 	Set up Ecosim to use an environmental preference function that will translate the impact of changing temperature for one group in the system (here: whiting)
 
 Environmental forcing function
 Environmental forcing functions can also be read in as monthly values from a CSV file.
 When using environmental preference functions (such as temperature, O2, salinity) they should be read in with the appropriate units, so, e.g., temperature in ˚C – not relative to the baseline temperature.  For this exercise we will use bottom temperature, which can be read in as annual values and included in a time series file (see Table 1).
 Check your model (Ecosim > Input > Forcing function) and load a time series (the one called anchovybay T in the downloaded database) to make sure you have the “T bottom” temperature read in. If not, read it in from the CSV file (below, or download).
 [image: ]Figure 1. Screenshot (Ecosim > Input > Forcing function form) of forcing function “T bottom” read in via a CSV time series file. The function has annual bottom temperature values for Anchovy Bay. If preferable, monthly temperatures could be read in instead. 
 Environmental preference function
 We next set up the preference function. Click Ecosim > Input > Environmental responses. Next click Add (in the lower left section of the form at the right) to add a new functional response function, double click on the name of the new function (at the bottom of the lower left panel), and a form Change shape should pop up. Change the shape name to, e.g., “whiting T” as we now will setup a temperature preference function for whiting to illustrate the approach. Then select Trapezoid, and set left bottom to 10, left top to 15, right top to 16 and right bottom to 19. Note that any shape can be defined (preferably based on data); the present example is for illustration only.  Press OK.[image: ]
 Figure 2. Ecosim > Input > Environmental responses > Change shape form.
 Next click Define response, and,
 	If not done already, set X min to 10 and X max to 19.
 	Click Whiting in the Group panel and click T bottom in the Temporal drivers’ panel, then click the arrow between the two panels to assign whiting to the bottom temperature function. You should now see a histogram with the temperature distribution from the forcing function – the histogram is for information and can help ensure that your function is in the right range
 	Set X min to 10 and X max to 19 (˚C; units not shown). Click OK to close the pop-up form.
 
 [image: ]Figure 3. Ecosim > Input > Environmental responses > Define response form.
 Next, click Apply environmental response (foraging), and check that T bottom has been applied to Whiting.  If not, click the cell that intersects T bottom and whiting. On the pop-up Define Ecosim foraging capacity response form, find your “Whiting T” shape, click the green arrow to move it to the right side (and apply it), see Figure 4.
 [image: ]Figure 4. Application of Ecosim foraging response. 
 Now run the model with and without the forcing function (you can disable it on the Figure 4 form by selecting the x between the two panels, run, extract results; apply again, run, extract results), and evaluate the impact of using this forcing function and environmental preference function.
 On Ecosim > Output > Run Ecosim, click the Save output button (floppy disk) below the top menu, and check Ecosim > Run results. Run Ecosim (time series fitted version) and extract the biomass trends by group (click the save button floppy disk discussed above, and click the little yellow folder to the right of the Run results. This should open Windows Explorer with the folder where the biomass results are stored). Open the file biomass_annual.csv. Save the csv file to a different directory (to avoid overwriting it).
 The Anchovy Bay model has a number of environmental preference functions, see Ecosim > Input > Environmental responses, including ones called Temp cold and Temp warm. In the Ecosim > Input > Environmental responses > Apply environmental response foraging, select the cell that intersects Cod and bottom T, and transfer the Temp cold function to the Applied responses. Do similar for the intersect between Anchovy and bottom T, and transfer the Temp warm function.
 Run Ecosim and extract the biomass trends by group. Save the output files (as above). Compare the biomass trajectories by species with and without the environmental preference functions applied.
 Table 1. Time series file for the Anchovy Bay tutorial. You may already have this CSV file from the Time Series Fitting tutorial, if not, you can download it here, or copy the content below, paste it into MS Excel, then save it as a CSV file. Import the CSV file to EwE as described in the tutorial.
   	Title 	Sealers 	Seal B 	Trawlers 	Cod B 	Whiting B 	Shrimp C 	T bottom 	dummy 
 	Weight 	0 	1 	0 	1 	1 	1 	1 	1 
 	Pool code 	1 	2 	2 	3 	4 	7 	5 	4 
 	Type 	3 	0 	3 	0 	0 	6 	2 	2 
 	1970 	1 	1 	1 	10 	1 	0.3 	17.1 	1 
 	1971 	1 	 	1.05 	 	 	 	17 	1 
 	1972 	1 	 	1.103 	 	 	 	16.9 	1 
 	1973 	0.75 	 	1.158 	 	 	 	16.7 	1 
 	1974 	0.5 	 	1.216 	 	 	 	17 	1 
 	1975 	0.25 	0.8 	1.276 	 	 	 	16.6 	1 
 	1976 	0 	 	1.34 	 	 	 	16.4 	1 
 	1977 	0 	 	1.407 	 	 	 	16.2 	1 
 	1978 	0 	 	1.477 	6 	0.8 	 	16.3 	1 
 	1979 	0 	 	1.551 	 	 	 	16.1 	1 
 	1980 	0 	1 	1.629 	 	 	 	16.3 	1 
 	1981 	0 	 	1.71 	 	 	 	16.4 	1 
 	1982 	0 	 	1.796 	 	 	 	16.1 	1 
 	1983 	0 	 	1.886 	 	 	 	16 	1 
 	1984 	0 	 	1.98 	 	 	 	16.2 	1 
 	1985 	0 	 	2.079 	 	 	 	16.5 	1 
 	1986 	0 	 	2.183 	 	 	 	16.6 	1 
 	1987 	0 	 	2.292 	 	 	 	16.6 	1 
 	1988 	0 	 	2.407 	 	 	 	16.8 	1 
 	1989 	0 	 	2.527 	4 	0.7 	 	17 	1 
 	1990 	0 	 	2.577 	 	 	 	17.2 	1 
 	1991 	0 	 	2.629 	 	 	 	17.6 	1 
 	1992 	0 	2 	2.682 	 	 	 	17.8 	1 
 	1993 	0 	 	2.735 	 	 	 	18 	1 
 	1994 	0 	 	2.79 	 	 	 	18.2 	1 
 	1995 	0 	 	2.846 	 	 	 	18.6 	1 
 	1996 	0 	 	2.903 	 	 	 	18.7 	1 
 	1997 	0 	 	2.961 	2 	0.6 	 	18.6 	1 
 	1998 	0 	 	3.02 	 	 	 	18 	1 
 	1999 	0 	 	3.08 	 	 	 	18.9 	1 
 	2000 	0 	 	3.142 	 	 	 	19 	1 
 	2001 	0 	 	3.205 	 	 	 	19.2 	1 
 	2002 	0 	3 	3.269 	 	 	 	19 	1 
 	2003 	0 	 	3.334 	 	 	 	19.3 	1 
 	2004 	0 	 	3.401 	 	 	 	19.2 	1 
 	2005 	0 	 	3.469 	1 	0.4 	2 	19 	1 
 	2006 	0 	 	3.5 	 	 	 	18.6 	1 
 	2007 	0 	 	3.5 	 	 	 	18.5 	1 
 	2008 	0 	 	3.55 	 	 	 	18.7 	1 
 	2009 	0 	 	3.6 	 	 	 	18.6 	1 
 	2010 	0 	4 	3.65 	 	 	2.4 	18 	1 
  
 
 
 Optional: you can use the Results extractor plug-in to more easily extract results from EwE runs.
 
 Media Attributions
	Ecosim > Input > Forcing function 
	Ecosim > Input > Environmental responses > Change shape 
	Ecosim > Environmental responses > Define response form 
	Ecosim > Input > Environmental responses > Apply environmental response (foraging) 



	Christensen, V, M Coll, J Steenbeek, J Buszowski, D Chagaris, and CJ Walters. 2014. Representing variable habitat quality in a spatial food web model. Ecosystems 17(8): 1397-1412 ↵
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				[image: ]
 Figure 1. Schematic representing how tuna may mediate the feeding interaction between albatrosses and small pelagics
 The development of the mediation concept and its inclusion in EwE comes from a model failure – that’s often how we best learn how to improve models. There’s nothing like failures!  Jim Kitchell and co-conspirators such as Carl Walters were at a NCEAS working group in Santa Barbara, Ca, making an Ecosim model of the central North Pacific Ocean with focus on tuna.  They modelled how the ecosystem of the North Pacific had changed over time, starting back before tuna fisheries were introduced in the open ocean.  Their model predicted that as the tuna fisheries increased, the target tuna populations would decrease, and this would have a cascading effect on their main prey, various small pelagic fish.  This, in turn would result in more prey being available for large piscivorous birds such as albatrosses, and the model indeed predicted an increase in these birds.
 Everyone was happy with this prediction – until they presented their model and findings at a seminar at NCEAS. There, a bird biologist chimed in: “But that is not what has happened there, albatrosses declined with the introduction of tuna fisheries”, and she made it clear that it was not because of incidental catch of seabirds in longline fisheries. Back to the drawing board then. Something was indeed wrong with the model, and the discussion soon focused on a non-trophic effect where the abundance of one group may impact the feeding interactions by other predators and their prey. We call this kind of indirect trophic effect “mediation”.
 In this case, tuna tend to stay in deeper and colder oceanic waters and only occasionally make foraging sprints up to the warmer surface layers. The smaller pelagics can better cope with the warmer surface water and when there are tuna around they tend to stay up there to minimize tuna predation.  When the tuna do move up to forage, they drive the small pelagics closer to the surface. This in turn makes the small pelagics more accessible to albatrosses, which only can forage in the upper few meters of the ocean – they are not divers.  When tuna become less abundant because of fisheries pressure, there is less need for the small pelagics to stay in the upper water layers, indeed the risk of predation by birds that are better divers may well make them go deeper.  It’s a balancing act of predation risk to be a small pelagic in a risky world.
 What we have here is a mediation effect where the abundance of one group (tuna) impacts the feeding interaction between two other groups, albatrosses as predators and small pelagics as prey.  An example of how to implement this in EwE is illustrated in Figure 2.
 [image: ]
 Figure 2. Mediation function for how tuna may impact the feeding interactions between albatrosses and small pelagics. X axis is tuna biomass, Y axis is relative exposure or vulnerability of small pelagics to albatross.
 In Figure 2, the X-axis represents the biomass of the mediator, tuna. When setting up mediation (Ecosim > Input > Mediation) one can define a shape such as in Figure 2. The next step then is to define the mediating group (Define mediating groups and fleets on the same form), so that the X-axis is defined once the shape has been set.  The Y-axis represents the feeding interaction between the impacted predator and prey, which is defined at Ecosim > Input > Mediation > Apply mediation and which can be applied to consumers and producers separately[1].  In the original case, one would select tuna as the mediator, and as impacted groups, albatrosses as the predator and small pelagics as the prey.
 The blue vertical stippled line in Figure 2 represents the Ecopath base mediator (e.g., tuna) biomass, and it can be moved freely. Moving it far to the left would imply that lower tuna biomasses would not result in notable less interactions between the impacts groups, but higher would. So, that would not work for the original case, which is probably best represented where the line is now since the mediating species is not expected to ever grow much higher in biomass than its ecopath base value.
 What shape should one use for a given mediation function?  There is no clear answer to that, so you should evaluate several alternatives. This is not an issue that has seen much attention in field studies, since it is typically difficult to obtain data well spaced over a range of mediator biomass densities, though the interest is growing thanks to the implementation in EwE.  The best advice is to do what makes sense, and to try alternative formulations to evaluate their impact notably as part of time series fitting. Or, with a warning, “handle mediation functions with care”.[2]
 What do you do if the (time-varying) mediator isn’t a functional group or fleet in your model?
 Make it a group. You can for instance add a detritus group that isn’t connected to anything, and then force the “biomass” of that group with the time-varying pattern.
 
 Mediation functions are used in both Ecosim and Ecospace.  The mediation functions are implemented in the code the same way as for forcing functions (see Environmental impacts chapter). Thus, when you apply the forcing functions to a consumer, you can (as for environmental forcing functions) choose between applying to search rate (a), vulnerability (v), arena area (A), or both v and A, combined.  When applying mediation to a producer, the production rate (P/B) is impacted.
 Mediation can for instance be used to model,
 	How turbidity may impact benthic primary producers. This could be due to shading from phytoplankton or perhaps it is turbid river runoff that impacts a coral reef. In that case, define “turbidity” as a detritus group, and force its “biomass” over time.
 	How bottom trawling may resuspend nutrients and increase phytoplankton production
 	How the “whale pump” brings nutrients to the surface and makes them available for phytoplankton production
 	How bottom trawling may crush benthic organisms and make them available to scavengers
 	How oyster spat preferably settle on old oyster shells. For this, add a “shells” detritus group, and send oyster mortality to that group. Then define a perhaps linear increasing function, define the “shells” as mediator, and define the feeding interaction between oyster and phytoplankton as the impacted interaction. It may be worth a try to make oysters a multi-stanza group, and make “shells” impact the youngest stanza’s (the spat’s) feeding only.
 	How kelp, other macro algae, oyster reefs or corals may be used as hiding places for juvenile fish, thus reducing their predation risk
 	How tuna mediates the interaction between albatrosses and small pelagics, and vice versa how albatrosses scare small pelagics from the surface and mediates the interaction between tuna and small pelagics
 	How to represent decline in consumption rates by zooplankton with high biomass of inedible blue green algae[3]
 	How schooling of small pelagics to minimize piscivore encounter rates may make them more susceptible to predators that thrive on schooling aggregations, (e.g., humpback whales)
 	How cleaner wrasse may improve the health of large reef-associated fish[4]
 	How (1) fish aggregation devices (FADs) attract tuna and make them more accessible to tuna seiners, and (2) dolphins may herd certain fish towards artisanal cast net fishers, and in a symbiotic manner be rewarded with a share of the catch.[5].
 
 
  
 Media Attributions
	Screenshot from EwE, not copyrighted. 



	In principle, this can also be applied to fleets, but we have not implemented that yet. Ask if you need it. ↵
	Harvey, C.J., 2014. Mediation functions in Ecopath with Ecosim: Handle with care. Canadian Journal of Fisheries and Aquatic Sciences 71, 1020–1029. https://cdnsciencepub.com/doi/10.1139/cjfas-2013-0594 ↵
	Kao, Adlerstein and Rutherford, 2014, The relative impacts of nutrient loads and invasive species on a Great Lakes food web: An Ecopath with Ecosim analysis, Journal of Great Lakes Research, 40 (Supplement 1), 35-52, https://doi.org/10.1016/j.jglr.2014.01.010.  This paper uses four different mediation functions. ↵
	Ainsworth et al. 2007. https://www.researchgate.net/publication/228377022 ↵
	The effect required for these cases is, however, not incorporated in EwE yet. It requires that fleets can be impacted – if you need this, ask ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Mediation

								

	
				
 Learning Objectives
  	Obtain experience with how non-trophic effects can be incorporated in EwE modeling
 
 
 
 We will, once again, use the ecosystem model of Anchovy Bay that we constructed in a previous tutorial (if need be, you can download it from this link). The purpose of this exercise is to incorporate non-trophic effects through mediation.
 Mediation
 Ecosim can incorporate non-trophic effects through what we call ‘mediation’. Ecospace can use such mediation functions that are defined in Ecosim as they are non-spatial. Examples can be that phytoplankton causes shading that may have negative impact on kelp, or that bottom trawls can smash bivalves, and thus make them accessible to, e.g., crabs.
 Open the Anchovy Bay model, then open a new scenario in Ecosim, (and name it, e.g., “mediation”). Go to Ecosim > Output > Run Ecosim, and run the model. Does the model run show whales increasing and seals decreasing? It should; it’s because of the biomass accumulation rates, we provided. Next load the Anchovy Bay time series (saved version is fine, if not available then read in the Anchovy Bay time series file again[1]). Run the Ecosim model again, and check that seals are now increasing (due to stop of sealing). Take note of the end biomass of adult mackerel and of anchovy, (you can get it from Ecosim > Output > Ecosim results). Also, on the Ecosim run form, click Show multiple runs on the bar above the graph, and do another run. Ecosim will now keep the runs in memory to make it easy to compare trends between runs.
 We now pretend that seals somehow scare mackerel away so that they have less access to anchovy as prey. Perhaps the seals hang around the anchovy schools to feed on approaching mackerel schools? (It’s not a very realistic example of mediation, but it can illustrate the principles only). We will set up this mechanism in Ecosim next.
 Go Ecosim > Input > Mediation. There should be one mediation shape (1: Mediation shape 1 – you can change the name to something more instructive by clicking on Values (or double clicking the name) and then write another name, e.g., seal-mackerel-anchovy). We’ll set this up so that the X-axis is relative biomass of seals, and Y-axis is the relative feeding rate of ad. mackerel on anchovy. The stippled vertical line represents the Ecopath baseline, so unity (relative value of 1) is where this stippled line is placed (you can move it). Now click Change shape, select Sigmoid, and it’s probably fine as is. If not play with numbers). Click OK to close the form. Next click Define mediating groups and fleets, click seals and the arrow to the right to move Seals over to Assigned groups and fleets). Click OK.
 Next, we need to define what it is that seals are impacting through mediation. For this, click Mediation (consumer), and click on the cell with adult mackerel as predator and anchovy as prey. Select the 1: seal-mackerel-anchovy mediation function, click the arrow to the right, to assign this shape to the mackerel – anchovy interaction. Leave the Apply multiplier to: on Search rate (a), this will impact the search rate of adult mackerel, and with this their consumption rate of anchovy as seals biomass changes. Click OK.
 Run Ecosim again, and compare the end biomass of adult mackerel and of anchovy without and with mediation.
 Try experimenting with different shapes and try moving the vertical blue dotted line (the Ecopath baseline reference) and check for what impact it makes. How can one go about getting shapes for mediation functions in a “real” application?
 Optional:
 Add a new group to the Anchovy Bay model: kelp. Use a P/B of 7 year-1, and a B of 5 t km-2, and add a new fleet “kelpers” that harvest kelp at a rate of 1 t km-2 year-1. Kelp serves as refugia and foraging arena for juvenile fish and some invertebrates. For illustration of the method, assume that shrimp hide for cod in the kelp. Create a new mediation function and define it as we did in the tutorial above.
 Then try to increase fishing for the kelpers, and evaluate the impact this has on shrimp.
 Try alternative mediation shapes and reflect on what you consider a reasonable shape to use.
 
	If you don't have the time series file, you can create it based on Table 1 in the Environmental Forcing tutorial or download it from this link ↵




	

			
			


		
	
		
			
	
		

		Tutorial: Trawling cultivates for squid (mediation)

								

	
				Before trawling became intensive on shelves, macro-algae, sponges, soft-corals, and other large habitat-forming growth was abundant and provided shelter for juvenile fishes. Bottom trawling removes the habitat structure, opening for even more intensive trawling, and often a valuable squid fishery emerges (Figure 1). Sainsbury and colleagues[1] described this process, and found that fishers would actively promote this destruction of habitat structure in order to cultivate squid fisheries. In this exercise, we will replicate the development based on a simple ecosystem model.
 [image: ]
 Figure 1. A simple flow chart (Ecopath > Output > Tools > Ecopath flow diagram) of a food web model designed to demonstrate how trawling may cultivate the ocean bottom for squid. Y-axis indicate trophic levels while the group circles perceived as round spheres (like real footballs) are proportional to group biomasses.
 To model such a development, we develop a simple model illustrating how EwE can be used to analyze fisheries ecological issues. Open EwE, and Menu > File > New to create a new model. Then select Ecopath > Input > Basic input, and you will have a spreadsheet with only one group (Detritus) listed as you start out. Now click Define Groups > Insert until you have at least eight rows. Then write the group names for each of the functional groups from Table 1, and click in the Producer column for the phytoplankton and macro-algae groups. Now select ‘OK’ and the model will be saved.
 Table 1. Basic input parameters for the trawl-squid model. B is biomass (in t km-2), P/B is production/biomass ratio (year-1), Q/B is consumption/biomass ratio (year-1), and EE is the ‘ecotrophic efficiency’, expressing the proportion of the production for which the fate is explained based on the model. The EE is typically used to check for mass-balance in the model.
 	 	Group 	B 	P/B 	Q/B 	EE 
 	1 	Piscivores 	0.5 	0.3 	1 	 
 	2 	Small fish 	1.5 	1 	4 	 
 	3 	Squid 	0.2 	2 	10 	 
 	4 	Benthos 	4 	5 	20 	 
 	5 	Zooplankton 	5 	20 	80 	 
 	6 	Macro algae 	0.5 	0.5 	 	1 
 	7 	Phytoplankton 	10 	150 	 	 
 	8 	Detritus 	10 	 	 	 
  
 You can cut and paste the input parameters from Tables 1 and 2 directly to your model, (but you may have to enter the EE for macro algae)
  
 You should now have a model with eight groups listed, and you should now enter the basic input parameter values from Table 1. Next select Ecopath >Input > Diet composition and enter the diet compositions from Table 2.
 Table 5.2. Diet composition for the trawl-squid model, given as proportions (by weight or volume).  Predators are listed in columns.
 	Prey \ Predator 	1 	2 	3 	4 	5 
 	Piscivores 	 	 	 	 	 
 	Small fish 	0.50 	 	0.30 	 	 
 	Squid 	 	0.05 	 	 	 
 	Benthos 	0.50 	 	 	0.05 	 
 	Zooplankton 	 	0.95 	0.70 	 	 
 	Macro-algae 	 	 	 	 	 
 	Phytoplankton 	 	 	 	 	1.00 
 	Detritus 	 	 	 	0.95 	 
 	Import 	 	 	 	 	 
 	Sum 	1.00 	1.00 	1.00 	1.00 	1.00 
  
 Continue to the Ecopath > Input > Fishery > Fleets > Define fleets, and change the name from Fleet1  to Trawlers. Next, go to Ecopath > Input > Fishery > Landings and enter a landing of 0.05 t · km-2 · year-1 of piscivores. Continue to Ecopath > Input > Fishery > Discards and enter a discard of 0.3 t · km-2 · year-1 of macro algae. Next go to Ecopath > Input > Fishery > Discard fate, and specify that all the discards will go to the detritus box, (i.e. enter 1.0 on the form).
 You have now entered all the input parameters that are required for the model. You may notice on the Ecopath > Input > Basic input form that all possible (i.e. not blocked as indicated with a yellow background color) input parameters have been entered for macro algae, i.e. biomass (B, t · km-2), production/biomass (P/B, year-1) ratio and ecotrophic efficiency (EE). By entering all the basic input parameters, you are tweaking the second Ecopath Master Equation (see chapter). Where we in most cases seek to estimate either EE, we have here for macro-algae entered the EE and Ecopath can estimate M2 (predation mortality), F (fishing mortality = catch / biomass), and P/B, so to ensure mass-balance, Ecopath will instead estimate either the biomass accumulation (BA) or net migration term (NM).
 Next step is to balance the model, select Ecopath > Output > Basic estimates. 
 Having entered all basic input parameters for macro-algae EwE will ask if you want to estimate biomass accumulation for the group. You do, as macro-algae were being fished and discarded by the trawlers, and we expect their biomass to be declining in the base Ecopath-situation. This will open the results form, recognizable by the grid background being shaded, and by parameters estimated through the Ecopath mass-balance calculations being shown in blue font.
 Play with Ecopath mass-balance
 
 In this example the model will balance as entered (unless you made a mistake). You can try, however, to see the impact of impossible or unlikely values, e.g., by going back to Ecopath > Input > Basic input, and change the biomass estimate for piscivores to 5 t · km-2. You will now get a warning that EE for small fish exceed 1. Go Ecopath > Output > Mortality rates > Mortalities, and note that for small fish the instantaneous predation mortality rate is shown in red to indicate that it exceeds the total mortality rate. Check Ecopath > Output > Mortality rates > Predation mortality rates to see the breakdown of the predation mortality, and it is clear that the problem with too high predation mortality is linked to the piscivores. No big wonder, we increased their biomass with an order of magnitude, and this comes back to haunt us. So, change the biomass for piscivores back to 0.5 t · km-2 to re-balance the model.
 When going to Ecosim, it’s a good idea to go straight in and run a simulation. Run first, ask later is the philosophy.
 When we next continue to the time-dynamic simulation model, Ecosim, it will pick up that there is a negative biomass accumulation term for macro algae. So, go Ecosim > Output > Run Ecosim, and enter a title for a scenario, e.g., Base simulation. Ecosim will save all parameters it requires for a run as part of this scenario, and this way you can easily store alternative scenarios.
 Now click the Run command button, thus running Ecosim ‘as is’, i.e. with default parameter settings. The graph will show how biomasses are predicted to change relative to the Ecopath-baseline biomasses. You should see the biomass of macro-algae decreasing asymptotically. This is a consequence of us having ‘told’ the model (by specifying a negative biomass accumulation term) that in the baseline situation, the macro-algae were decreasing with a given rate.
 Why don’t macro algae just continue to extinction?  With the default parameter setting there is assumed to be a density-dependent compensation for the producer group. As some macro algae are removed through fishing, those remaining get better conditions. You can change this prediction at Ecosim > Group Info by changing the Max relative P/B for macro-algae from the default 2.0 to, e.g., 1.01,  to indicate that there will not be any density-dependent compensation. Re-run Ecosim ­– and macro-algae will be heading toward extension.
 What is then the ‘right’ value to use for this parameter? Sorry, that is your problem, you are the one who needs to know about the groups in your systems, and we highlight this to strengthen what was stressed earlier: nothing substitutes data; at least not the kind of data that leads to knowledge.
 
 In the simulation up to now (the Base simulation scenario) only the macro-algae were impacted by the trawling, for the rest a status-quo situation is predicted. We can modify this by invoking a process known as mediation (see chapter). Mediation is here defined as a process where a group has a non-trophic impact on the trophic interactions of other groups in the system. In our case, the macro-algae serve as hiding places for small fish; they can hide for the piscivores and the squid that feed upon them.
 Let us model this with a new scenario. First save your model (Menu, File > Save Model), then select Menu, Ecosim > New scenario, and enter a scenario title, e.g., “with mediation”.
 Next go to Ecosim > Input > Mediation. In the lower left panel, click Add to add a mediation shape. Next, in the lower right panel, click Define mediating groups and fleets… ’ click macro-algae, the right arrow and OK. This defines the X-axis of Mediation shape 1 as being the biomass of macro-algae. Next change the shape of Mediation shape 1 by in the top panel clicking Change shape, selecting Sigmoid and enter values as on Figure 2.
 [image: ]
 Figure 2. Mediation shape for macro algae impacting piscivore predation on small fish as well as the interaction between squid and small fish.
 We now have to apply the mediation shape. Go to Ecosim > Input > Mediation > Apply mediation (consumer) and click the interaction between piscivores and small fish (column 1, row 2). On the ‘Apply FF and mediation functions’ form that pop up, click Mediation shape 1, the right arrow, Vulnerability radio button, and OK.  Perform the same operation for the cell indicating interaction between squid and small fish
 [image: ]
 Figure 3. Screen shot from Ecosim, showing a sigmoid mediation function that is used to impact the interaction between piscivores & squid and small fish as a function of macro algae biomass (x-axis). The stippled vertical line indicates the Ecopath baseline situation, and has here been moved to the right by clicking on the graph and moving it. Lower biomass of macro-algae will cause higher feeding interaction between piscivores and small fish, higher biomass lower. So, with the stippled line where it is, it indicates that completely eradicating macro algae would make small fish ~3 x more vulnerable to their predators.  
 We now have defined that if the biomass of macro-algae is lowered there will be more interaction (higher vulnerability) between piscivores and small fish, and also that this will lead to more predation by squid on small fish. Run the simulation again (Ecosim > Output > Run Ecosim >Run), and see what happens now.
 [image: ]
 Figure 3. Ecosim > Output > Group plot for small fish. The predation mortality plot shows increased predation by squid and decreased predation by piscivores. The group plots are very informative about your model and great to explore. 
 If your group plots have more than the 9 plots on Figure 3, you can click the Select plots… at the top right to hide some plots – it just makes the plots easier to see.
 Macro-algae will decline as before, this will cause small fish biomass to decrease because of increased predation from piscivores and squid. You can check that this is actually what is happening at Ecosim > Output > Ecosim group plots > Small fish, to see the plot with predation over time for the small fish. The lower abundance of small fish next causes their major predator, piscivores, to decline for lack of food, and the squid, which are released from the predation pressure caused by small fishes, and which are losing a competitor in form of the same group, increases their biomass. Fishing effort is constant, so that’s causing the change for the piscivores.
 You can use the model to explore the impact of additional Ecosim parameters. Notice in Figure 3 how the reduced B of small fish results in a reduction in feeding time for the group, which will limit their exposure to predators. We usually sets the Ecosim > Input > Group info > Feeding time adjustment rate to 0 for all but top predators, very young age groups and perhaps zooplankton. Check what happens to small fish is you set their Feeding time adjustment rate to 0.  Will they decrease less or more?
 You can download the model for this chapter at this link.
 The conclusion? This simple model indeed demonstrates that trawl fisheries might be able to “cultivate the ground” to improve the catches of squids. Let us end by citing Keith Sainsbury as a good example of reversing common logic: “if you are considering a management intervention, and you cannot get it to work using a simple model; what is the chance it will work in reality?”
 Attribution
  This chapter is adapted and updated from Christensen, V. 2009. Ecopath with Ecosim: Linking fisheries and ecology. Page 55-70, Chapter 5 in: S. E. Jørgensen, T-S Chon, F.A. Recknagel (Editors) Handbook of Ecological Modelling and Informatics. WIT Press
 
 
 
	Sainsbury, K.J., R.A. Campbell, and W.W. Whitelaw, Effects of trawling on the marine habitat on the North West Shelf of Australia and implications for sustainable fisheries management, in Sustainable Fisheries through Sustainable Habitat, D.A. Hancock, Editor. 1993, Bureau of Rural Sciences Proceedings, AGPS: Canberra. p. 137-145. ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Mediation and noise

								

	
				
 Learning Objectives
  The purpose of this exercise is to incorporate non-trophic effects through mediation based on a factor that is not modelled directly.
 	Obtain experience with how non-trophic effects that are not modelled directly in EwE can be incorporated in Ecosim and in Ecospace
 
 	Get a sense for the difference between temporal and spatial model drivers
 
 
 
 We will, once again, use the ecosystem model of Anchovy Bay that we constructed in the very first tutorial in this text book, but in a slightly modified form (Anchovy Bay noise.ewemdb). You can download it (along with a couple of CSV files) from this link.
 Modelling impact of noise
 Ecosim can incorporate non-trophic effects through what we call mediation. The mediation functionality can also be used in Ecospace, which can pick up the mediation functions that are defined in Ecosim, but spatial driver layers will need to be defined for use in Ecospace. In this tutorial, we illustrate how to incorporate effects of external factors, i.e. factors that are not modelled directly in EwE. We illustrate this through modelling impact of vessel noise on marine mammals.
 The key question for modelling impact of noise is: what is the impact of noise? You need to consider that question, there is no model that will know it – models are not very smart, but they are good at analysis. So, a reasonable way to handle this uncertainty is to read the literature, and evaluate a reasonable scenario, plus a high and a low impact scenario, as a minimum. Or, make a suite of potential scenarios and evaluate all. That can be automated, EwE can be run from scripts.
 In this tutorial, we illustrate the procedure for how to model impact of noise, and note that the procedure can be used for other external factors as well, e.g., light impacts.
 Implementation in Ecosim
 Open the Anchovy Bay noise model, then open a new scenario in Ecosim, (and name it, e.g., “noise mediation”). Go to Ecosim > Output > Run Ecosim, and run the model to see how it behaves. It should have whales increasing because of the biomass accumulation rates, we provided for this group.
 To model impact of vessel noise, we need a mediator, in this case it can be Vessel traffic. Add a fleet to your model: Ecopath > Input > Fishery > Fleets > Define fleets, click Insert and name the new fleet “Vessel traffic” (or any name, as you please). You do not need to enter any landings for the fleet, but you will get a warning when you proceed that there are no landings for this fleet. Just disable the warning.
 Next open Ecosim, and load the time series file “vessel noise.csv” (Ecosim > Input > Time series > Import, then browse to find the CSV file). Check if there are errors (warnings in the first column) and load if not (or fix errors if any). You will for instance get an error if you did not add a fleet.
 Run Ecosim, and check (Ecosim > Input > Fishing effort) that the vessel noise increases over time. Next to to Ecosim > Input > Mediation, and add or modify a mediation function. Click Change shape, and define a linear function with Start = 1.5 and End = 0.5. Give the function a name, e.g., Noise impact. Click OK.
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 Figure 1. Screenshot from EwE showing a mediation shape that can be used for modelling the impact of noise. The vertical (blue) dotted line represents the Ecopath baseline situation and it can be moved.
 You should now have a shape as in Figure 1. The stippled line represents the Ecopath baseline (time 0 in Ecosim), move the stippled line to the left (as in Figure 1). This shape now indicates that if vessel traffic increases 6-7 times, this will result in something (whatever will end up being at the Y-axis), decreasing from unity to around 0.4. If vessel traffic increases more than 6-7 times (i.e. beyond the scale of the X-axis), the Y-factor will remain at 0.4.
 Next, just below to the right of the mediation shape, click Define mediating groups and fleets, and assign Fleet 6, Vessel traffic, to the shape by clicking it in the left column to move it over to the right. Notice that if you for instance have noise impact for each fleet, you could assign more fleets – with corresponding weighting factors – some are noisier than others.
 Go back and run Ecosim (Ecosim > Output > Run Ecosim), and click Show multiple runs.
 Next define what is mediated; Ecosim > Input > Mediation > Apply Mediation (consumer), click 1 in the top row. This will bring up the Apply Mediation interface, where you can apply the Noise impact function over to the right, let it impact Search rate (the default). Click OK, and the Noise impact should now be impacting the feeding of whales. More noise decreases the efficiency of their search rate. Go back and run Ecosim again. Any difference?
 You can put numbers on the difference, by extracting biomass integrated over time from the Ecosim results form (Ecosim > Output > Ecosim results) after each run.
 Implementation in Ecospace
 Load an Ecospace scenario. Go to Ecospace > Input > Maps, and in the right-hand column, select Fisheries (), Sailing cost, and select Vessel traffic in the drop-down list. Double-click the label Sailing cost – Vessel traffic and a form with a spreadsheet will pop up. Here, select Import > From CSV and browse to find the file called Anchovy Bay-Sailing cost (6-Vessel traffic).csv. This will load a “sailing cost” which will be used to distribute the Vessel noise (from the fleet effort) spatially. This approach is a “hack”, which we can use for now – we will be adding a more explicit and direct way to include such impacts in a coming software update.
 Run Ecospace and evaluate the results with and without the noise mediation. Compare. An easy way to model with and without in succession is to go back to Ecosim and remove (or insert) the Apply mediation to whales.
 Compare the impact of noise between Ecosim and Ecospace runs. Where is it most pronounced? Why?
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		Fitting Models to Data
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		Density-dependence, carrying capacity and vulnerability multipliers

								

	
				An important feature of Ecosim is that it provides a straightforward approach for exploring alternative views for how the biomass of prey groups are controlled by a predator – or if they are. The two extreme views are “predator” control (also called “top-down”) and “prey control” (or “bottom-up”) – concepts that are quite difficult to fully grasp.  But they become really important when you start comparing a model to historical data as a way of establishing credibility of the model’s predictions, because assumptions about them dramatically impact whether the model can “track” or reasonably represent known historical disturbances such as increase in fishing mortality rates.  Thus our main attention in both qualitative and quantitative methods for comparing EwE models to data is at least initially on the parameters that determine the pattern of trophic control.
 We model this interplay between predator and prey control using “vulnerability multipliers,” which provide a factor for how much an increase in predator abundance may impact the predation mortality that it is causing on a given prey.
 	Low vulnerability multipliers (close to 1) mean that an increase in predator biomass will not cause any noticeable increase in the predation mortality the predator may cause on the given prey (see Figure 3.1).
 	High vulnerability multipliers, (e.g., 100), indicates that if the predator biomass is for instance doubled, it will cause close to a doubling in the predation mortality it causes for a given prey.
 
 [image: ]
 Figure 1. Lesser flamingos in Lake Nakuru, Kenya. Millions of flamingos overwinter in the lake where they feed on brine shrimp (Artemia) in the shallow parts of the lake. Do flamingos control the prey population? Or is it the productivity of the Artemia population that determines how much the flamingos get to eat? Would twice as many flamingos eat twice as many Artemia?
 On carrying capacity
  When a predator is at its carrying capacity, its production depends on how productive its prey populations are. If it’s a good year in the environment with high prey production, there will be more food for the predator – and its carrying capacity may increase. Vice versa if productivity is low. How much a predator population gets to eat depends on how productive their prey populations are. So, when a predator is close to its carrying capacity the system is “bottom-up” controlled. In this case, the Ecosim vulnerability multipliers are low, close to 1.
 If the predator is far from its carrying capacity, the predator has very little control over its prey populations (there are too few of them!), but it’s called “top-down” control because how much the predators eat depends on how many predators there are (rather confusing, eh?) Twice as many predators may eat twice as much food (and hence cause twice as high predation mortality) but have no notable impact on the prey population (still, it’s called “top-down” control). Here, we need to use high vulnerability multipliers in Ecosim.
 You can think of it like this. The vulnerability multiplier sets how many times the predation mortality a predator is causing on its prey may increase if the predator population were to increase to its carrying capacity. If that multiplier is 100, then the predator is far from its carrying capacity – the population can perhaps grow >100 times before reaching carrying capacity. “>100” because the competition between the predators will be intense when they are at carrying capacity, so the average individual will get less food than if their population was much lower.
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 Figure 2. Relationship between biomass of a predator and the predation mortality it causes on a given prey, as well as the corresponding Q/B for the given predator and prey (assuming that the predator does not reduce prey biomass substantially). Vulnerability multipliers, v, are estimated as max. predation mortality/baseline predation mortality, (e.g., 5 at the left-most stippled line). Baseline mortality is the mortality caused by the predator in the underlying Ecopath model.
 If we illustrate the relationship between predator biomass and Q/B (this is not an assumption in the actual Ecosim calculations) and assume that the predator in question does not cause any substantial (actually no) change in the prey biomass, we can calculate the relative Q/B for the predator (see Figure 2). For higher predator biomass, a change will result in relatively stable predation mortality. Hence, if biomass is impacted so as to cause a reduction, the individual predators will get more, their Q/B increase and this will largely compensate for the reduction in their abundance, bringing the biomass back up again.
 At lower biomass, Q/B will also increase, but to a lower degree. This is illustrated in Figure 3 showing how halving or doubling the predator biomass will impact the relative Q/B. At high biomasses, halving biomass results in close to a doubling in Q/B, which will tend to keep biomass high. There is, however, less and less relative surplus production as we move to the left on the curve. If biomasses are doubled instead, the Q/B will decrease when biomasses are high, resulting in a decrease in biomass back toward the original level, i.e., the biomasses will be stable when close to carrying capacity (where v’s are low), and unstable when far below carrying capacity (where v’s are high).
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 Figure 3. Relative increase (%) in Q/B as a function of predator biomass resulting from the predator biomass being halved or doubled. At high predator biomasses (i.e. near the carrying capacity for the given predator-prey interaction) a halving of predator biomass will result in nearly a doubling in the Q/B for the predator. The resulting surplus production will tend to bring the predator biomass back to the original level, and the overall effect is that the predator biomass will change only little. Conversely, a doubling of predators will cause the Q/B to be halved at high predator biomasses (resulting in very little effective change in biomass), while a doubling at low biomasses will result in only a very small reduction in Q/B.
 If vulnerabilities are high, the amount of prey consumed by the predator is the product of predator times prey biomass, i.e., the predator biomass directly impacts how much of the prey is consumed. Such situation may occur in a situation where the prey has no refuge, and is thus always taken upon being encountered by a predator. Such top-down control, also known as Lotka-Volterra dynamics, easily leads to rapid oscillations of prey and predator populations and with it, making it impossible to maintain prey populations in a model.
 Lotka-Volterra dynamics imply that a predator’s consumption equals number of predators times number of prey times a search rate factor.
 More predators means more consumption, and more prey means more consumption.
 
 In Ecosim, however, top-down control implies that a predator is far from its carrying capacity. Hence, if there’s only a small predator population around and conditions (available food, mortality reduction) allow it, the predator population may grow towards its carrying capacity. How much it may grow, given favourable conditions, depends on the vulnerability multiplier.
 If you are modelling an area where a predator population is close to its carrying capacity – maybe something like Kingman Reef where apex predators make up 85% of the total fish biomass – then those predators depend on how productive the prey population is. More predators does not mean more prey consumption, the system is bottom-up controlled, and vulnerability multipliers should be low for such predators.  This is a stable ecosystem configuration. If a burst of fishing should occur at Kingman Reef, those fish that are left will see improved prey conditions, their Q/B will increase, and the population will grow back towards its carrying capacity.
 Bottom-up control can also occur where a prey is protected most of the time, (e.g., by hiding in crevices) and becomes available to predators only when it leaves the feature that protects it. Here being caught is a function of the prey’s behaviour. Bottom-up control implies stable system conditions, so it’s associated with only small biomass changes in the prey and predator(s) concerned for instance as a function of fishing pressure.
 The converse (top-down control) is the situation that occurs when a predator population is far from its carrying capacity – for instance because the population has been fished to the brink. In this situation, there are only few predators around and their prey populations may have increased due to predator release or cascading.
 To model this interplay between top-down and bottom-up control in predator-prey interactions, the group biomasses in the underlying Ecopath model were in the foraging arena theory[1] [2] [3] [4] in Ecosim conceived as consisting of two components, one vulnerable and one invulnerable to predation. We’ll discuss this in more detail in the next chapter.
 Model behaviour depends strongly on the vulnerability multipliers. How do you set those then? The most common way is to fit the model to time series data, which may imply fitting to vulnerabilities along with environmental productivity (see chapter). It worth remembering though that the vulnerability multipliers are not “nuisance parameters” (i.e. parameters which have no specific interpretation), but express how far a predator population is from its carrying capacity
 Vulnerability multiplier = how many times might this predator increase the predation mortality it’s causing on its prey, if it were to grow to its carrying capacity?
 
 Carrying capacity is not constant; in Ecosim the vulnerability multipliers are relevant for and used only in the Ecopath baseline. Carrying capacity may then change for each and every time step in Ecosim if need be. Ecosim considers that and populations may change accordingly.
 If you reflect on figures such as Figures 2 and 3, note that the x-axis is biomass. That implies we are talking about density-dependence, how much impact a predator has on its prey populations and how much a predator gets to eat is density-dependent.
 
 Quiz
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/ewemodel/?p=996#h5p-2 
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				Ecosim predictions are sensitive to the Ecopath input parameters (usually biomass, production and consumption rates, diet, and fishery removals) as well as the predator-prey “vulnerability multipliers”, which are conditioned on the Ecopath inputs and tuned during model calibration.  In Ecosim, vulnerability multipliers have implications for stock-recruit dynamics, density dependence and compensation, carrying capacity, stock resiliency, interspecific interactions, and ecosystem energy flow[1]. However, the effect of different calibration strategies on the estimation of vulnerability multipliers in Ecosim and emergent stock productivity estimates has not yet been demonstrated, nor do we understand in a comprehensive way how sensitive model outputs are to different approaches and how this may influence derived advice.
 Ecosim predictions of consumption based on a simple mass-action model have been modified to consider the non-random dynamics of the foraging arena[2] [3] [4]. Prey biomass pools in Ecosim are dynamically divided into vulnerable and invulnerable components, which imply behavioural or physical mechanisms that limit the rate at which prey become vulnerable to predation (Figure 1[5]). The transfer rates between these components determine the amount of prey available to a predator and thus the degree to which a change in predator biomass will impact predation mortality and prey biomass.
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 Figure 1. Simulation of  flow between available (Vi) and unavailable (Bi−Vi) prey biomass in Ecosim. aij is the search rate of prey i by predator j, v is the exchange rate between the vulnerable and un-vulnerable state. Fast equilibrium between the two prey states implies Vi=vBi/(2v+aBj). Based on Walters et al. (1997).
 These transfer rates, or “vulnerabilities” (vij) as they are more widely known, influence predator and prey biomasses by regulating the consumption rates (Qij) of a predator j as described in the Ecosim predicting consumption chapter. 
 When working with Ecosim, one cannot adjust vulnerability exchange rates (vij) directly. Instead, this is done via vulnerability multipliers (kij), which can be more easily interpreted as the maximum increase in predation mortality rate that a predator can exert on a prey if the predator were to grow to its carrying capacity. The increase is relative to baseline Ecopath predation mortality rates (M2, where M2=Qij/Bi)  The vulnerability exchange rates (vij) are then set to the vulnerability multiplier (kij) multiplied by the baseline predation mortality (M2), i.e. vij=kijM2. Multipliers can range from one to infinity with two as the default value.
 The vulnerability multipliers are derived from the Ecopath baseline, and do not automatically change when running Ecosim across years. Ecosim dynamically handles the consequences of changes in predator and prey abundance based on the baseline situation, including changes in carrying capacity over time. The default value for kij of 2.0 assumes that the predation mortality rate can double at most, while a value down near 1.0 means that the predator is at its “carrying capacity”, which by definition means it fully utilizes its prey, so it cannot further increase the predation mortality it’s causing on the prey.
 High vulnerability multipliers imply top-down control, and low bottom-up control. Top-down control occurs where a predator is far from its carrying capacity, here, e.g., a doubling of predator abundance may result in close to a doubling in the predation mortality it are causing on it prey. With low vulnerability multipliers where a predator is at its carrying capacity, any increase in consumption has to be linked to changes in prey productivity – i.e. to bottom-up factors.
 For exploited species, it is thus extremely important to recognize that vulnerability multipliers do not only reflect the ecological limits caused by prey and predator behaviour, but also how depleted the exploited species is in the base Ecopath biomass state relative to the natural level (i.e., carrying capacity) that might be achieved if fishing were stopped. As such, for overexploited species to recover following reduced fishing, vulnerability multipliers need to be set relatively high so that predators can consume far more prey than in the initial Ecopath snapshot. Higher vulnerability multipliers tend to make groups more sensitive and responsive to changes in fishing mortality.
 Over time, multiple approaches to parameterize the vulnerability multipliers have been developed and adopted (Figure 2). While some approaches derive estimates from a priori knowledge and ecological observations or hypotheses in data-poor situations[6], users are more frequently turning to formal statistical estimation using calibration time series and a tuning process when time series are available[7]. Statistical fitting routines estimate vulnerability multipliers that bring simulations closer in-line with observations. However, users should be cautious, as statistically optimized multipliers may stray away from values that might be considered ecologically realistic. A thorough sense check is always recommended. The following sections explore these different approaches in more detail.
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 Figure 2. Pathways for estimating vulnerability multipliers (kij) in Ecosim. All pathways end with a reference to peer-reviewed examples.
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				 Vulnerability multipliers are perhaps easiest to understand when it is recognized that they reflect how far an exploited predator is from its carrying capacity (e.g., interpreted as unfished state); vulnerability multipliers should allow consumption rates that enable a species to recover from its Ecopath biomass to its unfished biomass if fishing ceases. EwE can use the ratio between a group’s unfished biomass and its Ecopath base biomass to estimate vulnerability multipliers for exploited groups, see, e.g., the EwE User Guide vulnerability multiplier estimator chapter.
 An added corollary is that the unfished state may be associated with high abundance of top predators and low abundance of their prey due to high predation mortality. If such top predator populations are fished down, predator release may cause the prey to increase. For those prey, the vulnerability multipliers should thus be set to a high value, even though the baseline model represents the unfished state.
 It can indeed be difficult to specify reasonable vulnerability multipliers for non-exploited species. Here, vulnerability multipliers need to be considered in the context of the foraging arena: the fine-scale spatial structure of the trophic interactions and what proportion of prey may be vulnerable to predation at any moment (Figure 1). The activity, spatial restrictions, and distributions of species provide insight into the likely vulnerability of prey to predation. This in turn provides a starting point from which it is possible to assign vulnerability multipliers. The distribution of predators could be restricted by limited mobility, habitat requirements, or the predation risk they face themselves, whereas prey vulnerability may be influenced by the time they spend in and out of safe behavioral states. This can be related to the availability of shelter, such as macroalgae, or specific ontogenetic life stages (for example juvenile fish may allocate less time to foraging), or be more restricted spatially (and thus unable to access vulnerable pools of prey) than their adult counterparts. Different behaviours, such as dispersal behaviours (e.g., moving to spawning sites), aggressive behaviours, or evolutionary behaviour (e.g., changes in shoaling dynamics) may also influence vulnerability to predation.
 Trophic levels have also been used to approximate vulnerability multipliers in situations where time series data were unavailable under the dubious assumption that the vulnerability multipliers are proportional to the trophic level of the predator. This approach assumes that higher trophic levels are further removed from their unfished biomass than lower trophic levels, typically because of historical overfishing. This may seem a reasonable assumption considering how global fisheries have historically targeted and depleted higher trophic level fish stocks[1] [2], but conflicts with the concept of using a priori knowledge to parameterize vulnerability multipliers based on region specific trends in historical exploitation or ecology.
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 Figure 1. Using history and ecology to estimate vulnerability multipliers (kij) in Ecosim. The illustration at the top of the figure provides examples where kij estimates can be inferred from functional group ecology and life history. Model simulations demonstrate how (a) prey vulnerability influences predator-prey biomass trajectories when predator biomass increases and (b) how kij estimates impact the rate of functional group recovery following reduction in fishing (inset figure).
 Finally, an approach to setting vulnerability multipliers was applied by Chagaris et al.[3] to constrain how much predation mortality by a given predator could increase relative to a prey’s total natural mortality
 [image: k_{ij}=\frac{M2_{cap}\cdot M_i}{M2_{base,ij}}\tag{1}]
 where M2cap defines the proportion of the natural mortality of a prey that a predator can be responsible for, Mi is the natural mortality of prey i, and M2base.ij is the base predation mortality by predator j on prey i. There may be ecological reasons, or reasons derived from data, to prevent a single predator from being accountable for large proportions of a prey’s natural mortality. Using these kij instead of default or model estimated values, (which are often higher) may also be driven by ambitions for model performance: Chagaris et al.[4] found that extremely high kij estimated by Ecosim led to instability at high fishing mortality rates when evaluating equilibrium yield curves, and  using M2cap values between 0.75 to 1.0 led to more reasonable estimates for FMSY (the fishing mortality at maximum sustainable yield) while also constraining theoretical maximum predation mortality rates to values that were compatible with prey natural mortality rates.
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				It is becoming more common for Ecosim vulnerability multipliers and primary production anomalies to be estimated using statistical routines, with Heymans et al.[1] demonstrating that it is best practice to estimate vulnerability multipliers by fitting model simulations to time series reference data. Longer time series are preferable as they provide an opportunity to explore important drivers of change and tend to have strong contrast in the data, which improves the model’s ability to estimate parameters, leading to more confidence in our assessment of ecosystem dynamics.
 Model fitting that includes estimation of primary production anomalies is basically the ecosystem equivalent of estimating recruitment and mortality anomalies in state-space approaches to parameter estimation for single-species models, a key difference being that the anomaly estimates may be informed by correlated variation in time series patterns of multiple species.
 The quality (precision, informative contrast over time) of time series data is important, especially if the fitted model is to be used for management purposes, as vulnerability multipliers (and thus predation rate changes), will be used in forward simulations to times beyond the data. In Ecosim, users can weight time series data to represent how reliable or variable time series are compared to the other reference time series. Low weights imply that the data either has high variance or is unreliable (e.g., underestimated or uncertain catches). Weightings impact the contribution of time series to the assessment of model performance, where a weight of 0 indicates that the time series will not be used in the calculation of “goodness of fit”. Weightings can be assigned based on a qualitative assessment of data pedigree (e.g., based on data origin), or by using more quantitative information, such as confidence intervals from survey estimates, the retrospective analyses of stock assessment models, or signal to noise ratio assessments[2].
 The procedure for estimating vulnerability multipliers and production anomalies that improve the fit of model simulation to calibration data is based on minimization of a sum of squares (SS) of prediction errors, which is then checked for overparameterization using the Akaike Information Index (AIC)[3] [4].
 The SS is used to calculate a log likelihood criterion (Figure 1), assuming normally distributed deviations of log model predictions from log observations, evaluated at the conditional maximum likelihood estimate of the prediction error variance and scaled in the case of relative observations (y) by the maximum likelihood estimate of the relative simulation scaling factor (q) in the equation y = q x X,  where X is the absolute observation. Model fitting then proceeds by numerical search procedures to seek parameter values that minimize SS.
 When generating a set of model fits under different fitting hypotheses or methods for choosing what parameters to include in the SS, AIC is then used to identify the model of best fit. AIC is a tool for model selection that penalizes for fitting too many parameters relative to the time series available for estimating the SS and is calculated as
 [image: AIC = n \cdot \ln (\frac{minSS}{n}) + 2K\tag{1}]
 where n is the total number of observations, or time series values, from the loaded calibration time series and K is the number of parameters estimated. When sample size is small, there is a large probability that AIC will select models with too many estimated parameters (i.e., overfit models). The modified AICc can be used to address this potential overfitting by including a correction for small sample sizes
 [image: AIC_c = AIC + 2K \cdot (\frac{K-1}{n-K-1})\tag{2}]
 As a rule of thumb[5], AICc should be used unless n/K > ~40. In other words, unless the number of estimated parameters equates to a minimum 2-3% of the amount of data, use AICc. AICc should therefore be used when assessing EwE model performance.
 A word of caution, the AIC calculations assume that the observations are independent whereas timeseries data such as typically used for ecosystem modelling have high autocorrelation. For this reason, it is advisable to test the impact on assumptions about n on model selection.
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 Figure 1.  Overview of the Ecopath and Ecosim modelling process. Using log likelihood criteria, vulnerability multipliers or production anomalies (e.g., climate or nutrient loading) may be estimated based on a non-linear search routine and vulnerability multiplier (vulmult) estimation. Prediction (fitting) failures after each estimation trial then inform judgmental changes in model structure and parameters. B is biomass, Z is total mortality, C is catch, W is average weight. Subscript 0 refers to the Ecopath model base year, and CC to carrying capacity. Bcc/B0 refers to vulmult. From Christensen and Walters[6].
 
 
 
 Multiple approaches have been developed to statistically estimate vulnerability multipliers (see Figure 2 in Vulnerability and vulnerability multipliers chapter). They can be estimated for predators, providing a single multiplier limit to all of a given predator’s base predation rates, and they can be estimated for individual predator-prey relationships, which assumes that the multiplier limits are heterogeneous across prey. This choice tends to be associated with user preference, ecological justification, or determined based on the approach that produces the best fit model. Whether estimating predator or predator-prey vulnerability multipliers, there are a few ways to select which vulnerability multipliers should be estimated:
 	manual selection based on a priori knowledge or species priority;
 	select vulnerability multipliers for groups with calibration time series; or
 	select the most sensitive vulnerability multipliers (i.e., those that when changed have the largest impact on SS).
 
 Manually selecting vulnerability multipliers allows for an early integration of ecological information but may lead to a sub-optimal model fit if the SS is not sensitive to the selected multipliers. Conversely, the sensitivity search may optimise model fit but it is purely statistical and does not know what makes sense ecologically. Only estimating vulnerability multipliers for groups with time series acknowledges that, to some degree, the parameter should be constrained by the available time series. The level of group connectedness within the food web (e.g., group consumption and predation) may also constrain the parameter search if changes in vulnerability multipliers impact the  contribution of other groups.  Groups that do not have informative time series or, have low connectedness in the food web, have widely variable estimated vulnerability multipliers – search routines can change those without any penalty incurred.
 Choosing how many vulnerability multipliers to estimate, without overfitting is another point of confusion and discussion. The number of vulnerability multipliers that can be potentially estimated is often significantly more than the data available to constrain simulations. EwE best practices suggest that a conservative number of Degrees of Freedom (DoF) and therefore parameters to estimate is one less than the number of calibration time series available[7]. This approach recognizes that values within time series are highly autocorrelated, viewing each time series as an “independent observation”, but  the  approach could be overly conservative, especially if long time series are available– especially if the contrast (ups and downs) and are not just one-way trajectories.
 Both manual and automated statistical calibration routines are available in Ecosim to search for vulnerability multipliers. The manual approach can be arduous when testing multiple fitting hypotheses (e.g., with or without fishing effort or primary production anomalies) as the number of plausible fitting combinations can easily reach the hundreds, if not thousands, increasing the likelihood of user error. In the past, users have overcome this issue by only testing the nth fitting scenario (e.g., 5, 10, 15 vulnerability multipliers etc.)[8] However this approach risks overlooking the vulnerability multiplier combination, which produces the best statistical fit. The stepwise fitting procedure developed by Scott et al.[9] automates this process, allowing for a broad exploration of the parameter space which accelerates the process and removes the problem of user error. Recent improvements to the automated approach have increased the computational speed by enabling multiple fitting scenarios to be tested simultaneously using computers multithreading capabilities (J. Steenbeek, pers. comm.).
 Novel approaches to estimate vulnerability multipliers using the manual and automated fitting routines have also been developed for two EwE models which are being used operationally to inform fisheries catch advice. Bentley et al.,[10] employed an approach, which combined searches for predator vulnerability multipliers and predator-prey vulnerability multipliers, whereas the approach developed by Chagaris et al.[11] uses the manual fitting tool in Ecosim to iteratively estimate the  most sensitive predator-prey vulnerability multipliers over multiple sequential (repeated) tuning iterations.[12].
 It is worth reiterating that statistical estimation of vulnerability multipliers does not necessarily have any bearing on ecology. While it is possible to exclude vulnerability multipliers from the search routine, there is currently no mechanism to include prior information or ecologically sensible bounds to constrain the limits for vulnerability multipliers included in the search routine. A judgement evaluation following the formal estimation of vulnerability multipliers should be applied to:
 	reflect on the ecological assumptions attached to estimated vulnerability multipliers,
 	assess how realistic functional group simulations are (in hindcast and future), and
 	understand and fix issues with model structure and parameterization (Figure 1) .
 
 It is possible to view the fit of each functional group to calibration time series and its contribution to the overall SS in Ecosim via the Ecosim > Output > Ecosim group plots form. This is often used to screen issues with model simulations, such as contradicting trends or misalignment in initial time steps, and direct fixes.
 However, what is often not accounted for when estimating vulnerability multipliers is their impacts on the advice products such as FMSY or food web indicators. The focus is often only on the goodness of fit of the model, but the impacts of estimated vulnerability multipliers on predictions and reference points should be evaluated[13]. We next provide two case studies to explore how alternate fitting approaches impact the emergence of vulnerability multipliers and how vulnerability multipliers impact model outputs.
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				The Anchovy Bay ecosystem model that is used to describe and test EwE scenarios throughout this text book was used to investigate how vulnerability multipliers emerge (and whether they re-emerge through fitting) and how this process is influenced by:
 	noise in the calibration data, and
 	the chosen approach for estimating vulnerability multipliers: “predator” or “predator-prey” vulnerability multipliers.
 
 We investigated the impact of emerging vulnerability multipliers on biomass and catch simulations and estimates of fishing mortality consistent with maximum sustainable yield (FMSY).
 Building a base Ecosim model[1]
 Ecosim simulations for Anchovy Bay were created by adding temporal trends to fishing effort and adjusting vulnerability multipliers. Simulated fishing effort trends  reflected trends often seen in reality:
 	sealers fishing effort followed an exponential decline as may be expected in response to conservation efforts/policy,
 	trawlers fishing effort followed an exponential decline under the assumption that whitefish (cod and whiting) stocks have been overexploited, leading to reductions in effort to encourage stock recovery,
 	seiners and bait boat effort followed a slight linear increase in response to growing demand, and
 	shrimpers effort increased assuming fishers shifted their target species to shrimp following reduced opportunities to catch white fish.
 
 Vulnerability multipliers (kij)  were adjusted following ecological assumptions and assumptions linked to the fishing effort trajectories. To distinguish between scenarios more easily, predator vulnerability multipliers will hereafter be denoted as kj, while predator-prey vulnerability will remain as kij. For predator  estimates, a mix of high, low and default  estimates were applied. For groups which were assumed to be overexploited,  values were estimated using the “Estimate Vulnerabilities” interface. For the predator-prey estimates, the Ecosim sensitivity search was used to identify the 10 most sensitive predator/prey kij parameters, which were then adjusted to ensure a range of high and low kij estimates were included.
 For the purpose of this exercise, these two simulations (one with predator kj and one with predator-prey kij) were viewed as perfect representations of their ecosystems, i.e., the biomass and catch simulations were “real observations”  driven by the “true” vulnerability multipliers. The aim of the following exercise was to test whether, when using these “real observations” as calibration time series, the “true” vulnerability multipliers would reemerge, and whether the addition of noise to the “real observations” had any impact on the emerging vulnerability multipliers. Biomass and catch simulations were extracted from Ecosim and four scenarios for observation data quality were prepared: noise (random noise, normally distributed around the mean (true) biomass trend to represent observation error) was added to the calibration time series with coefficients of variation (CV) of 0 (no noise) 0.1, 0.3, and 0.5.
 Predator vulnerability multipliers
 Vulnerability multipliers were reset to the default value of 2; fishing dynamics were not changed from those used to produce the “real observations.” The exported biomass and catch time series were used as calibration time series to estimate predator vulnerability multipliers for the functional groups seals, cod, whiting, shrimp, benthos, and zooplankton using the manual stepwise fitting interface. kj values for groups which had values of 2 in the initial model were not altered.
 Figure 1 shows how kj parameters emerged after model calibration, and how this altered functional group carrying capacities in the absence of fishing and FMSY estimates. kj values which emerged when estimated using the calibration time series with no noise were similar to the “true”  parameters (Figure 1a). Adding noise to the calibration time series led to divergence between the estimated kj values and the “true” parameters, highlighting the impact data quality can have on the fitting procedure and thus stressing the importance of evaluating the suitability of time series before using them to drive model calibration. The variability in kj re-emergence under the four data quality scenarios was also unique to specific functional groups, for example: kj estimates for cod showed greater re-emergence accuracy (or consistency) when compared to other functional groups. Cod is highly connected within the food web (i.e., cod is an opportunistic predator which is also preyed upon by higher trophic levels), therefore vulnerability multipliers which improve the model fit tend to be more constrained due to their potential to have large cascading impacts on the wider food web.  In addition, cod also experienced a period of collapse followed by recovery, which provides much needed contrast for the model to reliably estimate the vulnerability multipliers.
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 Figure 1. Estimation and impact of predator vulnerability multipliers (kj). The Anchovy Bay ecosystem model was calibrated against generated time series with incremental coefficients of variation (CV) to identify the impact of time series quality on (a) kj re-emergence and how kj estimates impacted (b) functional group carrying capacities in the absence of fishing and (c) estimates of relative fishing mortality consistent with achieving Maximum Sustainable Yield (FMSY).
 Functional group carrying capacities and estimates of FMSY were impacted by emerging  values (Figure 1b and 1c). Carrying capacities from scenarios with   parameters calibrated against data with no noise were most similar to those achieved with the “true”  parameters (Figure 1b), with dissimilarity generally increasing with the addition of noise to the calibration data. The importance of acknowledging the impact of  estimates beyond model fit is demonstrated with the resulting FMSY estimates: relative changes to FMSY estimates mirrored the deviations of estimated  values relative to the “true”  values (Figure 1c). Increases in  values led to decreases in FMSY, while decreases in  values led to increases in FMSY This is because higher  values enable groups to recover faster with the cessation of fishing and reach a higher carrying capacity, but they also decrease stock resilience to increases in F (functional groups decline faster and more severely if you increase their ).  It is worth noting that where differences between true and estimated FMSY occurred, they were not proportional to the difference in true and estimated vulnerability multipliers (i.e., large changes in kij do not result in equally large changes to FMSY).
 Predator-prey vulnerability multipliers
 Similar to the predator scenario, vulnerability multipliers were reset to the default of 2, and the exported biomass and catch time series (generated with “true” predator-prey vulnerability multipliers) were used as calibration time series to estimate predator-prey vulnerability multipliers. Predator-prey values for the ten most sensitive predator/prey parameters were estimated using the manual stepwise fitting interface. Figure 2 shows how  parameters emerged and how this altered functional group carrying capacities and FMSY estimates.
 In comparison to the emergence of predator vulnerabilities, the emergence of predator-prey vulnerabilities was less constrained with examples of poor  re-emergence accuracy across all calibration data scenarios (Figure 2a).  Functional group carrying capacities showed higher dissimilarity from their baseline when compared to predator simulations and their baseline (Figure 2b). Carrying capacity dissimilarity increased with the addition of noise to the calibration data, however simulations with no/low noise were notably more dissimilar when estimating predator-prey vulnerabilities as opposed to predator vulnerabilities (Figure 2b) which is due to the greater differences in kij estimates.
 Relative FMSY estimates, influenced by predator-prey kij values, showed higher dissimilarity from their baseline (Figure 2C) when compared to FMSY estimates influenced by predator kj values (Figure 1C). The links between predator-prey kij values and FMSY are less obvious than the links between predator kj values and FMSY due to the more complex interaction-specific consumption limits. This is particularly true for groups with mixed diets (e.g., cod, whiting, seals, and mackerel) while links between predator-prey  values and the FMSY estimates for groups, which are heavily dependent on a single prey group were observed for anchovy (FMSY mirrors the anchovy/zooplankton kij estimates) and shrimp (FMSY mirrors the shrimp/benthos kij estimates).
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 Figure 2. Estimation and impact of predator-prey vulnerability multipliers (kij). The Anchovy Bay ecosystem model was calibrated against generated time series with incremental coefficients of variation (CV) to identify the impact of time series quality on (a) kij re-emergence and how kij estimates impacted (b) functional group carrying capacities in the absence of fishing and (c) estimates of relative fishing mortality consistent with achieving Maximum Sustainable Yield (FMSY).
 Attribution This chapter is based on Bentley JW, Chagaris D, Coll M, Heymans JJ, Serpetti N, Walters CJ and Christensen V. 2024. Calibrating ecosystem models to support marine Ecosystem-based Management. ICES Journal of Marine Science, https://doi.org/10.1093/icesjms/fsad213. Adapted based on CC BY License. Rather than citing this chapter, please cite the source.
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				The Irish Sea EwE model[1] and Northwest Atlantic Continental Shelf EwE model[2] (hereafter called NWACS-MICE) have both been used to inform fisheries advice for their respective regions using ecological/ecosystem reference points[3]. Both models were designed to focus on commercial fisheries however, they have very different structures in terms of model complexity (Table 1). The two models were used to demonstrate the outcomes and management implications of vulnerability multiplier (kj or kij) estimation and compared estimates of FMSY and ecosystem indicators. Ecosystem indicators selected for this analysis included total system biomass, commercial biomass, total catch, system diversity (Kempton’s Q), the trophic level of the catch, and the trophic level of the community. Estimates of FMSY and ecosystem indicators were compared across the following nine fitting approaches:
 	Predator kj values, where the number of parameters estimated is one less than the number of available calibration time series (K-1).
 	Predator kj values estimated for all functional groups with time series.
 	Predator kj values using the automated stepwise fitting approach, where the applied kj values are taken from the model with the lowest AICc, and the vulnerabilities are reset to the default (2) at each fitting iteration.
 	Predator kj values using the automated stepwise fitting approach, where the applied kj values are taken from the model with the lowest AICc, and the vulnerabilities are retained from previous fitting iterations.
 	Predator-prey kij values, where the number of parameters estimated is one less than the number of available calibration time series (K-1).
 	Predator-prey kij values using the automated stepwise fitting approach, where the applied  values are taken from the model with the lowest AICc, and the vulnerabilities are reset to the default (2) at each fitting iteration.
 	Predator-prey kij values using the automated stepwise fitting approach, where the applied  values are taken from the model with the lowest AICc, and the vulnerabilities are retained from previous fitting iterations.
 	Predator-prey kij values using a repeated manual stepwise fitting approach, where the estimated kij (K-1) are retained from one iteration to the next (with a total of 5 iterations) and the final configuration is that with the lowest AICc, as was done in Chagaris et al.,[4].
 	A combination of predator kj and predator-prey kij values using the methods outlined by Bentley et al., (2020). Predator kj values were estimated using the automated stepwise fitting approach in #3. Predator-prey kij values were estimated using a manual stepwise fitting approach and the remaining degrees of freedom. The number of additional predator-prey kij’s was determined by their AICc score (note this approach was only carried out for the Irish Sea model  in this study).
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 Alternate fitting approaches led to the emergence of different vulnerability multipliers in the corresponding models of best fit (as determined by sum of squared deviations and AICc) for the Irish Sea (Figure 1) and NWACS-MICE (Figure 2). Different fitting approaches impacted estimates of FMSY in both models due to changes in species sensitivity to F with alternate vulnerability multipliers. Despite the increased complexity of the Irish Sea model, the patterns in FMSY variability are comparable between models, with certain species having consistent FMSY estimates across the nine approaches for vulnerability multiplier estimation. This includes cod and whiting for the Irish Sea and striped bass for the NWACS. As demonstrated in case study 1 (previous chapter), these species are opportunistic feeders which are also predated on by higher trophic levels, giving them a relatively high degree of connectivity within the food web models, which may constrict the emergence of vulnerability multipliers. Additionally, these groups have experienced a period of collapse, and in some cases recovery, which provides contrast for the model to estimate the vulnerability multipliers. Fitting approaches with similar properties resulted in more closely related FMSY estimates[5]. For example, FMSY estimates generated by approaches, which searched for vulnerability multipliers by “predator” tended to be more similar to each other when compared to those generated by approaches which searched by “predator-prey”, and vice versa. This emergent trend is perhaps most clearly seen in the FMSY estimates for menhaden and bluefish adults from the NWACS-MICE model (Figure 2).
 The approach used to estimate vulnerability multipliers had an impact on the derived ecosystem indicators (Figure 1b and Figure 2b). These impacts were relatively small, most deviations being within the range of 5-10% when compared to indicators from the published models. Trophic level indicators were particularly robust across estimation approaches, despite often larger differences being observed in diversity (Kempton’s Q) catch and commercial biomass indicators. Balanced reconfiguration within the ecosystem models (i.e., increases in some species and decreases in others with similar trophic levels) enabled the trophic indicators to remain similar across approaches. However, the dissimilarity in trophic level of the catch in the NWACS-MICE model was generally higher across scenarios where vulnerability multipliers were searched by “predator”. This reflects the higher FMSY reference points for adult weakfish and bluefish and lower FMSY reference points for menhaden and herring produced under the same fitting approaches. Overall, the Irish Sea EwE model showed greater dissimilarity in derived indicators than the NWACS-MICE model. This outcome is likely linked to the increased complexity of the Irish Sea model, and how a repeated search provides the opportunity to adjust more predator-prey vulnerability multipliers. This may be less of a concern for low complexity models as the parameter space is smaller, increasing the likelihood that the same vulnerability multipliers will be adjusted.
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 Figure 1. Irish Sea EwE outputs under alternate fitting approaches. Vulnerability multipliers for  the Irish Sea Ecosim model were estimated following seven alternate fitting approaches. The impacts of alternate fitting approaches and vulnerability multiplier estimates are shown for (a) estimates of FMSY (b) indicators of ecosystem structure and function. The impacts of vulnerability multiplier estimates on indicator simulations are illustrated by comparing new simulations against the simulations from the published model. The published Irish Sea model has vulnerability multiplier values estimated using the predator and predator-prey approach.[6]
 
 
 
 
 
 [image: ]
 
 Figure 2. NWACS-MICE EwE outputs under alternate fitting approaches. Vulnerability   multipliers for the NWACS-MICE Ecosim model were estimated following seven alternate fitting approaches. The impacts of alternate fitting approaches and vulnerability multiplier estimates are shown for (a) estimates of FMSY (b) indicators of ecosystem structure and function. The impacts of vulnerability multiplier estimates on indicator simulations are illustrated by comparing new simulations against the simulations from the published model. The published NWACS-MICE model has vulnerability multiplier values estimated using the manual repeated predator-prey vulnerability multiplier search approach.[7]
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 Limitations and future development
 It is not enough to estimate vulnerability multipliers and assume those which produce the best statistical hindcast fit are appropriate. Ecological reasoning and hypothesis testing must support statistical inference as it should when balancing Ecopath models[1], estimating primary production anomalies[2] and incorporating environmental drivers.[3] Part of this process should include a critical evaluation of calibration time series, as these, and their associated uncertainty, drive the statistical estimation of vulnerability multipliers. Using data with inherent inconsistencies will lead to variable and potentially biased estimates. Equally important is the lack of missing reference time series. Time series produce constraints, and when estimating vulnerability multipliers for groups without time series the lack of constraints allows the fitting procedure to explore a broad parameter space to let such groups indirectly impact other groups with time series.  All of the above, can impact model derived management advice.
 As shown in the case studies in the previous chapters (#1, #2), FMSY estimates can change in response to estimated vulnerability multipliers and their impacts on predator consumption rates, albeit with most changes being relatively conservative[4]. With high vulnerability multiplier values, species are more sensitive to changes in F and are therefore capable of recovering faster in the absence of fishing pressure, meaning maximum sustainable yields are achieved at lower fishing pressures (Figure 1a).   As predator consumption rates increase with higher vulnerability multiplier values, prey experience higher predation rates, reducing the yield that can be obtained by fishing at FMSY (Figure 1b). Unreliable vulnerability multipliers are not easily apparent when reviewing model hindcast simulations against calibration time series data. Comparing Ecosim FMSY to other estimates, or proxies (e.g., natural mortality), is one approach to assess vulnerability multipliers and has been demonstrated for the ICES key-run models of the North Sea[5] and Irish Sea[6]. Simulating models beyond observations, under alternate fishing or environmental scenarios, can also highlight issues with vulnerability multipliers by exploring group sensitivities and whether simulated responses to change falls outside of what might be considered ecologically reasonable. Future developments should also consider dependencies between vulnerability multipliers, whether correlation exists between vulnerability multipliers, and how this may impact the ability of a search routine to find stable solutions.
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 Figure 1. Effects of vulnerability multipliers on derived sustainable fishing advice. Estimations of fishing mortality at which MSY is achieved (FMSY). Based on Walters et al., 2005.[7]
 
 
 For EwE models to be of operational use, it should be possible to explain why estimated vulnerability multipliers are realistic. This could be based on knowledge of species’ ecology, carrying capacity, or natural mortality. We envisage that the future development of Ecosim will encourage users to think more critically when calibrating models by building options to restrict the statistical vulnerability optimisation routine. The objective of this would be to enable users to constrain vulnerability multiplier estimation using a priori knowledge where, importantly, data is available to justify doing so. Increased control over the search for vulnerability multipliers could be used to set upper and lower parameter limits, or limits determined by carrying capacity, and penalise parameter combinations which operate outside of predefined limits.
 Such constraints would also have important implications for Ecospace: the spatial-temporal component of EwE. High vulnerability multipliers, and the large increases in predation mortality which they enable, can have disproportionately large impacts in Ecospace when prey are restricted to small areas (as predators are able to deplete them rapidly). Vulnerability multipliers in Ecospace require further consideration given how spatial heterogeneity may impact species physiology, habitat carrying capacity, and predator-prey interaction rates. Spatial considerations are implicit within the vulnerability concept and enable spatial considerations to be integrated indirectly into Ecosim. The necessity for vulnerability multipliers, or at least those in Ecosim which go some way to indirectly recognising spatial heterogeneity, may be negated by the explicit consideration of spatial heterogeneity in Ecospace. Alternate vulnerability multiplier combinations may be needed depending on the priority use of Ecosim or Ecospace and the different mechanistic role vulnerability multipliers may play across the two components.
 Recommendations
 Calibration methods for EwE are not prescriptive. Any one of the methods included in Figure 2 of the Vulnerability and vulnerability multipliers chapter, or new methods, may be suitable for use if they can be justified. That said, the first case study showed that predator vulnerability multipliers are more likely to re-emerge than predator-prey vulnerability multipliers, and that re-emergence is impacted by data quality. Below we provide best practice recommendations to evaluate the appropriateness of vulnerability multipliers and their impact on model uncertainty:
 	Recommendation 1: Limit the number of vulnerability multipliers to be estimated. The most efficient way to limit the number of parameters is to estimate by predator, add individual predator-prey combinations if you have specific arguments for why this is necessary. Avoid estimating vulnerabilities for groups without time series as the lack of constraints can lead to unrealistic estimates.
 	Recommendation 2: Explain vulnerability multipliers. Provide justifications for setting initial vulnerability multipliers (or keeping the default). If estimating vulnerability multipliers using a statistical routine, check if they make sense relative to the exploitation and ecology of the predator and the ecology of the predator-prey interaction.
 	Recommendation 3: Sense check carrying capacities. Vulnerability multipliers augment the upper limit for predator consumption rates, which dictates how predators respond to changes in mortality rates (e.g., release from fishing pressure or predation) or in prey biomass. It is important to review how predator biomass responds to such changes and critically evaluate whether the changes are plausible and whether the limits of estimates should be constrained (i.e., setting upper and lower limits).
 	Recommendation 4: Look beyond goodness of fit when evaluating model performance. Combinations of vulnerability multipliers that achieve the best statistical fit (i.e., SS and AICc) do not necessarily produce the “best” model, if other model outputs, such as indicators, FMSY reference points, and forward projections, are unlikely. Assessment of wider model performance should be undertaken to review vulnerability multipliers.
 	Recommendation 5: Perform vulnerability multiplier sensitivity analyses. It is best practice to acknowledge and communicate model uncertainty. Calibrating Ecosim models, and thereby choosing one of multiple approaches to estimate vulnerability multipliers, introduces additional uncertainty into the process. Exploring model performance under alternate calibration approaches tests the sensitivity of model outputs to changes in vulnerability multipliers and identifies which vulnerability multipliers consistently emerge.
 
 ”
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		Tutorial: Time series fitting

								

	
				 Learning Objectives
  	Obtain experience with the procedures for fitting an ecosystem model to time series data
 	Develop and understanding of the difference between drivers and reference time series
 	Develop and understanding about the impact of missing drivers
 
 
 
 The purpose of this exercise is to explore how to fit an ecosystem model to time series data. For this, we use the ecosystem model of Anchovy Bay that we constructed in a previous tutorial (download). When gathering time series for use in Ecosim, we construct a spreadsheet, and save it as a comma-separated value (CSV) file that can be read by the time-dynamic module of EwE, Ecosim.
 The CSV file must have a specific format, see Table 1. You can copy this table to Excel and save it as a CSV file.
 Table 1. Time series file for the Anchovy Bay tutorial. You can copy the content below, paste it (Paste Special > Text) into MS Excel, then save it as a csv file. Import the csv file to EwE as described in the tutorial.
   	Title 	Sealers 	Seal B 	Trawlers 	Cod B 	Whiting B 	Shrimp C 	T bottom 	dummy 
 	Weight 	0 	1 	0 	1 	1 	1 	1 	1 
 	Pool code 	1 	2 	2 	3 	4 	7 	5 	4 
 	Pool code 2 	 	 	 	 	 	 	 	 
 	Type 	3 	0 	3 	0 	0 	6 	2 	2 
 	1970 	1 	1 	1 	10 	1 	0.3 	17.1 	1 
 	1971 	1 	 	1.05 	 	 	 	17 	1 
 	1972 	1 	 	1.103 	 	 	 	16.9 	1 
 	1973 	0.75 	 	1.158 	 	 	 	16.7 	1 
 	1974 	0.5 	 	1.216 	 	 	 	17 	1 
 	1975 	0.25 	0.8 	1.276 	 	 	 	16.6 	1 
 	1976 	0 	 	1.34 	 	 	 	16.4 	1 
 	1977 	0 	 	1.407 	 	 	 	16.2 	1 
 	1978 	0 	 	1.477 	6 	0.8 	 	16.3 	1 
 	1979 	0 	 	1.551 	 	 	 	16.1 	1 
 	1980 	0 	1 	1.629 	 	 	 	16.3 	1 
 	1981 	0 	 	1.71 	 	 	 	16.4 	1 
 	1982 	0 	 	1.796 	 	 	 	16.1 	1 
 	1983 	0 	 	1.886 	 	 	 	16 	1 
 	1984 	0 	 	1.98 	 	 	 	16.2 	1 
 	1985 	0 	 	2.079 	 	 	 	16.5 	1 
 	1986 	0 	 	2.183 	 	 	 	16.6 	1 
 	1987 	0 	 	2.292 	 	 	 	16.6 	1 
 	1988 	0 	 	2.407 	 	 	 	16.8 	1 
 	1989 	0 	 	2.527 	4 	0.7 	 	17 	1 
 	1990 	0 	 	2.577 	 	 	 	17.2 	1 
 	1991 	0 	 	2.629 	 	 	 	17.6 	1 
 	1992 	0 	2 	2.682 	 	 	 	17.8 	1 
 	1993 	0 	 	2.735 	 	 	 	18 	1 
 	1994 	0 	 	2.79 	 	 	 	18.2 	1 
 	1995 	0 	 	2.846 	 	 	 	18.6 	1 
 	1996 	0 	 	2.903 	 	 	 	18.7 	1 
 	1997 	0 	 	2.961 	2 	0.6 	 	18.6 	1 
 	1998 	0 	 	3.02 	 	 	 	18 	1 
 	1999 	0 	 	3.08 	 	 	 	18.9 	1 
 	2000 	0 	 	3.142 	 	 	 	19 	1 
 	2001 	0 	 	3.205 	 	 	 	19.2 	1 
 	2002 	0 	3 	3.269 	 	 	 	19 	1 
 	2003 	0 	 	3.334 	 	 	 	19.3 	1 
 	2004 	0 	 	3.401 	 	 	 	19.2 	1 
 	2005 	0 	 	3.469 	1 	0.4 	2 	19 	1 
 	2006 	0 	 	3.5 	 	 	 	18.6 	1 
 	2007 	0 	 	3.5 	 	 	 	18.5 	1 
 	2008 	0 	 	3.55 	 	 	 	18.7 	1 
 	2009 	0 	 	3.6 	 	 	 	18.6 	1 
 	2010 	0 	4 	3.65 	 	 	2.4 	18 	1 
  
 
 
 If you download a CSV file or add/delete groups in your model, please note: the CSV files use numbers to refer to groups and fleets. You have to check the CSV file to ensure that the group and fleet numbers in the CSV file and your model correspond.
 The first row gives titles of the time series, the second row is optional and gives weights that will be used as weighting factors for the estimation of summed squared residuals (SS). The pool code is the fleet number (for effort, here Sealers and Trawlers), the functional group number (for biomasses and mortalities, here Seal, Cod, Whiting, and Shrimp), or a forcing function number, (here “dummy”). The type is a code, explained in the time series chapter of the User Guide – it can be replaced by descriptive abbreviations as explained in the User Guide, e.g., BiomassRel instead of type 0. The following rows give the time series data by year. Notice that drivers (effort and fishing mortalities) should be given for all years, (or effort will be set to 0 for missing years), while reference time series can be for some years only.
 For this tutorial, you will need a time series file, so copy the data in Table 1 to a blank Excel spreadsheet and save it as a CSV file.
 Open EwE, then open (Menu > File > Open model) the Anchovy Bay database and model in Ecopath. Proceed to Ecosim > Input > Time series where you can import your time series file by selecting Import, and browse to the anchovybay.csv file. (If needed, you can download the CSV file from this link).
 When the time series tab opens, check out each of the time series (see thumbnails at the bottom). We have effort, relative biomasses, and a catch series.
 Before you start fitting the model, make a run of Ecosim (Ecosim > Output > Run Ecosim > Run. Examine the plots and notably work your way through Ecosim > Output > Ecosim group plots. To illustrate what to look for, examine the seals. You’ll see that the Ecosim run (line) shows a small increase in seal biomass, while the time series (dots) indicates that seals have quadrupled. This indicates that the vulnerability multiplier setting for seals is too low, i.e. that seals with the default vulnerability multiplier of 2 are assumed to be too close to their carrying capacity.  [Read the density dependence chapter for more].
 The default vulnerability multiplier setting (2.0) tells Ecosim that seals can at most double the predation mortality they are causing on their prey, while the time series says they have increased their biomass four times. Can you see the discrepancy?
 You can try to increase vulnerability multiplier for seals as predators and see what happens, and you should go back to run Ecosim ever so often, while doing the fitting to find out what is happening.
 In Ecosim now do the following,
 	Ecosim > Input > Vulnerabilities form, click the top left cell to select all cells. Then enter 2 in the top right field to the left of where it says Apply, then click Apply, to reset all vulnerability multipliers to the default 2.
 	To find the vulnerability multipliers that have the biggest impact on model fit (summed squared residuals, SS, see the estimating vulnerabilities chapter), go to Ecosim > Tools > Fit to time series, set the No of blocks to 1, then click Sensitivity of SS to V (V is the vulnerability multiplier, see the vulnerability and vulnerability multipliers chapter). Leave by predator checked, then click Search. The search routine will find the group for which the vulnerability parameter has the biggest impact on the SS. Click OK, and this information will be passed on to the search form.
 	On the search form, click Search, wait till the search routine has converged, click no to further searching. Note the SS and AICc estimates.
 
 Repeat the steps above with increasing number of search blocks and parameters until you are searching for all predators, then try searching predator-prey combinations, and carry on until you have established a pattern.
 Up to now, we have evaluated density-dependent effects, including how ecological factors and fisheries impacts fitting, next is to add environmental effects by estimating ‘primary production anomalies‘ that let system productivity vary over time. We can do that by searching for spline points. For this we need a forcing function, and we can use the “dummy”, go Ecosim > Input > Forcing function > Apply FF (primary producer) , and click the phytoplankton row. Then select the “dummy” and use the green arrow to move it to applied functions.
 Back on the Ecosim > Output > Tools > Fit to time series form, uncheck the vulnerability search and check the anomaly search. Now,
 	Click the Forcing function tab. Then click Reset all to reset the forcing function.
 	Click the Anomaly Search tab on the top. Then set the number of spline points to 2.
 	Then click Search, and wait till the search routine has converged, click no to further searching when prompted. Note the SS and AICc estimates.
 
 Repeat the steps above with increasing number of spline points, e.g., 2, 3, 5, 10, and 20. Also try to estimate a primary production anomaly for all years by setting the number of spline points to 0. If the initial search for parameters doesn’t get it to move away from the starting point (flat line), then repeat (click yes when asked).
 Finally, try doing a combined vulnerability search and anomaly search. First reset as earlier, then set the number of spline points to 3, and try searching for 2-8 vulnerability parameters, using the search by predator option.
 Again, collect the results, examine the SS and AICc, and consider.
 So, what lessons can you learn from this exercise? One important is that it is easy to over-fit a model. If you examine some of the fits where many parameters have been estimated, you’ll see that groups for which we do not have any time series have radically changed vulnerabilities. When there is no time series information there is no penalty for the fitting procedure, so for such groups there is no stopping it. Does it make sense?
 When fitting many parameters, you likely found that the vulnerability multiplier setting for whales was set very high. This makes whales perhaps double in abundance, and the fitting procedure likely chose this outcome because of the secondary effect whales have on other species through predation. This may or may not be real, and it certainly shows the importance of examining the outcome, and the value of having information at hand.
 If you examine the fitting for cod and whiting, bear in mind that they are caught by the same fleet, and subject to the same change in effort. Cod is estimated to have a low vulnerability multiplier, whiting a high. Why? Both have decreased considerably according to the time series, but if you examine the Ecosim > Output > Ecosim group plots, you’ll notice that predation mortality is relatively more important for whiting than for cod (and fishing mortality, vice versa). So, as fishing effort for the trawlers increased significantly this would have the biggest impact on cod. To sustain this, the search routine chose a low vulnerability multiplier setting for cod. It would have less impact on whiting, but whiting decreased according to the time series. Therefore, the vulnerability multiplier setting had to be increased.
 Sensible? Well, you need to have knowledge or at least a gut feeling of what has happened in your ecosystem. Data is good.
 Other parameters
 There are other factors that impact the fittings, but we do not (yet) have a built-in way of fitting to those. Here are some examples of parameters of importance,
 Ecosim, Group info
 The Ecosim Group info parameters are explained in a tutorial.
 Feeding time adjustment rate: does a consumer change the amount of time it spends feeding when feeding conditions change? Most fish tend not to, so we usually set this parameter to 0 for all but marine mammals and birds, top predators, and juvenile/larval fish.
 Density-dependent catchability: For schooling fish and for species showing range-contraction, the CPUE from fisheries are often misleading with regards to abundance. A corollary of this is that the catchability will change with their abundance (density-dependence!) If you have reason to think that may be the case for a group, you can use this parameter.
 Handling time: The parameter QBmax/QB0 (for handling time) can be used to ensure a Holling type-II functional response. Lower the parameter to 2 or 3 to evaluate the effect.
 Switching power: If a predator shows a Holling type-III functional response (switching), you can set this here. So, if the predator stops eating things as they become rare, and switches to feed relatively more of them as they become abundant, try using this parameter.
 
 About AIC and AICc
  [image: AIC = nlog(RSS/n) + 2k + constant*n] [1]
 where k is the number of parameters estimated and n is the number of observations being fitted to (i.e. n is the number of time series values, this being number of series used multiplied by the number of years for each). The constant*n can be ignored if n is the same (i.e. the observation data to be fitted to is the same) and we are comparing between alternative hypotheses.
 So, using AIC to compare among alternative hypotheses (model parameterizations) in Ecosim, we need to calculate:
 [image: AIC = nlog(minSS (from Ecosim)/n) + 2k]
 AICc is AIC with a second order correction for small sample sizes, to start with:
 [image: AIC_c = AIC + 2k(k-1)/(n-k-1)]   where n is the number of observations
 Since AICc converges to AIC as n gets large, AICc should be employed regardless of sample size (Burnham and Anderson, 2004).
 n is the number of observations being fitted to (i.e. n is the number of time series values, this being number of series used multiplied by the number of years for each)
 SS (sums of squared residuals ([Observed / Estimated]2) from Ecosim)
 k is the number of parameters estimated. This is the number of distinct vulnerabilities plus number of primary production anomaly points (last year-first year or the number of spline points if these are used.
 
 
 
 Quiz
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/ewemodel/?p=966#h5p-4 
 
 
 
	Venables, W. N., & Ripley, B. D. (2002). Modern applied statistics with S, 4th ed. New York, NY: Springer. ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Monte Carlo runs

								

	
				 Using Monte Carlo routine on Mac with Apple M chip
 We have noticed a problem (October 2024) when running the MC routine on newer Macs with Apple M chips using Parallels Desktop: the routine takes many more runs to find a balanced model, and the runs are more chaotic than when run on a native Windows machine.
 If you are using the MC on an Apple M machine for production runs, we suggest you try to run the simulations on a native Windows machine as well.
 We have not found any problems for other EwE routines.
 
  
 Ecosim has a Monte Carlo (MC) facility  for evaluating input parameter uncertainty by resampling parameters to search for input parameter combinations that result in better fit to time series.
 [image: ]You can open scenarios and load time series by clicking the down-arrow next to the icons at the top of the EwE interface.
 The routine requires a balanced model with time series, and we will here use the “Anchovy Bay true.ewemdb” model, with the “anch bay” scenario and the “anchovy bay true” time series, (download all along with an AIC spreadsheet from this link). Open the model, and load the scenario and time series. Then open the MC routine from Ecosim > Tools > Monte Carlo simulation. Check the Settings tab. If you check Retain better fitting estimates, the routine will resample parameters from a new better fit whenever such are obtained. This turns the routine into a Markov Chain Monte Carlo (MCMC) routine, which usually will make it possible and easier for the routine to find additional mass-balanced solutions.
 On the B tab, set the CV to 0.4 for all groups (just click where it says CV in the top row, then enter 0.4 in the Apply box, return), and just leave the other parameters as is. Click Run trials.
 Go to the Biomass plot tab. For each run (of the default 20), the routine samples the parameters until it finds a balanced model, (how many tries that takes is given in the Ecopath runs field), it then runs Ecosim, and estimates summed squared residuals (SS). If the SS is lower than the previous best, the model will (if Retain better fitting estimates is checked), resample the input parameters around the new set of parameters that gives the lower SS. If you select Apply best fit the routine will transfer the best set of input parameters to the Ecopath model. You should therefore take care not to overwrite your model, so, it really is best to work on a copy of your model.
 We here use just 20 runs for the simulations; in a real analysis, you may well choose to use thousands.
 If you want to get statistics for parameter ranges etc., then click the Save output > All results in one file option before doing the run. You can locate the saved file from the Menu > Tools > Options > File Management. There, click the folder symbol to the right of Monte Carlo trial results, and you’ll get to a folder with a file, MonteCarloTrials.csv, which has the results – in a cumbersome format that requires some manipulation to make sense of.  For this simple model with just 20 runs, there’s over 1100 lines in the CSV file as parameters are saved for each run.
 If you instead use the Save File > Separate files per trial, the routine will make a folder for each run and then save (in this case) 76 files within each run folder. For instance, biomass annual.csv, which will have the biomass by functional group for each year in the run. To deal with such file complexity: use R (or similar) for analysis.
 You can use MC with the EcoSampler plug-in to store the samples that the MC runs for further analysis. See the EcoSampler User’s Guide for further information.
 Media Attributions
	EwE interface shortcut for loading files, scenarios and time series 
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		Stock reduction analysis

								

	
				A very useful technique for using long term data in stock assessment is Kimura’s “stock reduction analysis”. In this technique, historical catches are treated as fixed, known quantities, and are subtracted from simulated stock size over time so as to aid in estimating how large (and/or productive) the stock must have been in order to have sustained those catches and to have been reduced by some estimated fraction from its historical level. In some assessment literature, treating catches as fixed knowns is also called “conditioning on catch”. A drawback of treating catches as fixed values is that catches in fact arise from the interaction of fishing effort and abundance, and ignoring this dynamic interaction amounts to treating the catches as purely depensatory impacts on stock size (when simulated stock size declines, the fixed catches can cause progressively larger calculated fishing mortality rates F, leading to a depensatory spiral of rapid collapse in the simulated stock, which may or may not have been possible in the real system).
 When creating historical reference CSV files for model testing (see Import time series), all or part of a catch time series for any group(s) can be treated as a forcing input (with simulated F calculated each year as (input catch)/(simulated stock size) ) by setting its data type to -6 (rather than the usual 6 for fitting catch data). Note that the catch time series for a group can be entered in two columns, with one column set to data type 6 and one to data type -6, where catches for years to be treated as forcing are placed in the -6 column and catches for years when catch is to be predicted from effort or assessment Fs placed in the 6 column. Most often, this splitting of catches into two columns should be used in cases where there are no independent assessments of F for some early years.
 The Monte Carlo simulation interface in Ecosim can be used to search for Ecopath biomasses needed to have sustained historical catches. We cannot search for such initial biomass values by simple nonlinear search methods, due to the biomass constraints implied by Ecopath mass balance. The Monte carlo simulation interface can do a large number of simulations with randomly varying trial values of Ecopath biomasses, and can retain trial values that result in improved model fit; such a search or fitting procedure is known as a “Matyas search”.
 
	

			
			


		
	
		
			
	
		

		Tutorial: Uncertainty in time series data

								

	
				The Multi-sim tutorial is designed to address uncertainty in time series data, be they environmental forcing functions, fishing effort, biomass series or other, see the EwE User Guide guidelines for Multi-sim.. Use the Anchovy Bay true.ewemdb database (download). Open the database, and go to Ecosim > Tools > Multi-sim. The EwE Multi-sim can read in time series files with varying forcing functions. You can get the format for the CSV file to use if you click Example on the Multi-sim interface. For your own use, use that file derived from your own model. Here, we will instead download a zipped file that holds a folder with 20 CSV files. Each of these 20 have a time series of environmental productivity that is derived as auto-correlated values based on the original true time series values.
 Download the zipped multisim csv.folder, unzip and place it somewhere (where you can find it again).
 [image: ]Figure 1. Top part of one of the Anchovy Bay time series files used for the Multi-sim analysis in this tutorial.
 Each CSV file looks like this, only difference is that the values in the Fitting column varies between files, but any of the time series in file can be varied, if so desired.
 Now check that the Fitting time series is applied to primary production. Go Ecosim > Input > Forcing function > Apply forcing (producer) and check that F2 is applied to primary producers (or apply it, if it is not).
 Here’s a sample showing how the “Fitting” time series look for four of the CSV files,
 [image: ]
 Figure 2. Four series of auto-correlated time series for environmental productivity. The original time series is indicated in red on each plot.
 On the Multi-sim interface, Input > Source folder, select Choose, and browse to find the folder with the CSV files that you just downloaded. Select the 20 CSV files, by clicking All in the right column.
 On Output, select where you want Multi-sim to write output. Select which indicators you want to get output of, e.g., Biomass. Next click Run. Multi-sim will now run Ecosim 20 times, each time with a different time series for the environmental forcing function read in. If saving biomass as in this example, it will make a folder for each of the 20 runs, and save two files in each, biomass_annual.csv and biomass_monthly.csv. This structure lends itself easily for analysis in R.
 Compare the time series in some of the output files, play!
 There’s a log file saved that shows what Multi-sim has done, in Figure 3 is an example.
 [image: ]
 Figure 3. Log-file from Anchovy Bay Multi-sim run
 
	

			
			


		
	
		
			
	
		

		Tutorial: Fitting time series with true values

								

	
				In a previous tutorial we fitted the Anchovy Bay model to a simple time series file, mainly in order to explore the time series fitting procedures of Ecosim in a simple manner. Here, we will expand on this, notably by evaluate fitting when considering fisheries, food web, and environmental conditions, i.e. we add an environmental forcing function.
 The present tutorial is a test to see how well Ecosim can fit a model with known parameters. The time series ‘data’ for this tutorial were thus derived from a model run with known primary production forcing and with known vulnerability multipliers. Can we retrieve those values?
 Open the model Anchovy Bay true.ewemdb (download); then load the anch bay scenario, and then the anchovybay true time series, (which is also available in the anchovybay true.csv time series file).
 Reset the vulnerability multipliers to the default: Ecosim > Input > Vulnerabilities. Click the upper left cell in the spreadsheet (above 1 and to the left of Prey\predator), to select the entire sheet, then enter the value 2 in Set: at the upper right, and click Apply to the right.
 Run the model, Ecosim > Output > Run Ecosim > Run button. Check the output, notably on the Ecosim Group plots. As an example of what to look for, examine the cod screen. The model shows bigger decline in biomass than the data. What does that tell us about the vulnerability multiplier for cod?
 Check the Ecosim > Input > Forcing function form where you should find two forcing functions, 1: True PP, (which we will use later for comparisons), and 2: Fitting, (which we will use for fitting). Check the Ecosim > Input > Forcing function > Apply FF (producer) form. Here there should be an F2 in the (single not blocked entry field) for Phytoplankton (if not, then click the empty field and select the FF.  The two forcing functions are, by the way, included in the time series file, and when/if you read it in, you’ll have to specify that you do not want to read in each of these as monthly values.
 Now go Ecosim > Tools > Fit to time series. Try running a number of different fits; first with vulnerability search only. E.g., search groups with time series, and search for vulnerability multipliers for the seven groups with time series. Note what the ‘base’ SS is, and what you get with seven estimated parameters, probably a substantial reduction in SS. Try also to estimate fewer vulnerability multipliers. Also search for most sensitive parameters, and try with different number of parameters. Which groups are most/least sensitive? Are there any implications to be deducted from this? Notably consider if we are likely to have or get time series for the more sensitive groups.
 For each run it is always a good practice to check the vulnerability form to see the estimated multipliers.
 Also compare vulnerability multiplier fitting with searches by predator and by predator/prey combinations. As a rule, we find that searches by predator are most efficient – and easier to explain.
 Reset the vulnerability multipliers. Now search for a primary production anomaly; check the Anomaly search on the Fit to time series form, and uncheck the Vulnerability search, so only search for an environmental signal. Before each run go to Ecosim, Input data, Forcing functions, and reset the shape of the Fitting forcing function. Try with different number of spline points, e.g., 2, 3, 4, 6, 10, and finally 0 (i.e. annual PP). Do you see clear environmental signals? Evaluate not just SS, but also if the anomalies are plausible (there can be a tendency to cut off or wildly increase PP at the beginning or end of time series as this often can be done without time series ‘penalty’). Based on this, select one or several number of spline points to test for the combined Vulnerability and Anomaly search – try such runs.
 When you’ve done runs to fit, copy the results from the table on the Fit to time series form to a spreadsheet (so you don’t lose them). Evaluate AICc values, and consider implications for model selection.
 	Consider how well the fitting routine is able to find the PP anomalies and vulnerabilities.
 	Discuss the findings and their implications.
 
 Optional
 There is an additional time series in the model database, “anchovybay true partial”. It is similar to the previous, but omits a number of early time series values that help identify the cycling pattern. Try this time series to consider the effect of having time series with contrast.
  
 
 Vulnerability multipliers for the Anchovy Bay model 
  Your model version may be a bit changed from what’s below, but should be close
 	1 	Whales 	1.14 
 	2 	Seals 	2.38 
 	3 	Cod 	1.28 
 	4 	Whiting 	6.17 
 	5 	Mackerel juv 	1.10 
 	6 	Mackerel ad 	1.60 
 	7 	Anchovy 	1.21 
 	8 	Shrimp 	>1000 
 	9 	Benthos 	3.22 
 	10 	Zooplankton 	2.26 
  
 
 
 

	

			
			


		
	
		
			
	
		

		Tutorial: Anchovy Bay Ecosampler

								

	
				Ecosampler is a routine that creates alternative Ecopath models, and then uses each of these models for analysis based on the core EwE routines (i.e. Ecopath, Ecosim, and Ecospace). Ecosampler is included in EwE Vers. 6.6., and is available from Menu > Tools > Ecosampler in the Navigator.
 The Ecosampler guide is in the EwE User Guide.
 Open the Ecosampler form and check the Record button (making it red for recording). Go to Ecosim > Tools > Monte Carlo simulation, and run. Notice in the Ecosampler interface that it saves each balanced Ecopath model.
 Turn of the Ecosampler recording. Follow the directions in the Ecosampler User Guide.
 Ecosampler can run for the basic Ecopath run, Ecosim run and Ecospace run, as well as run loaded plug-ins. But it cannot (yet) run the various modules built into EwE, e.g., policy search, fit to time series. For now, you can load a sample at the time in the Ecosampler routine, then run the various routines in EwE, one after the other. Or, design a plug-in that will do that!
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		Ecosim: Fisheries

	

	
		
	

		


		
	
		
			
	
		

		Tutorial: Maximum sustainable yield (MSY)

								

	
				 Learning Objectives
  This exercise is designed to,
 	Obtain experience with evaluation of single-species vs. ecosystem-level MSY
 
 
 
 MSY and evaluating trade-offs for anchovy fishery
 The first management scenario includes a comparison of a single-species versus ecosystem-level Maximum Sustainable Yield (MSY). The methodology is described by Walters et al. (2005[1]). While MSY is a concept that has some clear problems as a management objective, notably from a conservation perspective[2]), it does provide a reference point for management, including from a societal perspective[3].
 	Use the Anchovy Bay model in a version that is fitted to time series. If you don’t have one, you can download one from this link. Once loaded, load the Ecosim scenario (but not the time series), check that you have vulnerabilities saved (Ecosim > Input > Vulnerabilities). Make a run to check model. Then reset the effort for all fleets (Ecosim > Input > Fishing Effort > Reset All).
 	Run the model, extract the results for the final year, and save the values from the run in a spreadsheet. You can extract the values from the Ecosim > Output > Ecosim results form, save Fleet, value end, and Group, biomass end.
 	Then increase the fishing effort for bait boat fleet (which are targeting anchovy) to 10. Run.  Extract results, and copy to your spreadsheet.
 	Stop fishing altogether for the bait boats and extract results.
 	You will notice that shrimps are impacted indirectly by the anchovy fishery. Try setting a high fishing effort for anchovy and also increase the shrimpers’ effort.
 	Try changing effort for other fleets (do some ecosystem manipulations) to see if you can increase the value of the fishery without crashing the ecosystem.
 
 After playing with this, examine the results in your spreadsheet. Notice that your results depend on two major factors:
 		Prices by species (and by fleet): examine the landing prices (Ecopath > Basic input > Fishery > Off-vessel prices. Consider how your results depend on the prices.
 	How each species reacts to changes in fishing pressure. This factor is closely related to the vulnerability multipliers in Ecosim, (remember: 2 is default setting; below 2 is closer to carrying capacity, above 2 is further from carrying capacity).
 
 
 
 Evaluate how changes in fishing pressure for a species impacts itself and the ecosystem through MSY analysis (Ecosim > Tools > FMSY). Notice that there are two main options for the MSY search: Full compensation, (which includes ecosystem effects on other species), and Stationary system, (which assumes no ecosystem effects, i.e. single-species analysis). With full compensation, Ecosim runs normally including species interactions. With the stationary system option, only the target groups will be impacted, the abundance of predator and prey species will be kept constant, frozen as they were.
 		On the FMSY form, run analysis by fleet, choose ‘both’ for Assessment to display and Data to display. [If after a run, the Run button isn’t enabled, then click Group, Fleet, Group, or close the FMSY form and open it again]. 	For the seiners and bait boats, you may have to increase the relative F to, e.g., 10 or 30 to make sure you get to an overexploited state
 
 
 	Are the MSY’s realistic? If not, you need to reconsider your vulnerability settings.
 
 
 
 The figures below (Figure 1 and 2) show Anchovy Bay MSY output for seiners and for cod.
 [image: ]
 Figure 1. MSY interface for the seiner fleet showing complex species interactions showing run with compensation (due to species interaction) as well as stationary system run (no food web effects). The seiners catch both mackerel and anchovy, therefore increased effort will benefit anchovy as the higher effort has more impact on their predator, mackerel. Note in the stationary run, anchovy MSY is lower than with compensation, whereas it is opposite for mackerel. Increased seiner effort will benefit cod as whiting (their competitor and predator), suffers from decreased anchovy availability. Shrimp increases because of less predation by whiting. 
 
 [image: ]
 Figure 2. MSY analysis for Anchovy Bay cod. With the stationary system only cod is impacted, while runs with compensation (full Ecosim species interaction) have whiting abundance increasing (not shown) leading to corresponding increase in whiting catches. Shrimps also benefits from increased cod fishing. In contrast, anchovy declines when whiting increases and this in turn leads to their predator mackerel decreasing as well. 
 You can do batch runs to evaluate MSY for all species using the Find FMSY routine on the Ecosim > Tools > FMSY form. For this, first click the Auto-save output at the top of the form, then the save symbol on the second menu at the top of the form. From the Menu > Tools > Options > File management form you can find the folder location for where the MSY results are saved (named MSY iterations). See output in Table 1.
 Table 1. Output from Find FMSY batch run, extracted from the files FMSY_FullCompensation.csv and FMSY_StationarySystem.csv.  For anchovy, the effort was increased enough to estimated FMSY in the full compensation run (FmsyFound = 0), but the full compensation has much higher FMSY for anchovy compared to the stationary system. For shrimp the stationary system prediction is overly optimistic as it does not consider that shrimp predators are competing with the fishery. The general finding is that FMSY is higher when ecosystem interactions are considered (full compensation). 
  	Full compensation 
 	Group 	 FmsyFound 	 Fmsy 	 Cmsy 	 Vmsy 
 	Whales 	               – 	               – 	               – 	               – 
 	Seals 	            1.00 	            0.07 	               – 	            0.00 
 	Cod 	            1.00 	            0.18 	            0.46 	            4.61 
 	Whiting 	            1.00 	            0.16 	            0.23 	            0.94 
 	Mackerel 	            1.00 	            0.39 	            0.37 	            1.48 
 	Anchovy 	               – 	            0.58 	            3.15 	            6.74 
 	Shrimp 	            1.00 	            0.51 	            0.62 	          12.33 
 	 	 	 	 	 
 	Stationary system 
 	Group 	 FmsyFound 	 Fmsy 	 Cmsy 	 Vmsy 
 	Whales 	               – 	               – 	               – 	               – 
 	Seals 	            1.00 	            0.07 	            0.00 	            0.00 
 	Cod 	            1.00 	            0.19 	            0.48 	            4.82 
 	Whiting 	            1.00 	            0.12 	            0.20 	            0.80 
 	Mackerel 	            1.00 	            0.36 	            0.41 	            1.62 
 	Anchovy 	            1.00 	            0.29 	            1.56 	            3.35 
 	Shrimp 	            1.00 	            0.34 	            2.46 	          49.27 
  
 Quiz
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/ewemodel/?p=450#h5p-5 
 
 Media Attributions
	Ecosim > Tools > FMSY 
	Ecosim > Tools > FMSY 
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		Management strategy evaluation

								

	
				Management strategy evaluation (MSE) is concerned with evaluating uncertainty about the impact of applying alternative formal rules for varying fisheries over time, given uncertainty about ecosystem dynamics (as represented by key Ecopath and Ecosim parameters) and about biomass states over time due to stock assessment errors. The main tool in EwE for simulating such uncertainties and rules is the “CEFAS MSE plug-in” (Tools > Cefas MSE) developed by Mackinson and colleagues.[1]
 The CEFAS plugin provides a way to represent uncertainty by doing multiple simulation scenarios with different parameter values, while comparing various management performance measures across these simulations for alternative harvest management decision rules. The decision rules included in the plug-in were developed in response to questions raised about multi-species management strategies in the ICES (North Sea) management area, but broadly represent harvest management decision rule options for most highly managed areas in the world.
 The CEFAS MSE works with output control: quotas. There is an older module that also uses quota limits, but with limited ability to limit quotas based on rigid species quota allocations by fleet and simple “weakest stock” or “most profitable” quota constraints It is possible to use input control with the alternative EwE MSE procedure based on linear programming optimization. See the MSE Constrained Optimization of Fishing Effort chapter.
 Management decision rules are represented by several main components:
 	So-called “harvest control rules” (HCRs, see Figure 1) representing desired patterns of variation in total fishing mortality rate for target species as a function of species biomass (comparisons of such HCRs is a central concern in single-species management strategy evaluation).
 	Imposition of alternative rules for discarding, e.g. forbidding discarding may effectively cause “weakest stock” management by not allowing fishing fleets to avoid harvest limits by discarding catches of weaker stocks), or allowing highest value management by seeking fleet operations that will maximize total profit despite discarding impacts, or assuming ability of fleets to do “selective fishing” of only valued target species.
 	Limits on total fishing effort by fleets and on year-to-year allowable changes in fishing effort.
 
 Quite complex calculations are done at each simulation time step in order to meet (or not) the constraints implied by the single-species HCRs. For details, see the supporting information from Mackinson et al.[2]
 [image: ]
 Figure 1. Examples of harvest control rules (HCRs) used for management strategy evaluation. Type 1 is the “ICES standard” advice rule where F declines linearly to zero when biomass is below MSY Btrigger. Type 2 is “Precautionary”, easing the rate of reduction in F between MSY Btrigger and Blim. Type 3 is the most “Protective”, applying the most severe reductions in F, which declines linearly from Fmsy at MSY Btrigger to zero at Blim . Type 4 is considered the most “Realistic”, similar to Precautionary, but recognizes that a small level of residual non-target by-catch mortality may remain on a stock at B ≤ Blim. From Mackinson et al. (op. cit., Figure 4).
 A key part of management strategy evaluation is to determine the effect on management performance of errors in biomass estimates due to random survey variation and to cumulative errors caused by stock assessment procedures. For multispecies models, it is not practical to simulate the complex data gathering and assessment model fitting procedures that are used to obtain biomass estimates for more valuable species. Instead, the plug-in uses an observation by Walters[3] that errors in biomass estimates from common stock assessment methods (virtual population analysis, statistical catch at age analysis or stock synthesis models) propagate over time in a relatively simple pattern that can be modelled by a statistical filtering equation. The equation predicts that even single large survey errors can cause errors in stock assessments (impacts on estimates from assessments) that propagate over several years so as to possibly have large cumulative impacts on over- and/or under-harvesting.
 [image: ]
 Figure 2. Flowchart indicating how the CEFAS MSE plug-in first creates a (large) number of possible EwE models (drawn randomly) then continues to the management strategy evaluation (Figure 3). From Mackinson et al. (op. cit., Figure 1)
 The CEFAS MSE plug-in approach has two stages. First it creates a number of plausible EwE (Ecopath) models by sampling distributions of input parameters (biomass, feeding, production and consumption rates and predator-prey interaction rates) (Figure 2). Next, it simulates the effect of alternative management strategies defined by their HCR and regulatory mechanisms (Figure 3).
 For guidance of how to use the CEFAS MSE plug-in, most notably see the paper by Mackinson et al. (op. cit.), the chapter about the CEFAS MSE in the EwE User Guide based on the supplementary materials from Mackinson et al. (op. cit.) as well as the tutorial following this (web and pdf versions only).
 [image: ]
 Figure 2. Flowchart for evaluation of alternative management strategies. From Mackinson et al. (op. cit., Figure 2).
  
 
	Mackinson S, Platts M, Garcia C, Lynam C (2018) Evaluating the fishery and ecological consequences of the proposed North Sea multi- annual plan. PLoS ONE 13(1): e0190015. https:// doi.org/10.1371/journal.pone.0190015 ↵
	Mackinson et al. (2018) S1 Supporting Information. Technical methods of the uncertainty and MSE routine. https://doi.org/10.1371/journal.pone.0190015.s001 ↵
	Walters C. 2004. Simple representation of the dynamics of biomass error propagation for stock assessment models. CJFAS 61(7):1061-1065. https://doi.org/10.1139/f04-120 ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Management strategy evaluation (CEFAS plug-in)

								

	
				
We use management strategy evaluation to test how alternative management procedures are affected by uncertainty. We here use the Anchovy Bay true MSE model, which you can download from this link. It’s a zip file with the database, once unzipped, open it in EwE and use the anch bay Ecosim scenario, and the anchovybay true (annual) time series.
 There is a detailed description of the CEFAS MSE plug-in in the EwE User Guide
 
 The CEFAS MSE plug-in is found under Tools at the top row menu. Open it, and go through these steps on the Basic setup,
 	Data path: you need to browse to a path that you want to use for the (many!) files that the MSE plug-in will need
 	Model area: is used to convert the landings per unit area (t km-2 year-1) to total landings (t year-1) and total economic value. Do not change the model area here! If you need to for a later application, go to Ecopath > Input > Model parameters and change it there, but don’t do that now.
 	Basic inputs: click to create the MSE file structure. On the pop-op form you can set CV for parameters. For this tutorial, we can leave it as is. Just click Save.
 	Survivabilities: For this, leave as is. Save
 	Diets: For this, leave as is. Save
 	MSE models: create 20 models. Click the little arrow to the right, and the routine will create 20 Ecopath models based on the underlying Ecopath models and the assumed uncertainties
 
 Next, we define fishing strategies. We start by defining some general parameters,
 	Max effort increase: default is 10% change from year to year. OK to leave at default
 	Stock assessment: defines recruitment parameters for stock assessment model. OK to use default for this tutorial.
 	Assessment error: here you can define (1) biomass estimation error by group and (2) fleet implementation error by fleet. Leave at default. In the built-in MSE, these errors can vary over time, here they are assumed constant.
 	Quota share: not of concern here as each species is caught by only one group
 	Biomass limits: by default, no limit. Leave as is.
 
 Now define a fishing strategy, click Review, and Add strategy. Let’s call the new strategy, “cod rebuilding”. Under Harvest Control Rules (HCR), click Add HCR. Make it biomass group: Cod. Fishing mortality group: Cod. Target or Conservation: Conservation. OK.
 Add another HCR. Biomass group: Whiting. Fishing mortality group: Whiting. Target or Conservation: Target. OK
 If you select one of the HCRs in the HCR spreadsheet, you can see and edit each HCR. For now, set the max F for both cod and whiting to 0.3 (this is close to FMSY, you can check it in Ecosim > Tools > FMSY), for other parameters, just leave with default values.
 Under Regulations > Trawlers, select Highest value. OK. This option will allow the trawlers to operate until they’ve fished the quota for the highest value stock, i.e. cod.
 Set up an additional fishing strategy, very similar to the one above, call it “Cod rebuilding no discarding”, and the only difference from above is that we use Weakest stock as regulation.
 On Run MSE, set the number of models to run to 20, and the number of years to project to 10. The MSE plug-in will run the underlying Ecosim model as setup and then project for an additional 10 years for each run. Check Yearly results only. Click the little arrow run button.
 The plug-in will come back after making the 20 runs, and let you know if the runs have been successful and that the results are saved (in the results folder). There’ll be more than 700 CSV files in the results, so have fun exploring them all. One by one: isn’t feasible, this calls for a structured approach, e.g., using R. We will not be going there now, but look at some details only.
 The results.csv file in the Results folder gives a summary of the 20 runs by strategy. Parameters are biomass min, biomass end, catch, landings, discard mortality, discard survival. Check it for differences in the two strategies.
 Details are in the various folders, check for instance biomasses and catches for cod and whiting for the two strategies.
 Do the strategies have implications for other species than the two target species?
 What are the average catches, average value and variability for the two target species in the strategies?
 Are the runs identical for years 1-46? If not, why?
 Check out the ChokeGroup folder, file ChokeGroup_Trawlers_FleetNo2.csv file to see if one of the target groups caused fishery closure.
 Explore!
 Ask questions such as,
 	What are the average catches, biomasses, and revenues?
 	How variable are these values?
 	How often will the fisheries be closed?
 	How often will biomasses be below acceptable level?
 	What are the implications of a no discard policy?        
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		Constrained optimization of fishing effort

								

	
				Optimization methods like Ecosim’s policy optimization search procedure (see Fishing policy exploration chapter) have been used to find, by fleet, fishing efforts that maximize various multi criteria benefit functions for ecosystem management, with criteria ranging from total profits to total employment and maintenance of ecosystem structure.   These optimization methods work by running an ecosystem model that includes fishing mortality rates for multiple biomass groups by the multiple fleets, for long enough simulation periods for production and trophic interaction effects to play out.  Fishing efforts by fleet are varied across simulation runs so as to seek the effort combination that maximizes the long-term benefit function.  The result is a vector EOPTj,  j=1,…,nf, of optimum long-term efforts for the nf fleets included in the model.
 A relatively simple linear programming method could theoretically be used to find long-term efforts that are constrained to be at or below the long term optima EOPTj found in the policy optimization, while respecting the relative fishery values represented in the long term optimization and also constraints associated with fishing mortality rate targets or upper limits by species. We have not attempted to implement that theory. But the same optimization procedure can also be used to set annual effort limits in MSE simulations, as an option to use effort input controls rather than the output (quota) controls assumed in an older EwE module and the newer CEFAS MSE module (see MSE chapter).  The present chapter explains the basic linear programming formulation.
 Unfortunately, simple long term optimum long-term efforts typically cannot be used directly in management strategy evaluations (MSEs), since they ignore constraints associated with fishery development (how fast efforts can grow or be reduced) and more importantly typically involve fishing efforts that would cause ecosystem simplification (overfishing of weaker stocks, even use of fleets to cull some species so as to increase productivity of others).  In at least some jurisdictions like the United States, there is a strict legal mandate prohibiting over-harvesting (fishing rate exceeding Fmsy) for any species.  Further, in modeling management decision making over time, it is often necessary to represent the use of “control rules” that prescribe reduced fishing mortality rates for particular stocks when those stocks are below desired reference biomass levels.
 A relatively simple linear programming method suggested by Murawksi and Finn[1] can be used to find short-term (annual) efforts that are constrained to be at or below the long-term optima EOPTj, while respecting the relative fishery values represented in the long-term optimization and also constraints associated with fishing mortality rate targets or upper limits by species.  Suppose that the fleets harvest i=1,…,ns species (or biomass groups), with each unit of effort for fleet j causing a fishing mortality rate qij on species i (qij is the catchability coefficient for species i by fleet j, and is also the Ecopath base fishing mortality rate for i,j).  Suppose that for each species i, there is a target or maximum allowable fishing mortality rate FTARGETi, summed over all fleets that cause fishing mortality (landings and/or discards) on i.  Suppose that we assign an “importance weight” vj to effort by fleet j, where vj reflects the relative value of increasing (or maintaining) effort for fleet j because of its contribution to overall long term ecosystem value and/or its legal entitlement to fish.  Then the linear programming optimization can be formulated simply, as, maximize,
 [image: \sum \limits _{j=1}^{nf} v_j E_j \tag{1}]
 by varying the efforts Ej subject to the constraints,
 [image: EMIN_j < E_j < EOPT_j \text{ for j=1, ..., nf} \tag{2}]
 [image: \sum\limits_{j=1}^{nf}q_{ij} E_j \leq FTARGET_i \text{ for i=1, ..., ns} \tag{3}]
 That is, try to make the efforts Ej as large as possible without exceeding EOPTj while allowing efforts of at least EMINj and not allowing the sums of qijEj to exceed target fishing rate FTARGETi for any species i.  An alternative formulation for recognizing fishery development rate constraints would be to replace the first set of nf constraints (Eq. 2) with EMINj < Ej < EMAXj. Where the EMIN and EMAX are allowed to vary from year to year by limited increments from the previous year’s values, and are not allowed to exceed EOPT.
 Figure 1 illustrates the kind of complicated solutions that can arise from this optimization, even for a very simple case where two fishing fleets pursue just two species, with one fleet having higher catchability for one of the species and the other fleet having higher catchability for the other species.
 [image: ]
 Figure 1.  Graphical representation of the linear programming problem.  Each line represents a constraint (vertical and horizontal lines are the EOPT constraints, sloped lines are the FTARGET constraints.
 The lines in Figure 1 represent effort levels that exactly meet the constraints; efforts must be to the left and below each line in order to be feasible.  Thus the feasible effort combinations are only those in the polygon from the graph origin out to the first constraint lines met.  Since efforts are to be as large as possible, the solution has to lie along one of those first lines met, and in fact has to be on one of the three vertices marked A, B, C.
 	Effort combination A represents Fleet 1 being severely restricted, but Fleet 2 operating at its EOPT. 
 	Effort combination C represents Fleet 2 being severely restricted but Fleet 1 operating at its EOPT, and
 	Effort combination B represents a “balanced” policy choice where both fleets are restricted to below EOPT in order to “share the burden” of avoiding exceeding either of the two FTARGET species constraints.
 
 Which of these three combinations will be chosen (solve the linear programming maximization) depends on the value weights vj in Eq. 1.  If v1 is much higher than v2, combination C will be chosen, combination A will be chosen if v2 is larger, and setting the two v’s equal will more likely lead to the balanced combination B.  Note also in Figure 1 that as the FTARGET constraints are “relaxed” (increased so the sloped lines move upward and to the right), it becomes more likely that the optimum effort combination will lie near EOPT for both fleets; likewise, as these constraints are “tightened” (reduced so the sloped lines move down and to the left), it becomes more likely that the EOPTs will not be in the feasible region so that the optimum solution will lie either with a mixed effort combination or with one or another of the fleets shut down entirely.
 Using the linear programming formulation, it is simple to evaluate the cost, in terms of lost total value, of introducing more restrictive constraints on species harvest rates.  In the overall management strategy evaluation setup for Ecosim, the only other way to evaluate this cost is to do policy runs with and without “weakest stock” constraints on fleet quotas, where all fleets are assumed to share equally in reductions needed to meet such constraints.  The linear programming solution may well demonstrate that such equal sharing of the conservation burden is in fact far from optimum.
 The linear programming formulation can also be used to demonstrate potential increases in fishery value from selective fishing practices that change the species-specific catchabilities qij.  For example, if q12 and q21  (catchability of species 1 by fleet 2 and of species 2 by fleet 1) could be greatly reduced in the Figure 1 example, the slopes of the two FTARGET constraint lines would decrease/increase so as to move the solution toward higher total efforts (move point B up and to the right, closer to the EOPT1-EOPT2 intersection) and thus higher total value.
 The key to getting useful results from the linear programming exercise is to make wise choice of the fleet value weights vj.  One objective option for doing this each year (assuming a management strategy where biomass and perhaps catchability qij estimates are being updated regularly) is to set each weight to be
 [image: v_j = \sum \limits _{i=1}^{nf}P_{ij}q_{ij}B_i \tag{4}]
 where Pij is the landed price for species i by fleet j and Bi is the current estimated biomass of species i.  Using this formula, vj is just the sum over species of predicted catches per effort times prices, so that vjBj represents the (short term) predicted total value of landings by fleet j and the overall linear programming objective function just becomes the predicted total landed value of all catches.
 An option in the management strategy evaluation interface allows users to replace the complicated older EwE and CEFAS rules for setting quotas to limit mortality rates to acceptable levels, to instead use annual LP optimization each year during each MSE simulation run so as to limit fishing efforts rather than quotas.  The basic idea is just to replace the single Ej values in the equations above with time-varying values calculated for each year and group using annual values for the FTARGETi target fishing rate for each group i  for that year, calculated from the estimated biomass of the group and the group’s harvest control rule that specifies how target fishing rate for the group should vary with stock size. This option can lead to complex policy changes over time, especially when the FTARGETi decrease with decreases in biomasses Bi.
 
	Murawski, S.A. and J.T. Finn. 1986. Optimal effort allocation among competing mixed-species fisheries, subject to fishing mortality constraints. Can. J. Fish. Aquat. Sci. 43: 90-100. https://doi.org/10.1139/f86-010 ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Stock recovery scenarios

								

	
				 Learning Objectives
  	Get experience with how to consider the combined impact of fisheries, environmental conditions, and food web structure in a simple ecosystem model
 	Get experience with a more complex procedure for time series fitting
 
 
 
 The cod population in Anchovy Bay has been depleted, and there is concern for its recovery. Assessments in the 1980s indicated overexploitation to be the cause of the population decline, and the trawl fishery for cod was closed in 1990, despite concerns for the socio-economic consequences. It was some comfort, however, that the stock was predicted to rebound within a few (cod) populations, perhaps in a decade or so.
 By 2010, the cod population, however, had shown little sign of recovery. In this tutorial, we use a previously constructed, (but slightly modified) ecosystem model of Anchovy Bay to evaluate alternative hypotheses for why the cod population has not recovered to its 1970-level in spite of a strong reduction in fishing pressure.
 Download the Anchovy Bay Cod Recovery.ecomdb database along with the cod recovery.csv time series file from this zip file. Open the EwE software and load the Anchovy Bay model, the Ecosim scenario, and import the cod recovery time series file. Then run Ecosim, and note the Summed Squared residuals (SS, on the run screen, top left corner). You can scroll through the groups, to see the trajectory for each (along with the groups contribution to the SS).  Also, open the Group plot form (Ecosim > Output > Ecosim group plots), and examine the plots for each of the functional groups/species. You will notice that the fits to time series are pretty poor – which shouldn’t be surprising as we are only starting the fitting process now.
 For the fitting, we will consider the combined impact of fisheries, environmental conditions, and food web structure. We do that in a semi-structured manner.
 Predictions of the impact of fisheries will, in any model, depend on density-dependent factors. In Ecosim, the most important factor is the vulnerability multiplier. Vulnerability multipliers express how much the predation pressure that a given predator causes on its prey can be increased if the predator was to increase to its carrying capacity. If the predator is at carrying capacity, it cannot increase the predation pressure on its prey (that’s what being at carrying capacity means), so the vulnerability multiplier should be 1. If, on the other hand, the predator has been depleted, the vulnerability multipliers should be higher. The default setting for vulnerability is 2, i.e. a predator can at most double the predation mortality it’s causing on its prey.
 If you examine the Ecosim group plots after the first run, you’ll notice for seals that the time series indicate a strong increase (7x) in the seal population, while Ecosim indicates less than a doubling. Why? The default vulnerability is part of the problem. Try increasing the vulnerability multipliers for seals as consumers, (Ecosim > Input > Vulnerabilities, click the column heading for column 2 (i.e. for cod as consumer), enter, e.g., 10 in the Set input box in the top right corner, and click Apply).
 Run Ecosim again, and check the trajectory for seals. Better? You can also try to lower the vulnerability multipliers, e.g., to 1.1 and see what happens. By the way, the vulnerability multipliers scale from 1 to infinity, it can never be lower than 1, that would mean that the predator had exceeded its carrying capacity in the Ecopath baseline). Most of the ‘action’ is in the 1-20 range, as you increase the vulnerabilities beyond that it gradually has less and less impact.  Note that the Ecosim time series fitting may come back with very high vulnerability multipliers – it may be that changing the multiplier from, e.g., 100 to 100,000 decreases the SS a tiny tiny bit. If that happens, the best is to manually reduce the multipliers and check if it makes any difference in the SS.
 For cod, we know that it has been exploited as a target fishery in Anchovy Bay for more than a century, so it would not have been close to its carrying capacity in 1970, (the year for which the Anchovy Bay ecosystem model was constructed, which provides reference points for vulnerability multipliers and other settings).  So, to improve the fit, how should you change the vulnerability setting for cod as a consumer? Try it.
 The above goes to show that vulnerability multipliers are not ‘nuisance’ parameters, they have a clear interpretation that makes sense from an ecological perspective, and could in principle be estimated independently of the ecosystem model. The main hurdle for this, however, is that while carrying capacity is on old and well-founded concept, it changes, every day, so it would be difficult, (but perhaps not impossible) to estimate it independently – this factor is indeed what most single-species assessment estimate (Bt/Bo) – though with little basis in reality.
 Therefore, our best option is to use constraints in our model, to estimate the density-dependent vulnerability multipliers. We can do this using ‘observations’, made accessible to the model through time series files. In our case (cod recovery.csv), it is rather restricted what we have: seals have increased, cod declined and have not recovered, whiting have increased a bit, and shrimp catches have increased. The principle here is: the more information we have, the more constraints this pose for the model. Therefore, the more data, the more difficult the fitting becomes, but the more confident we can be about the model behavior.
 To use the time series for fitting, go to Ecosim > Tools > Fit to time series. Click Search groups with time series, and Search. Ecosim will now run a time series fitting, trying to find vulnerability multipliers that minimizes the SS. You will likely see some reduction in SS, but nothing spectacular. Next, go back to Ecosim, Output, Run Ecosim, and make a run. Examine the group plots. You will likely find that the fit for seals is good, but not the fit for cod, which likely have recovered to the 1970-level as a result of the lower fishing pressure in Anchovy Bay since 1990. Also, shrimp catches don’t even get near to matching the level from the time series.
 In conclusion for where we are so far, time series fitting to evaluate the impact of fishing provides some information, but doesn’t explain why cod hasn’t recovered. Is it the environment that has changed then? Reset the environmental forcing function by going to Ecosim > Input > Forcing functions, click the 1: Fitting function, and click Reset.
 Next question is: Is it the environment then? To evaluate this, we need information about how the environmental productivity of Anchovy Bay has changed since 1970, with the most important indicator being primary production. Unfortunately, such long-term information is hardly ever available as oceanographers tend to run their models for short time periods only. There is indeed a gap between oceanography and fisheries, and we need to fill it.
 In lieu of environmental productivity data, we can ask Ecosim to estimate a ‘primary production anomaly’ (PPA), i.e. how might relative primary production have to have changed over time to fit the time series better. First, go to Ecosim > Input > Forcing function > Apply FF (producer), click the spreadsheet cell for phytoplankton, select 1: Fitting, and click the arrow to the right to apply this forcing function. This only means that you’ve associated primary productivity with the forcing function. Go to Ecosim > Tools > Fit to time series, and click Search groups with time series, click Vulnerability Search (i.e., checked), click Anomaly Search. Then click the Search, Anomaly Search tab.  You should now see the 1: Fitting forcing function on the form. Next, increase the Spline points on the form, e.g., to 8, and click Search. Ecosim now starts a search, resetting vulnerability multipliers and evaluating the combined effects of density dependence (vulnerabilities) and environmental productivity changes (primary production anomaly).
 The SS will likely have decreased somewhat (keep track!), but not a lot, so what has it done? Go back to Ecosim > Output > Run Ecosim, and make a new run – the vulnerability multipliers and primary production anomaly from the search have been transferred there already. Examine the Ecosim group plots, check the estimated vulnerabilities and the primary production pattern. You’ll find that there isn’t much improvement for cod. Why?
 One part of the answer is that the time series fitting puts the same weight on all of the time series as entered. There’s a weight attributed to each, and the time series file we read in had a weight of 1 for all. If you really want the search to prioritize cod, you could give the cod biomass time series a higher weight, perhaps 10 or even 100. The downside is that you’d be twisting your ecosystem model in the direction of a single-species model.
 What then?
 Perhaps cod reacts differently to environmental change than the ecosystem overall? To evaluate this, let’s consider how temperature impacts cod (they like cooler water), and fortunately temperature is usually one of the time series we may obtain from the oceanographers.
 If you look in Ecosim > Input > Forcing functions, you should find a T bottom time series. Let’s apply this to cod. Go to Ecosim > Input > Functional responses, here there should be a Temp cold environmental response function, which we’ll use for cod. Click Ecosim > Input > Functional response > Apply functional responses, click the cell intersecting Cod juv. with T bottom, and transfer Temp cold to Applied responses. Do the same for Cod ad.  Does it improve the fit? Some, but cod is likely still not recovering to the 1970-level.
 Fit to time series again, use the Search group with time series option, but add shrimp as consumer to the fitting (select a non-used color, and click the column heading for group 10).
 Examine the fit. You’ll likely find that seals increase more in Ecosim than in the time series. The search has chosen a higher vulnerability for seals in order to get more increase and therefore more predation pressure on cod, to help keep that group down. If you examine the diet composition for seals, you’ll see that cod is a very minor component, but this represents a high predation pressure on cod.
 Next, examine the diet compositions. You’ll see the whiting does not eat cod. That’s unlikely to be correct, so try including it. For instance, by letting juv. whiting take 0.005 juv. cod (and change the proportion of zooplankton in the juv. whiting diet to 0.9. For ad. whiting change the proportion of juv. cod to 0.03, for ad. cod to 0.01, and for benthos to 0.34. Run Ecosim, then do a new fit to time series, again with fitting for groups 2, 4, 6, 10, i.e. groups with reference time series including shrimp, (which has a catch time series).
 How does this look? Does cod recover now?
 You likely have a pretty good fit now, examine it, each group, vulnerability multipliers, … Think about how you got the fit. Also, try to get the predictions to break down again. Play! But reflect on what you’re doing and notice what effect you see for different scenarios.
 Even if you now have a good fit, try one more thing. Redo the time fit, but this time also include an Anomaly search for a primary production anomaly (using spline points, still 8 perhaps). Do the search, and when it’s done compare to the derived forcing function (1: fitting) to the forcing function that was actually used when constructing the model (3: True PP). You’ll likely find some resemblance between the two shapes, but also that the (1: fitting) shows much more variation. The reason for this is that the search criteria is chasing observations, and can do that without penalty as the time series we use in this example have very little constraints. You can get an idea about this by going back to Ecosim and do a run. You’ll likely see some strange things happen in between years with observations
 Primary production (PP) should preferably not change over time with more than perhaps +/- 20% or so, and in this case the change was likely much more. Try setting the PP Variance to 0.01, (which will provide a much lower prior for the sampling). This likely caused much less variation in the PP anomaly plot.
 Examine the Akaike Information Criteria estimates from the various run on the time series plot, what does that tell you?
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		Fleet effort dynamics

								

	
				 Ecosim and Ecospace can include fishing pressure in two ways: using fishing mortality or fishing effort. If fishing mortality is used, the corresponding catch is calculated for each time step from catch = fishing mortality · biomass. If effort is used, the key assumption is that the fishing mortality in the Ecopath baseline model corresponds to an effort of 1 (unity). Any change in effort over time will result in a proportional change in fishing mortality.
 So, if in the Ecopath baseline, catch = 0.2 t km-2 year-1 and biomass for the group in question is 1 t km-2, the fishing mortality is calculated from the catch/biomass ratio to 0.2 year-1. If fishing effort increases, e.g., to 1.1 then this results in an F of 0.2 · 1.1 = 0.22 year-1.  This is not an EwE invention, it follows straight from how fishing effort was originally defined.[1]
 Effort is associated with fleets, and many fleets catch more than one species. That’s fine, the F’s will show the same proportional change for all species. But what if both effort for a fleet impacts a species for which there also a fishing mortality entered? In that case we have no choice but to let the fishing mortality overrule the effort for such a species. This indeed offers some flexibility, for instance in an application with a multi species fleet where there’s detailed information from assessment for one species. We can then use the fishing mortality from the assessment for that species, and fleet effort for the rest.
 
  
 There are three ways to specify temporal changes in fishing fleet sizes and fishing effort:
 	By sketching temporal patterns of effort in the model run interface;
 	By entering annual patterns via reference CSV files along with historical ecological response data; and
 	By treating dynamics of fleet sizes and resulting fishing effort as unregulated and subject to fisher investment and operating decisions (“bionomic” dynamics, fishers as dynamic predators).
 
 To facilitate exploration of alternative harvest regulation policies, the Ecosim default options are (1) or (2).  However, you can invoke the fleet/effort dynamics model where effort is estimated, rather than input, by checking Ecosim > Input > Ecosim parameters > Fleet effort dynamics. Input parameters must then be set on the Ecosim > Input > Fleet size dynamics form.
 When the fleet/effort response option is invoked, Ecosim  starts each by erasing all previously entered time patterns for fishing efforts and fishing rates, and replaces these with simulated values generated as each simulation proceeds. The fleet/effort dynamics simulation model uses the idea that there are two time scales of fisher response:
 	A short time response of fishing effort to potential income from fishing, within the constraints imposed by current fleet size, and
 	A longer time investment/depreciation “population dynamics” for capital capacity to fish (fleet size, vessel characteristics).
 
 These response scales are represented in Ecosim by two “state variables” for each gear type g.
 Fast time response model
 Eg,t is the current amount of effort (active, searching gear, scaled to 1.0 at the Ecopath base fishing mortality rates), and Kg,t is the maximum possible effort (Eg,t < Kg,t).
 At each time step, a mean income per effort index Ig,t is calculated as
 [image: I_{g,t}=\sum_i q_{g,i} B_i P_{g,i} \tag{1}]
 where i = ecological species or biomass group, qg,i is the catchability coefficient (possibly dependent on Bi) for species i by gear g, and Pg,i is the market price obtained per biomass of i by gear g fishers.  Also, mean fleet profit rates PRg,t for fishing are calculated thus:
 [image: PR_{g,t}=I_{g,t}-c_g \tag{2}]
 where cg is the cost of a unit of fishing effort for gear g (cost and price factors are entered via the Definition of fleets and Market price forms). For each time step, the “fast” effort response for the next (monthly) time step is predicted by a sigmoid function of income per effort and current fleet capacity:
 [image: E_{g,t+1}=\frac{K_{g,t}I^p_{g,t}}{I^p_{hg}+I^p_{g,t}} \tag{3}]
 Here, Ihg and p are fleet-specific response parameters. Ihg is the income level needed for half maximum effort to be deployed and p is a “heterogeneity” parameter for fishers: high p values imply all fishers “see” income opportunity similarly (start or quit at similar income values), while low p values imply fishers “turn on” their effort over a wide range of mean incomes (start or quit over a wide range of average incomes), as shown in Figure 1.
 [image: ]
  
  
  
  
 Figure 1. Effect of the “heterogeneity” parameter, p, on effort/income function.
  
  
 Slow time response model
 For each fleet, slow effort responses are modelled as changes in fleet capacity (Kg,t), which is a function of the capital depreciation rate ρg, the capital growth rate rg,t and profit PRg,t. The capital growth rate is calculated via a growth factor gfg,t, i.e.,
 [image: gf_{g,t+1}=\frac{K_{g,t}(r_{g,t}+\rho_g)}{PR_{g,t}} \tag{4}]
 where Kg,1, ρg and rg,1 are set by the user. The annual capacity Kg,t is then updated as
 [image: K_{g,t+1}=K_{g,t}(1-\rho_g)+gf_{g,t}PR_{g,t+1} \tag{5}]
 Attribution This section was adapted and edited from the unpublished 2008 EwE User Guide.
 
	Beverton, R.J.H. and Holt, S.J. 1957. On the dynamics of exploited fish populations. Fisheries Investigations, 19, 1-533. Chapman and Hall, Facsimile reprint 1993, London. 533 pp. ↵
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				 If you need a refresher in economics, see, e.g., the open source textbooks Principles of Macroeconomics and Principles of Microeconomics.
 
 Fisheries systems are composed of linked biophysical and human subsystem with interacting ecological, economic, social, and cultural components.[1] In previous and subsequent sections of this book, information is provided on how to use EwE models to assess the ecological consequences of environmental change as well as of fisheries policies, conservation efforts (e.g., marine protected areas), and alternative uses of the marine environment (e.g., off-shore wind farms). Yet, humans, being integral parts of fisheries systems, also require attention in our modelling efforts.
 Fishers’ actions are driven by economic objectives and their desire to secure their wellbeing.[2] [3] Thus, their choices and behaviours, whether legal or not, occur along a gradient and are implemented by the same individuals or vessels, in their pursuit for a good life.[4] Understanding the socio-economic characteristics of the fishers and fleets operating in the systems we are modelling, is key to assess whether the economic incentives at play promote compliance with existing or proposed regulations. [5] [6] [7]  [8] Moreover, environmental and policy changes have direct and indirect consequences on fishers’ income and broader social and economic policy goals. Yet, managers, decision makers, and regulators often lack adequate performance metrics covering the human dimensions of fisheries systems. This limits their capacity to assess or predict the socio-economic consequences of change in fisheries systems, as well as trade-offs among conflicting management objectives and the uncertainty behind them.[9] [10] [11] [12]
 More efforts are needed to adequately characterize and couple fisheries and their linked downstream supply chain nodes in food web models so that they can be used to inform decisions in the realms of the ecosystem approach to fisheries, ecosystem-based fisheries management, ecosystem-based management.[13] [14] [13,14]. Fortunately, EwE has multiple capabilities for including fisheries socio-economics in food web models and improving our understanding of the feedbacks between human activities and ecosystem dynamics.
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				EwE can directly produce multiple socio-economic indicators. Nonetheless, EwE models can also be linked to, or coupled with, external bioeconomic models to expand its capabilities. A first step, however, is the identification of ex-vessel prices for the multiple functional groups included in the model. These data can be obtained from local or national reports, as well as from existing regional (e.g., EU’s Scientific, Technical and Economic Committee for Fisheries) and global (e.g., Sea Around Us) databases.
 Users should begin by defining the currency to be used in the model by selecting the correct monetary units (e.g., USD, EUR, CNY) while setting the models’ parameters (Ecopath > Input > Model parameters). Then, after defining the model’s functional groups and fishing fleets, and including the corresponding landings data, users will be able to input price data for each functional group – fishing fleet combination with catches. This is achieved in the off-vessel prices form (Ecopath > Input > Fishery > Off-vessel prices), and the data included should reflect the value of a ton of fish or shellfish caught within the model area in the base year. Based on this data, the model can estimate three socio-economic indicators pertaining to revenue by multiplying the off-vessel prices with the corresponding landed amounts for each functional group – fishing fleet combination and adding these values across: (i) functional groups (i.e., the landed value per functional group), (ii) fishing fleets (i.e., fleet level revenue), and (iii) across functional groups and fishing fleets (i.e., total landed value or total producer revenue).
 If multiple Ecopath models are available for the same project area, then the landed value per functional group, the fleet level revenue, and the total producer revenue can be used to compare the fisheries over time. Moreover, if time series data for off-vessel prices is available, then the outputs from Ecosim and Ecospace runs (e.g., time series data of catches per fleet) can be used to estimate these three indicators externally. Yet, EwE can also model these internally, if information is available on how sensitive off-vessel prices are to changes in landed quantities. This can be achieved through price elasticities (Ecosim > Input > Price elasticity). For more information on this see the chapter on Price elasticity.
 In some cases, the value of a fishery may increase over time (due to higher catches or off-vessel prices). However, the fleets’ profitability might not follow the same trend if fishing costs (e.g., wages, fuel) have increased at a much faster rate. Indicators related to profits (i.e., Profits = Revenue – Costs) are thus useful for capturing these changes, particularly if multiple fleets are involved. This is also a relevant concern for modelling the consequences policies pertaining to fisheries subsidies.[1]
 There are multiple ways by which EwE allows users to get a grasp of profitability. It begins by obtaining information about the cost-income structures of the fishing fleets. These data can be directly collected using surveys or semi-structured interviews[2] [18], extracted from secondary literature (mainly grey literature), or requested to the government bodies responsible for its collection at subnational or national levels. EwE allows users to input cost-income data by expressing it as a percentage of the fleet level revenue, where: Total Value of the fleet = Fixed costs + Cost per unit of effort + Cost of sailing + Profit. This information can be included in the model in the same form used to define the fleets (Ecopath > Input > Fishery > Fleets).
 Here, Fixed costs include costs that are independent of changes in effort levels at the fleet scale (e.g., capital investments, management, and monitoring costs). Cost per unit of effort and Cost of sailing are both used to express variable costs, or costs that change proportionally to changes in fishing effort (e.g., fuel, food for the crew, wages). If the user only plans to use Ecopath or Ecosim, then all variable costs should be included as Cost per unit of effort (i.e., Cost of sailing should be left empty). Only if the intention is to build an Ecospace model, then variable costs should be split, highlighting the cost fraction that will vary directly depending on the spatial allocation of fishing effort (e.g., fuel costs). These costs should be included as Cost of sailing, while all other variable cost should be entered as Cost per unit of effort. The default settings for all fleets places Fixed costs at 0%, Cost per unit of effort at 40%, Cost of sailing at 40% and Profit at 20%. These defaults might be representative for some fleets, yet for most they will not (e.g., STECF 22-06).
 Understanding what proportion of the fleet level revenues correspond profits allows users to estimate fleet level profits out of Ecosim and Ecospace runs.[3] [4] [5] [6] [7] [8] [9]. Moreover, if additional information is available of what percentage of the fleet level revenue is used for wages, how many vessels are operating and how many people are employed per vessel, then modelers can also estimate fishers’ average salaries per fleet. This information could then be used to compare it with annual country level minimum wages to assess if, and under which scenarios, fishers operate below the poverty line. Additionally, having information about fishing costs and profits is essential for modelling effort dynamics within EwE (see the chapter on Fleet effort dynamics), as well as for fishing policy exploration (see chapter on Fishing policy exploration). An alternative way to parametrize fishing costs is described in the Value chain modelling chapter.
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				Economist classify fisheries as primary industries, highlighting their supporting role for numerous secondary (e.g., seafood processors) and tertiary industries (e.g., hotels and restaurants) in the economy.[1] [2] Extractive industries are generally limited at creating value. For example, the direct economic contribution of fisheries to national economies around the world ranges only between 0.5% and 2.5% of their Gross Domestic Product (GDP).[3] [4].
 However, fishing requires inputs from other industries to operate (e.g., boat building industry and fishing net manufacturers),[5] and as fish, marine invertebrates and macroalgae move along supply chains, they are transformed into accessible seafood products tailored to meet the needs of consumers.[6] Thus, fisheries have “upstream” (i.e., prior to fishing) and “downstream”(i.e., post-harvesting) economic effects, which are commonly characterized using input-output models to estimate multipliers (see the External bio-economic models chapter). These multipliers are factors used for approximating the extent of the contribution of an economic sector to a nation’s economy.
 The EwE Value Chain plug-in is a powerful tool for characterizing the downstream economic effects of the fishing fleets.[7] The economic agents or components within the value chain are referred to as enterprises described via a set of common attributes (see Table 1) and segregated based on their function within the value chain. The value chain model is coupled to ecosystem model through the fishing fleets. These are considered as producers, given that they are the main source of raw materials for the seafood supply chain. Non-extractive activities using marine living resources (e.g., ecotourism or non-retaining recreational fisheries) and some types of aquaculture enterprises can also be considered as producers. Enterprises that receive marine living resources from producers and transform them into seafood are classified as processors. These typically include fish cutters and filleters, canneries, seafood freezing facilities, or fishmeal processing plants.[8] [9] [10] However, some aquaculture operations can also be classified as processors if they receive feed or seeds from other processors or producers within the system.[11]
  
  
 Table 1. Input parameters used to characterize seafood value chains in EwE’s value chain plug-in.
 	Topic 	Parameter 	Symbol 	Unit 
  	Identity 	Name 	 	 
 	Nationality 	 	 
 	Products 	Agricultural 	Ra 	$/t 
 	Energy 	Rc 	$/t 
 	Industry 	Ri 	$/t 
 	Services 	Rs 	$/t 
 	Ticket sales 	Rt 	$/effort 
 	Subsidies 	Energy 	Ue 	$/t 
 	Other 	Uo 	$/t 
 	Pay or share 	Worker, female 	Ps or Ss 	$/t or % 
 	Worker, male 	Ph or Sh 	$/t or % 
 	Owner, female 	Pf or Sf 	$/t or % 
 	Owner, male 	Pm or Sm 	$/t or % 
 	Input 	Agricultural 	Ia 	$/t 
 	Capital cost 	Ic 	$/t 
 	Energy cost 	Ie 	$/t 
 	Industrial cost 	Ie 	$/t 
 	Services cost 	Is 	$/t 
 	Cost 	Management 	Cm 	$/t 
 	License 	Cl 	$/t 
 	Certification 	Cc 	$/t 
 	Observers 	Co 	$/t 
 	Observer rate 	Cr 	 
 	Taxes 	Environmental 	Te 	$/t 
 	Export 	Tx 	$/t 
 	Import 	Ti 	$/t 
 	Production 	Tp 	$/t 
 	Value added tax 	Tv 	$/t 
 	Licenses 	Tl 	$/t 
 	Employment 	Worker, female 	Js 	#/t 
 	Worker, male 	Jh 	#/t 
 	Owner, female 	Jf 	#/t 
 	Owner, male 	Jm 	#/t 
 	Dependents 	Female worker dependents 	Ds 	#/worker 
 	Male worker dependents 	Dh 	#/worker 
 	Female owner dependents 	Df 	#/owner 
 	Male owner dependents 	Dm 	#/owner 
  
 The remaining enterprises in the seafood value chain are classified as either distributors or sellers, depending on their functional roles. Distributors typically include middlemen linking producers and processors, enterprises specialized on transporting seafood from processors to sellers, or seafood exporters linking producers with foreign markets. Sellers, on the other hand, connect producers, processors and distributors with consumers, and these typically include seafood wholesalers, supermarkets, small municipal markets, street vendors and restaurants.
 It is important to highlight that the information required to populate the value chain within EwE, such as an enterprise’s management costs or its number of female workers (Table 1) must be expressed in a per tonne basis (e.g., $ per tonne or jobs per tonne). Moreover, the forms within the plug-in (Ecopath > Output > Tools > Value chain) provide ample freedom regarding what information to include. If available data for characterizing enterprises is highly aggregated, it is still possible to populate the value chain by including a single item in the cost structure. The same is the case for the employees, workers, and dependents if data is not segregated by sex.
 Links between enterprises are characterized by tracking losses in weight and gains in value are estimated using the ratios between the weight of products leaving an enterprise and the weight of inputs it used to create them. These values are provided in live weight equivalents (e.g., the weight of fish in the can) and not the total weights (e.g., weight of cans including fish, liquids, and tin). Gains in value are estimated in a similar manner, using the ratios between the value of products and inputs flowing through each enterprise.
 Calculations for estimating (i) revenue, (ii) profit, (iii) contributions to GDP, and (iv) employment for all enterprises described within value chain are expressed with the following equations,
 [image: L_c=W_{p,c}\cdot \prod\limits_{e=1}^c (\frac {W_{i,e}}{W_{p,c}} ) \tag{1}]
 where L_c is the live weight equivalent for a given value enterprise for which the value chain holds enterprises from the first (a producer) to the last element in the chain (c),  Wp,e is the weight of products for the enterprise (e), and Wi,e is the weight of input (“raw material”) for the same enterprise.
 [image: R_p=W_p \cdot (R_a+R_e+R_i+R_s) \tag{2}]
 where Rp is the overall production revenue for the enterprise. Revenues from subsidies (U) are calculated from,
 [image: U=W_p (U_e+U_o) \tag{3}]
 [image: \text{Total revenue } (R)=R_p + U \tag{4}]
 [image: \text{Cost of input and operation } (I)=W_p (I_c+I_e+I_i+I_s+C_m+C_l+C_c)\tag{5}]
 [image: \text{Cost of observers } (O) = W_p (C_o \cdot O_r)\tag{6}]
 [image: \text{Taxation costs } (T) = W_p (T_e+T_x+T_p+T_v+T_i+T_l)\tag{7}]
 [image: P_w = \begin{equation} \left\{ \begin{array}{cc} W_p \cdot (P_s + P_h) , \text{ if using a wage system} \\ W_p \cdot V_{f,s} (S_s+S_h) , \text{ if using a share system} \end{array} \right. \end{equation} \tag{8}]
 where Vf,s is the value of the product (by fleet and by species) per unit weight.
 [image: P_o = \begin{equation} \left\{ \begin{array}{cc} W_p \cdot (P_f + P_m) , \text{ if using a wage system} \\ W_p \cdot V_{f,s} (S_f+S_m) , \text{ if using a share system} \end{array} \right. \end{equation} \tag{9}]
 [image: \text{Total costs } (C)=I+O+T+P_w+P_S \tag{10}]
 We calculate the number of jobs for workers (Jw) and owners (Jo), and the total number of jobs from the sum of Jw and Jo.
 [image: J_w=W_p (J_s+J_h)\tag{11}]
 [image: J_o=W_p (J_f+J_m)\tag{12}]
 Further the numbers of dependents of workers (Dw) and owners (Do) is calculated from
 [image: D_w=W_p (D_s \cdot J_s + D_h \cdot J+h) \tag{13}]
 [image: D_o=W_p (D_f \cdot J_f + D_m \cdot J_m) \tag{14}]
 which can be summed to give the total number of dependents, D = Dw + Do.
 For producers, it is assumed that the number of jobs is proportional to effort, while their income depends on the catch value of the catches.
 The socio-economic indicators (i.e., i-iv, see above) can be summarized by: (a) functional group, (b) fishing fleet, and (c) any enterprise within the value chain, or (d) for the whole fisheries sector. Moreover, the contributions to the GDP and employment can be divided between activities taking place at sea and on land to estimate income and employment multipliers (e.g., how many jobs (or $) are made on land for each job (or $) made at sea) by fleet, functional groups and across the fisheries system.
 At the Ecopath stage, the value chain models can be used to address multiple questions related to characterizing the economic network. For example: Which fishing fleets are the most important contributors to national employment (at sea and on-land)? Are the income multipliers similar among functional groups and fishing fleets? How big is the fishing industry in economic terms? Do mackerels contribute more to a country’s GDP when fished by purse seiners or by gillnetters? Are canneries and seafood freezing plants paying similar wages to the women they employ? How many people are employed in export-driven seafood supply chains in comparison to those selling locally? Are people earning annual salaries above the minimum wage across all enterprises in the seafood value chain?[12] [13] [14]
 Value chains are good tools for highlight the roles played by marginalized groups within the fisheries sector (e.g., women, small-scale fishers, subsistence fishers) in a systematic manner. For example, characterizing seafood value chains in Peru under this approach revealed that supply chains starting with small-scale fishers were the main contributors to employment and GDP across the fisheries sector, although being responsible for only 15% of the country’s catch.[15] Additionally, the implementation of this approach in Baía Formosa (Brazil) allowed the users to quantify the indirect contribution of subsistence fisheries to local economies.[16]
 Furthermore, understanding value chains’ flows and structures opens new opportunities for addressing “what-if” questions regarding the end use of marine living resources, and how these affect their potential contribution to the economy, employment and job security (a known limitation of input-output models)[17]. For example, a study revealed that a transition from the fishmeal-dominated status quo to a hypothetical scenario where all anchoveta (Engraulis ringens) landed in Peru were used for canning; would result in a 53% reduction in the country’s fishmeal production, a 21% increase in fisheries sectors’ profitability, a 183% increase in job creation, and 179 times more seafood production.[18] Moreover, national and provincial value chains can be compared to highlight how the same functional groups and fishing fleets can have dissimilar employment and income multipliers at different spatial scales (revealing the local importance of certain functional groups or fishing fleets).[19]
 At the Ecosim model stage, value chain models can be used for equilibrium analyses. For example, Christensen et al. [20] sought to assess the maximum sustainable yield (MSY) by setting a constant fishing effort over a 25 year-long Ecosim run, letting the system reach a steady state and then repeating the run with a new fishing effort level. They explored a wide range of effort levels (from no exploitation to overexploitation) on a theoretical fleet targeting tuna. In each step revenue, fishing costs, income, and employment for the fleets and the entire supply chain, were registered. This approach allowed researchers to: (i) highlight trade-offs between fishing fleets (e.g., tuna fleet vs mackerel fleet), (ii) showcase how fishing costs are non-linear (although commonly assumed to be so in equilibrium analysis [6]), and (iii) highlight the strengths of using MSY instead of the Maximum Economic Yield (MEY) as a descriptor for the maximum socio-economic benefits that can be achieved by a fishery.[21]
 Moreover, value chain models can also be used together with Ecosim and Ecospace for studies involving hind- and forecasts. This tool is robust for expressing the socio-economic outcomes of “what-if” scenarios (from climate change to fisheries policies), and for testing the effects of broader economic policies (e.g., the introduction of new taxes or the elimination of fuel subsidies). Moreover, granted that it allows users to define the cost-income structure of the fleets in a more detailed manner (Ecopath > Output > Tools > Value chain > Components > Producers), even if only producer data is available, the Value Chain plug-in can strengthen estimates for the fishing profitability over time, as well as simulate the evolution of particular variable cost (e.g., fuel costs) across scenarios.
 Yet, it is important to note that in these instances, food web modelling outputs (i.e., catches per fleet per functional group) will enter the value chain model without affecting its base parametrization. Thus, some value chain outputs might be misleading given that value chain parameters are not equally stable over time. For example, processing yields (e.g., the difference between the total weight of tuna entering a cannery and the weight of tuna in the cans coming out of it) tend to be quite stable over time, unless important changes in processing technology come to play. Alternatively, if a processing industry (e.g., reduction industry) is growing in a country, then the number of workers or owners per tonne of processed fish will vary substantially between years. Thus, if the processing capacity is in excess in the year corresponding to the base value chain model, then projections on the contribution this industry for total employment might be overestimated in future years (as the processing plant could still take more fish without having to adjust its labour force).
 Given this issue, it is key to ground model outputs with data when using the value chain models, particularly for medium to long-term projections. First and foremost, users should highlight, when reporting results, that uncertainty in model outputs increases substantially over time. The classic economic assumptions of ceteris paribus will be damaging to fisheries system if the resulting management advice is given based exclusively on socio-economic indicators using a single set of value chain parameters. Just as one should avoid giving fisheries management advice using only Ecopath models, one should also avoid using static value chains. Solutions for these limitations can be undertaken by:
 	Developing multiple value chain models for consecutive years (e.g., 5 or 10 years) and running Ecosim over each value chain parametrization. The outputs could be plotted together to highlight the consequences of parameter and structural uncertainty in the socio-economic projections, or
 	Constructing a base value chain model for a 5-year or 10-year period (by averaging annual parameter values over time) and then using the coupled value chain-Ecosim runs only to study changes over that same period or a future period of the same length.
 
 The latter solution is certainly a less preferable one. However, access to data might make it difficult to develop multiple consecutive full value chain models. Notwithstanding, adopting a scenario approach to value chain outputs is still useful, particularly by forcing users to explicitly state their hypothesis on what is assumed to remain constant over time and why.
 Nonetheless, EwE’s Value Chain plug-in grants unique capabilities for directly estimating the income and employment multipliers of specific marine living resources (i.e., through EwE functional groups), producers (i.e., fishing fleets) and the fisheries sector. Moreover, it provides modelers with a platform to synthesize large amounts of socio-economic knowledge of fisheries systems to provide a description of its whole economic subsystem in a succinct but comprehensive manner, much like what an Ecopath model does for an ecosystem’s food web.
 The process of constructing a value chain model requires developing a working hypothesis of its structure and understanding what information is available, how it is stored, who has access to it, and who collects and updates it. This process is quick to reveal areas (e.g., enterprises, items within their cost structure or segments of the value chain) with information deficits, that can be used to prioritize research and monitoring efforts. Moreover, if conducted in a participatory and inclusive manner, this process can help strengthen seafood traceability,[22] improve managers’ understanding of leverage points along the supply chain, and be used to simulate the consequences of potential governmental interventions (both at sea and on land) on the national economy. For example, value chain models in EwE can be used together with the Management Strategy Evaluation (MSE) Module or the CEFAS MSE plug-in (See the MSE CEFAS tutorial)[23] to simulate the effects of implementing alternative management procedures (e.g., harvest control rules) on individual or multiple functional groups using indicators that describe the ecological, economic and social components of fisheries systems. This allows modelers the capacity to directly quantify trade-offs amongst management objectives and harvest strategies, while highlighting how the costs and benefits of the different management procedures are distributed among stakeholders and their enterprises within the system. [24] [25] [26].
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		Tutorial: Value chain

					Santiago de la Puente and Villy Christensen

			

	
				 Learning Objectives
  	Obtain experience building value chains in EwE
 
 
 
 
 The fishing industry around Anchovy Bay is important for peoples’ livelihoods and health, providing both jobs and food. In order to potentially evaluate tradeoffs in fisheries management, we will construct a value chain to describe how the different parts of the fishing industry contribute to the overall economy and social system.
 We need to define the size of the ecosystem (in km2) as value chain analyses operate with amounts, not densities. Hence, landings per unit area (t km-2 year-1) should be multiplied with the area (km2) to obtain total landings (t year-1)
 We will use the Anchovy Bay ecosystem model that we constructed in a previous tutorial (download). First open the model and check that it is mass balanced (Ecopath > Output > Basic parameters). Then go to Ecopath > Input > Model parameters and set the model area to 10000 km2 (if not already entered). Also make sure that you have selected the appropriate monetary units. As Anchovy Bay is located somewhere in Europe, lets choose Euros for now.
 Then let’s go to Ecopath > Input > Fishery > Off-vessel price. Currently we have five fleets. Each functional group-fleet combination requires an off-vessel price (change the default values). A ton of seals should be worth € 600, a ton of cod should be worth € 1,400, a ton of whiting should be € 200, a ton of mackerel should be worth € 350, a ton of anchovy should be € 160 and a ton of shrimp € 17,000. However, we know that anchovies when caught by bait boats are landed in better condition and hence are worth more. Please include a price for them of € 160 per ton when caught by bait boats.
 Next go to Ecopath > Output > Tools > Value chain. This will load the value chain plug-in of EwE. On the parameters form, check “Run with Ecopath”. Then go to the flow form. Select Add > Create producers for fleets, then click Arrange, and say Yes, if it asks if you want to save. You should now have five fleets as boxes on your flow chart form. The five producers will be linked to the EwE model and pick up baseline landings (and off-vessel prices) by fleets from the base model.
 Next, we need to add processors, distributors, wholesalers, retail sellers and consumers to the value chain (and link them together). You can rename the enterprises in the properties table (click on a box and look at the right section of the screen).
 	Shrimpers, Trawlers and Seiners sell their catch to Primary processors who fillet the fish and cut it into portions. Fresh seafood products are then sold to Coolers, distributors that transport them in refrigerated containers to Fresh seafood wholesalers. Retailers like Restaurants that cater Tourists and Fish mongers that sell fish to Local consumers purchase their seafood from the Fresh seafood wholesalers.
 	Seiners and Bait boats sell their catch to the Canneries. Canneries place their production in Warehouses using Trucks. Trucks are a distributing company that does not purchase the cannery’s production. They charge a fee for the service of delivering the product to a warehouse that needs it (i.e., acts like a broker). Warehouses sell products to Supermarkets where Local and Regional consumers can place their orders.
 	Trawlers also sell part of their catch to Freezing plants. These sell their production to a distributing company, Frost Trucks, that sell this production to the same Warehouses that purchase canned seafood.
 	Sealers sell their catch to the Anchovy Bay Company (ABC), which processes seals into fancy pelts. These are directly sold to Regional consumers.
 
 Your value chain should look something like in Figure 1.
 [image: ]
 Figure 1. Screenshot of value chain implementation for Anchovy Bay. The enterprises are arranged with producers (= fleets in EwE model) in the first column (with a hook icon). Processors are in the second column (with building icon), distributors in the third column (with semi truck icon), whole sellers in the fourth column (with shop icon), retailers including restaurants are in the fifth column (with shopping cart icon), and consumers are in the last column. The boxes in the value chain are connected with arrows, the width of which indicate what proportion of the flow leaving a given box is passed on to the connected box. The producers receives catches from the EwE model (all modules) and passes these on through the value chain.
 However, you may notice that the Trawlers and Seiners are color marked in your flowchart. This lets us know that we need to specify how the landings are distributed between the processors they supply. You do this by clicking Move, then click the link between (e.g., Trawlersand Primary Processors). In the properties table to the right, select a functional group (e.g., cod), and add a biomass ratio (e.g., 0.5). However, it is much easier to add all of this in Value chain > Components > Landings.
 We can for this tutorial populate the Anchovy Bay value chain by downloading a spreadsheet with input tables from this link. For convenience, we have included a table with the landing distributions in Tabel 1. You can copy the information from this table (or from the Landings tab in the spreadsheet).
 Table 1. Landing distributions for the Anchovy Bay value chain analysis. The table is included in the Anchovy_bay_value_chain.xlsx spreadsheet.
         	 	Name 	Source 	Target 	External 	BiomassRatio 	ValueRatio 	EcopathGroupName 
 	1 	Landings of 2: Seals 	Sealers 	ABC 	False 	1 	1 	2: Seals 
 	2 	Landings of 3: Cod 	Trawlers 	Primary processors 	False 	0.5 	1.1 	3: Cod 
 	3 	Landings of 3: Cod 	Trawlers 	Freezing plants 	False 	0.5 	0.9 	3: Cod 
 	4 	Landings of 4: Whiting 	Trawlers 	Primary processors 	False 	0.5 	1.1 	4: Whiting 
 	5 	Landings of 4: Whiting 	Trawlers 	Freezing plants 	False 	0.5 	0.9 	4: Whiting 
 	6 	Landings of 5: Mackerel 	Seiners 	Canneries 	False 	0.5 	1.2 	5: Mackerel 
 	7 	Landings of 5: Mackerel 	Seiners 	Primary processors 	False 	0.5 	0.8 	5: Mackerel 
 	8 	Landings of 6: Anchovy 	Bait boats 	Canneries 	False 	0.5 	1 	6: Anchovy 
 	9 	Landings of 6: Anchovy 	Seiners 	Canneries 	False 	0.25 	1 	6: Anchovy 
 	10 	Landings of 6: Anchovy 	Seiners 	Primary processors 	False 	0.25 	0.8 	6: Anchovy 
 	11 	Landings of 7: Shrimp 	Shrimpers 	Primary processors 	False 	1 	1 	7: Shrimp 
  
 
 Now let’s go to Run value chain, set data aggregation to Results by fleet and Run Ecopath. You can now explore results by fleet, by enterprise type, and by combinations. As you can see this run tells you a lot about revenue, but little about employment and profits. So, let’s add a bit more data.
 First let’s add more information about the flows of biomass and data along the value chain. Go to Value chain > Components > Links. Then copy / paste the information from Table 2 (below) or from the Links tab in the spreadsheet.
 Table 2. Enterprise links for the Anchovy Bay value chain analysis.
         	 	Name 	Source 	Target 	External 	BiomassRatio 	ValuePerTon 	ValueRatio 
 	1 	Cannery to Trucks 	Canneries 	Trucks 	False 	0.5 	 	1.9 
 	2 	Coolers to Fresh fish 	Coolers 	Fresh fish 	False 	1 	 	3 
 	3 	Fish monger to Locals 	Fish mongers 	Locals 	False 	1 	 	5 
 	4 	Freezing plant to Frost trucks 	Freezing plants 	Frost trucks 	False 	0.8 	 	2.3 
 	5 	Fresh fish to Coolers 	Primary processors 	Coolers 	False 	0.7 	 	1.7 
 	6 	Fresh fish to Fish monger 	Fresh fish 	Fish mongers 	False 	0.8 	 	2 
 	7 	Fresh fish to Restaurants 	Fresh fish 	Restaurants 	False 	0.2 	 	5 
 	8 	Frost trucks to Warehouse 	Frost trucks 	Warehouses 	False 	1 	 	2.5 
 	9 	Pelts to Regional 	ABC 	Regional 	False 	0.15 	40000 	0 
 	10 	Restaurants to Tourists 	Restaurants 	Tourists 	False 	1 	 	7 
 	11 	Supermarket to Locals 	Supermarkets 	Locals 	False 	0.6 	 	3 
 	12 	Supermarket to Regional 	Supermarkets 	Regional 	False 	0.4 	 	3 
 	13 	Trucks to Warehouse 	Trucks 	Warehouses 	False 	1 	 	4 
 	14 	Warehouse to Supermarket 	Warehouses 	Supermarkets 	False 	1 	 	1.2 
  
 
 Now go to Run value chain and Run Ecopath. What new things do you see?
 One final step. Let’s add some costs for the producers. Please copy the costs from Table 3 or from the Producers tab in the spreadsheet. Go to Run value chain and Run Ecopath once again. Can you find any enterprise with negative profits? Why are they negative?
 Table 3. Cost structure for producers in the Anchovy Bay value chain analysis.
      	Producer 	1 	2 	3 	4 	5 
 	Name 	Bait boats 	Sealers 	Seiners 	Shrimpers 	Trawlers 
 	Category 	Producer 	Producer 	Producer 	Producer 	Producer 
 	Nationality 	0 	0 	0 	0 	0 
 	Broker 	False 	False 	False 	False 	False 
 	Name (local) 	 	 	 	 	 
 	Ecopath fleet 	4 	1 	3 	5 	2 
 	Unlikely outputs 	 	 	 	 	 
 	Biomass ratio 	 	 	 	 	 
 	Energy products 	0 	0 	0 	0 	0 
 	Industrial products 	0 	0 	0 	0 	0 
 	Service products 	0 	0 	0 	0 	0 
 	Ticket revenue 	0 	0 	0 	0 	0 
 	Energy subsidy 	0 	0 	1 	0 	1 
 	Other subsidies 	0 	0 	0 	0 	0 
 	Female worker pay 	0 	0 	0 	0 	0 
 	Male worker pay 	0 	0 	0 	0 	0 
 	Female owners pay 	0 	0 	0 	0 	0 
 	Male owners pay 	0 	0 	0 	0 	0 
 	Other worker pay 	0 	0 	0 	0 	0 
 	Female worker share 	30 	50 	15 	20 	10 
 	Male worker share 	30 	50 	15 	20 	10 
 	Female owners share 	0 	0 	0 	0 	0 
 	Male owners share 	0 	0 	0 	0 	0 
 	Capital cost 	5 	2 	1 	1 	1 
 	Energy cost 	10 	2 	15 	8 	12 
 	Industrial cost 	0 	0 	0 	0 	0 
 	Services cost 	0 	0 	0 	0 	0 
 	Management cost 	0 	1 	2 	0.5 	0.5 
 	Royalty cost 	0 	0 	0 	0 	0 
 	Certification cost 	0 	0 	0 	0 	0 
 	Monitoring cost 	0 	1 	5 	1 	3 
 	Monitor coverage rate 	1 	1 	1 	1 	1 
 	Environmental tax 	0 	0 	0 	0 	0 
 	Export tax 	0 	0 	0 	0 	0 
 	Import tax 	0 	0 	0 	0 	0 
 	Production tax 	0 	0 	0 	0 	0 
 	Profit tax (prop.) 	0 	0 	0 	0 	0 
 	VAT tax 	0 	0 	0 	0 	0 
 	License tax 	0 	0 	0 	0 	0 
 	No. female workers 	0 	0 	0.01 	0.01 	0 
 	No. male workers 	0.6 	2 	0.5 	1 	0.9 
 	No part-time workers 	0 	0 	0 	0 	0 
 	No. other workers 	0 	0 	0 	0 	0 
 	No. female owners 	0 	0 	0 	0 	0 
 	No. male owners 	0 	0 	0 	0 	0 
 	Female worker dependents 	0 	0 	0 	0 	0 
 	Male worker dependents 	0 	0 	0 	0 	0 
 	Female owner dependents 	0 	0 	0 	0 	0 
 	Male owner dependents 	0 	0 	0 	0 	0 
  
 
 If everything else fails (or you want to take a shortcut). Here’s a link to an Anchovy Bay model with the value chain database.
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		Price elasticity

								

	
				 Seafood prices vary, often in unclear ways. Maybe a rare species doesn’t have much of a market because people prefer to eat what they know – what they know how to prepare and like. Or, the rarer a species gets, the higher price it fetches if demand keeps steady. Abalone and bluefin tuna might be examples. Demand for seafood can also impact supply where increased demand leads to higher prices, which in turn may drive more fishers to target the species in question, or vice versa increased supply may lead to lower landings prices, especially where processing capacity is a limiting factor.
 So, landings prices are not constant, but may change due to demand and supply factors. How do we consider that in EwE? The starting point is the landings prices in the Ecopath input parameters. Almost all EwE applications have simply taken those landings prices as being constant, and evaluated management options based on that assumption (corresponding to the solid lines in Figure 1). But landings prices are not constant!  Economists deal with that issue through what is called price elasticity[1].
 For economists, price elasticity (ep) is generally defined as,
 [image: e_p = \frac{dQ/Q}{dP/P}\tag{1}]
 
 where Q is the quantity demanded and P is the price. So, price elasticity represents the ratio between how much demand changes and how much the price changes. If prices increase, demand will decrease is the general expectation for a good with price elasticity. If for instance a 10% increase in price leads to a 10% decrease in demand, the situation is called “unit elasticity”, and it results in revenue being constant (corresponding to the stippled lines in Figure 1).
 [image: ]
  
 Figure 1. A. Two examples of price elasticity. The dotted line represents unit elasticity where an increase in landings of x% leads to a corresponding decrease in landing price of x%. The horizontal line represents a perfectly inelastic situation where price is independent of supply, i.e. the default assumption in EwE where price is independent of landings (if not including price elasticity).  B. Revenue (total landing value) for the situation with unit elasticity (dotted line) and inelastic (straight line) where revenue is proportional to landings.
 The situation is a bit more complicated for capture fisheries where there often is a complex relationship between demand and supply – and for that matter with production capacity where more boats doesn’t automatically result in more supply.  For “traditional” seafood species prices may be relatively stable as landings change, perhaps with demand increasing prices with low supply, and with dropping prices when processing capacity becomes a limiting factor. For less traditional seafood, which may be the rarer species that consumers are not used and willing to purchase, prices may be low with low supply and only increase if and when catches increase.
 In EwE, we consider the complex pricing pattern through a price elasticity functionality in Ecosim. In Ecosim one can define the relationship between supply and resulting landing price. The supply may be for one or more functional groups caught by a one or more fishing gears, and the resulting landing price may then be changed proportionally for groups – gear combinations that are specified separately. So, in principle one could have that the supply of one species impacts the price of another. Take as a hypothetical example that increase landings of walleye pollock for surimi (imitation crab) production might impact the landing price for king crab.
 The price elasticity functionality while defined in Ecosim can subsequently be used anywhere in EwE where landed value is calculated, e.g., in the value chain, policy optimization, or MSE.
 For hands-on details of how price elasticity is implemented in EwE, please see the Anchovy Bay price elasticity tutorial and the EwE User Guide.
 
	For more about price elasticity, see, e.g., the open textbook Principles of Microeconomics by Emma Hutchinson, University of Victoria. ↵



	

			
			


		
	
		
			
	
		

		Tutorial: Price elasticity

								

	
				We will, once again return to Anchovy Bay where anchovy are caught by seiners and bait boats, In spite of the name of the second fleet, the anchovy from both fleets are primarily used for human consumption. The bait boats land high-quality anchovy, and have a secondary market supplying anchovy for recreational fisheries and a lobster trap fishery (not in the model).  Because of the high quality, the bait boats average €3/kg for anchovy, which is more than the €2/kg that seiners command. Anchovy is popular as a tasty, healthy and economic fish to buy in the fresh fish supply. But there is a limit to how much can be sold as there are no exports, so it’s only the local markets that have demand. The implication of this is that the price for anchovy is impacted by supply, which we can introduce in the model through price elasticity.
 We can use any version of the Anchovy Bay model that you may have or you can download it from this x.
 Open the model, go to Ecosim and do a run (Ecosim > Output > Run Ecosim > Run), check the model output to acquaint yourself with the model.
 Next, let’s change the model slightly so that we can get more anchovy from it. Go to Ecosim < Input < Fishing effort, click on Trawlers at the lower panel, and then Set to value, enter 5 to increase trawler effort five times throughout the Ecosim run. Do the same for Seiners, also five times increase. This change is to fish out whiting and mackerel, the major predators on anchovy to allow for a build-up of anchovy that can sustain a higher fishing pressure. Run Ecosim (Ecosim > Output > Run Ecosim > Run), see Figure 1.
 [image: ]
 Figure 1. Ecosim run with five times increase in effort for Seiners and Bait boats. Notice how the anchovy biomass initially declines, then increases beyond the baseline in spite of higher fishing pressure. This shows predator release. 
 Next, go to Ecosim > Output > Ecosim results > Group landed by: and extract the anchovy catches and values for Seiners and Bait boats.  Store these values for later.
 Open the Ecosim > Input > Price elasticity form, and Add a shape. If you’ve worked with Mediation, you may notice that the setup is very similar (though the shapes are green – the colour of money, some say), and programmatically the price elasticity form is indeed derived straight from the Mediation form.  Click Change shape set Shape type to Linear and set Start to 1 and End to 0.1. Hopefully, you’ll now have a shape like in Figure 2.
 [image: ]
 Figure 2. Price elasticity shape defined on the Ecosim > Input > Price elasticity form. 
 In the Figure 2 shape, note that there is a vertical stippled blue line. That line sets where on the figure the Ecopath baseline situation is. That is, when the landings are at that level the landing price(s) will be the same as entered in the Ecopath baseline (€2/kg and €3/kg, for anchovy landed by seiners and bait boats, respectively).  The default placement of the vertical blue line is at ⅓ of the X-axis, and in this example the value there is 0.7 x the max value. If landings increase 3 times, the Y-axis value will be reduced to the minimum value of 0.1, and it will remain for any higher catch level. Does that seem reasonable = what you want? If not, you can use your mouse to move the vertical blue line to the left or right as you see fit. Just remember that the vertical line represents your baseline and ask what will happen if catches change.
 The linear shape in Figure 2 is an approximation that is not data-driven, but a quick and easy way to explore the impact of price elasticity. You could dive and perhaps find data – do that for a real application.[1]
 We now have a shape, but need to define what it represents. Click Define supply on the Price elasticity form and the Define supply form pops up (Figure 3).
 [image: ]
 Figure 3. Define supply form for price elasticity. Under Seiners click Anchovy and then the arrow-right button to transfer Seiners > Anchovy to the Assigned landings. Press OK.
 Assign the Seiners > Anchovy landings to drive the price elasticity from as shown in Figure 3. Note that the relative weight is the unit landing price for the group. This is of relevance where you have more than one group driving the price elasticity. In that case  the default assumption is that the overall measure of landing capacity if a function of the value of each of the groups being landed.  That’s an assumption, replace it with data, where possible (if not, it’s a reasonable default assumption).
 Next we need to apply the function, this is done at the Ecosim > Input > Price elasticity > Apply price elasticity form, see Figure 4. Follow the instructions in the figure legend.
 [image: ]
 Figure 4. Apply price elasticity form. One by one, click the intersection between Seiners or Bait boats vs. Anchovy, and on the pop-up form use the right-arrow to apply the functions, and press OK. The figure shows the second of intersections (Baits boats and Anchovy) being applied. Once completed, there should be $1 (for first price elasticity function) for anchovy for boat fleets. 
 Notice that it is the landings of anchovy from the seiners fleet that drives the price elasticity function, but that the impact of this is being used for anchovy from both the seiners and the bait boats. Is that logical? Perhaps not, but the bulk of the catch come from the seiners, and bait boat delivers a high quality specialty product. But the main purpose of this is really just to demonstrate that it possible to have landing prices for one fleet being a function of another fleet’s landings – think for instance about the potential case of surimi production impacting pricing for king crab.
 You should now have the complete setup of price elasticity for the Anchovy Bay model. When you run economic routines, e.g., the value chain or policy optimization, the landing price of anchovy will be a function of the landings. But here, we’ll simply extract the value of the landings from a standard Ecosim run.
 Run the Ecosim model again (Ecosim > Output > Run Ecosim > Run), and you’ll hopefully find that the run looks exactly like it did the first time we ran Ecosim in this tutorial (similar to Figure 1). That’s because price elasticity only changes the value of the landings in this case, so the runs are identical. If you instead were doing policy optimizations with value as an objective, the runs, i.e. the optimum would be different.
 Again, extract the anchovy catches and values from the Ecosim results form (Ecosim > Output > Ecosim results > Group landed by:).
 	Compare the anchovy landings, are they the same with and without price elasticity?
 	What about the anchovy values?
 
 There more about price elasticity in the preceding chapter and in the EwE User Guide.
 
	For a real application, you could develop a function to describe price elasticity from data and implement that function in, e.g., Excel or R. Make your x-axis (landings) with 1200 steps, and copy/paste those to the spreadsheet under Values on the Price elasticity form. Such data exists! see for instance Parente J, V Henriques & A. Campos. 2021. The anchovy fishery by the Portuguese coastal seine fleet - landings and fleet characteristics. DOI:10.1201/9781003216599-76 where there's a relationship between sale price of anchovy and anchovy landings ↵
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		Fishing policy exploration

								

	
				 
 The interface for the policy exploration is described in a EwE User Guide chapter.
 
 Background
 A central aim of fisheries management is to regulate fishing mortality rates over time so as to achieve economic, social and ecological sustainability objectives. An important dynamic modelling and assessment objective is thus to provide insight about the trade-offs involved in setting such mortality rates, including the impact of how they may vary over time – for instance during development or recovery from past overfishing. Recognizing that the question of what is “optimal” is a question of societal definition and also that we indeed cannot expect models to provide very precise estimates of what may be optimum fishing mortality rates, the ambition level is rather to explore trade-offs as a consequence of alternative management scenarios, rather than provide a prescription for the “optimal policy”.
 To this effect, Ecosim implements a formal optimization method that can be used to search for fishing policies that would maximize particular policy goals or “objective functions” for management. This method is an “open loop” policy exploration simulation and optimization that acknowledges that policy may be defined as an approach towards reaching a broadly defined goal, that fisheries policies are often implemented via quotas that are recalculated annually, and through regulation that affects fleet structure and deployment.
 Two very different approaches are implemented in the policy search for identification of optimum levels of fishing efforts for multiple fleets that may each exploit multiple species from an ecosystem.
 (1) The “sole owner” or societal approach
 
 The aim of the “sole owner” approach is to identify a single, overall performance measure for combined value from all fishing operations, then vary the by-fleet efforts so as to try and maximize this performance measure.
 A fundamental problem with the “sole owner” approach is the implicit assumption of value and cost pooling. Supposedly “optimum” solutions often involve operating one or more fleets at uneconomic levels, essentially using these fleets to cull some species so as to increase production from other, more valued species.
 
 
 
  
 (2) Multiple fishing rights
 
 The “multiple fishing rights”  approach treats each fishing fleet (and perhaps non-consumptive stakeholder or user groups as well) as a separate economic industry with some legal right or entitlement, then seek a level for each fleet that optimizes a fleet-specific performance criterion such as total profits or growth until profitability (ratio of profits to income or cost) falls to a typical or reasonable level for economic industries in the economy as a whole.  The basic problem in this “multiplayer game” approach is that performances of the fleets are linked through tradeoffs due to bycatch and trophic interaction effects.  Growth of some fleets may enhance fishing opportunities for others, (e.g., fishing on piscivores can result in higher net production of planktivores), while growth of other fleets may shunt surplus production away from other fleets, (e.g., fishing on planktivores can reduce production of piscivores and abundances of non-target species that are valued for non-consumptive activities like whale-watching).
 When filtered through the complex of ecological interactions involved in a food web, the net effect of any fleet on any other can be quite counter-intuitive.  For instance, in development of management policy for red snapper (Lutjanus campechanus) in the Gulf of Mexico, it has been assumed that large bycatches of this species in shrimp trawls have been deleterious to recruitment, and that sustainable harvests of red snapper would be increased if shrimp trawlers were required to use bycatch reduction devices (BRDs).  But rather there is evidence that recruitment of the snapper may actually have increased since development of the shrimp fishery, and ecosystem modelling suggest that this may be because shrimp trawling has had a larger negative effect on competitors and predators of juvenile red snapper (and shrimp) than its direct mortality effect on the juveniles.
 
 One approach to multispecies optimization would be to promote selective fishery practices by each fleet (minimize wasteful bycatch with no apparent trophic benefits), then encourage each fleet to develop to an optimum economic level (defined by some criterion like profit or profitability).  Then as multiple fleets develop in successive moves of the multiplayer game, cross-impacts (both positive and negative) would be exposed in terms of impacts on catches and costs, and the optimum or target level for each fleet would evolve over time in response to changes in the other fleets.  Such a system might or might not approach some multi-fleet bionomic equilibrium (they typically do in Ecosim simulations), but that equilibrium would typically involve considerable erosion in ecosystem structure especially at top trophic levels due to shunting of production into fisheries for species of lower trophic levels.
 
 
 
 Trade-offs between fleets
 [image: ]Figure 1. Fleet trade-offs in Anchovy Bay. The analysis shows, e.g., that reducing the effort for sealers with 10% would have a positive impact (by value) on sealers, seiners and bait boasts, but a negative impact on other fleets and on total landed value. 
 As discussed in connection with the multiple fishing rights discussion, there may well be trade-offs between fleets. To explore this independently of the fishing policy search, we suggest you run the “Fleet trade-off analysis”, which can be assessed at Ecosim > Tools > Fleet trade-off.[1]
 The fleet trade-off analysis, runs Ecosim once for each fleet in a model. For the first run, the effort of the first fleet is set to 0.9 times the current Ecosim fleet effort, Ecosim is run, and the value of the landings for each fleet is calculated and stored. In the second run, the effort of the second fleet is reduced to 0.9 times the Ecosim effort, and so forth. Values are evaluated for the last year of the run.
 Base effort for fleet trade-off analysis
 Be aware that the routine will use the Ecosim fleet effort over time as the baseline effort and multiply this effort with 0.9 for every time step. Depending on the questions asked, it may thus be advisable to reset all effort to the unity baseline (Ecosim > Input > Fishing effort > Reset all). This was done for the example in Figure 1.
 
 The output of the routine is saved to a CSV-file, which subsequently can be used as datafile to produce output such as in the figure to the right. In the Anchovy Bay case shown on the figure to the right, negative income is shown in read, and positive income in blue. In the example, reduction of trawler effort, has a negative income on itself and on sealers, while the three other fleet benefits. Overall, those benefits do not outweigh the cost to trawlers (the Total is negative).  In the Anchovy Bay case, there are no fleets for which a reduction would lead to an overall increase in catch value, but for many other models we have seen cases where this was the case.
 R-code for producing fleet trade-off plots can be downloaded from this link (filename: FleetTradeOff_R_Code.zip). Download and unzip the R file, and place it in a directory where you also place the CSV-file downloaded from running the fleet trade-off analysis. Then run the R file.
 
 Open loop
 The fishing policy exploration module implements what control systems analysts call an “open loop”[2] simulation that acknowledges that policy may be defined as an approach towards reaching a broadly defined goal, but that actions must vary over time in response to new information.
 An “open loop policy” provides a prescription for what to do at different future times without reference to what the system actually ends up doing along the way to those times.  It would obviously be wrong to just apply an open loop policy blindly over time, each year committing a fishery to fishing rates calculated at some past time from only the data available as of that time.  In practice, actual management needs to be implemented using feedback policies (see MSE chapter) where harvest goals are adjusted over time as new information becomes available and in response to unpredicted ecological changes due to environmental factors.
 But in spite of the need for feedback in application, the open loop policy calculations serve a purpose, they can be done regularly over time as new information becomes available, to keep providing a general blueprint (or directional guidance) for where the system can/should be heading and to gain insights about trade-offs associated with alternative management policies.  Also, we can often gain valuable insight about the functional form of better feedback policies (how to relate harvest rates to changes in abundance as these changes occur) by examining how the open loop fishing rates vary with changes in abundance, especially when the open loop calculations are done with Ecosim time forcing to represent possible changes in environmental conditions and productivity in the future.
 Policy objectives
 The policy exploration/optimization has two alternative objective functions, where by default the objective function is defined based on an evaluation of five weighted policy objectives[3] as described below.
 The second option implements a risk-averse utility measure that instead of setting relative weights to different objectives as described above, use an alternative objective function that invokes a balanced “investment portfolio” of fishing activities. This method is described in the Risk-averse portfolio utility chapter and invoked by checking the Maximize portfolio utility option as described in the Fishing policy exploration chapter in the EwE User Guide.
 
 Maximize fisheries rent
 This objective, maximizing profits or net economic value, R, is based on calculating profits as the value of the catch (catch · price, by fleet and species) less the cost of fishing (fixed + variable costs, scaled proportional to effort). Giving a high weight to this objective often results in phasing out most fleets except the most profitable ones, and the wiping out of ecosystem groups competing with or preying on the more valuable target species.
 Maximize social benefits (jobs)
 The social benefits objective (J) is represented by the employment supported by each fleet. The benefits are calculated as number of jobs (assumed proportional to the catch value), and are fleet specific. Optimizing efforts often leads to more extreme (with regard to overfishing) fishing scenarios than optimizing for profit.
 
 Maximize mandated rebuilding of species
 The mandated rebuilding objective (Blim) can capture that external pressure (or legal decisions) may force policy makers to concentrate on preserving or rebuilding the population of given species in a given area. In Ecosim this corresponds to setting a threshold biomass (relative to the biomass in Ecopath) for one or more species or groups, and optimizing towards the fleet effort structure that will most effectively ensure this objective. The implications of this are case-specific: we are finding that the optimization routine may rigorously hammer (through increased fishing) competitors and predators of the species in question; or at the other extreme that fisheries may be shut down without social or economic consideration (as is indeed often the case when legal considerations take over).
 This objective can thus be used to include consideration of biological limits, such as Blim in harvest control rules, but as described above, it may potentially point to measures that are a bit smarter than standard operating procedure: “close the fleet”.
 Maximize biodiversity
 The maximize biodiversity objective (D) captures only a single indicator for biodiversity, the biomass distribution across functional groups in the ecosystem model. The assumption is that as, e.g., exploitation increases, the system will move towards a biomass concentration for a few groups only. In Anchovy Bay, as an example, optimization for jobs (catch value) will result in a system that’s dominated by shrimp and anchovy.  The objective is by default calculated using the Shannon diversity measure, with Kempton’s Q index being optional.
 Maximize ecosystem structure
 The ecosystem structure objective (a component of “ecosystem health” is inspired by E.P. Odum’s[4] description of ecosystem “maturity”, wherein mature ecosystems are dominated by large, long-lived organisms,[5] The default setting for ecosystem structure is the the group-specific biomass/production (B/P, unit: year) ratio as this measure expresses the average longevity by functional group. The ecosystem structure optimization often implies reduction of fishing effort for all fleets except those targeting species with low weighting factors.
 In addition to the default setting for average longevity, the “Maximize ecosystem structure” can be used with a range of network analysis indicators that can be defined by functional group, e.g., the trophic level.
 Objective function
 
 The policy search optimization by default uses an objective function incorporating the five objectives discussed above, each weighted[6].  The routine will iteratively seek to maximize the objective function by setting relative fishing effort (E) by fleet (fl),
 [image: f(E_{fl}) = \text{Max}(w_1 R + w_2 J +] \begin{equation} \left\{ \begin{array}{cc} w_3 \cdot (B_{lim} – B) ,                       \text{ if }B<B_{lim} \\ 0 , \text{ if } B \geq B_{lim} \end{array} \right\} \end{equation}[image: +w_4 D + w_5 \frac{B}{P} )\tag{1}]
 There is an art to using this function in actual implementations: what weights to use? Using the same weight wi on two or more objectives should not be expected to translate to even importance for those objectives. It may for instance be much easier to increase profitability than the biodiversity objective, calling for higher weights on biodiversity for a balanced solution.  See the chapter for more discussion of this.
 The fishing policy search routine then estimates time series of relative fleet sizes that would maximize this multi-criterion objective function. In Ecosim, the relative fleet sizes are used to calculate relative fishing mortality rates by fleet, assuming the mix of fishing rates over biomass groups remains constant for each fleet type, (i.e., reducing a fleet type by some percentage results in the same percentage decrease in the fishing rates that it causes on all the groups that it catches, i.e. leads to proportional changes in catchabilities). It is, however, possible to consider hyper-stability and hyper-depletion effects by specifying density-dependent catchabilities in Ecosim (Ecosim > Input > Group info > Density-dependent catchability, see the Group info tutorial).
 The Risk-averse portfolio utility chapter describes an optimization method based on an alternative objective function.
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		Risk-averse portfolio utility

								

	
				The fishing policy search procedure provides an option for optimum fishing patterns (Ecosim > Tools > Fishing policy search > Maximize portfolio utility) designed to search for relative fleet sizes that would maximize a utility function of the form,
 [image: w_1 \log(NPV) + w_2 Slog(B) - w_3 V \tag{1}]
  where the wi are utility weights chosen by the user and the utility components NPV, Slog(B), and V are defined as:
 	NPV is net present economic value of fisheries landings, calculated as discounted sum over all fleets and times of catches times prices minus costs of fishing, i.e. the discounted total profit from fishing the ecosystem.
 	Slog(B) is an existence value index for all components of the ecosystem over time.  It is calculated as the discounted sum over times and biomass pools of “structure weights” times logs of biomasses, scaled to per-time and per-pool by dividing the sum by the number of simulation years and number of living biomass pools.  The Structure weights are by default the B/P ratios for more long-lived groups.
 	V is a variance measure for the prediction of log(NPV) + Slog(B).  It is assumed to be proportional to how severely the ecosystem is disturbed away from the Ecopath base state, where disturbance is measured at each time in the simulation by the multidimensional distance of the ecosystem biomass state from the Ecopath base state.  This term is negative, implying that increased uncertainty about the predictions for more severe disturbances causes a decrease in the mean of log(NPV); this term represents both aversion to management portfolio choices that have high variance in predicted returns, and the observation that the mean of the log of a random variable (NPV x PB) is approximately equal to the log of the mean of that variable minus half the variance of the variable.   Large w3 can be used to represent both high uncertainty about predictions that involve large deviations of biomass from the Ecopath base state, and strong risk aversion to policy choices that have high uncertainty.
 
 This utility function combines several basic concepts of utility.
 	The log scaling of value components represents the notion of “diminishing returns”, that adding some amount to any value measure is less important when the value measure is already large as compared to when the value measure is small.
 	The log scaling also represents the notion of “balance”, that no value component should be ignored entirely (unless it is assigned a zero wi); the overall utility measure approaches minus infinity if either net economic performance (NPV) or if any biomass component of the ecosystem (any biomass Bi in Slog(B)) approaches zero.
 	It represents the notion that our predictions about the future of both economic performance and biodiversity (biomasses) become progressively more uncertain for policies that result in more extreme departures from the Ecopath base state about which we presume to have at least some knowledge.
 
 In the terminology of portfolio selection theory in economics, fishing policies result in a portfolio of value components with “expected total returns on investment” equal to NPV+SB.  But policies that have higher expected total returns are most often also ones that would push the ecosystem into more extreme states, and hence represent portfolio choices with higher uncertainty (variance) in total returns.  For example, maximizing the deterministic prediction of NPV in Ecosim often involves a “farming policy”, in which fishing is deployed so as to severely simplify the ecosystem to maximize production of one or a few species that appear at present to be the most valuable (price, potential total catch). The lobster fisheries of the east coast of North America exemplify this.
 Simple NPV maximization may even involve deploying some fleets just to remove predators and competitors for the most valued species, just like deploying pesticides and herbicides to remove “pests” in agricultural systems.  But simplifying an ecosystem in such ways can make the behaviour of the system deeply unpredictable, by creating opportunities for ecological response (population growth) by a variety of species that are rare in the “normal” ecosystem and hence are not well researched or understood in terms of their potential impacts on valued species should they become abundant.  Simplifying an ecosystem is hence much like investing in high-risk, high-return stock market options; such investments may make you rich, but they may also bankrupt you.  Most people are risk-averse as investors, and seek to “spread risk” by investing in “balanced portfolios” with lower expected returns on investment but much lower probabilities of severe loss.
 The prediction variance measure V is not meant to represent all components of variation or uncertainty about future biomasses and fishery values.  V goes to zero for policies that hold or maintain the ecosystem at the Ecopath base state Bo for every biomass, for all simulation times.  It is obviously not correct to suggest that we would expect no variance in future biomasses (and hence in the harvest components of NPV as well) if such a policy were implemented.  Imagine running a very large number of simulations of future biomass changes under such a policy, while varying all possible uncertain quantities such as the Ecopath base biomasses and biomass accumulation rates, productivities, Ecosim vulnerability parameters, environmental forcing inputs representing oceanographic productivity regimes, future demand and price patterns, and changing vulnerabilities to fishing due to biophysical and technological factors.
 Even for the baseline policy where Ecosim predicts stable expected or mean biomasses over time, realistic simulations with environmental forcing would likely reveal high variances and complex covariance patterns for most biomasses over time, i.e. we would see wide probability distributions of possible future biomass states for the ecosystem.  We can, however, not describe all uncertainty well enough to accurately calculate the variances of such distributions.  But note that much of that variance in predictions of future biomasses (and hence variance in the value components) would be due to sources of uncertainty and variability that are the same no matter what the policy choice, i.e. would cause about the same amount of variance in predictions for any future harvest policy that we might simulate.  When comparing policy choices using an optimization objective function, there is no point in including extra constant terms that do not change with the policy variables, (e.g., a base variance Vo in predictions that does not change with fishing rate policy and just represents uncertainty about any prediction that Ecosim might make).  Hence the V distance measure is meant to represent only extra variance or uncertainty in predictions for policy scenarios that would likely drive biomasses far from the Ecopath mean state.
 Ecosim does not deliberately advocate or promote any particular risk-averse portfolio approach to public investment in ecosystem fishery and existence values.  Rather, it provides the logarithmic utility function option to explore alternative more or less risk-averse attitudes about ecosystem values.  It is always advisable to construct a series of policy scenarios with varying utility weights w1, w2, and w3 on the log utility components, to see how placing different emphases on these components would alter the predicted best policy choice.
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		Tutorial: Policy exploration procedure

					Villy Christensen and Santiago de la Puente

			

	
				 About this tutorial: It is intended for more complex applications of the fishing policy module rather than for introductory EwE courses. There’s a simpler tutorial to start with (link).
 Preparation: Read the Fishing policy optimization chapter (see chapter) and the User Guide interface description (see chapter) before embarking on this tutorial.
 
 The EwE policy exploration module is a complex but capable beast, designed for policy exploration of trade-offs, not for providing management advice for direct implementation. The policy advice it can produce is strategic rather than tactical (i.e. broad, directional policy advice rather than specific management advice). It can thus contribute at the table where policy discussions take place, in particular by providing options for and trade-offs in ecosystem-based management.
 In this tutorial, we’ll go through and explain details for how the module may be used for actual policy exploration. As part of this, we will outline, step by step, a procedure we find useful for conducting a more complete policy exploration that can be published and potentially can contribute to policy development.
 Model scope and behaviour
 We assume that your model is indeed to be used for actual policy exploration, and advise that the model, while being predictive (rather than descriptive, see the Defining the ecosystem chapter) should include the fleets among which the policy module will seek to balance trade-offs – this may well be all fleets operating in the given ecosystem as trade-offs often are through food web interactions and bycatch.  Further, the target species for the fishery should be included in the model, along valued species that they take as bycatch, along with their prey and competitors, and where applicable top predators such as marine mammals and species of conservation concern.
 For the model behaviour in response to proposed fisheries changes it is important that the model is fitted to time series data – this implies that density dependence related to carrying capacity has been considered (see Density dependence and carrying capacity chapter), and the vulnerability multipliers that affect population resilience have been modified accordingly, (see Vulnerability and vulnerability multiplier chapter).
 It should hardly come as a surprise that we use Anchovy Bay for illustration in this tutorial.  If needed, you can download a version of the Anchovy Bay model that is fitted to time series data from this link. This is the version that is used for this tutorial.
 Note though that the time series fitting is rather incomplete in this version of the Anchovy Bay model, e.g., effort is lacking for several fleets.
 
 Fleet considerations
 If you have fleets in your system that it does not make sense to optimize for, e.g., optimizing for profit for a recreational fleet or a “catch-all” IUU[1] fleet, they can be considered in optimizations without being included in optimization searches.  For this, on the Blocks form in the interface select the first (black) block, then click the name of the fleet in the spreadsheet, and all years will be blackened out. When this is done, the Ecosim effort will remain as entered for that group, but the calculations of objectives will still include impacts of and on the blocked fleet(s).
 As an example, the recreational fleet may be relying on a species that is also a target for a commercial fleet that is considered in the optimizations. Abundance changes caused by changing the commercial fleet effort will then impact the catch rates of the recreational fleet, which in turn will impact optimization measures that are affected by the recreational fleet.
 For evaluating the Social value (employment) objective, it is important to set the relative Jobs/catch value parameters in the Ecosim > Tools > Fishing policy search table. By default these are at unity (1) for all fleets, which is a reasonable assumption for Anchovy Bay (so we will leave all Jobs/catch value at 1 for this tutorial), and indeed perhaps for many other places. Still, this parameters is important and it is best if you can use local or regional data.
 Time period: retrospective or forward?
 There are two different approaches that have been used for policy optimizations, retrospective analysis vs. forward-looking scenarios, and we will describe both in the present extended tutorial.
 The general advice is, where possible use forward-looking scenarios, but if for some reason this isn’t feasible, the retrospective analysis is also a good option.
 Retrospective analysis
 For this, the idea is to explore a what-if of the kind “how might the situation in this system have developed if the policy objectives had been implemented throughout the historic time period“. This allows fitting of the model to time series data and to include environmental productivity patters. So, here we know what happened and we compare that to what might have happened if we had optimized the fisheries from early on.
 Forward-looking scenarios
 For these, the idea is to use a model that has been fitted to time series data, running up to the present. We then explore what options we have looking forward to explore alternative policy optimization scenarios.  We may for instance add 20 years[2] to the runtime in Ecosim (Ecosim > Input > Ecosim parameters > Duration of simulation), then on the Ecosim > Tools > Fishing policy, click the black colour in the Blocks section, and block the historic time period for all fleets so that the optimizations will only be done for future years.
 Forward-looking scenarios beg the question of how to handle a changing environment. The often-taken approaches for this are,
 	Make the policy optimizations on the background of no change, i.e. keep the environmental productivity and patterns as they were at the end of the historic period,
 	If you have environmental productivity patterns, then repeat those pattens going forward,
 	Use output from climate models to drive the Ecosim environment.[3] 
 
 Exploratory analysis
 Objective ranges
 Policy explorations are often intended to explore less extreme, more balanced solutions for fleet tradeoffs. That calls for using weights on several policy objectives (see textbook Policy exploration chapter) – but what weights are needed to make the resulting fishing efforts “balanced”? Using the same weight (e.g., 1) for all objectives is not likely to results in a reasonable balance of performance measures. What then?
 When you are ready to explore the policy optimization, the first step is to evaluate the range of optimized fishing efforts that result for each objective. Open your model (or Anchovy Bay from this link), load the Ecosim scenario you want to use, but do not load time series. Then run four policy searches with default settings varying only the objective weights. In the first search give the Net economic value a relative weight of 1, and leave the relative weight on all other objectives at 0. In the second run, give the Social value (employment) a value of 1, and all others 0.  Then third and fourth runs are with only weights on Ecosystem structure and Biodiversity, respectively.
 There is no need to include the Mandated rebuilding objective in the range of tested optimizations as this objective differs in behaviour, and serves a purpose different from other objectives. When invoked it is either, (1) a forced rebuilding or (2) providing a limit for the minimum acceptable biomass (Blim/B0)[4]. This objective is thus intended to take precedence over all other objectives, and it should have a weight that trump all other objectives, (so very high, e.g., 100). The Mandated rebuilding is functional group specific, and only impacts the optimization when the biomass of a specified group falls below a user-defined reference level (Blim/B0). When the biomass is at or above Blim/B0, the objective has no impact on the optimization.
 For Anchovy Bay, we may get results as in Table 1 from the single objectives optimization runs.
 Table 1. Policy optimization objective ranges for four runs, each with weight on only one objective at the time.  
 	Optimizing for \ Objective 	Econ. 	Social 	Ecosys. 	Biodiversity 
  	Econ. 	1.84  	1.15  	0.96  	1.02  
 	Social 	(2.26) 	2.34  	0.59  	0.88  
 	Ecosys. 	1.28  	0.68  	1.32  	1.05  
 	Biodiversity 	0.71  	0.50  	1.08  	1.05  
 	Min. value 	-  	0.50  	0.59  	0.88  
 	Max. value 	1.84  	2.34  	1.32  	1.05  
 	Range 	1.84  	1.83  	0.73  	0.17  
 	1 / range 	0.5  	0.5  	1.4  	5.9  
  
 Table 1 shows the outcome from the four objective-by-objective runs. The range of objective values are indicated (ignoring negative Net economic values) and make it clear that the two economic objectives have the largest range, followed by Ecosystem structure. The Biodiversity objective has a much more narrow range.  There is no truth or absolute values coming out of this exploratory analysis, but it serves to illustrate that using equal weight on all objectives is unlikely to lead to a balanced solution. Instead, as a first estimate for weights to use across fleets one may be able to use the inverse of the ranges, see Table 1.
 Using the inverse of the objective range may lead to a more “balanced” outcome during optimization exercises as this scaling better reflects the how “easy” it is for each objective to influence the objective function. This should, however, not be taken to mean that using the inverse range represents the truth, the whole truth and nothing but the truth: it is merely a more reasonable starting point than assuming the using the same relative weight for all objectives is a balanced solution.
  
 If a search is stuck with negative profit
 It can happen when you start running optimizations with the “limit cost > earnings” option, that both the net economic value and the social indicator (jobs) are negative already at the two initial runs. This indicates that a penalty has been applied in the search routine where the penalty increases rapidly as the ratio cost/income increases toward and exceeds 1.0. Such a penalty is needed to make the optimization move away from fleet efforts that drive cost > earnings.
 When it happens from the onset, it indicates that the baseline effort is unsustainable. In the case of Anchovy Bay, the culprit is the sealers fleet, which has a high, unsustainable effort in the base year. In Ecosim run, the fleet is shut down after a few years, but in the optimization, the high initial effort is maintained through the run. The optimization takes the cost and value at the baseline and sums the cost and value at the last year, and it multiplies that last year with a discounted value of what the last years catch would be worth if it were continued for an additional 20 years (i.e. there’s a high weight on the end state relative to the baseline).
 In some cases, the optimization routine can find its way out of the unsustainable fleet effort range, but not always. If the routine keeps producing negative indicators for the first two objectives, try making a run where you flatline the effort (1 throughout), and see which fleets end up having negative profit in the last year. Then reduce the effort for those fleets, and run the optimization again.
 Searches with “limit cost > earnings” may have issues, and are not at all guaranteed to work. Consider if you can get by without using this option if there are problems with this in your model.
 
 When running the policy optimization for Anchovy Bay with objective weights = the inverse of ranges from Table 1, the results in the table below are obtained.
 Table 2. Objective function values and fleet effort for a retrospective optimization for Anchovy Bay with weights set to inverse range of objectives. Optimization started with Ecopath base effort.
 	Total 	Econ. 	Social 	Ecosys. 	Biodiversity 
  	3.70  	1.69  	1.08  	1.05  	1.02  
 	 	 	 	 	 
 	Sealers 	Trawlers 	Seiners 	Bait boats 	Shrimpers 
 	0.89  	1.66  	0.72  	0.85  	0.59  
  
 Introducing priors for weighting schedules
 This type of weighting schedule perhaps best illustrates the outcomes of broad policy goals such as “securing the triple bottom line” or “promoting profitable, sustainable and just fisheries”.
 Granted that this discourse has become more mainstream, we are work under the assumption that fisheries stakeholders and the civil society are generally aiming for sustainable futures. However, different stakeholder groups will have different ways of weighting objectives, within and across fisheries systems. For example, fishers in some location may want to maximize fisheries rent twice as much as ecosystem structure, while recreational divers in another may want to maximize biodiversity 50% more than social benefits and 90% more than fisheries rent.
 Published literature using EwE’s policy search routine has addressed this by building scenarios where different weighting schedules are applied to represent a “compromise” among stakeholder objectives.[5] However, grounding scenarios with field data is something that modellers should strive for. To adequately capture people’s viewpoints, researchers should collect primary data (e.g., through semi-structured interviews or surveys) that allows them to construct alternative weighting schedules for different types of stakeholders operating in the system. This requires questions that rank optimization objectives and map the relative distance between them.
 For instance, let’s say that a survey was implemented along the multiple communities that inhabit Anchovy Bay. The goal was to gather data on the policy preferences of coastal dwellers rather than those of the more “usual suspects” of fisheries systems (e.g., fishers, seafood processors, distributors, or sellers). People were asked to agree with certain statements (e.g., “Economic growth must be a priority for the my country, even if it affects the environment” or “Fishing effort should be restricted to prevent overfishing, even at the expense of losses in employment”), and the answers were arranged using a 5 point Likert scale with options ranging from “Strongly disagree” to “Strongly agree”. As questions addressed all permutations among objectives included in the policy search routine, we created a distance matrix for them and used it to rank them.
 Inhabitant of Anchovy Bay prioritized maximizing ecosystem structure as the central objective of local fisheries policies. This objective was closely followed by maximizing biodiversity, and more loosely followed by employment and revenue considerations. For the sake of simplicity, no questions addressed the mandated rebuilding objective. Inhabitants of Anchovy Bay are thus more pro-environment than the fishers, and certainly more in favour of conservation than local politicians believe their constituents to be. Using the responses we created an index where the objective with the highest value was given a value of 1, and all other objectives were scaled to it based on their relative importance, which leads to the weightings in Table 3.  These values can then be used as multipliers for the weights of the objectives used in the “balanced” outcome run, to skew them towards their preferences and highlight the differences.
 Table 3. Relative weighting as obtained from interviews with Anchovy Bay community members. The table also shows the inverse weighting from Table 1 and the resulting combined weight, which is the product of the community weighting and the inverse weighting.
 	Objective 	Rel. weight 	Inverse weighting 	Combined rel. weight 
  	Economic rent 	0.56 	0.5 	0.3 
 	Social benefits 	0.75 	0.5 	0.4 
 	Ecosystem structure 	1 	1.4 	1.4 
 	Biodiversity 	0.94 	5.9 	5.5 
  
 
 Table 4. Objective function values and fleet effort for a retrospective optimization for Anchovy Bay with weights set to the combined weigthings from Table 3. Optimization started with Ecopath base effort.
 	Total 	Econ. 	Social 	Ecosys. 	Biodiversity 
  	3.98 	1.33 	0.81 	1.38 	1.04 
 	 	 	 	 	 
 	Sealers 	Trawlers 	Seiners 	Bait boats 	Shrimpers 
 	0.05 	1.21 	0.03 	0.46 	0.62 
  
 Comparing Table 2 and Table 4, it’s noticeable that adding the strong conversation-oriented view of the Anchovy Bay community has some socio-economic consequences. The economic rent and social benefits performance values were reduced with 20-25%, the ecosystem structure indicator increased ~30%, while the biodiversity measure (which is relative hard to impact) increased with a couple of percent.
 If you want to explore the effect that the two optimizations have on fleet catches and values, and on group biomasses, you can extract that information (after each optimization) from the tables on the Ecosim > Output > Ecosim results form.
 Local maxima
 As part of the exploratory analysis, it is important to check whether the maximization search is impacted by the start point, i.e. whether the optimization solutions are unique. By default the optimization routine will start with the fishing rates defined by the Ecopath baseline. It’s possible, however, to instead using random fleet effort (Random F’s in the policy interface) to check if the optimization routine is likely to get stuck at local maxima.  All optimization routines are impacted by this, the ones in EwE being no exceptions.
 We illustrate this for Anchovy Bay by running 70 optimizations with the combined rel. weights from Table 3, and runs initialized with random F’s. The outcome of that exploratory analysis is presented in Figure 1.
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 Figure 1. Box plot[6] showing minimum, first quartile, median, third quartile and max value of objective function value for indicators and relative effort for fleets for 70 policy optimizations run with random Starting F initialization.  It’s clear that only the relative effort for the bait boats varies between runs (with one run way higher than the 69 others), and that the optimizations overall are robust to local maxima.
 From Figure 1, it is clear that for this version[7] of the Anchovy Bay model, there is very little tendency for the optimization to get stuck on local maxima. The variation in the objective estimates and effort patterns are very similar across all runs (apart perhaps from bait boat effort), with only a few runs indicating presence of local maxima.
 That this Anchovy Bay model isn’t prone to get stuck on local maxima should not invite complacency, but be seen as a warning that there may be local maxima. We ran the optimizations 70 times for Figure 1 to illustrate this point – but also to show that it rarely happens. Bottom line is, run your optimization a number of times (maybe 10 to 20), check how consistent the output is. Then run the model once, check if the outcome corresponds to the majority of the random runs. If it does, you’re good to go.
 
 The overall conclusion is that policy optimizations for Anchovy Bay are not very prone to get stuck on local maxima. This is also what we have found for many other ecosystem model optimizations, giving some comfort that the starting point isn’t very critical. Still, this needs to be checked for all models, so including a search with random Starting F’s should be included in all more serious policy explorations.
 Fleet trade-off analysis
 [image: ]
 Figure 2. Fleet trade-off analysis for Anchovy Bay showing impact a 10% reduction in effort for the fleet listed in rows has on the fleets listed above columns. Negative impacts are in red, and positive in blue. 
 A next step of exploratory analysis is the fleet trade-off analysis described in the Fishing policy chapter (link to fleet trade-off). We refer to that section for description, including for code to produce plots.
 We suggest that you perform the fleet trade-off analysis for your model and explore the outcome. For Anchovy Bay (Figure 2), the plot shows the impact that a 10% reduction for the fleets mentioned to the left, are predicted to have in the value of the catch for all fleets. Red circles indicate reduction in value, and blue increase.  The impacts are displayed so that the circle areas are proportional to the changes in value of the catch, and are thus comparable across fleets[8].
 For Anchovy Bay, the fleet trade-off analysis shows some both straightforward and more complex patterns. Notice for instance that a reduction in bait boats‘ effort will have a positive impact on seiners. That makes sense since the two fleets both catch anchovy. But conversely, a reduction in seiners‘ effort lead to a small reduction in landed value for the bait boats. Why? Seiners also catch mackerel, and the reduced effort will lead to more mackerel, which in turn will have a negative impact on anchovy, and hence on bait boats, (which only catch anchovy).
 The strongest impact of effort reduction is for trawlers and shrimpers, the two fleets that have the highest value in the model base year. Reduction in trawlers‘ effort has a considerable negative impact on trawlers, but also an almost corresponding negative impact on shrimpers. That makes sense as the reduction should lead to more cod and whiting, both of which eat shrimp.  But conversely, reducing shrimpers‘ effort leads to an increase in shrimp landings (so they must be overexploited in the baseline – given the baseline predator-prey conditions though). But why does this not lead to an increase in the value of trawlers‘ landings?  The reason is that shrimp have a positive impact on whiting and mackerel, but a negative impact on cod. Notably, the increase in whiting impacts cod negatively.  Those relationships becomes clearer if you check out the Mixed Trophic Impact analysis (Ecopath > Output > Tools > Network Analysis > Mixed trophic impact > Impact data), which shows that shrimpers have opposite impact on cod versus whiting and mackerel.
 Your policy questions?
 Having explored the behaviour of your model, e.g., as described above, the next issue is to clearly define what questions you are asking for your model. An example of this is Alms et al. 2022, [9] who compared output from three defined Ecosim scenarios, (1) ban on shrimp trawling, (2) gill net effort reduction of 25%, and (3) the combination of (1) and (2), and then compared these to the output of single- and multi-objective policy optimizations. Here, the multi-objective optimizations were designed to serve as more balanced solutions.  See the paper for details.
 Anchovy Bay
 While the complex patterns in the fleet tradeoff (Figure 2) can be explained as above, they raise some questions. There is a big negative impact of reducing trawlers‘ effort and a big positive impact of reducing shrimpers‘ effort.  Is this then what we should explore? Well, it’s certainly interesting scenarios, but there are some complications, and it is in line with what actually happened in Anchovy Bay. Effort of trawlers indeed increased 2-3 times over time, but the shrimp effort increased by almost an order of magnitude.  Does this make sense when the fleet trade-off analysis indicate that shrimp catches would increase if shrimpers‘ effort was reduced?  The finding is not really wrong, but it doesn’t not consider that the increase in the trawlers‘ effort reduced the abundance of cod and whiting, which in turn lead to many more shrimps being available for the shrimpers. Predator-release!
 What the above indicates is in essence that the Anchovy Bay ecosystem of today is very different from that of 1970. Therefore, we will next run the policy optimization for Anchovy Bay as a forward-looking scenario where we keep the run from 1970-2010 as it was in the fitting, and then conduct the policy optimization from 2011 (year 42) onwards. Figure 3 illustrates the setup.
 If you change the  Ecosim > Tools > Fishing policy search > Base year to the end of the time series, the routine will automatically black out the years of the time series. In that case, the economic data (cost and value) in Ecopath > Input > Fishery > Fleets are assumed to represent your base year, not the Ecopath model year (Year 1 or 1970 for Anchovy Bay).
 
 [image: ]
 Figure 3. Fishing policy search interface set up to do a forward scenario for Anchovy Bay. The optimization will not change the effort for the first 41 years (in black), but search for one effort for each fleet for the last 20 years. If you cannot see all the years, try the zoom icons in the interface and widen the aspect ratio of the interface.   
 We run the forward-looking scenarios with Random F drawn to start the optimizations, which will ensure that we do not get stuck in a local maxima for all runs (even though we have found above that the risk of this is small). We here do not use the “limit cost > earnings” as this tends to hang the optimizations for the Anchovy Bay model[10].
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 Figure 4. Indicator values from Anchovy Bay model policy optimizations with inverse range weighting vs. community-based weightings (from Table 3). The community places higher weights on ecosystem structure and biodiversity, and the optimizations indeed reflect this. It’s clear that all of the objectives contributes to the total objective function score, which is the sum of the four objectives – actually with less variation for the community-based weighting. But the improved ecological score is offset by lower employment and profit[11].   
  
 [image: ]
 Figure 5. Plot[12] comparing fishing policy optimizations for Anchovy Bay model with weight as defined based on inverse range and community input in Table 3. Value is proportional to jobs, so the Jobs end plot indicates around a 25% reduction in jobs with the community-based weighting.  
 The fleet effort value, catch and biomass results for the Anchovy Bay model forward-looking policy scenario are presented in Figure 5, again comparing optimizations with the inverse range weightings vs the community opinion based weightings (both from Table 3). The results show the complex trade-off patterns between the two weighting schemes.
 Your case
 We suggest that you as a starting point go through this extended tutorial and conduct policy optimizations on a fitted version of your ecosystem model, working your way through the steps described in the tutorial.
 Pretty good yield
 When you run optimizations, you’ll often see that the objective function may rather quickly get to more than 98% of the final objective function score. If you start with Ecopath base F, the effort changes may be rather limited when you pass the 98% mark, but the last few percent may cause big changes in effort.  It may be worth exploring those intermediate states (by stopping the optimizations before it finishes by itself).
 This is to some degree related to the idea behind Ray Hilborn’s Pretty Good Yield[13] for MSY.
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		Tutorial: Trade-offs between policy objectives

								

	
				Fishing policy exploration for Anchovy Bay
 We will explore trade-offs between fisheries rent, social benefits, mandated rebuilding of species, ecosystem structure and diversity. The methodology was originally described by Christensen and Walters (2004)[1], but has since been modified to include species diversity (by default using the Shannon diversity index).
 	Use the Anchovy Bay model in a version that is fitted to time series (or download). Once loaded, load the Ecosim scenario, (but not the time series), check that you have vulnerability multipliers saved, not just default values (Ecosim > Input > Vulnerabilities). Make a run to check model.
 
 Open the fishing policy search (Ecosim > Tools > Fishing policy search), select Initialize using Random F’s, and set Number of runs to 3. Click Objectives on the tab at the bottom part of the form. Set the search objective for Net economic value to 1. This will result in three searches, all seeking to optimize the net economic value.
 	Do a search. Examine and evaluate the results – at the end of the search the estimated fishing efforts are transferred to the Ecosim > Input > Fleet effort form, so you can simple run Ecosim to explore the results from the optimizations.
 	Are the three runs similar?
 
 	Try a similar search for optimizing for social considerations (jobs). 	Do a run and display the absolute value of the landings (Data to plot > Value (absolute)
 	Reset the fleet effort for all, run again, and check what the original values were.
 	What has the optimization done?
 
 
 	The policy search works by fleet, and in this case the trawlers catch both cod and whiting. It is very likely that if we split the trawlers in two fleets, one for cod and one for whiting, that the optimizations would keep whiting down in order to rebuild cod. You can try this on a copy of the database.
 	Try to optimize for Net economic value (1), Social value (1), and Ecosystem structure (1) 	Is this a more balanced outcome?
 	Using the same weight on different objectives does not in any way guarantee that all count the same. What matters for this is how easy it is to change the objectives, and the weights may have to be changed to reflect that. There is no rule of thumb for this, you will have to use trial and error combined with evaluation of runs.
 
 
 
 
	Christensen, V., Walters, C.J., 2004. Trade-offs in ecosystem-scale optimization of fisheries management policies. Bull. Mar. Sci. 74, 549–562. ↵
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		External bio-economic models

					Santiago de la Puente

			

	
				No model is capable of doing everything, nor should it be. However, EwE models can be linked or coupled with external routines forming an ecological-social-economic modelling chain. For example, some authors have coupled Ecosim with bioeconomic models to get a better handle on fishing effort dynamics. For each time step, the bioeconomic model uses the predicted catches per fleet (Ecosim output) to estimate the fleets profitability and predict the next time steps’ fishing effort level, which are then reintroduced as inputs for Ecosim.[1] [2] [3]
 In other cases, EwE models have been linked with Input-Output (I-O) models, [4] Social Accounting Matrices (SAM) [5] and Computable general equilibrium (CGE) models.[6] These tools also allow estimation of the broader economic impact of the fisheries across national or regional economies (much like the Value Chain plug-in). I-O models characterize the flows of goods in a symmetrical industry by industry format (i.e., goods supplied vs consumed) and are used to estimate direct (measures of actual expenditures by establishments operating in the sector), indirect (measures of economic activity of other industries supplying an industry or using its outputs) and induced economic effects of a particular industry (measures of economic impact derived from the expenditure of salaries gained in the sector on other sectors of the economy).[7] SAMs are extensions of input-output models, with their main advantage being that they consider the social-economic linkages as well as other transactions (such as linkages between production and household sectors).[8] Finally, CGE models provide an analytical framework to assess the impact of fishery policies on regional economies and social welfare.[9]
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		Spatial modelling primer

								

	
				This chapter gives a primer about some of the higher level questions that are dealt with in connection with spatial modelling in EwE.
 When to “go spatial”?
 So, you’ve created an ecosystem model, tuned it with regard to carrying capacity in order to replicate the known ecosystem history, and you’re considering taking it to the next level, to explicitly represent spatial patterns and dynamics. When should you do that?  The first and foremost question to consider is whether the policy/research question (see chapter) that is driving your work is inherently spatial. If it is, consider constructing a spatially-explicit model. Take for instance if you’re to evaluate the impact of a marine protected area (MPA) – such a question indeed calls for a spatial model.
 EwE includes a spatial model, Ecospace, which in essence provides an model with a bunch of Ecosim models, each running in a cell in a regular spatial grid, while keeping track of flows between spatial cells along with human and environmental impacts.  The Ecospace model was originally[1] developed to address questions about the functioning of MPAs, but has has over the years been expanded in various ways to become a capable tool for ecosystem-based fisheries management (EBFM), multi-sectoral EBM, and prediction of climate change impacts. The details of that are described in the current and next part of this textbook.
 It should be stressed, once again, that Ecospace is not “better” than Ecosim, which in turn is not “better” than Ecopath. Ecospace is more complex, and as a general rule, the best model to address a given policy/research question is the simplest model that can address it. Adding more “realism” may not improve a models predictive capability, it may have the opposite effect, indeed.  So, you “go spatial” when there’s no way around it, when you really need it. Not in order to produce pretty maps –and yes, we all love pretty maps, but that’s not a sufficient reason for adding complexity).
 Eulerian vs. Lagrangian movement
 There are two basic approaches to modelling spatial movement (at least in fluid dynamics, which we can lean heavily on for modelling trophic flows), Eulerian vs. Lagrangian, (Figure 1).
 Eulerian[2] approaches analyzes overall flow patterns over space and time  from the fixed viewpoints of spatial cells, and estimates movements across cell boundaries, averaging the flows in and out of cells.  This form for modelling goes hand in hand with population-based modelling where the basic unit is the population, which in turn in impacted by changes in the form of flows, e.g., mortalities. The original (and default) Ecospace model representation is an example of a Eulerian approach.
 Lagrangian[3] approaches in contrast tracks the movement of individuals in a system  and follows their trajectories over space and time.  Given that the Lagrangian approach opens for following individuals, it serves as a foundation for Individual Based Models (IBM), also known as agent-based models, which models populations with all (or representative) individuals modelled explicitly.
 For EwE multi-stanza groups, you have the option of using the default Eulerian or an IBM approach in Ecospace (see chapter).
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 Figure 1. Eulerian (left) vs. Lagrangian (right) approaches to modelling of spatial movements. Eulerian approaches average flows from a fixed perspective, here a spatial cell where it keeps track of movements and advection to the four neighbouring calls. Lagrangian approaches track particle flows spatially across the model domain. 
 Domain definition
 Spatial extent
 There are several questions to be addressed as part of the model domain definition. A first is the spatial extent of the model. The key factor here is that your model policy/research question should dictate the model extent. That may not seem very specific, indeed it isn’t, so let’s illustrate with an example.
 If you’re working on fisheries management in the Azores Islands where both seamount and pelagic fisheries are important, you’ll make a local model that includes all of the relevant fisheries.  This will then include tuna species whose distribution and population dynamics is at the scale of the North Atlantic. How do you deal with that?  The simple way is to include immigration and emigration for the tuna. This will result in the given amount of tuna always coming in (immigration), while the amount of tuna leaving (emigration) will be a function of how many that are caught in the Azores area.  This will not be correct, but from the point of view of the Azores Islands’ managers, it is a reasonable assumption[4].
 Still, it will not capture the dynamics of the tuna population. If that was the policy/research question that the model was intended to address, then the model domain was not properly defined. It should have been a model of the North Atlantic instead
 The key lessons to draw from this is (1) that the extent of the model domain should be chosen based on the policy/research question to be asked of the model. Further, (2) one can only model the dynamics of groups whose dynamics take place within the model domain. When key aspects of their dynamics are over a larger area, we can model the impact of such groups on the system, but will have limited capability to model the impact of within-system actions on these groups.
 Spatial structure
 A next choice to be made for a spatial model is what grid structure to use. The high-level choice is between a regular grid or polygons where polygons can be of any shape while rectangular grid in ecosystem models ten to be consistent, usually rectangular cells that are equally sized (often varying with latitude though).
 Generally, regular grids are used for analyzing spatial patterns of a continuous type across a large area where consistent interpretations are wanted. Polygons are in other fields often used for aspects such as administrative boundaries, use patterns and other where the spatial patterns may differ between the polygons. For ecosystem models, among other habitat characteristics can be good patterns for defining polygons.
 [image: ]
 Figure 2. Polygon vs. regular grid domain spatial structure. Both types are used for ecosystem models, e.g., polygons for Atlantis and regular grids for Ecospace. 
 Using polygons make it simple to interpolate over larger area with generally much fewer cells required to describe the spatial characteristics of a model domain.  But it comes at the price of having to estimate how much flow there is between cells that only overlap partially (Figure 1).  On the upside, polygons calls for much fewer cells – take for instance a model of a country’s EEZ stretching 200 n.miles out from the coast. The core dynamics and fisheries will be in the perhaps narrow coastal zone with detailed habitat structures, while the offshore area will be much more uniform and with focus on the pelagic zone. Such a domain could with polygons be defined with more polygons in the coastal region and only few in the offshore. when using regular grid, the same resolution must be used throughout.
 What to choose then? For the spatial model of EwE, we have chosen a regular grid based on an evaluation of the computational cost involved in keeping track of the exchange between irregular cells.  The “everybody loves pretty maps” argument was not instrumental in the decision, but the regular grid does offer some advantages when it comes to describing for instance the impact of placing alternative energy platforms in an ecosystem. It’s straightforward to evaluate alternative scenarios with the regular grid compared to a polygon system. Also, we’ve found that the regular grid makes it really straightforward to develop alternative model resolutions in one go. When constructing spatial layers, we often make them with different resolutions in one go, so that when running the models we start with a low resolution grid to start getting the models to behave, then shift to an intermediate when the model is more tamed, and finally to a high resolution for the production runs. Generally, the results don’t change between the medium and high resolution runs, but … everybody loves pretty maps!
 Dimensionality
 Time is the fourth dimension, but how many dimensions to you need for your ecosystem model?  That (as you’ll know already) depends on your policy/model question. The general answer is as few as possible, nothing new about that either.
 If the question relates to water movements, we really have no choice but to go for a 3D model. It is necessary to capture how flow fields will the impacts are temperature patterns, a.o. We use hydrodynamic models for that.
 But what about ecosystem models? 3D comes at a cost of one to two orders of magnitude in run time compared to a 2D model, so what’s preferable, 2D or 3D? There is no definitive or correct answer to that question, there are trade-offs. Plankton move up and down in the water column daily, and whales may dive to the bathypelagic zones in minutes. In consequence, we decided to go 2D for the spatial model of EwE, to stick to the map, not go 3D.  This is both for computational speed (see Run time below), but also because it isn’t really necessary to answer the type of policy/research questions we have seen posed to models.
 Why not 1D to make it even simpler? One-dimensional models in the form of transects do indeed have a role to play, and in a 2D world they can easily be constructed. It’s more complicated to change a 1D model to 2D, so that’s another reason for the spatial EwE model being 2D.
 Time step
 The 3D vs 2D debate also has consequences for what time step to use.  The general rule is that particles or organisms should only be able to move to the nearest neighbour cell within a time step, not across multiple.  For 3D models that often have a large number of layers in the vertical zone this typically means that the time step is measured in minutes. That is a problem for ecosystem models where they dynamics of key species of interest may well be captured with time step measured in months.
 For the spatial EwE model, the default time step is indeed a month, so 12 time steps per year, which is the time unit used for rates such as the production/biomass ratio.  For the vast majority of the questions asked of ecosystem models with focus on human impacts, such time lines are indeed what is called for.
 May be added, that if the policy/research question calls for for instance analyzing short term aspects, this can be accommodated straightforwardly by simple changing the unit of the Ecopath input rates from annual to a finer scale. E.g., using daily rates will result in Ecospace time steps of 24/12 = 2 hours.
 It should be noted that Ecospace is not appropriate for explicitly modeling the very fine scale horizontal and vertical movement/mixing processes (10’s of meters, hours to days) that create foraging arena vulnerability exchange relationships.  The effects of such relationships are already represented in the Ecosim model search rate and vulnerability exchange parameters, including such effects as limited diurnal overlap by vertically migrating foragers and/or their prey.  A few people have tried to use Ecospace to explicitly model movement for example between spatial patches representing predation refuges and other patches where foraging takes place.  This creates both a double-accounting problem for trophic interaction rate predictions and also typically a really fine spatial grid with huge computational requirements per time step.
 Run time
 While last in this chapter, it is not least. It matters how long time it takes to run a spatial model. Spatial ecosystem models are complex beasts (in contrast to physical models where behaviour isn’t a factor), and we will never[5] be able to tame such models without trial and error, i.e. without exploring the input parameter space and evaluation model performance.  In practice this calls for model run time to be short enough to make multiple runs with output exploration feasible.
 Quiz
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		Introduction to Ecospace

								

	
				Setting the stage
 Marine ecosystems are complex systems affected by the state of the environment and a myriad of human activities. The full impact of these human activities on the complex ecosystem are becoming more critical to understand, and are now requested by agencies concerned with numerous policies and strategies that involve spatial management actions (in Europe, for instance by the Common Fisheries Policy, Marine Strategy Framework Directive, Farm to Fork, Zero Pollution and Biodiversity Strategies). All of these have divergent end-points, but all require an understanding of how multiple forms of human activities impact marine ecosystems. To better manage our impact on marine ecosystems, and notably consider trade-offs in management, there is a need to advance scientific capabilities to provide both quantitative descriptions and quantitative evaluations of the effect of spatial management interventions, factoring in plausible future changes in climate and human activities.
 Spatial-temporal ecosystem modeling has grown in capacity, complexity, and focus to undertake such complex tasks, and is increasingly considered an indispensable tool to contribute to policy and management, including multi-sectoral Ecosystem Based Management (EBM) and Marine Spatial Planning (MSP).
 Among the tools available, the temporal and spatial dynamic model EwE approach is of special interest for its wide range of applications across ecosystem types. Ecospace has notably been used to contribute to EBM, most often to a subset of EBM, Ecosystem-Based Fisheries Management, or EBFM. Applications of Ecospace include the evaluation of spatial trophic interaction patterns, modeling of species distribution based on habitat suitability, the assessment of Marine Protected Area (MPA) placement and connectivity, harvest allocations and, more recently, environmental impact analysis and the assessment of episodic mortality events, effects of changes in nutrient inputs, climate change, and cumulative impacts (e.g.,[1] [2] [3] [4] [5] [6] [7] [8] [9] [10] [11] [12] [13] [14] [15] [16] [17] [18].
 The development of Ecospace has involved an evolutionary process where many additional capabilities have been developed over the years in response to requests by users. The more recent advancements include the Habitat Foraging Capacity Model (HFC[19])and the Spatial Temporal Data Framework (STDF[20]), which have enabled Ecospace applications to fully consider climate variability and change, taking into account different types of uncertainty[21] [22]. These innovations and a substantial increase in the various applications of EwE[23], provided a call for an update of the Ecospace, which led to a book chapter by de Mutsert et al.[24] upon which a number of the chapters in the present text book are based (as attributed). The present text book and the EwE User Guide seek to present the most up-to-date guidelines for using and understanding Ecospace’s capabilities and challenges.
 About Ecospace
 The Ecospace model is a spatially explicit time dynamic model based on the Ecopath mass-balance and Ecosim time dynamic routines[25] [26]. It applies the same set of differential equations as used in Ecosim, executed for each functional group and cell in a grid of cells. In Ecosim, a set of differential equations is defined based on the biomass components of change for consumer functional groups, expressed as
 [image: \frac{dB_i}{dt}=g_i\cdot\sum\limits_{j=1}^{n}Q_{ji}-\sum\limits_{j=1}^{n}Q_{ij}+I_i-(F_{it}+e_i+M0_{it})\cdot B_{it}\tag{1}]
 where Bit is the biomass of i at time t, gi is the growth efficiency, Ii is the immigration rate; Fit is the mortality rate due to harvesting (fishing mortality); ei is the emigration rate; and M0i the other mortality (mortality not explained in the model). The terms Qji and Qij represent the consumption due to predation by j on i, and by i on j, respectively. For primary producers, the consumption rate term is replaced by a production rate function f (Bit)) represents primary production rate as a function of the group biomass[27]; that function is nonlinear, representing competition effects for light and nutrients.
 The consumption rates Qji are predicted using equations from foraging arena theory (see chapter), where the biomass of prey i is split between a vulnerable (Vij) and a non-vulnerable (Bi-Vij) component.  The vulnerability exchange parameters used in predicting the various Qji mainly represent spatial distribution and movement behaviors at very fine scales, typically far smaller than the size of Ecospace spatial grid cells.
 In Ecospace, the spatial extent of the ecosystem is represented by a grid of cells, each of which can be defined as land or water, and each cell can have characteristics or attributes like a habitat type. Ecospace then represents the biomass (B) and consumption (Q) dynamics over a two-dimensional space as well as time[28]. Space, time, and state are considered discrete variables by using the Eulerian approach, which treats movements as "flow" of organisms among fixed spatial reference cells.
 In the original Ecospace model[29], a first step of parameterizing entailed the definition of a base map based on habitat information (depth strata, bottom type, etc.) in the study area. Species preferences were then (and still can be if more elaborate spatio-temporal habitat use functions are not used) assigned to these habitat types based on the biology and ecology of the species included in each functional group of the ecosystem model, their depth distributions, their preferred sediment type, etc. In addition, the original Ecospace model required for habitat definitions,
 	the dispersal (spatial mixing) rate of each functional group in "preferred" habitats,
 	the relative dispersal rate in "non-preferred" habitats, and
 	the relative feeding rate in non-preferred habitat by functional group.
 
 Fishing mortality rate for each cell can represent effects of fishing effort by multiple fishing fleets, and each fishing fleet can be depicted as operating in a specific region and habitat type, and cells can be defined as protected areas for particular or all fishing fleets.  Fishing effort is assumed to move between grid cells over time in response to spatial and temporal variation in profitability of fishing.
 [image: ]
 Figure 1.  For each cell, the inbound dispersal rate Ii is the sum of emigration flows from the four surrounding cells, while the outbound instantaneous dispersal rates mi from a given cell in Ecospace make up the basic Ecosim emigration rates ei, and vary based on the pool type, cell conditions/habitat, and response of organisms to predation risk and feeding conditions.
  
 Moreover, spatial variations of primary productivity and fishing costs can be defined as initial conditions for the basic model.
 For trophic interactions, fishing, and movement calculations, biomass is considered as homogeneous within each cell and movement of biomass and flows is allowed across the borders to adjacent cells. For each cell, the immigration rate Ii of Eq. 1 is assumed to consist of up to four emigration flows from the surrounding cells (Figure 1). The emigration flows (Bout,rci) are in turn similarly represented by instantaneous movement rates mi times the biomass density in the cell (Brci) with the sum of those loss rates like mi,j+1 representing the emigration rate ei in eq. 1:
 [image: B_{out,rci}=\sum\limits_{d=1}^{4}m_{id}\cdot B_{rci} \tag{3}]
 where (rci) represents cell row and column for group i, and d is movement direction (up, down, left or right).
 The instantaneous emigration rates mi,d from a given cell in Ecospace are assumed to vary based on the functional group, habitat preferences, and can be set to vary with trophic conditions within each cell (to model responses of organisms to predation risk and feeding conditions). The probability of movement of organisms towards favourable habitats was in the original Ecospace formulation calculated by means of a "habitat gradient function" for each mapped habitat type and species or group i. Biomass dynamics in unsuitable cells were modified by predicting higher rates of emigration, lower feeding rates, and/or higher vulnerability to predation, and a complex gradient calculation continues to be used so as to modify dispersal rates to cause higher movement rates of biomass toward suitable cells.
 In more recent versions of Ecospace, a habitat capacity model has been included to estimate cell-specific continuous habitat suitability factors where the area that species can feed in each cell is determined by functional responses to multiple environmental factors[30]. See the habitat capacity chapter.  It is optional whether to use a habitat and/or habitat suitability for any given group, though in many recent applications habitat suitability is used predominantly while habitats mainly are used for defining where fleets can operate.
 The very large equation system represented by eq. 1 with mixing terms is solved numerically on one month time steps using an implicit integration method (BDF2, second order backward differentiation), that works very well for long-lived species but tends to predict short lived species to change more slowly than Ecosim predicts.  As in Ecosim, the Ecospace BDF integration does not "see" the very rapid boom-bust dynamics that can be exhibited by groups with high P/B (e.g. phytoplankton and short-lived zooplankters), but instead predicts an average biomass for these groups.
 For advanced applications involving multi-stanza groups, there are two Ecospace option[31].  The first "multi-stanza" solution option. is to keep track of overall multi-stanza numbers at age over the map while predicting local variation in abundance from concentration patterns predicted from spatial mij variations of the differential equation system.  The second or "IBM" option is to divide the multi-stanza recruitment numbers at each time step into a large number of packets of individuals, then simulate random and directed movements of these packets over the map as the organisms grow.  Details of the IBM equations are presented later in the chapter on Spatial implementation of multi-stanza and IBM.
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				Why are species where they are?
 To bridge the gap between ecosystem models and species distribution models, the spatial-temporal explicit module Ecospace includes a habitat capacity model[1] that addresses the central question, “why are species where they are?” The overarching assumption in the habitat capacity model is that they are where they are because they prefer certain combinations of environmental and ecological conditions.
 Prior to the inclusion of the habitat capacity model in Ecospace, species distribution models and ecosystem models offered limited capabilities to work jointly to produce needed integrated assessments: assessments that take both food web dynamics and spatial-temporal environmental variability into account. The habitat capacity model is fairly simple and its integration in EwE mainly implied replacing a binary habitat variable with a continuous habitat suitability factor, where the area that species can feed in each cell is determined by functional responses to multiple environmental factors. This modification builds on the fact that animal populations have lower local impacts as the size of their forage area increases. The habitat capacity model offers the ability to drive foraging capacity from multiple physical, oceanographic, and environmental factors such as depth, bottom type, temperature, salinity, oxygen concentrations, etc., which have cumulative impacts on the ability of functional groups to forage. Since cell capacity is calculated for every functional group at every time step, this modification makes the model fully temporal and spatially dynamic.
 Using relative habitat capacity to predict spatial abundance
 A reasonably simple and tractable way around the binary parameterization of habitat definition is to define a continuous relative habitat capacity Crcj for each group j in each cell (with row and column) r,c, where Crcj varies from 0.0 to 1.0, and is calculated for each cell as a function of a vector of habitat attributes Hrc = (H1,H2,…Hv)rc of that cell, i.e. Crcj = fi(Hrc). For example H1 might be water depth, H2 might be proportion hard bottom, H3 might be summer water temperature, etc. Figure 1 provides a schematic overview of the basic calculations in the habitat capacity model.
 [image: ]
 Figure 1. Schematic diagram of the habitat capacity model calculations with four (hypothetical) environmental preference functions (any number of functions is possible). During model run, cell-specific environmental parameter values can be read from data layers for each time step, and a cell-specific habitat capacity value is estimated as the product of the environmental preference values. No weighting is used, but weighting can be considered by altering the shapes of the environmental preference functions.
 To include environmental factors with higher or lower weight, let the Y-axis values (Figure 1) vary more or less through the X-axis range.
 The proportion of a cell that a species (or functional group) can use is thus a continuous value from 0 to 1, and allows inclusion of as many environmental factors as needed to define the foraging capacity of a cell for a species in an Ecospace model.
 If the functions fj() are chosen carefully, Crcj can be updated over time with relatively little computational cost, for example by loading time-varying values of Hrc generated by other models or remotely sensed data for physical or biophysical change, and implemented using the spatial-temporal data framework of Ecospace, (see User Guide chapter for how-to).[2]
 In order to use the Crcj habitat assessments, the Crcj values have to be linked to trophic interaction dynamics to specify how Crcj impacts food consumption and predation rates. A simple and reasonable way to represent this linkage is available through the basic foraging arena equations used to predict trophic interaction (food-web biomass flow) rates Eq. 1.
 For this, the consumption rates Qij are based on the foraging arena theory (see chapter), where the biomass of prey i is split between a vulnerable (Vij) and a non-vulnerable (Bi-Vij) component. The transfer rate, called vulnerability (υij) between the two fractions determines the vulnerable biomass at time interval dt,
 [image: \frac{dV_{ij}}{dt}=v_{ij} \ (B_i-V_{ij})-v_{ij} \ V_{ij}-\frac{a_{ij} \ V_{ij} \ B_j}{D_j}\tag{1}]
 where aij is the effective search rate for the predator j, and Dj represents loss of time searching due to handling time for the predator. The vulnerability parameter υij is a function of the maximum increase in predation mortality under the given predator/prey conditions (see vulnerability multiplier chapter). High values of υij imply large proportions of biomass (Bi) vulnerable to predator j (Vij), and thus imply Vij = Bi, and that the predator j is far from its carrying capacity with regards to prey i.
 If we consider how Ecosim represents biomass dynamics (exclusive of spatial mixing effects), trophic interaction and fishery effects are modelled by equations of the basic form (looking at only one prey type to simplify the equation)
 [image: \frac{dB_j}{dt}=\frac{g_j \ a_{ij} \ v_{ij} \ B_j \ B_i}{2 \ v_{ij}+a_{ij} \ B_j}-Z_j \ B_j\tag{}]
 where Zj is total instantaneous mortality rate of j, gj is growth efficiency (corresponding to the production/consumption ratio, which can vary as predators grow in size), vij is prey vulnerability exchange rate, and aij is the rate of effective search by the predator. Note that in this model, vulnerable prey density Vij is represented by the foraging arena equation Eq. 1), which simplified can be expressed when there is only one prey type i as
 [image: V_{ij}=\frac{v_{ij} \ B_i}{2 \ v_{ij}+a_{ij} \ B_j}\tag{3}]
 where predation pressure in a cell depends on the foraging arena area in that cell. If we assume that variation in relative habitat capacity for the predator means variation in the foraging arena area over which a species can forage successfully, we can include variation in relative habitat capacity in the model by dividing the denominator aij·Bj term by relative habitat size or capacity Crcj, i.e.,
 [image: V_{ij}=\frac{v_{ij}\ B_i}{2\ v_{ij} + a_{ij} \ B_j / C_{rcj}}\tag{4}]
 In effect, this assumption concentrates predation activity into smaller relative areas when C (foraging arena size) is small, so as to drive down vulnerable prey densities Vij more rapidly as Bj increases in locales with less foraging arena area.
 Importantly, including Crcj as a modifier in the aij·Bj / Crcj predation rate term results in the equilibrium predator biomass (Bj for which dBj/dt=0) being proportional to Crcp, i.e.,
 [image: B_j=(g_j \ v_{ij} \ B_i / Z_j-2 \ v_{ij}/a_{ij}) \ C_{rcj}\tag{5}]
 That is, using the Crcj as modifiers of the foraging arena consumption rate equation results in spatial patterns of biomass of consumers being proportional to Crcj, other factors (prey biomasses Bi and mortality rates Zj) being equal over space. We could, of course, also had assumed that variation in habitat capacity also affects the vulnerability exchange rates vij, search rates aij, and predation rates Zj (and if so, added minor changes to the code to implement these assumptions), but the default assumption is that the dominant cause of “poor” or relatively small habitat capacity is lack of usable foraging arena area. As such, the basic change made to the rate equations is a simple division of the denominator terms for predator search term, by-arena vulnerable prey density equations, by the capacity values Crcj.
 The new model is made compatible with earlier Ecospace models by providing the option to derive capacity directly from presence/absence of habitats. In this case, habitat maps and habitat preferences are directly converted to a capacity map for each functional group. Cells that contain a preferred habitat will receive a full capacity of 1, other cells will receive a capacity of (almost) 0.  The implementation in Ecospace further ensures that it is optional for every group in a model to use habitat maps and/or habitat capacity to drive distributions.
 Setting initial adjusted biomasses
 In going from Ecopath to Ecospace, it is assumed that the Ecopath base biomasses represent the average over all modeled cells of the cell-specific biomasses. This means that Ecospace biomass densities can be much higher in favourable spatial cells if there are relatively few such cells. Initial biomass densities Brcj(0) reflecting the Crck variation are assigned at the start of each Ecospace simulation by assuming that these biomasses are proportional to the Crcj. If there are nw water cells, such that overall biomass density for group k across the grid is given by nwBi* where Bi* is the Ecopath base biomass for group j, the initial spatial biomass densities are assigned as
 [image: B_{rcj}(0)=(C_{rcj}/ T \ C_j) \ nw \ B_j^*\tag{6}]
 where TCj is a total capacity index over the grid for group j, i.e.,
 [image: TC_j=\sum\limits_{r,c}C_{rcj}\tag{7}]
 and the sum over r and c is over all nw water cells in the spatial grid. Note that TCj << nw implies severe concentration of group j biomass on few cells.
 Correction of search rate and vulnerability parameters for spatial overlap patterns
 Spatial concentration of biomass for any group implies a requirement to adjust the rates of effective search au and vulnerability exchange rates vu for all foraging arenas u that are used by group j and its predators j’, since without such adjustments predicted predation rates (using foraging arena equations from Ecosim) at the higher local densities would be artificially increased from the rates implied by Ecopath base consumptions. In order to make this adjustment, the rates are set so that the total consumption for each arena link is the same in Ecospace as in Ecosim, scaled up to the total number of water cells. This implies the condition
 [image: n_w \ Q_u= (a_u \ v_u \sum\limits_{r,c} B_{rcj} \ B_{rcj}^{'})\ / \ (2 \ v_u+a_u \ B_j^*)\tag{8}]
 Here, Qu is the Ecosim base biomass flow rate for arena link u, B‘rcj is the initial predator abundance (biomass for non-stanza groups or sum of numbers at age times length squared for multi-stanza groups) for cell (r,c), and Bju* is the spatially invariant initial predator abundance obtained by noting that applying the Crcj correction in Eq. 4 results in
 [image: B_j^* = (n_j \ B_{Ecosim,j}^{'}) / TC_j^{'}\tag{9}]
 Here B’Ecosim,j is the Ecosim initial predator abundance. Using the assumed relationships above, between initial Brcj,  B’rcj and Crcj, Eq. 8 can be written as:
 [image: Q_u = (a_u \ v_u \ B_{ju}^{**} \ B_j^*) \ / \ (2 \ v_u+a_u \ B_j^*)\tag{10}]
 where Bju** is the prey-predator “incidence weighted” mean prey biomass divided by Bj* for link u given by
 [image: B_{ju}^{**} = (B_j^* \ \sum\limits_{r,c}C_{rcj} \ C_{rcj}^{'}) / TC_j\tag{11}]
 Note that this reduces to just Bju* if all predator C’rcj are near 1.0 for the same (r,c) cells where prey Crcj are near 1.0, i.e. where there is strong spatial overlap of the prey and predator distributions, but can be much lower than  for cases where predators occupy restricted spatial areas compared to the prey. Assuming the same vulnerability exchange rate vu as in Ecosim (from total base consumption rate over all predators using arena u) where k is the user-supplied vulnerability multiplier (aka Vulmult, see vulnerability chapter), Eq. 10 can be solved for au
 [image: a_u = (2 \ v_u) \ / \ [B_{j'}^{*} \ v_u \ B_{ju}^{**} \ / \ (Q_u-1)]\tag{12}]
 Unfortunately, this calculation fails if vu B*ju / Qu < 1, which can happen with relatively low vu settings and weak overlap between prey and predator such that B*ju is much less than Bj. In that case, the assumed spatial distribution overlap pattern simply cannot support the total predation rate estimated for the link in Ecopath and Ecosim, and instead we simply set
 [image: v_u=1.001 \ Q_u / B_{ju}^{**}\tag{13}]
 before solving for au in Eq. 12 so as to provide at least some large estimate of au to make simulations come as close as possible to predicting the base Qu. The rate of effective search au is further adjusted upward by the multiplicative factor Qm Qoj’/(Qm Qoj’-1) to account for handling time effects in order to create type II functional response effects by setting a low ratio of maximum (Qm) to base feeding rate (Qo).
 Modification of spatial mixing rates to reflect movement toward preferred cells
 For species with body sizes and mobility large enough to exhibit oriented dispersal and/or migration, it is reasonable to assume that dispersal rates between adjacent spatial cells are distorted so as to maintain abundance differences reflective of differences in habitat capacities between the cells.
 Without such distortions or oriented movement, random dispersal between cells would greatly reduce abundance gradients created by the Crcj capacity effects, and for species with restricted habitat use would result in too much biomass dispersing into unsuitable spatial cells so as to cause biomass to decrease substantially from Ecopath base biomasses, even without any changes in fishing pressure or predator abundances. For each border between cells, e.g. between cell (r,c) and cell (r,c+1) to its right, Ecospace assumes instantaneous mixing rates m1jBrcj to the right and m2jBrcj to the left. Absent orientation implies m1j=m2j=mj, where mj is an (input) expected dispersal rate.[3] In order to avoid smearing of the distribution, the dispersal rates are set so that
 [image: m_{1j} \ B_{rcj} = m_{2j} \ B_{rc+1j}\tag{14}]
 Assuming biomasses are then to remain near or proportional to Crcj, this balanced movement condition implies that the m1j and m2j have to be varied so as to meet the balance condition
 [image: m_{1j} \ / \ m_{2j} = C_{rc+1j} \ / \ C_{rcj}\tag{15}]
 Ecospace meets this condition by setting the exit rate to mj for whichever cell has lower capacity Crcj, then adjusting the exit rate for the cell with higher Crcj to mj times the capacity ratio. Thus for example if Crc+1j  >Crcj, m1j to the right is set to mj and m2j to the left is set to mjCrcj/Crc+1j so that m2j will be very small if Crcj << Crc+1j , i.e. movement into the low capacity cell will be severely restricted.
 Rounding off this chapter, the source publication[4]study used simulation modeling to evaluate the sampling characteristics of the habitat capacity model, based on an artificial data set and a spatial food web model of a marine ecosystem. This was used to derive “true” distribution based on environmental preference for the functional groups in the model, and then evaluate the degree to which it is possible to recreate the “true” distributions from sampling. As part of this, the impact of sample size and uncertainty in key parameters was evaluated. We refer to the source publication for details, and note that the habitat suitability model can be used to address a suite of new ecological questions, such as the impact of habitat degradation due to coastal development, eutrophication and climate change.  In most cases, it should be considered to use the habitat capacity facility instead of the pre-defined habitat approach.
 Quiz
  An interactive H5P element has been excluded from this version of the text. You can view it online here:
 https://pressbooks.bccampus.ca/ewemodel/?p=1150#h5p-11 
 
 Attribution This chapter is based on Christensen, V, M Coll, J Steenbeek, J Buszowski, D Chagaris, and CJ Walters. 2014. Representing variable habitat quality in a spatial food web model. Ecosystems 17(8): 1397-1412. https://doi.org/10.1007/s10021-014-9803-3. Reused with License Number 5757230625588 from Springer Nature. Rather than citing this chapter, please cite the source.
 
 
 Media Attributions
	From Figure 1 in Christensen et al. 2004 
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		Spatial implementation of multi-stanza and IBM

								

	
				Ecospace biomass dynamics
 For functional groups not represented by multi-stanza population dynamics accounting, Ecospace represents biomass (B) dynamics over a set of spatial cells (k) with the spatially discretized rate formulation
 [image: dB_{ik}/dt=g_iQ_{ik}-Z_{ik}B_{ik}-(\sum\limits_km_{ikk'})B_{ik}+\sum\limits_{k'}m_{ik'k}B_{ik'} \tag{1}]
 where Bik is the biomass of functional group i in spatial cell k; gi is conversion efficiency of food intake by group i into net production; Qik is total food consumption rate by group i in spatial cell k; Zik is total mortality rate of group i biomass due to predation, fishing, etc.; mikk΄ is instantaneous movement rate of group i biomass from cell k to cell k΄; and mik΄k is movement rate of group i biomass from cell k΄ to cell k.
 All of the terms on the right hand side of Eq. 1, except gi, are treated as dynamically variable over time so as to reflect changes in food availability (Qik), fishing effort and predation risk (Zik), and seasonal changes in movement patterns (mikk΄). Food consumption rates Qik are calculated as sums over prey types j (i.e., Qik = ΣjQjik). Likewise, total mortality rates are calculated as sums over predator types and fishing fleets f: Zik = Moi + Σf Fifk + ΣjQijk/Bik , where Moi is unexplained mortality rate, the fishing rate components Fifk by fleets f are predicted from spatial distributions of fishing effort for each “fleet” f over the grid cells k, and the Qijk/Bik ratios represent predation rate components of M (i.e., Mijk = Qijk/Bik) calculated from predator j consumption rates Qijk.
 The Ecospace grid cells are arranged as a rectangular grid with rows r and columns c, so that each cell k exchanges biomass directly only with those cells k΄ that are in adjacent rows and columns. If cell k represents row r, column c, then k΄ is restricted to cells (r – 1,c), (r + 1,c), (c – 1,r), and (c + 1,r). Exchanges at the map perimeter are set to zero, except for groups that are assumed to be advected across the map, in which case biomasses at the map boundary are set to constant (Ecopath base estimate) values.
 From the Ecosim Age-structured dynamics chapter:
 The basic accounting relationships for multi-stanza groups are
 [image: N_{a+1,t+1}=N_{a,t} \exp(-Z_{s,t}/12) \tag{2}]
 [image: W_{a+1,t+1}=\alpha_a q_{a,t}+ \rho W_{a,t} \tag{3}]
 [image: B_{s,t}=\sum\limits_{a=a1(s)}^{a2(s)} N_{a,t}W_{a,t} \tag{4}]
 Here, Na,t is number of age a (in months) animals in calendar month t, Wa,t is mean body weight of age a animals in month t, and Bs,t is the biomass of stanza s, defined as the mass (numbers × weight) of animals aged a1(s) through a2(s) months. Zs,t is the total mortality rate of stanza s animals, defined the same way on the basis of fishing and consumption as for other model biomass groups i as Zs,t = Mos + ΣfFsf + ΣjQsj/Bs. All animals in stanza s are treated as having the same predation risk and vulnerability to fishing. The aggregated bioenergetics parameters aa and r are calculated to make body growth follow a von Bertalanffy growth curve (with length-weight power 3.0) with user-defined metabolic parameter K. Exact von Bertalanffy growth occurs when predicted per-capita food intake qa,t is equal to a base food intake rate that is calculated from the consumption per biomass parameter (Qs/Bs) provided by the user for each stanza. The metabolic parameter r, which equals exp(–3K/12), is based on the assumption that metabolism is proportional to body weight[1].
 Actual or realized food intake qs,t at each time step is calculated from the total predicted food-intake rate for the stanza (Qs,t) as qs,t = Qs,twa,t2/3/Ps,t, where Ps,t is the relative total area searched for food by stanza s animals and is computed as Ps,t = ΣaNa,twa,t2/3. For foraging-arena food-intake and predation-rate calculations involving stanzas, Ps,t is used instead of Bs as the predictor of total area or volume searched for food per unit time. The assumption that area searched and food intake vary as the ⅔ power of weight (i.e., as the square of body length) is a basic assumption that also underlies the derivation of the von Bertalanffy growth function. For notational simplicity, Eqs. 2-4 above are presented without a species index.
 
 Original representation of multi-stanzas in Ecospace
 When the multi-stanza option was originally developed for Ecosim, it was not incorporated directly into Ecospace. Instead, each stanza was treated as its own higher-order functional group for Ecospace biomass-dynamics calculations without accounting for age structure within the stanza. Rather, the age-structure of each stanza was assumed to be in equilibrium. Body weight was computed grid-wide (not cell-specifically) for each stanza. Feeding rates were assumed proportional to a relative search-area index Ps calculated from a prediction of the numerical abundance of the stanza Ns as Ps = Ns̅Ps, where ̅Ps is the initial (t = 0) per-capita mean of the relative area-searched index Ps,t, i.e.,
 [image: \bar P_s=\sum\limits_aN_{a,0}W_{a,0}/\sum\limits_aN_{a,0}\tag{5}]
 Dynamics of the numbers in each stanza Ns were computed for each cell by the differential equation
 [image: dN_{sk}/dt=R_{sk}-Z_{sk}N_{sk}-(\sum\limits_{k'}m_{ik'k}N_{sk})\tag{6}]
 where Rsk is an approximate difference between recruitment (incoming) rates and exit (to next stanza) rates for stanza s in spatial cell k. If the age structure within the stanza is assumed to remain near equilibrium, the Rsk term in Eq. 6 can be approximated as
 [image: R_{1k} = E_{tk} (1-exp(Z_{sk}(a_2(1))/12)) \; \text{for} \; s = 1 \tag{7a}]
 [image: R_{sk} = N_{s-1,k} Z_{s-1,k} / (\exp(Z_{s-1,k}(a_2(s-1)-a_1(s-1))/12)-1) \; \text{for} \; s>1 \tag{7b}]
 Eq. 7a represents egg production rate minus survival rate to the age at exit from stanza s = 1. Egg production is assumed to be approximately proportional to biomass Bsk of the oldest (adult) stanza s in cell k. Eq. 7b is derived from the equilibrium of the delay-differential equation for Ns that results from assuming spatial gain and loss rates to be approximately balanced, so that the dominant effects on Ns are gains from individuals progressing from the previous stanza and from losses of individuals as they progress to the next stanza and mortality within the stanza.
 The equilibrium assumption needed for derivation of Eq. 7 can lead to inaccurate predictions because it can result in incorrect size distributions if incoming and outgoing numbers are not in balance, and size then affects the predation-rate parameters (areas searched, maximum prey-consumption rates). Eq. 7 is a relatively poor approximation for both egg production and net rates of numbers gained through graduation from younger stanzas and loss to older stanzas, so this early version of Ecospace tended to predict incorrect absolute values for cell-specific numbers Nsk relative to Ecospace-predicted cell-specific biomasses Bsk, but the predicted spatial distributions of abundances were at least qualitatively reasonable. In past applications, Ecospace generally predicted that Nsk was relatively high in cells with high egg production, in cells with favourable habitat, and in cells near seasonally varying optimum migration positions for migratory stanzas.
 Predicting multi-stanza spatial distribution from continuous mixing-rate models
 In an effort to avoid the large computer-memory requirements and massive accounting calculations (for typical models, on the order of 103 more calculations per time step) required for replicating the full age-structure accounting for multi-stanza groups for every grid cell of large Ecospace models, a simple approach based on combining the overall multi-stanza population accounting (as described in the Ecosim Age-structured dynamics chapter, eq. 2-4 above) with the relatively simple Eq. 7 diffusion model for predicting relative spatial abundances by stanza. This approach depends on two key assumptions:
 	the Ecosim multi-stanza accounting system can be applied for each multi-stanza population as a whole (summed over all Ecospace grid cells), given reasonable estimates of mean food consumption rates qs,t and mortality rates Zs,t averaged over the grid cells (a basic assumption that is made anyway in the non-spatial Ecosim representation of any large area) and
 	the diffusion model, Eqs. 6-7, gives reasonable predictions of the relative distribution of the biomass of each stanza over grid cells whether or not the absolute numbers Nsk are predicted correctly, hence preserving effects of complex spatial-overlap patterns among stanzas.
 
 We then perform the Ecospace time solution on monthly time steps using the following four-step procedure:
 	We use the results from integration of Eqs. 6-7 to apportion the spatial distribution of total stanza biomass Bst  over spatial cells k to give Bsk relative cell biomasses using Bsk = BstNsk/ΣkNsk.
 	The spatial Bsk biomasses (and relative predator-search areas Psk = PstNsk/ΣkNsk) are then used in the Ecosim foraging arena and fishing rate calculations for each cell k to predict food-consumption rates Qsk and mortality rates Zsk.
 	Biomass-weighted average food-consumption rates ̅qs,t, and mortality rates ̅Zs,t, for the whole population are calculated as,[image: \bar q_{s,t}=\sum\limits_k B_{sk}q_{sk}/B_{st} \ \ \text{and} \ \ \bar Z_{s,t}= \sum\limits_k B_{sk}Z{sk}/B_{st} \tag{4a,b}]
 	The system-scale multi-stanza accounting is done by means of Eqs. 2-4 with the biomass-weighted averages (̅qs,t, Zs,t) to give predicted total population age and size structure and total stanza biomasses Bs,t+1 at the start of the next month.
 
 This procedure retains some information about predicted changes in spatial abundance patterns due to mixing processes and spatial variation in mortality rates Zsk because Zsk is included in the prediction of relative numbers Nsk by cell from Eqs. 6-7, but it discards information about spatial variation in growth rates qso in favour of using a single system-scale prediction of body growth (Eq. 3 with consumption rate qs,t represented by ̅qs,t).
 Further, it fails to account for the cumulative divergence that can take place in both age and size structure for relatively sedentary species resident in spatial cells that are protected from fishing. That is, for “adult” stanzas containing many age classes, it fails to represent the potential accumulation of older, more fecund animals in protected areas, considered by some to be a key benefit of marine protected areas. One possible solution to allowing accumulation of large adults in specific areas is to split the oldest stanza group into a number of stanzas, but doing so is an approximate fix rather than a solution.
 For resident species, the mixing-model approach also fails to account for regional variation in growth rates associated with spatial cells that have higher basic (primary and lower-trophic-level) productivity or reduced intraspecific competition due to limited recruitment. For these reasons, the mixing-model approach is best suited to analyses of pelagic systems, where relatively high mobility results in averaging of feeding and mortality rates over substantial areas. When used for systems with many resident or sedentary species, the approach is potentially misleading and should be used only to provide computationally “quick-and-dirty” policy screening for options such as size and spacing of MPAs, to be followed by more careful screening according to the more detailed individual-based approach described below.
 Individual-based approach for predicting spatial patterns in growth, survival, and distribution
 Most regional populations exhibit at least some degree of localized or cell-scale variation in recruitment, body growth, and survival rates, and erosion of this local structure has serious implications for maintenance of both biodiversity and overall productivity. The original and mixing-model approaches described above cannot adequately capture such local structure, which can result from the cumulative effects of the development of a fishery or from MPAs. Ecospace therefore includes a much more detailed and realistic approach to the representation of localized trophic-interaction effects based on concepts of individual-based modeling (IBM).
 In the IBM approach, we retain the spatial biomass-dynamics accounting for non-multi-stanza species represented by Eq. 1 and the multi-stanza population dynamics accounting of Eqs. 2–4, but rather than solving Eqs. 2–4 once for each stanza using spatially averaged (grid-wide) food-consumption and mortality rates, we divide the age-0 recruits for each multi-stanza population (N0,t) into a large number np of packets (cohorts). Each packet is assumed to represent some number of identical individuals of the population, and all packets from the monthly recruitments start out with the same individual biomass and numbers at recruitment (Np,0,t = N0,t/np). Each packet is then followed independently as it moves among spatial cells on the grid. This approach is similar to that recommended by Rose et al.[2] and Scheffer et al.[3]
 The growth-survival Eqs. 2-3 are then solved for each packet, yielding its predicted age and size dynamics (Np,a,t and Wp,a,t). Packets are discarded from the overall population when they reach a maximum age (denoted amax) beyond which Np,a,t is negligible. Each packet p is assigned an initial spatial position Xp,0,t,Yp,0,t, and movements of the packet over time are predicted from both random (diffusive) and oriented (migratory) changes in position. At each simulation time step, the ecological conditions (food intake rates, mortality rates) for the spatial cell in which each packet is located are used in Eqs. 2–3. The overall accounting for Bs,k and Psk needed for trophic-interaction predictions (impacts from and on biomasses of non-stanza species in each cell k) then involves simply summing Bp,k,t and Pp,k,t packet biomasses and predation search areas over those packets present in each cell k, before foraging arena predictions of Qsk, Zsk are performed for that cell.
 The obvious advantage of the IBM approach is that it retains the cumulative history of each packet’s space-use pattern, in the form of the packet’s numerical (worth) and body size (weight) states. For sedentary species, local differentiation in growth and accumulation of older animals is represented by how packets in different local areas (cells) fare over time. Further, through use of restricted movement rules, collections of packets can easily be made to form distinctive local populations, presumably key units of local adaptation and biodiversity, including as a consequence of local environmental conditions.
 A disadvantage of the approach is that it requires massive computation, both for the survival-growth calculations and for movement of a sufficient number of packets over the simulated grid to permit realistic spatial distributions and variation. This number must be determined by trial and error; the number of packets must be increased until results stop changing. Most of the computational effort (typically about 90%) ends up being in the simulation of movement as changes in the locations Xp,a,t, Yp,a,t.
 Monthly survival-bioenergetics updates for each packet are based on food intake and mortality rates predicted for the spatial cell where the packet is located at the start of the month. No attempt is made to integrate q or Z rates over times within the month spent in different cells; doing so would be prohibitively computationally intensive. This omission amounts to assuming either that cell sizes are set large enough that most movements over any month occur within a single cell or that spatial correlation in productivity and predation risk among nearby cells there is reasonably high, so movements over such cells would result in the same predicted food intake and mortality rates obtained from the initial cell. Effects of violating this assumption could be tested if the model were run with varying grid cell sizes.
 The initial or spawning position for each packet (Xp,0,t, Yp,0,t) is set to the centre of a cell k, where the probability of recruiting to cell k is set equal to Ekt/ΣkEkt and Ekt is the predicted total egg production in cell k for month t summed over all packets that are in cell k at the start of the month. This procedure allows spawning to occur well away from locations of larval settlement or juvenile growth because larval dispersal and juvenile migration can be explicitly represented, through either different or similar movement-simulation rules as used for packets of older fish. In particular, the IBM approach “encourages” formation of local stock structure; recruitment tends to occur near centres of egg production. In the context of MPAs, lower mortality rates Z in designated cells can result in the accumulation of older, more fecund fish, and those cells can thus become local areas of high reproduction.
 Monthly movements by each packet are simulated as a set of ns increments to the X,Y values that determine location on the grid. The user specifies an average annual movement distance, which implies an average monthly movement distance. The number of moves ns each month is then set so that the distance per increment cannot exceed the width of one cell. Each movement is made only in a cardinal direction (N,S,E,W), so that only X or Y (not both) changes for each move. The probability of choosing each of the four directions, k΄, is set to mskk΄/Σk΄mskk΄, where mskk΄ is the instantaneous movement rate from cell k to k΄ calculated for the continuous biomass model (see Eq. 1). As noted above, the mskk΄ can be set equal for all k΄, to represent purely diffusive movement, or biased to represent avoidance of cells with unsuitable habitat, movement toward preferred habitats, or seasonal migration patterns. This method for choosing movement directions makes it possible to use the same user interface for entering assumptions about movement distances and orientation for multi-stanza populations as for groups represented only by biomasses, and it ensures that the multi-stanza movement patterns are broadly comparable with predictions from the computationally faster continuous mixing-model version of Ecospace.
 Attribution The chapter is adapted from Walters et al. 2010, Bulletin of Marine Science[4], which permits authors to use figures, tables, and brief excerpts in scientific and educational works provided that the source is acknowledged and the use is non-commercial.
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		Tutorial: Spatial model of Anchovy Bay

								

	
				
 Learning Objectives
  	Introduction to basic Ecospace operations
 	Introduction to the habitat capacity model of Ecospace
 
 
 
 Getting started
 Advice: Use a lower resolution map while developing and testing the model. You can always change to a higher resolution map once you have the model behaving and are ready for production runs.
 
 Open the Anchovy Bay model that we created in a previous tutorial (or download it). Load the time series that we previously added to Ecosim. Open Ecospace and create a new scenario (you decide what to call it).
 Go to Ecospace > Input > Ecospace parameters tab: If you loaded the time series then the Run time on the tab is likely to be 41 years, and number of time steps is 12. Notice that Ecospace can use variable time steps, but fine to leave this at 12 (monthly) time steps per year.
 Next task is to create the spatial map that we will use for the tutorial: Click Ecospace > Input > Maps in the Navigator. At the top of the right-hand side panel, click Edit basemap. Set Number of rows to 20, and Number of cols (columns) to 20. This gives us 20 x 20 = 400 cells to work with. More would give us a prettier picture, take longer time to run, and not necessarily give us different results. Set Cell length to 20 km. Click OK. EwE will save and close the form.
 Select Input > Maps again, and click Depth at the right-hand side panel. Now click the icon to the right of Depth. This will open a form that will allow you to: Edit Layer ‘Depth’. Click the Data tab, and you will get a spreadsheet.
 How to get bathymetry: see this tutorial
 Now download and open the spreadsheet Spatial Anchovy Bay.xlsx, and on the first tab (Depth), highlight the values (including row and col numbers), the press Ctrl + C (for copy).
 For Mac users: Copying from Mac Excel to EwE running in virtualization can be problematic, and may lead to only alternate rows being copied. It’s related to file format (end of line character), and beyond our control. If you encounter problems with this, you may need to use Excel in the Windows installation where EwE is running.
 Go back to Ecospace, click the top left cell in the depth data spreadsheet, and press Ctrl + V (for paste). You should now have the depth map for Anchovy Bay.
 Habitat capacity model
 [image: ]
 Figure 1. Example of a hand-drawn response function. Ecospace will rescale the Y-axis, so the shape matters, but not the amplitude.
 
 Next, we want to start parameterizing the habitat capacity model. Here, we’ll illustrate this with a simple example (before loading a version of the model with more layers). Click Ecospace > Input > Ecospace environmental responses. Click Add on the lower center panel in order to add a response curve. For now, think of this shape as representing the depth distribution of a species, e.g., for cod. We can read in such shapes, but for now just get by with a sketched shape. So draw a shape, for instance with a low value at low X, then increasing to a max at 1/3 of the max X-value and then gradually declining to 0 again. (Maybe somewhat as in Figure 1).
 First, we need to define the X-axis, (Ecospace > Input > Ecospace environmental responses > Define environmental response). Set X-min and X-max above the right-hand side panel. Leave X-min at 0. Set X-max to, e.g., 400 m (just to try it). Click OK, and X-axis on the Driver histogram & response function  plot below should update.
 Now we have to assign the functional response above to cod. Go to Ecospace > Input > Ecospace environmental responses > Group capacity model, and select Use environmental responses for all groups. (Just click the row header, and it will select all, then change the box in the top right to True). It is OK to have both Use habitat and Use environmental responses selected, (but we won’t be using the habitats here, so you can also uncheck the Use habitat – though it makes no difference when there are no habitats defined).
 Next, go to Ecospace > Input > Ecospace environmental responses > Apply foraging response. In the spreadsheet, click the cell under Depth for Cod. In the left panel, click the shape you made, click the green arrow to the right, OK to assign this shape to cod. There will be a histogram of depth values up in the panel to the right. This histogram is just for your reference. Now we are to Click OK to exit the form.
 It takes processing time to draw the distribution maps in Ecospace. So, to speed things up, the Graph tab is opened by default (the time plot is much faster).
 Now it’s time to run Ecospace. Go to Ecospace > Output > Run Ecospace, and click the Run Ecospace button at the bottom-left of the center panel. By default, Ecospace will show you a time plot, but you can see spatial maps, it you select the Map tab above the time plot. On the small distribution maps that appears, you should see that cod have a distribution that is impacted by the functional response you defined.
 Explore the Ecospace model a bit.
 Anchovy Bay Spatial
 Next, let’s read in a version of the model that has more data. Download the file Anchovy Bay Spatial.ewemdb.zip from this link. It has a new version of the Anchovy Bay database. Unzip and open the database in EwE.
 Go to Ecospace > Input > Ecospace environmental responses, and explore the additional shapes (see Figure 2).
 [image: ]
 Figure 2. Nine environmental response function plots (left panel). Each of these figures describes a plot as indicated in the right panel. This example shows the depth foraging response for shrimp and benthos, which are assumed to show a log-normal like distribution ranging from 10 to 250 meters depth with a peak around 70 meters.   
 
 On the next tab, Ecospace > Input > Ecospace environmental responses > Apply foraging arena shapes, you can find an example of how to allocate shapes for the model groups (Table 1).
 Check if the model you use has environmental drivers defined. On the Ecospace > Input > Maps page, click the pen icon by Environmental drivers in the right-hand listing, and define the input driver maps here. For this Anchovy Bay tutorial that would be Depth (which already is there), temperature and distance from coast.
 Table 1. Applied environmental response function shapes.
 	Group no 	Group name 	Depth 	Temperature 	Distance from coast 
 	1 	Whales 	3: Depth cod 	 	7: Distance whales 
 	2 	Seals 	2: Depth whiting 	 	8: Distance seals 
 	3 	Cod 	3: Depth cod 	5: Temp cold 	 
 	4 	Whiting 	2: Depth whiting 	6: Temp warm 	 
 	5 	Mackerel 	4: Depth pelagics 	5: Temp cold 	 
 	6 	Anchovy 	4: Depth pelagics 	6: Temp warm 	 
 	7 	Shrimp 	1: Depth shrimp-benthos 	 	 
 	8 	Benthos 	1: Depth shrimp-benthos 	 	 
 	9 	Zooplankton 	 	 	 
 	10 	Phytoplankton 	 	 	 
 	11 	Detritus 	 	 	 
  
 
 The habitat based foraging arena shapes are used for each functional group to calculate how much foraging arena there is in each spatial cell in the model. As such it replaces or supplements the habitats that were used in previous versions of Ecospace – which either were good or bad for the individual groups, see the Habitat capacity chapter.
 The original type of defined habitats can still be included in Ecospace. This is for (1) compatibility with existing Ecospace models, (2) for use to restrict groups to specified habitat types, and (3) for potential use to allocate effort for fishing fleets. This is illustrated in the present tutorial, see Ecospace > Input > Maps, where you under Habitats in the right-hand side panel, can find four habitats, Coastal, Sand, Rocky, and Deep. These habitats are used on the Ecospace > Input > Ecospace Fishery tab to allocate fleets to habitats; e.g., the trawlers are not able (or allowed) to operate in cells with rocky bottom.
 Note that explicit habitats can occupy a fraction of a cell. See for instance the Rocky habitat. Click on the Icon to the right of Rocky, which brings up the: Edit layers ‘Rocky’. (This is where you can change the map icon for the habitat). Here, click Data on the top left, and you can see that there are rocky reefs in fractions of some habitats.
 Run and explore the model.
 Media Attributions
	Ecospace > Input > Ecospace environmental responses > Add form 




	

			
			


		
	
		
			
	
		

		Tutorial: Making a base map (bathymetry)

								

	
				One of the first steps for setting up an Ecospace scenario is to get a depth base map along with cell water area. Here’s a short example of how you may access bathymetry and cell water area maps.
 We here use publicly available bathymetry data sets obtained from the GEBCO website. GEBCO provides a global terrain model for ocean and land, providing elevation data, in meters, on a 15 arc-second interval grid. It is accompanied by a Type Identifier (TID) Grid that gives information on the types of source data that the GEBCO_2023 Grid is based on. The data set is updated annually.
 	Go to GEBCO’s global ocean and land terrain models’ website, then download data for area of interest. The resolution at the GEBCO website is 15 arc-seconds, so about 463 m N-S for each cell. Select a custom area, then Esri ASCII, Grid format, and add to basket. View and download the data.
 	In the downloaded folder, there will be an .asc file, that’s the one we want for Ecospace. Here’s an example of how this can be done,
 	Open R-Studio and create a new R script file, save the file
 	Load the terra package 	library(terra)
 
 
 	Set your working directory, e.g., 	work.dir = dirname(rstudioapi::getActiveDocumentContext()$path)
 	setwd(work.dir)
 
 
 	Read in the map, e.g., 	map = -rast (filename) 	where filename is the name of the downloaded .asc file
 	For Ecospace we want depths to be positive, hence the minus sign in front of raster
 
 
 
 
 	The map is fairly high resolution, so you’ll likely want to aggregate it. Aggregation is by default by averaging, so we need to get rid of the land values before aggregating, 	map[map<0] = NaN
 
 
 	You can see the map using, 	plot(map) 	See Figure 1.
 
 
 
 
 
 [image: ]
 Figure 1. High resolution raster map as extracted from the GEBCO website. The area shown is the central part of Howe Sound near Vancouver BC. For each cell, the water area is a GIS parameter that is used in the R calculations.
  
 	To aggregate the map, decide on how many times (X) you want to reduce the number of rows and how many times (Y) you want to reduce the number of cols. (or try till you have something suitable), e.g., 	facto = c(X,Y)
 	low_res_map = aggregate(map, facto, FUN=mean, na.rm=TRUE, na.action=NULL) 	excluding land cells from averaging with na.rm
 
 
 	plot(low_res_map) 	See Figure 2.
 
 
 
 
 
 [image: ]
 Figure 2. Low resolution raster map as calculated using the R code in this tutorial. The map is aggregated with a 4 by 4 factor, so it has 1/16 of the resolution of Figure 1. For each aggregated cell, the water area is calculated based on water area in each cell in the high resolution that was extracted from the GEBCO website.
  
 	Calculate the proportion of cells that have water 	prop_water_cells = aggregate(not.na(map), facto, fun=sum) / facto[1] / facto[2]
 
 
 	Get the cell area; it is in m2, so change to km2 	cell_area = cellSize(low_res_map)/10^6
 	water_area = prop_water_cells * cell_area
 
 
 	Finally save to asc file 	writeRaster(low_res_map, ‘my_depth_map.asc’, overwrite=TRUE)
 	writeRaster(water_area, ‘my_water_area_map.asc’, overwrite=TRUE)
 
 
 	Open the .asc file with Excel, and read the number of rows and cols from the header
 	Now open EwE, and create a new Ecospace scenario
 	Open Ecospace > Input > Maps 	Click Edit basemap, and set the rows and cols to the same as in the .asc file
 	Double click the Depth layer
 	The values will likely all be 1, click the top-left corner and set all to 0 (=land), this is because the Ecospace import will not always overwrite water with land
 	Click Import > From ASCII grid > import your asc file > OK
 
 
 	Water area is used in calculations of results across the map, so not for displaying densities on maps, but for extraction of, e.g., catches or biomasses for functional groups
 	That should be it.
 
 Attribution (data)
 GEBCO Compilation Group (2023) GEBCO 2023 Grid  https://www.gebco.net/
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		Spatial fishery dynamics

								

	
				Fishing fleets are specified in the Ecopath model, along with landings, discards, discard mortality rates, discard fate and market values of each landed species and non-market price. When moving to Ecospace, it is important to enter the percentage of costs that are “sailing related” (e.g., fuel, crew) in Ecopath and then specify how the relative cost of fishing is expressed across the modeled area. With this information, Ecospace will distribute fishing effort spatially through a gravity model[1] [2], where the effort allocated to each spatial cell is based on the profitability of fishing estimated as the difference between expected income and costs of fishing in each cell[3], thus proportional to the net benefits (profits-costs) gained from fishing in a given cell. When no cost or revenue information is entered, the fleets will gravitate to cells with the highest biomass of their target species. The cost of fishing can also be used to keep fleets from operating in certain areas, e.g., on the windward side of Caribbean islands or to keep fleets out of neighboring countries’ EEZ.
 Ideally, expected income should be estimated with local economic and market data, otherwise it can be estimated using prices per functional groups from global price databases available based on average prices[4], or even better, regional or local data if applications are regional.
 There is an option on the Ecospace map to calculate the cost of fishing based on the assumption that it is proportional to the distance (km) from the nearest coast or port. This is done based on Euclidean distances from the nearest port for each fleet. The calculation is very rudimentary and does not calculate pathway lengths around land masses thus, more suitable data can be used when available.
 Each fleet can be allowed to operate – or restricted from fishing – in one or more habitat types, and MPAs can be placed that exclude one or more fishing fleets during specified months. For a detailed description of fishing dynamics in Ecospace,[5][6]. In addition, there is a new feature of the Ecospace model called the “MPA dynamic routine”. This routine allows one to study the spatial-temporal creations of MPAs, which can be allocated to fleet(s) at any moment in time during a simulation, and can be operative monthly or annually. This feature allows full control of MPA location or deletion in time and space[7]. It can be a good idea to use environmental preference functions to distribute ecosystem groups spatially and habitats to distribute fishing effort.
 Ideally, the emergent fishing effort distributions predicted by Ecospace should be compared to observed spatial effort patterns, such as those from logbook and vessel monitoring systems (VMS and/or AIS) data[8], and parameters would be adjusted to improve agreement. However, this has rarely been done in practice[9], due to a lack of spatial effort data in most modeled systems and difficulties in modeling fisher behavior and complex spatial management. Alternatively, one may attempt to force fishing effort using the spatial-temporal framework by either directly importing fleet-specific sailing cost maps that make it prohibitively expensive to fish in certain cells, or by designating an MPA or habitat for each fleet and loading time-varying maps of closed cells or habitat types. Additionally, habitat layers and MPAs can be used to impose administrative boundaries that prohibit fleets from operating in certain jurisdictions. While Ecospace contains great flexibility in representing spatial fishery dynamics, thus far little attention has been devoted to spatial effort dynamics[10][11] compared to the biomass and ecological responses generated by Ecospace. This represents a component of the Ecospace that would benefit from simulation research, demonstration, and application.
 Attribution
 The chapter is based on de Mutsert et al.[12], adapted with permission.
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		Predicting spatial effort

								

	
				EwE works with multiple fishing fleets, with fishing mortality rates (F) initially distributed between fleets based on the distribution in the underlying Ecopath base model. In Ecospace the F’s are distributed using a simple logit-choice or “gravity model” where the proportion of the total effort allocated to each cell is assumed proportional to the sum over groups of the product of the biomass, the catchability, and the profitability of fishing the target groups, divided by relative cost of fishing the cell [1] [2]. This profitability of fishing includes factors such as the cell-specific cost of fishing.
 Assuming that there are N cells representing water areas, each fleet k can cause a total fishing mortality rate N · Fk. For each step in the simulation this rate is distributed among cells, c, in proportion to the relative utility weights Gkc calculated as
 [image: G_{kc}=O_{kc} U_{kc} \frac{\sum\limits_{i} p_{ki} q_{ki} B_{ic}} {C_{kc}} \tag{1}]
 where Okc is 1 if cell c is open to fishing by fleet k, and 0 if not; Ukc is 1 if the user has allowed fleet k to work in the habitat type to which cell c belongs, and 0 if not; pki is the relative price fleet k receives for group i fish, qki is the catchability of group i by fleet k (equal to the Fki in the Ecopath model); Bic  is the biomass of group i in cell c; and Ckc is the cost for fleet k to operate in cell c. Based on the weights in Eq. 1 the total mortality rate is distributed over cells according to
 [image: F_{kc}=N \ F_k \ G_{kc}^p / \sum\limits_{c} G_{kc}^p\tag{2}]
 while each group in the cell is subject to the total fishing mortality
 [image: F_{ic}= \sum\limits_{k}F_{kc} \ q_{ki}\tag{3}]
 The p parameter here represents variation among fishers in perception of the best place to fish, and is set to 1.0 by default.  Setting p to higher values results in effort being more concentrated in the most profitable cells, and lower values cause effort to be more spread out (due to either wide variation among fishers in their actual best locations to fish, or lack of information that causes them to just try fishing everywhere).  Readers familiar with logit choice theory may recognize the G weights as exp(utility) values, with utility assumed to be proportional to the logarithmic difference ln(income)-ln(cost) in income and cost components of decision choices.
 Attribution This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R Forrest. 2008. Ecopath with Ecosim User Guide. 
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		Tutorial: AIS in Anchovy Bay

								

	
				A new management regulation for Anchovy Bay now requires that all trawler fishing boat transmit their position via Automatic Identification System (AIS) while at sea. The AIS signals are automatically picked up by the fisheries management authority, and maps with relative number of hours that trawlers are in the bay are now recorded and used for management purposes. We have permission to access to some of these files, and this tutorial will explain how to use such data.
 First, this calls for some changes to our spatial ecosystem model for Anchovy Bay (Anchovy Bay spatial.ewemdb, you can download it from this link) as the effort data is available for two trawler fleet, one operating in the western part of the bay and a second in the eastern part of the bay. Open your model, and do the following,
 	Maybe do a Save as, and save it as a new model, e.g., Anchovy Bay AIS
 	Add a new fleet as fleet #6: Trawlers East. (Ecopath > Input > Fishery > Fleets > Define fleets)
 	Rename your existing fleet #2 to Trawlers West while you are at the Define fleets form.
 	On Ecopath > Input > Fishery > Fleets set Effort related cost to 0 for fleet #2 and #6, and Sailing related cost to 80 for fleet #2 and #6. Now that we have AIS data to distribute the effort for the trawlers, we want to follow it as much as possible, and this will help with that.
 	On Ecopath > Input > Fishery > Landings, distribute the landings for fleet #2 to be shared equally between fleet #2 and fleet #6, so half of the #2 landings go to the new fleet.
 	Open your BayOfAnchovies Ecospace scenario, and go to Ecospace > Input > Ecospace fishery > Habitat fishery, and make fleet #2 and #6 fish in Fish everywhere (all habitats).
 
 Now we need to process the AIS files. They are saved in ASCII format (.asc), and you can download them from this link. ASCII is a spatial raster format, and if you rename the files to .csv they can be read by Excel. It is, however, much easier to do the operations we need in R. The files represent relative number of hours boat are in spatial cell by year for each fleet. We want to express the data as relative fishing cost, so we need to invert the values.
 R code for reading AIS ASCII files with relative hours in cells and converting them to relative fishing cost
  library(terra) # for spatial operations
 #============= Set up directory links and folders =============================
 work.dir = dirname(rstudioapi::getActiveDocumentContext()$path)
 setwd(work.dir)
 # Read .asc files
 west = rast(“ab fleet west.asc”)
 east = rast(“ab fleet East.asc”)
 # these AIS files have values of relative # of hours that boats were in grid cells
 # invert to get relative fishing cost
 west.c = 1/west
 east.c = 1/east
 writeRaster(west.c,”ab fleet west cost.asc”,overwrite=T)
 writeRaster(east.c,”ab fleet east cost.asc”,overwrite=T)
 plot(west.c)
 plot(east.c)
 
 
 If you prefer, you can do the file manipulations in Excel, but it’s a more tedious process. First step is to change the file ending to .csv. Open it, likely with space a delimiter. Do the inversion of the cells, save it, and then manually change the file ending back to .asc
 If you run the R code, you should have two new files in the folder where you saved the R code: ab fleet west cost.asc and ab fleet east cost.asc. These are the ASCII files you can read in a spatial coast files. For this do the following,
 	Go to Ecospace > Input > Maps click Sailing cost in the right-hand panel. In the lower right panel, change Fleet to 2. Trawlers West
 	Double click where it says Sailing cost at the top right, and a spreadsheet will pop up. Select Import > From ASCII grid and browse to load ab fleet west cost.asc
 	 Repeat this for fleet #6.
 
 You now have the setup for using the AIS, so all that’s needed is to run your model, check what’s happening to effort for especially the two trawler fleets. Making sense?
 But does the predicted effort patterns indeed make sense? Do the two trawler fleets actually fish where the target species (cod and whiting) are? If not, why? You are using actual AIS data, so it does represent where the trawlers have been. Even if it is where they’ve spent time sailing but not necessarily fishing. For instance, the trawlers were allowed to fish where there’s hard bottom/reefs, but they may not actually be fishing there. But, the most likely reason for a discrepancy is?
 It’s probably that the model predictions for where the cod and whiting are distributed is flawed, we should check that. When we find discrepancies, that’s when we learn something. There’s nothing better for modelling than finding problems with a model, that’s when you learn something that can be used to improve the model. The more information we get to add to the model, the more constraints are added, and that makes the models better.
 Models are like gourmand master chefs, the better ingredients you give them, the better courses they’ll make.
 Here’s a link to a version of the Anchovy Bay model with the two trawler fleets and the AIS cost layers.
 
	

			
			


		
	
		
			
	
		

		Tutorial: Ecospace maps

								

	
				So, you have an Ecospace model, it looks good, well, on the screen it does, but how do you make publication ready plots? That’s what this tutorial intends to give you some hints about.
 In the process we’ll be using some GIS maps for the study area, but unfortunately we only have low-resolution maps of Anchovy Bay (and no GIS map for overlay), so we’ll use a colder study area, the Barents Sea. There, snow crabs have been expanding, and we’ll produce some maps to visualize how their distribution has changed.
 We have a spatial model for the area, developed as part of the EISA project, coordinated by NIVA. Open your Ecospace scenario, the go Menu > Tools > Options > File management, and check the Ecospace > Run results > Biomass maps (ASCII format) option. Make a run, and Ecospace will save ASCIII raster maps to the directory that is specified on the File management form. That’s a lot of files being saved, by the way, so we need some reasonably smart way of handling them.
 Let’s attack this using R. Get R up and running, make a folder for your mapping code, create an empty R file and save it. Copy the ASCII files you want to work with to a subfolder, in this example named asc.
 # Then load libraries (install as needed):
 library(terra)        # for spatial operations
 library(viridisLite)  # colour blind friendly scheme for plotting
 library(viridis)      # colour blind friendly scheme for plotting
 # Next set your working directory:
 #============= Set up working directory =============================
 work.dir = dirname(rstudioapi::getActiveDocumentContext()$path)
 setwd(work.dir)
 # We need some colours to work with, here they are in a block:
 # =======We need some colours to work with ========================
 colrD=viridis(n=128,begin=0, end=1, direction=-1, option=”C”) 
 for(ix in 1:3) {colrD[ix] = “#FFFFFF”} 
 # =======end of colours ===========================================
 # Let’s tell R where to find the ASCII maps:
 files.start = list.files(path=”asc”
                          ,full.names=T,pattern=glob2rx(“EcospaceMapBiomass-some-crab*.asc”) )
 # And let’s count how may files there are in the folder:
 how.many = length(files.start)
 # We’ll need a background to mark the area outside of our study area
 backgr = rast(files.start[1])
 values(backgr) = 0  #cells outside study value needs to get a value (will be NA otherwise)
 # Find the max biomass on any map for scaling maps:
 maxv=0
 for(i in (1:how.many)){
   bef = rast(files.start[i])
   max.bef = max(setMinMax(bef))
   maxv = max(max.bef,maxv)
 }
 # Get a map of land to put on top of Ecospace map, this makes it much easier to see where your area is (compare Figure 1 B and 1C, below):
 land = rast(“land_10k.asc”)
 # Let R know your file name and type
 pdf(file=”Four strong maps.pdf”,width=6,height=8,bg=”transparent”)
 # We here want four plots for demo:
 par(mfrow=c(2,2))
 # Set margins to make plots fill the space better
 par(mar=c(0,0,0,0))
 par(oma=c(0,0,0,0))
 par(xaxt=”n”, yaxt = “n”, bty=”n”)
 # There are so many files, we only want to select some:
 for(i in seq(11,how.many,by=6)){
   plt = rast(files.start[i])
   # first plot a grey background (Figure 1 A)
   image(backgr,xlab=””,ylab=””,useRaster=T,cex.main=2,zlim=c(0,1),col=”grey70″)
   # use the same scale for all plots (Figure 1 B)
   image(plt/maxv,xlab=””,ylab=””,add=TRUE,useRaster=T,cex.main=2,zlim=c(0,1),col=colrD)
   # add land on top of plot (Figure 1 C)
   image(land,xlab=””,ylab=””,add=TRUE,useRaster=T,cex.main=2,zlim=c(0.5,1),col=”grey30″
   # check the plot to find the X-Y coordinates for where to place a legend on top (Figure 1 D)
   year=as.character(1984+i)
   text(700000,-2300000,year,col=”white”,cex=2.5)
 }
 # turn off the device to save the pdf
 dev.off()
 [image: ]
 Figure 1. Maps of species distribution showing four stages of the plotting as described in text above.
 That’s it, you now have some sample code with which you can read Ecospace maps and plot it.
 You can download the R-code and sample files for this tutorial at this link.
 
  
 What about Anchovy Bay?
 [image: ]
 Figure 2. Map of mackerel biomass in Anchovy Bay at the first and last year of the model run, along with the difference (last-first) in the third plot.
 Anchovy Bay should not be left out, so we’ve stored the R-code for the plots at the link in the textbook below. You should be able to download the code, place it in a folder, then open the R-code, run the model, and it should produce the plot. The plots will be in the pdf sub folder.
 To use the code for your own plot, you will need to
 	Run your model in Ecospace set to save: Click the floppy disk icon, then check Ecospace > Run results > Biomass maps (and any other maps you may want to plot)
 	Line 20, set filedir = the folder where you have stored your Ecospace ascii files (.asc)
 	Line 23, check the ascii files and get the first map about one year into the run (probably named 013). Set mth1 = “013” (or whatever yours is called, enter as string, i.e. with “” around the number)
 	Line 25, set mth2 = the last month in your data files (e.g., “481”)
 	Line 27, enter title for the first set of plots
 	Line 29 Enter title for second set of plots
 
 That’s all, the code should produce a pdf for each group in your model.
  
 You can download the R-code (and data files) for producing the Anchovy Bay maps in Figure 2 from this link.
 
  
 Attribution
  The underlying spatial model used for the first part of tutorial was developed by the EISA project, coordinated by NIVA.
 
 
  
 Media Attributions
	Original 
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		Migration and advection

								

	
				Ecospace dynamically allocates biomass across a grid map while accounting for mixing rates between adjacent grid cells.  In the simplest cases, the basic assumptions about these rates are,
 	they are symmetrical from a cell to its four adjacent cells if all four cells have equal habitat capacity,
 	which is modified whether a cell is defined as “preferred habitat” or not (running means over adjacent sets of five cells allows for smooth transitions between habitat types), and
 	user-defined increased predation risk and reduced feeding rate in non-preferred habitat.
 
 Additionally, Ecospace can simulate advection of biomass for organisms that drift passively with surface currents, and also seasonal migrations of organisms that move over large distances within each year.  For multi-stanza groups, an additional option (see Ecospace IBM chapter) allows division of each monthly cohort into a large number of packets, with movement of these packets simulated as a stochastic process so as to potentially generate realistic patterns of movement (and possibly migration) of organisms of different ages.
 Representing seasonal migration in Ecospace
 Larger organisms commonly have seasonal migration patterns that allow them to utilize favourable seasonal resource and environmental conditions over large spatial areas. Such movements can be represented in Ecospace in two ways. First is using a simple “Eulerian” approach, which involves explicitly modelling changes in instantaneous rates of biomass mixing among the Ecospace spatial cells, in some way that approximates at least the changing center of distribution of the migratory species.  The second way is the “Lagrangian” approach, which is for multi-stanza groups only. It simulates stochastic movements of a large number of “individuals”, i.e packets of biomass that move together over the spatial map.
 The Eulerian approach is implemented in Ecospace by allowing users to define a monthly sequence of “preferred” position map cells (or clusters of cells) by first declaring which groups that are migratory on the Ecospace > Input > Dispersal form, then on the Ecospace > Input > Maps form sketch (or import) for each month the preferred cells for each migration group.
 The Migration dialogue box displays a map of the Ecospace region, with migratory species, month by month over a calendar year. Preferred position for each month (and the annual trajectory of preferred positions) is set by setting a value on the interface and sketching the area of distribution
 [image: ]
 Figure 1. Migration input at Ecospace > Input > Maps.
 Double-clicking on the selected functional group name (“Whales” in Figure 1), will bring up a spreadsheet with the migration values. These can be imported and exported, and thus derived externally for more reproducible behaviour.
 The mathematical method used in Ecospace to create migratory behaviour is quite simple. Spatial movement is represented in general in Ecospace as a set of instantaneous exchange rates across the boundaries of adjacent spatial cells. For migratory species, these exchange rates are simply multiplied by relative factors at each simulation time step, where the factors depend on distance from the preferred cell for that time step as shown in Figure 2. The function is reversed for movement across a northern cell boundary. A similar function is used for east-west movements with map column-preferred column as the independent variable.
 The factor has no effect (multiplies movement rates by 1.0, so movement rates are similar in all directions) for cells near the preferred cell (or cluster of cells), and “shuts down” movement away from the preferred cell for cells far from that preferred cell. Note that the base movement rates that are multiplied by the migration factors may not be the same in all directions to start with; these base rates can include advection effects and/or increased/oriented movement rates towards preferred habitats. That is, migration effects can be combined with advection and orientation of movement toward preferred habitats; it was the intention to represent such combined effects that motivated the multiplicative factor formulation in the first place.
 [image: image]
  
 Figure 2. Relative movement rates; see text for details.
 Tips for setting up migration in Ecospace
 Unfortunately, there is no way to make the Ecospace migration simulations very simple to set up, particularly when using the IBM option to simulate movement more realistically for multi-stanza groups. Generally one must do considerable numerical experimentation to find reasonable migration parameter values and a stable numerical solution scheme. These cannot be computed in advance since they depend on a variety of details about the spatial map grid and species movement characteristics. Here are a few key points to keep in mind while experimenting (by repeated simulations) with the migration interface:
 	The concentration parameters are relative values that the user needs to set by trying alternatives (generally in the range 0.5 to 4.0) to see what values give general distribution patterns similar to those observed in the field. Low values (<1.0) lead to weak distortion of movement toward preferred cells and hence to more widely spread distributions, while high values (e.g. 3.0) give distributions strongly concentrated near the preferred cells.
 	Mean annual movement distances (Ecospace > Input > Dispersal form) have to be set large enough for migrating species to be able to “track” movements in preferred locations. As a general rule, set the base dispersal rate for migratory species to at least 100L km/year, where L is mean body length in cm.  This is particularly critical for multi-stanza groups where different stanzas commonly reside in non-overlapping areas, and may need to move considerable distances during each “ontogenetic habitat shift” (without suffering too high relative predation risk or poor feeding rate conditions).
 	Setting high concentration parameter values (>2.0) and/or moving animals through a very complex map with many coastal blocking features can result in numerical instability in the Ecospace solution algorithm. The best way to correct this is to reduce the movement distances somewhat; it may also be necessary to reduce the Successive over-relaxation (SOR) weight (Ecospace > Input > Ecospace parameters form) used in solving the linear equations involved in the numerical scheme for integrating the spatial rate equations (implicit method, BDF2 backward differentiation that is most often stable but can be problematic when there are very strong spatial gradients).
 	Setting high concentration parameter values can also result in “overfishing”. Ecospace allocates total fishing effort over the map proportional to the total number of cells initially used by each fishing fleet,  so when the model generates a concentrated distribution of some favoured species, the total effort will concentrate accordingly and can sometimes generate very high fishing rates near the center of the migrating stock distribution. Remedies include reducing total effort by reducing the total efficiency multiplier (Ecospace > Input > Ecospace fishery > Fleet dynamics > Tot. eff. multiple. ) and distributing effort more widely (reduce value of “effective power” on the same form).
 
 	Concentrating a migratory predator can cause local depletion of food organisms and/or reduced per- predator feeding rates due to prey vulnerability limits. If these effects cause simulated total predator biomass to incorrectly decline over time (and if the user determines that the declines are not due to an artifactual overfishing effect), then it may be necessary to either increase total prey abundances (in Ecopath) or vulnerability of prey to the predator (Ecosim > Input > Vulnerability multipliers form).
 	Multi-stanza population dynamics may behave strangely or incorrectly when one or more life history stages are migratory while other(s) are not. Ecospace does not keep track of the full population age/size distribution for each spatial cell (prohibitive memory and computing time requirement), and instead updates only the total abundances by stanza then distributes those using either the non-stanza prediction of biomass distribution or the IBM packet simulation approach. Either approximation tends to “dampen” abundance fluctuations in the early life history stanzas that might be created by, for example, seasonal movement of the adults to spawning locations near preferred juvenile habitats.
 
 We were cautious above when describing the Ecospace potential to track migrating stanza populations, but a recent PhD dissertation by Fanny Couture (soon available at the UBC Open Collection of Theses and Dissertations), shows that it can be possible to successfully track migrating stanza of numerous different seasonal runs of Pacific salmon. The outcome of this was indeed beyond our cautious expectations.
 
 Advection in Ecospace
 Advection processes are critical for productivity in most ocean areas. Currents deliver planktonic production to reef areas at much higher rates than would be predicted from simple turbulent mixing processes. Upwelling associated with movement of water away from coastlines delivers nutrients to surface waters, but the movement of nutrient rich water away from upwelling locations means that production and biomass may be highest well away from the actual upwelling locations. Convergence (down-welling) zones represent places where planktonic production from surrounding areas is concentrated, creating special opportunities for production of higher trophic levels.
 Once an advection pattern has been defined, the user can specify which biomass pools are subject to the advection velocities (vu,vv field) in addition to movement caused by swimming and/or turbulent mixing. This allows examination of whether some apparent “migration” and concentration patterns of actively swimming organisms, (e.g., tuna aggregations at convergence zones) might in fact be due mainly to random swimming combined with advective drift.
 Older versions of Ecospace had an interface that allowed users to “sketch” simple advection patterns which were then corrected to insure mass balance (or allowed to exhibit areas of upwelling and downwelling into depths not modeled by Ecospace).  That method never worked well, and we advise users to work with advection fields calculated with credible and well-tested hydrodynamic models.
 Output from hydrodynamic models can be used as time-varying spatial input for Ecospace via the Temporal Spatial Framework of EwE, see the EwE User Guide for details.
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		Spatial planning: MSP Challenge

					Jeroen Steenbeek

			

	
				Marine or Maritime Spatial Planning (MSP) has developed as a tool to evaluate how the many and often conflicting uses of the marine environment may best be designed. However, management of marine space, at various scales, across a wide range of socioeconomic sectors and national and transnational boundaries, under the influence of natural processes and climate change, with their associated uncertainty, is a daunting task for which managers and planners are often ill-prepared[1].
 As a reaction to this challenge, the Marine Spatial Planning (MSP) Challenge simulation platform was developed to integrate best available geographic, maritime, and marine data provided by many proprietary institutions with science-based simulation models for shipping, energy, and ecology. The data and models are linked together in a Unity game-engine based interactive platform[2]. This simulation platform allows anyone, experts as well as nonexperts, to operate it for planning support such as stakeholder engagement, codesign, interactive scenario development, professional learning, and student education.
 The MSP Challenge simulation platform has been used for many interactive sessions with planners, stakeholders, and students in various parts of the world. In an interactive session or “game”, participants take up the role of planner (or stakeholder) in one of the countries in a sea basin. As planners, users have an overview of the entire sea region and can review many different data layers to make an assessment of the current status. They design management plans for future uses of space in their exclusive economic zone over a period of several decades, and need to negotiate with neighbouring planners to have their plans approved. They can also consult other countries or develop and implement transboundary plans regarding a wide range of planning activities, including shipping routes, wind farms and power grids, and marine protected areas (MPAs). In a typical MSP session, planning phases alternate with simulation phases where the consequences of planning decisions for energy, shipping, and the marine environment are simulated and visualized as indicators and heat maps at the sea basin level. Digital game technology makes it fun and easy to draw and modify plans, run the simulations, and interact with others. Elements of gameplay such as challenges and objectives, a story line, role-play, and performance feedback can be used to facilitate interactions among the participants in a session.
 The MSP Challenge simulation platform and the EwE approach have now been integrated to translate the gradual implementation of spatial plans into changes in environmental conditions and fisheries regulations (henceforth called pressures). These pressures were incorporated into the calculations of Ecospace to affect the state of the marine ecosystem components over time and space. Aggregated, spatially explicit Ecospace predictions (henceforth called outcomes) were sent back to the MSP Challenge to disseminate the state of the ecosystem components to session participants.
 Both the MSP Challenge and the EwE approach are data-driven software systems. Within the bounds of a fixed set of equations and behaviours embedded within the software, these systems are parameterized to represent any ecosystem with its specific challenges and dynamics. We have connected the MSP Challenge and EwE software systems through a few new software components as shown in Figure 1.
 [image: ]
 Figure 1. An overview of software components needed to connect the Ecopath with Ecosim (EwE) computational core to the marine spatial planning (MSP) challenge. EwE shell is the central software library that encapsulates the EwE modeling logic to receive MSP player-derived pressure layers and to deliver outcome layers back to the MSP software system. MSP Tools is a plug-in to the EwE desktop software that allows EwE modellers to design the connectivity between a specific MSP scenario and an EwE model, and to test the behaviour of this EwE model as if connected to the actual MSP game. MEL, the MSP-EwE Linker, is a software library that integrates EwE shell into the MSP game engine by converting MSP player actions to pressure maps for consumption by the EwE shell, and by delivering ecological outcomes to the MSP Challenge game.
 Pressures: impacting the ecological model
 Several distinct pressure categories were defined,
 	Noise is the spatial distribution and intensity of low frequency noise resulting from shipping, construction, etc. The noise map layer acts as an environmental driver layer in the Ecospace habitat capacity model and affects per-cell foraging suitability for functional groups sensitive to low-frequency noise.
 	Surface disturbance and bottom disturbance are the spatial distribution and intensity of physical disturbance at the surface and the bottom, respectively. This pressure includes the presence of temporary and transient structures and vehicles, turbidity due to anthropogenic activity, some forms of pollution, etc. The disturbance map layers act as environmental driver layers in Ecospace and affect per-cell foraging suitability for functional groups sensitive to these disturbances.
 	Artificial substrate is the spatial distribution and intensity of artificial structures that provide shelter and/or habitat to sensitive functional groups. This layer acts as an additional habitat in Ecospace to increase habitat-derived cell suitability in Ecospace.
 	Protection is the spatial distribution of locations where fishing is impossible due to the presence of other activities or prohibited through fisheries restrictions. This per-fleet map layer acts as a MPA layer in Ecospace, blocking fishing effort for all sensitive fishing gears in cells where MSP activities that generate this pressure are present.
 	Fishing intensity is a scalar pressure to increase or decrease the nominal amount of fishing across the game area.
 
 [image: ]Figure 2. Schematic overview showing how spatial plans (actions), in vector format, are converted to pressure grids, in raster format. This example shows how oil platforms, ferry and shipping lines, wind park construction, and dredging contribute to the noise pressure grid via conversion factors unique to each type of action.
 During simulation phases, the MSP Challenge software converts spatial plans created by players into pressure maps using an action-pressure conversion matrix, as follows (Figure 2).
 	Spatial plans, which are entered as points (e.g., anchorages, oil and gas platforms) and lines (e.g., shipping routes, cables, pipelines, etc.), are spatially expanded to their area of impact using impact factors, expressed in the action-pressure conversion matrix as a ratio of Ecospace cell size. The zone width may be multiplied by the intensity of the spatial plan where applicable (e.g., shipping intensity). The zone-to-cell surface overlap is then calculated as a measure of spatially explicit pressure intensity on a value range from zero (no pressure) to one (maximum pressure).
 	The cell area overlap of spatial plans, which are entered as polygons (e.g., dredging sites, marine protected areas, harbours, wind farms, etc.), is directly calculated and multiplied by the impact amount stated in the action pressure matrix and intensity of the spatial plan, where applicable.
 	Total pressures from point, line, and polygon features are added per cell and range from zero (no pressure) to one (maximum pressure). Ecospace directly integrates the pressure grids into designated maps of environmental drivers, habitats, and protection, and directly incorporates the per-fleet fishing effort multiplier, to affect ecosystem dynamics.
 
 Ecospace directly integrates the pressure grids into designated maps of environmental drivers, habitats, and protection, and directly incorporates the per-fleet fishing effort multiplier, to affect ecosystem dynamics.
 Outcomes
 Outcomes are spatially explicit aggregations of Ecospace predictions. The complex results of food web dynamics are condensed to provide MSP session participants with key ecological results and indicators. Outcomes can consist of four types of Ecospace predictions: group biomass, group catch, fleet effort, and biodiversity indicators.
 The data in the outcome maps are reflected in the MSP software on a fixed colour gradient that represents one order of magnitude deviation from Ecopath baseline values. This relatively simple display system facilitates game participants to perceive drastic (local) changes in ecosystem functioning on a uniform scale across all outcomes.
 Attribution The chapter is an extract from Steenbeek et al. 2020[3] adapted under a Creative Commons Attribution-NonCommercial 4.0 International License. Rather than citing this chapter, please cite the source.
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		Tutorial: MPAs in Anchovy Bay

								

	
				The cod population in Anchovy Bay has been depleted, and there is concern for its recovery. Here, we will do a retrospective analysis to evaluate the potential impact of using protected areas as a management tool.
 We will use a version of the Anchovy Bay model that has been modified slightly and fitted to time series. Download the Anchovy Bay Spatial.ewemdb database. Open the EwE software and load the model. If there’s a time series in the model, then load it. Next, load the Ecospace scenario included in the model, named BayOfAnchovies, and run Ecospace. Extract results (for all groups and fleets) from the Ecospace Results form.
 Now it’s time to add MPAs and examine how they function,
 	On the Ecospace Maps form, right hand side, click the pencil to the right of MPAs, and on the pop-up Define MPAs form, click Add, and OK. The form will close, and you now have one type of MPA, by default called MPA1 (but you can change it), in your model.
 	Open the MPAs form again. If you select the MPA1 layer (click on it), you can now edit the layer, the tools at the bottom of the right-hand side provides drawing tools for the editing. Sketch a nice big MPA covering part of the area where cod occur.
 
 	Reset all fishing effort, Ecosim > Input > Fishing effort, Reset All. Then set the effort for trawlers to 2.
 	Go back to Maps, and make a nice big MPA covering part of the area where cod occur.
 	On Ecospace > Input > Ecospace fishery > MPA enforcement, you can allow or disallow fleets from operating in the MPA. By default no fleets will be allowed inside, but change this so that only trawlers are not allowed inside (i.e. remove the check mark for the other fleets).
 	Run Ecospace and check the impact for cod. Do you see any?
 	Try changing the base dispersal rate for all groups from the default 300 km/year to 10 km/year, (Ecospace > Input > Dispersal)
 	Run Ecospace again and see if you can see any impact of the MPA for cod and other species (both within the MPA and overall)
 	Extract the results and compare to the original run. Which groups change?
 	Did catch value change?
 
 
 So, dispersal rates are important for spatial modelling, and especially for the performance of MPAs.  That’s a fact, both in modelling and for actual efficiency of MPAs. Ideally, MPAs will allow populations to build up, and the spill-over effects to neighbouring areas be large enough to sustain the people who rely on the fisheries for their livelihood.
 See introduction to dispersal rates along with a dispersal estimation IBM model in the EwE User Guide
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		Spatial optimization

								

	
				This chapter provides a brief introduction to the Spatial optimizations tool in Ecospace, (Ecospace > Tools > Spatial optimizations). For instructions on how the routine is implemented in EwE, see Spatial optimizations in the EwE User Guide. There is also a tutorial in the next chapter (web- and pdf-versions).
 We describe two approaches for spatial optimization of protected area placement, both based on maximizing an objective function that incorporates ecological, social, and economic criteria. Of these, a seed cell selection procedure[1] works by evaluating potential cells for protection one by one, picking the one that maximizes the objective function, add seed cells, and continue to full protection. The other is a Monte Carlo approach, which uses a likelihood sampling procedure based on weighted importance layers of conservation interest (similar to Marxan’s) to evaluate alternative protected area sizing and placement. The two approaches are alternative options in a common spatial optimization module, which uses the time- and spatial dynamic Ecospace model for the evaluations. The optimizations are implemented as components of the Ecopath with Ecosim approach and software. In a case study, we find that there can be protected area zoning that will increase economic and social factors, without causing ecological deterioration. We also find a tradeoff between including cells of special conservation interest and the economic and social interest, and while this does not need to be a general feature, it points to the use of modeling techniques to evaluate the tradeoffs.
 The most widely used approach for spatial planning with a conservation perspective is the Marxan approach and software, (http://www.uq.edu.au/marxan/) developed primarily by Hugh Possingham and colleagues at the University of Queensland. Marxan is a very flexible approach capable of incorporating large data sources and use categories, it is computationally efficient, and lends itself well to enabling stakeholder involvement in the site selection process.
 We view the new importance layer sampling procedure as complimentary to the Marxan approach in that its strong side, through the underlying trophic modeling background is in evaluating ecological processes, including spatial connectivity and predicting future states – topics that were not well covered in the original Marxan analysis. In doing so, we, however, involve a rather complicated dynamic model, even if user-friendly, and this unavoidably has a cost. We therefore advocate that the two approaches, with their given advantages and limitations, be applied in conjunction – using two sources to throw light at a problem from different angles, beats one, any time. We have in order to facilitate such comparative studies developed a two-way bridge between Marxan and EwE, enabling exchange of spatial information and of optimization results between the two approaches.
 Objective function
 Table 1. Objective function employed for spatial optimization. Each objective is given a weighting factor, and the optimization seeks to optimize the summed, weighted objectives.
 	Objective 	Description 
  	Profit 	Estimated by fleet, and summed over all such 
 	Jobs 	Estimated from value of fisheries, and relative number of jobs/value 
 	Mandated rebuilding 	A minimum acceptable level, by group 
 	Ecosystem structure 	Default values are based on biomass/productivity ratios expressing average longevity, weighted by group 
 	Biomass diversity 	Biomass evenness among groups 
 	Boundary weight 	Estimated as total boundary length over the protected area size. Relates to spatial connectivity 
  
 We employ an objective function for the optimizations that corresponds to the objective function used in the policy optimization module of EwE. This module uses a non-linear search routine to find a combination of effort by fishing fleets that will maximize the objective function.
 The objective function in turn includes ecological, economic and social indicators, even legal constraints if pertinent, through considering profit, number of jobs, stock rebuilding, and two ecological measures. For the spatial optimizations we add a further indicator in form of a boundary weight factor (see Table 1).
 The profit objective is calculated by summing revenue across all fleets, and subtracting the cost for operating. Cost is considered a linear function of effort with a fixed cost added. The following calculation,
 [image: R_t=\sum \limits_{f} \sum \limits_{i} (F_{fi}\cdot B_i \cdot V_{fi}) - \sum \limits_f (E_f \cdot C_{v,f}-C_{p,f}) \tag{1}]
 is performed for each time t step to estimate the revenue Rt, with Ffi  being the fishing mortality for group i caused by fleet f, Bi is the biomass of i, and Vfi is the ex-vessel value per unit weight of i caught by f. Ef is the relative effort for f, the Cv,f is variable cost per unit effort for f, and Cp,f is the fixed cost for fleet f.
 The calculations in Eq. 1 are, as indicated, performed for each time step, with benefit summed over time. We, however, discount future values based on either a traditional discount rate, or an inter- generational discount rate[2], based on user preference.
 As a social indicator, we use the number of jobs over time Jt created in the ecosystem, and we estimate this for each time step t from the landed value of the exploited group times the relative number of jobs per unit value Ni, or Jt = ∑f  Ffi Bi Vfi Ni. Similar to the profit objective, we discount the number of jobs over time.
 We estimate the mandated rebuilding objective Mt for each time step t from
 [image: M_t=\sum\limits_i B_i / B_{I*} \tag{2}]
 where Bi* is the baseline Ecopath biomass for group i, and equals the group biomass Bi if Bi is lower than the mandated biomass, Bm,i for the group, and Bm,i if it is not. The mandated rebuilding objective can be used to set “Minimum Biological Acceptable Levels” (or MBAL as commonly used) by giving this objective a high weighting. As long as the biomass is above MBAL the objective won’t matter, but should it get below MBAL, it will! By setting high mandated biomasses Bm,i for a group it can also be used to capture “existence values,” e.g., of marine mammals of interest for a whale watching industry. We do not discount the mandated rebuilding structure over time.
 The ecosystem structure objective is meant to capture that mature (K-type) ecosystems tend to be dominated by long-lived species and individuals[3]. We seek to capture this characteristic through the inverse production/biomass ratio, estimating for each time step
 [image: S_t=\sum\limits_i B_i \cdot S_i \tag{3}]
 where St is the overall ecosystem structure measure, and Si the ecosystem structure factor for i. We provide default values for Si in form of the inverse P/Bi ratios (unit, year), supplied as part of the basic parameterization of the Ecopath model. To avoid unduly influence by very short-lived species we have (arbitrarily) set Si to 0 for groups with an average lifespan of less than a year, (i.e. groups whose P/Bi is less than 1 year-1).
 The ecosystem structure objective is not discounted over time; having long-lived species in the future being deemed as important as having them now.
 As a measure of biomass diversity, we use either the Shannon index or a modified version of Kempton’s Q75 index, both of which originally were developed to describe species diversity[4]. We here used a biomass diversity indicator following Ainsworth and Pitcher[5] (2006), albeit slightly modified. We estimate the biomass diversity index Q75 from
 [image: Q_{75} = S / (2 \log (N_{0.25-S} / N_{0.75-S})) \tag{4}]
 here S is the number of functional groups, and Ni-S is the biomass of the iSth most common group, using a weighted average of the two closest group if iS is not an integer. The biomass diversity index describes the slope of a cumulative group abundance curve. As a sample with high diversity (evenness) will have a low slope, we reverse the index and express it relative to index value from the Ecopath base run Q*75, that is
 [image: Q_{75}^{'} = (2-Q_{75})/Q_{75}^* \tag{5}].
 We truncate the index in the extreme and unlikely case that Q75 would more than double from the base run. We only include higher trophic level groups (TL>3) in the calculation of the biomass diversity index – should this, for models with only few functional groups, lead to less than 10 groups being included in the calculations. We, however, base the calculations on all living groups. As for the other ecological indicators, we do not discount future index values.
 The final element in the objective function represents spatial connectivity, expressed through the boundary weight factor, L is estimated as L = ∑a Ac / ∑b lb where the total protected area size Ac is summed over spatial cells c, and the boundary length is estimated by summing over all protected cell b the side lengths Ib that do not border another protected cell or land. The boundary weight factor is similar to the Boundary Length Modifier that is used in Marxan to impact spatial fragmentation.
 With the elements of the objective function being defined, we can now obtain the overall objective function measure O from
 [image: O=w_R \cdot R + w_J \cdot J + w_M \cdot M + w_S \cdot S +w_Q \cdot Q_{75}^{'} \tag{6}]
 Where each of the objective weighting factors, w, can assume any value, including zero, which is used for measures that are ignored in a given optimization. We use the objective function measure for both of the optimization methods described below.
 Seed cell selection procedure
 This optimization method is based on a previous study[6][7], in which a very simple optimization scheme was used to evaluate tradeoff between proportion of area protected and the ecosystem-level objective function. We have modified the previous approach by securing a better program flow, and notably by changing the objective function from considering only profit from fishing and existence value of biomass groups to the more detailed function described above (Eq. 6).
 The procedure takes as its starting point the designation of one, more, or all spatial cells as “seed cells”, i.e. cells that are to be considered as potential protected cells in the next program iteration. The procedure will then run the Ecospace model repeatedly between two time steps, closing one of the seeds cells in each run, while storing the ecosystem objective function value. The seed cell that results in the highest objective function is then closed for fishing, and its four neighboring cells (above, below, and to either side) are then turned into seed cells, unless they are so already, or already are protected, or are land cells. This procedure will continue until all cells are protected.
 The time over which the selection procedure is run is chosen dependent on the application. Typically, an ecosystem model is initially developed and tuned using time series data to cover a certain time period, e.g., from 1980 to 2020. Subsequently, the model is used in a scenario development mode to evaluate for instance protected area placement covering the period 2020-2040.
 The major result from the seed cell selection procedure is an evaluation of the trade-off between size of protected area, and each of the objectives in Eq. 6. This can, for instance, be used to consider what proportion of the total area to close in subsequent, more detailed analysis based on importance layer sampling.
 Importance layer sampling procedure
 An advantage of the seed cell modeling approach described above is that it allows a comprehensive overview of the tradeoff between proportion of area closed to fishing, and the ecological, social, and economic benefit and costs of the closures. This is done, based on the information already included in the EwE modeling approach, with no new information being needed. While this may be an advantage from one perspective, it does not allow use of other forms of information, notably in form of geospatial data, such as, for instance, critical fish habitat layers from GIS.
 To address this shortcoming, we have developed an alternative optimization routine for the Ecospace model, which uses spatial layers of conservation interest (“importance layers”) to set likelihoods for spatial cells being considered for protection. The optimizations are performed using a Monte Carlo (MC) approach where the importance layers are used for the initial cell selection in each MC realization. The Ecospace model is then run, the objective function (Eq. 6) is evaluated, and the results, including which cells were protected, are stored for each run (see Figure 1).
 [image: ]
 Figure 1. Logic of the importance layer sampling procedure. For each run a given percentage of all cells are protected based on weighted likelihood in importance layers. The evaluation of each run is done independently based on a defined objective function.
 The importance layers are defined as raster layers, with dimensions similar to the base map layers in the underlying Ecospace model, i.e. they are rectangular cells in a grid with a certain number of rows and columns. Each cell in a given layer has a certain “importance” for conservation, expressed, e.g., as the probability of occurrence for an endangered species. For each importance layer λ, we initially scale the importance layer values to sum to unity, and then calculate an overall cell weighting wc for each cell c from
 [image: w_c = \sum \limits_{\lambda} w_{\lambda} \cdot C_{c, \lambda} \tag{7}]
 where w_{\lambda}[/latex] are the importance layer weightings, and [image: c_{c, \lambda}] the cell-specific, scaled importance layer values. In order to evaluate how well the importance layers are represented in each optimization run, we estimate
 [image: w_{\lambda}^{'}=\frac{\sum \limits_{c} w_{\lambda} C_{c',\lambda}}{\sum \limits_{c} w_\lambda C_{c*,\lambda}} \tag{8}]
 where c’ indicates cells selected in a given run, and c* is the cell with the highest weightings for the given layer. The layer-specific indicator wλ‘ can obtain values in the range between 0 and 1.
 For each optimization search, one has to select the proportion of water cells to protect in the runs, as well as how many times to repeat the Monte Carlo runs. It is possible to set the search routine up to iterate over a range of protection levels, e.g., from 10% to 100% protected in steps of 10%.
 Similar to the seed cell selection procedure, we typically develop and tune the model to an initial time period, and then use the sampling procedure to evaluate scenarios for protected areas for a subsequent time period.
 Ecospace can read raster files with spatial information such as importance layers or other Ecospace base map layers from comma separated text files (.csv), ESRI ASCII files (.asc), and ESRI shape files (.shp). The files need to have layers or columns with row and column numbers matching the Ecospace model. This capability is designed to allow straightforward exchange between the Ecospace modeling and Marxan analysis, with the constraint that it needs to be possible to represent the layers in raster form. The reading of the spatial files is described in more detail in the Spatial optimization chapter of the EwE User Guide.
  
 Attribution This chapter is an edited extract from Christensen, V., Z. Ferdaña, J. Steenbeek. 2009. Spatial optimization of protected area placement incorporating ecological, social and economic criteria. Ecological Modelling 220:2583-2593 10.1016/j.ecolmodel.2009.06.029. Adapted with License Numbers 5757350148022 and 5757730967909 from Elsevier. The publication includes simple case studies for illustration.
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		Tutorial: Spatial optimization

								

	
				
 Learning Objectives
  	Obtain experience with how to set up Ecospace for optimization as part of marine spatial planning
 
 
 
 We use the spatial ecosystem model of Anchovy Bay that we have worked with in a number of previous tutorials. The purpose of this exercise is to evaluate alternative placements of marine protected areas, and evaluate which gives most protection at the least cost. The EwE spatial optimization routine is described by Christensen et al. (2009)[1]
 Importance layers for conservation
 Anchovy Bay has a number of species and habitats that are of conservation concern, including,
 	a threatened dugong population that is protected and occurring in areas with human activities that may impact the population recovery.
 	a bird nesting area where ships may disturb breeding birds and fisheries deplete resources close to the breeding area,
 	two estuaries that are important as fish rearing areas and for biodiversity, and
 	an extensive hard bottom area, which among other is home to a rare, endangered and protected species: Charcharodon endangerous.
 
 The groups of conservation concern are not included in the Anchovy Bay model, (which is focused on commercially important fish species, their prey groups and competitors along with socio-economic aspects), so how do we go about modelling their protection? The spatial optimization module of EwE is designed with that in mind. The first task is to obtain distribution maps for the groups of concern, and read those into Ecospace. Subsequently, we will define an objective function based on economic, social and ecological factors, and search for a protection scheme that will optimize conservation concern at the least possible cost (as defined through the objective function).
 For the conservation layers, we need raster maps, i.e. spreadsheet-like maps with rows and columns quantifying for each cell how much there is of the area of concern. For instance, expressing how often dugongs are observed in each spatial cell.
 For Anchovy Bay, we have such distribution maps for the four groups as concern (Figure 1), and you can download the file Importance layers.zip from this link. The file has four CSV files, one for each of the four conservation or importance layers.
 [image: ]
 Figure 1. Importance layers imported from CSV files to Ecospace > Input > Maps > Importance.
 [image: ]Figure 2. Adding importance layers (click the pen to the right of Importance)
 Use a version of your Anchovy model for which you have already defined the spatial distribution of the Ecopath groups. You can download a zipped version of the Anchovy Bay spatial database from here, if required. Open the Anchovy Bay spatial, and the Ecospace scenario with spatial distributions. Then go to Ecospace > Input > Maps and in the right-side column, click the pencil to the right of where it says Importance (0) (Figure 2). [If it says Importance (4), you can skip this step, the importance layers have already been defined]. Now add four layers, and name them: Rocky bottom, Dugong feeding, Bird nesting, and Estuary. Click OK.
 In the right-side column, you should now have the four importance layers. Double-click where it says Rocky bottom, and an Edit layer form should pop-up. Here you can either cut-and-paste the content from the Rocky bottom.csv file (that were in the Importance layers.zip file), or you can select Import > from CSV… and import the csv file directly. Do the same for the three other importance layers, and check that you have density maps for each.
 Note that if you click on the name of an importance layer, you can edit the given importance layer with the tools in the lower part of the right-hand side column – at the bottom section named Importance. This is especially useful to quickly develop and evaluate hypotheses – you can do that before you have actual distribution maps, and get an idea of what’s important and what’s not. The philosophy is: model first, data later.
 So, how do you decide on what weights to use for the Importance layers? There are no rules for that short of considering what is important? With that in mind, experiment with different weight settings and evaluate the outcome.
 Now go back to Ecospace > Input > Maps > Importance (4) and click the pen to the right. In the form, the second column will give the weight of each distribution layer with a default value of 1. Using the default values mean that later when the spatial optimization routine selects cells for protection, cells from each of the four distributions are equally likely to be included, irrespective of how many cells there are in each layer. Hence, a given cell in a layer that has only a few cells (e.g., Estuary) is more likely to be protected than a given cell in a layer with many cells (e.g., Hard bottom).
 Two final checks before we go to the spatial optimization routine,
 	Check if you have a marine protected area (MPA) defined. On Ecospace > Input > Ecospace fishery > Marine Protected Areas, you can check if you already have any MPAs defined. If not, click Define MPAs at the top row, and add an MPA. OK. On the form, you can define which months the MPA is closed – leave it at closed all months. Further, on Ecospace > Input > Ecospace fishery > MPA enforcement, you can define if individual fleets are allowed to operate in an MPA or not. The default is that no fleets are allowed to work in any MPAs, leave it at that.
 	Check the dispersal rates in your model, Ecospace > Input > Dispersal. Set Base dispersal rates to 10 km year-1  (click the column title Base dispersal rate, and enter 10 in the Apply box). This highly unrealistic setting will make the MPAs more efficient at building up biomass, and is only used to better illustrate how the optimization routine functions.
 
 Objective function
 The spatial optimization module is at Ecospace > Tools > Spatial optimizations. On the rather complex form that pops up, you can define and run the optimizations. At the top, Search type, select Importance layer. The next steps are all on the Parameterization tab.
 First, set Start year to 30. With this the optimization routine will first do a run of Ecospace, and store the state at Year 30. The optimizations will then only do each model run from year 30 to 41. This is to speed up things in this tutorial, you will need to evaluate how long time it takes for MPA effects to be significant in a real application before deciding. Also set the Base year to 30, which tells Ecospace that the economic and social factors are for that year. In the first column, check that the MPA drop-down list is set to the MPA you want to optimize for (in case you have several MPAs defined).
 In the next column, you can set how much of the area that should be closed (in percentage of the number of water cells, i.e. not counting land cells). For now, leave this at the default 20%. Also, set the number of iterations to 20 – in a real application you would use many more, hundreds or more likely, thousands.
 Next, we define the objective function, this is done in the left-most table in the next row. The objective function includes the elements from the policy optimization plus a few add-ons,
 	Net economic value, i.e. the profit made by the fishing fleet (or in the overall fishing sector if the value chain is defined and used)
 	Social value (employment), defined based on the job/catch value from the second table (or through the value chain)
 	Mandated rebuilding, can be used to force rebuilding if target values are entered in the third table, first column
 	Ecosystem structure is an ecological measure based on one of EP Odum’s maturity indicators: maximizing the average longevity in an ecosystem (which characterizes mature stable ecosystems). We capture this with the inverse P/B, i.e. B/P (unit: year), which expresses the average longevity of a group. The default values are B/P from the Ecopath base model, excluding fast turnovers (e.g., shrimp and zooplankton), and you can consider, which groups you think it’s reasonable to include. For now, you can just leave it at the default values.
 	Biodiversity optimizes by default for the Shannon index, used to express how uniform the biomass distribution is across the functional groups in the model, assuming that it ecologically is more optimal to have the biomass more distributed rather than concentrated on a few groups.
 	Boundary weight is used to capture how continuous the MPA network is. The index is calculated as the length of the boundary between cells protected and not protected divided by the total MPA area. For instance, one cell in an MPA will have a boundary weight of 0.25 (area = 1, boundary = 4), whereas two adjacent cells will have a boundary weight of 0.33 (area = 2, boundary = 6). A 2 x 2 cluster of MPA cells will have a boundary weight of 0.5.
 
 For this tutorial, set the Net economic value to 1, the Social value to 1, and the Boundary weight to 1.
 In the third table, the Max fishing mortality can be set to avoid that groups are fished unsustainably by entering the maximum acceptable fishing mortality for groups of concern.
 Model runs
 That’s it, ready to run. Press the run button, and you can select the Map tab to see what it is doing. Once completed, you can select results from the runs with the highest value of the objective function at the bottom of the form. The default is the 10% of the runs with the highest value, that means the two best runs when there’s only 20 runs. In a real application, you may have thousands of runs, and you would select a lower percentage of the runs, perhaps the best 1%.
 In the right-most panel, you can select the Best count layer, and it will show how many times each cell was included in the best runs. This is indicated by the heat map, and you can see the count if you hover over a cell with the mouse pointer.
 If you want to, you can click Convert to MPA, and the best cells will be transferred to the MPA layer in Ecospace. Do that, and check it out (Ecospace > Input > Maps, MPA layer), it will be a pretty spotty map with so few runs, but it serves to illustrate the functionality.
 Try to change the weights for the importance layers, (available on Ecospace > Tools > Spatial optimizations > Importance layers tab above the map lot). For instance to set the weight for Hard bottom to 1, and the rest to 0. This should lead to more contagious cell selection. Go back to the Spatial optimization module, and try running again.
 Play! That’s how we all learn and it’s much more funner than school.
  
 Media Attributions
	Ecospace > Input > Maps > Importance 
	Ecospace > Input > Maps, adding Importance layers 



	Christensen, V., Z. Ferdaña, J. Steenbeek. 2009. Spatial optimization of protected area placement incorporating ecological, social and economic criteria. Ecological Modelling 220:2583-2593 ↵
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		Coastal restoration

					Kim de Mutsert

			

	
				Coastal restoration projects, especially wetland recreation, benefit marine and coastal species by restoring habitat that serves as important nursery grounds[1] [2]. The construction phase of the project and/or the environmental changes of the area under restoration are likely to have effects on the species currently residing in that area, and the impact of those changes need to be assessed. Coastal restoration projects are different from other construction projects that may affect species assemblages in that the long-term effects on the natural environment are aimed to be positive, and the future without restoration is likely to negatively affect coastal species over the long term.[3]
 Ecospace is uniquely equipped to assess the effects of these environmental changes on fish and shellfish communities, as it can evaluate relatively short-term effects (months to years) of the construction/environmental disruption, as well as the long-term effects (decades) of having a restored environment on coastal and marine species that make use of that environment (for part of their life) over generations. By comparing this outcome to a future without action, the difference between taking this action or not can be evaluated over the short-term and the long-term.
 A notable example of an area where large restoration projects are occurring and are planned is the Mississippi River Delta in the United States. In addition to various other coastal restoration and protection projects, the construction of large sediment diversions is planned, which are floodgates at select locations along the lower Mississippi River designed to let river water and sediments back into wetlands that were cut off from freshwater inflow by river levees in recent history (CPRA[4]). The introduction of freshwater and sediment through these floodgates will alter the environment of the receiving estuaries by reducing salinity, and increasing turbidity, nutrient concentrations, and wetland acreage amongst other changes.[5] [6]  Ecospace models developed to evaluate potential effects on fish and fisheries of these projects were included in resource managers’ decisions on diversion flow regime and location[7](Figure 1).
 The models provided anticipated redistribution of species[8] [9], and demonstrated the potential impact of sea level rise on the anticipated outcome. This approach needs a coupled modeling framework, since Ecospace will simulate the effects on fish and fisheries of the environmental change that occurs as a result of diversion openings and restoration projects, while the environmental change itself (e.g., salinity, amount of habitat) needs to be simulated by different models[10] [11] [12].
 [image: image]
 Figure 1 – Conceptual diagram of coupled modeling framework used in the Mississippi River Delta model[13].
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		Application of spatial models

								

	
				This part provides a number of examples of how Ecospace is applied to address scientific, management and policy questions, and serves to demonstrate the utility and versatility of the Ecospace modelling approach. The bulk of the case studies in this part are adapted from de Mutsert et al.[1] with permissions from Elsevier.
 
	De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. https://doi.org/10.1016/B978-0-323-90798-9.00035-4 ↵



	

			
			


		
	
		
			
	
		

		Food web effects of human-made structures

								

	
				The INSITE funded project entitled “Investigating food web effects due to human-made structures using COupled Spatial Modelling” (COSM) assessed the potential ecosystem effects of human-made structures in the North Sea, and forecasted what might happen to marine species communities if structures were to be removed through decommissioning[1].
 An Ecospace model was built for a published North Sea EwE model[2] at 0.25 decimal degree resolution. Besides bathymetry and 5 natural habitat layers, proportional coverage of various classes of human-made submerged structures were brought in as non-natural habitats in the HFC model in addition to mean water column temperature. Species’ functional responses to the various types of man-made structures were determined through Generalized Additive Models (GAMs) analyses. The historical fishing effort for main fishing gears was also included.
 [image: image]
 Figure 1. – Effect of structure types on aggregated functional groups identified through statistical analyses of gridded survey data (significant relationships shown only). A positive (green bubble) effect indicates that the occurrence of the group is increased through the presence of structures, while negative effects (red bubbles) indicate the opposite. Bubble size is proportional to the change in probability of occurrence of the group in the region where the relevant structure type is present, thus independent of spatial coverage of the structures.
 The model required a 10-year spin-up period, and the model ran for 40 years. The COSM study yielded interesting findings (Figure 1):
 	Human-made structures affected local community compositions, which could disperse throughout the wider North Sea ecosystem;
 	The removal of oil and gas platforms and pipelines may ultimately create losers (rays and sand eels) and winners (sharks, flatfish and roundfish);
 	The presence of wrecks and wind turbines appeared to have a much greater impact than oil and gas infrastructure on rays, sharks, sand eels, flatfish and demersal roundfish;
 	Importantly, all modeled effects of structures were minor compared to the potential effect of climate change (e.g., increase in temperature) or fisheries (increase in effort);
 	Although the additional habitat provided by platforms and pipelines may be relatively small, they were assessed as important for some non-commercial species of conservation concern as refuges against natural variability.
 
  
 Attribution
  This chapter is based on de Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. https://doi.org/10.1016/B978-0-323-90798-9.00035-4, adapted with permission, License Number 5651431253138.
 Rather than citing this chapter, please cite the source.
 
 
 
 
	Lynam, C., Steenbeek, J., Mackinson, S., Garcia, C., Wright, S.R., Posen, P., Lincoln, S., Kirby, M., 2017. COSM: Investigating food web effects due to man-made structures using COupled Spatial Modelling. Cefas COSM Final Report C6236. Cefas Laboratory, UK. ↵
	ICES (2016). Report of the Working Group on Multispecies Assessment Methods (WGSAM). ICES Expert Group reports (until 2018). Report. https://doi.org/10.17895/ices.pub.5673 ↵



	

			
			


		
	
		
			
	
		

		Marine renewable energy and aquaculture

								

	
				Modeling the effect of the installation of marine renewable energy devices (MREDs) and aquaculture sites on the surrounding ecosystem is challenging. Deployment of structures for offshore renewable energy (ORE) and farming (e.g., cages) can lead to exclusion zones, limiting the access to the area for users such as shipping, fishing and tourism[1] [2] [3][4]  as well as ‘artificial reefs’ effect with the presence of new structures that can supply nursery areas and feeding grounds for fish species (Petersen and Malm, 2006; Wilhelmsson et al., 2006). Larvae and juveniles can disperse from these sites to the surrounding area leading to a ‘spill-over effect’, enhancing local production[5].
 MREDs can negatively impact species indirectly, by changing habitat properties, as well as directly, by causing collision risks with moving turbine components[6] [7]. For diving species, there is also the risk of collision with static underwater structures[8]. Moreover, these devices can also produce continuous low frequency noise that propagates in the air as well as underwater causing dislocations of acoustically-sensitive species[9] [10] [11] [12] (Bailey et al., 2010; Brandt et al., 2011; Madsen et al., 2006; Tougaard et al., 2020, 2009).
 Serpetti et al.[13] evaluated the impact of wind farms as a MRED on the West Coast of Scotland by assessing the impact of the low frequency noise produced by the operational wind turbine (see section 6.8 below) and by assessing the seabird spatial dislocation caused by the presence of the offshore wind turbines (OWTs). Three species within the seabird functional group (representing 45% of the total biomass) of the previously published West Coast of Scotland model[14], were assumed to show significant spatial dislocation caused by the wind turbines[15] The Ecospace results estimated a significant decrease in seabird biomass of 8% within an 8 km2 region set around the OWTs site (Table 1). In the same study, the impact of salmon farming was also tested. The attraction of predators by the farms and the organic enrichment of detritus by deposition of wasted feed and feces on the seabed below and surrounding the fish farms was simulated (Table 1). The spatial distribution of top predators (large fish and seabirds) affected the marine ecosystem through top-down control pathways causing the decline of their prey within the area. Similarly, changes in bottom-up controls were included through detritus enrichment and cascaded through the food web causing the increases of infauna, epifauna and other benthic species (Fig. 14). The spatial distributions of infauna and epifauna also showed larger diffused footprints in relation to the detritus enrichment footprint proportional to their dispersal rates (30 km/year for epifauna, and 3 km/year for infauna)
 Table 1. Mean relative annual biomasses changes of selected functional group for different selected scenarios (modified from Serpetti et al.[16])
 	Functional group
  	A: Operational wind farm
  	B: Predator attraction by fish farm
  	B+: Detritus organic enrichment
  
 	Seabirds
  	-8.1%
  	3.6%
  	3.6%
  
 	Cod
  	-0.7%
  	10.1%
  	11.1%
  
 	Haddock
  	-0.9%
  	5.9%
  	7.1%
  
 	Whiting
  	-5.0%
  	5.4%
  	5.7%
  
 	Saithe
  	0.0%
  	20.8%
  	20.9%
  
 	Flatfish
  	0.0%
  	-0.1%
  	0.0%
  
 	Herring
  	0.0%
  	-0.1%
  	-0.1%
  
 	Poor_cod
  	0.0%
  	0.0%
  	-1.2%
  
 	Sandeel
  	0.2%
  	-0.4%
  	-0.1%
  
 	Sprat
  	0.1%
  	-0.3%
  	-0.2%
  
 	Nephrops
  	0.0%
  	-0.1%
  	-1.5%
  
 	Lobster
  	0.1%
  	-0.4%
  	-3.1%
  
 	Velvet_crab
  	0.0%
  	0.0%
  	1.8%
  
 	Infauna
  	0.0%
  	0.0%
  	2.2%
  
 	Epifauna
  	0.0%
  	-0.2%
  	10.3%
  
 	Detritus
  	0.0%
  	0.0%
  	3.3%
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 Figure 1. Relative biomasses spatial distribution of detritus, infauna and epifauna showing the relative foot-print increases of detritus, infauna and epifauna (modified from Serpetti et al.[17])
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		Marine protected areas

								

	
				The primary reason to develop Ecospace was to open up for evaluating the effects of MPAs on protected species and their ecosystems, along with the consequences of reallocation of fishing effort[1] [2] [3]. Several local and regional applications followed, covering a diversity of ecosystems including temperate and tropical ecosystems[4] [5] [6]. However, Ecospace MPA applications have only recently started applying the HFC model and the capabilities of the Spatial-Temporal Data Framework .
 For example, Dahood et al.[7]  developed an Ecospace model to analyze the food-web dynamics of an Antarctic marine protected area by simulating scenarios of sea-ice loss and fishing. Results suggested that no-take zones may be particularly important to enhance the resilience of species that have recently experienced population decline and to ensure positive outcomes from establishing a marine protected area in the region.
 In Coll et al.[8] a series of local, sub-regional and regional Ecospace models were developed to assess how Mediterranean ecosystems associated with networks of MPAs (i.e., MPAs sensu lato) can sustain present conditions and future change of fisheries exploitation rates and patterns in a sustainable way. Potential configurations of MPA network(s) were investigated considering current protected areas (including Natura 2000 sites), already formally proposed areas (such as the Ecologically or Biologically Significant Areas or EBSAs), and other proposed areas not being formally recognized, such as the Areas Under Consensus or the Priority Areas for Conservation of Species at Risk (PACS) following Micheli et al.[9] and Coll et al.[10]. Different proposals were also tested to partially or totally close hake spawning and nursery areas to bottom trawling, and to extend the bottom trawling prohibition of coastal areas to 100 and 150 meters. In addition, the prohibition of bottom trawling below 1000 meters in the Mediterranean Sea was investigated (WWF/IUCN[11]), and other sustainable managed areas such as the Fisheries Restricted Areas (FRAs) as declared by the General Fisheries Commission for the Mediterranean Sea, GFCM were included.
 To overcome a main limitation of MPAs in the region, which is their small size compared to the study area, Coll et al.[12] developed a geographically nested ecosystem modeling approach (Fig. 15), in combination with the Biomass Emitter plug-in (Steenbeek, 2018). This plug-in carries over biomass fluctuations obtained from fine-scaled local dynamics to corresponding spatial cells in coarser, more regional models as boosts in biomass to fished species, both landed and discarded (Steenbeek,[13]).
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 Figure 1. Geographically nested ecosystem modeling approach developed to assess the impacts of MPAs in Western Mediterranean Sea. Local areas include the MPAs of Cerbère-Banyuls, Cap de Creus, and Medes Islands MPAs (red area: no-take, orange area: partially-protected, green area: unprotected surrounding MPA). The sub-regional areas include the three MPAs and their surroundings to model the network of MPAs (reproduced from Coll et al.[14])
 The Biomass Emitter can be parameterized with either relative or absolute biomass trends obtained for Marine Protected Areas from finer scaled models, from field data collected for different MPAs, or by applying empirical equations following previous studies. It can apply any number of biomass trends, as obtained from fine-scaled MPA models, to boost the biomasses of the same groups in corresponding spatial areas in coarser scale models. Through the Biomass Emitter, the biomass effect of an MPA as computed in fine-scale models is effectively carried over to coarser-scaled models that otherwise would have been unable to mathematically represent the impact of these MPAs (Steenbeek[15]).
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		Hypoxia and nutrient loading

								

	
				A common problem in coastal ecosystems is the need to reduce excessive nutrient loads. Since the inflow of nutrients is also the reason why many coastal systems are so productive, food-web models are useful tools to simulate the effects of nutrient load reductions on fish and shellfish communities[1].
 To be able to evaluate the trade-offs between the potential reduced productivity as a consequence of nutrient reduction through bottom-up effects, and increased productivity due to improved water quality, negative effects of eutrophication to coastal species need to be quantified and included in the model. Examples of this include hypoxia[2] [3] and harmful algal blooms[4]. The change in frequency and severity of such events under a nutrient reduction scenario needs to be simulated as well, which often requires hydrodynamic-biogeochemical-lower trophic level models that can then be coupled to an Ecospace model[5], or otherwise used to inform or constrain the nutrient flows in Ecospace[6].
 Ecospace can currently serve as a powerful coupled modeling framework to simulate effects on higher trophic levels of eutrophication, hypoxia and/or HABs, and to simulate how nutrient load reductions affect these coastal systems and the species that reside in them. In Piroddi et al.[7], a pan-European marine modeling ensemble of fourteen high trophic level models was developed to assess the impact of eutrophication reduction in European Regional Seas. The study included Ecospace models for almost all European seas under two nutrient reduction management scenarios. The main goal was to test the impact of legislation and the management measures that have been implemented to halt nutrient overload in marine ecosystems. Results suggested that the proposed nutrient reduction measures may not have a significant impact on the structure and function of European marine ecosystems. Among the assessed criteria, the spawning stock biomass of commercially important fish stocks and the biomass of small pelagic fishes would be the most impacted, albeit with values lower than 2.5%. The impact on species diversity and trophic level indicators was even lower (Figure 1).
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 Figure 1. Box plots representing the mean change (%) and standard deviation for TL indicators: (A) Mean trophic level of the community (mTLco); (B) Mean Trophic Level of the Catch (TLc) for every MSFD region/sub-region and smaller areas within an MSFD region/sub-region. Yearly modelled data points are plotted as coloured circles (modified from Piroddi et al.,[8], which lists acronyms)
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		Episodic mortality events

								

	
				There are many short-lived stressors affecting marine and coastal environments that occur over only a portion of the ecosystem. Often, exposure to these stressors can result in immediate mass mortality of marine organisms in the affected area. Examples of such episodic mortality events include toxic and harmful algal blooms, hypoxia, temperature extremes, and chemical spills. When modeling impacts, it is important to consider the spatial and temporal overlap between the stressor and species in the ecosystem, as well as the severity of the stressor, lethality, sub-lethal effects, and food-web effects. Sub-lethal effects of the stressor can be captured through the Ecospace habitat capacity model, which reduces foraging capacity in affected cells, resulting in lower consumption rates, slower growth, and movement away from the area.
 In EwE version 6.6+, Ecospace can directly include mortalities in response to environmental stressors, in addition to the feeding responses enabled through the habitat capacity model[1] [2]. The mortality response functions can take any form, but would typically follow a logistic function, similar to dose-response curves common in ecotoxicology studies. When combined with the mortality response, the foraging response may in some cases moderate the lethal effects by driving movement away from the stressor. Food web effects may lead to slower recovery times following an episodic mortality event if, for example, the forage base is severely reduced. In addition, food web dynamics can also lead to compensatory increases in biomass due to lower abundances of predators and competitors.
 The Ecospace mortality response functions were conceptualized to simulate the impacts of red tides on the West Florida Shelf (WFS). Red tide blooms are caused by the toxic dinoflagellate Karenia brevis and occur almost annually on the WFS, often leading to mass mortality of invertebrates, fish and marine megafauna. Stock assessment models by SEDAR for gag Mycterpera microlepis and red grouper Epinephelus morio have attempted to account for red tide mortality, and managers have been forced to make decisions about future catch levels while red tide blooms were ongoing.
 An existing Ecospace model of the WFS was adapted to include red tides and estimate mortality rates of key species[3] (Figure 1). Monthly maps of K. brevis cell concentration (ranging from 0 to 106 cells/l) were included as an environmental driver using the spatial-temporal framework. Information on species-specific responses to red tide is lacking, but it is generally understood that fish kills are likely when cell concentrations are >105 cells/l. To address this uncertainty, a set of logistic mortality and foraging response functions were evaluated with varying slopes and inflection points. Time series of red tide mortality rate were then generated from the simulations, by dividing the biomass loss due to red tides by total biomass, which was then fed back into the stock assessment model and management projections.
 In addition, the WFS Ecospace model identified red tide as a possible driver of gag recruitment dynamics, demonstrating delayed recovery times of gag when the entire food web was impacted by red tide. The model also demonstrated different effects across marine taxa due to spatial overlap with red tide (severe blooms typically occur nearshore) and movement rates (migratory pelagics were less affected by red tide).
 The approach described here for red tide on the WFS can be generalized to other stressors that are spatially restricted and cause direct mortality. It also provides a way to integrate studies conducted across multiple scales, from individuals to populations and ecosystems, using the Ecospace spatial-temporal framework and environmental response functions.
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 Figure 1. Red tide mortality and foraging response curves used in the WFS Ecospace model (top row), an example monthly map of red tide cell concentrations input as an environmental driver using the Ecospace spatial temporal data framework (bottom left), and the resulting red tide mortality for gag grouper from 2002-2021[4]
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		Noise impact

								

	
				Species have different hearing capabilities; therefore, different species are sensitives to different noise frequencies[1] [2]. Modeling behavioral changes, such as changes in spatial distribution of acoustically-sensitive species in response to anthropogenic noise is particularly challenging due to the need for species-specific responses to defined noise frequencies layer(s) in an Ecospace model.
 The importance of quantitative measures of noise frequencies produced in order to assess their impacts on sensitive species has been suggested[3] [4] [5]. Baleen whales, for example, are sensitive to low-frequency (10-500 Hz) noise, and are therefore considered most at-risk from shipping noise[6] and other low-frequency noise devices such as marine wind and tidal turbines[7](Kikuchi, 2010). A recent study demonstrated that seals also responded to low frequency noise from ships by changing their diving behavior[8]. Some high-frequency components (up to 160 kHz) of shipping noise can have substantial effects on higher-frequency sensitive cetaceans including harbour porpoises[9] [10] [11]. In a recent study, harbour porpoises showed high sensitivity to acoustic deterrent devices (ADDs), originally designed to protect fish-farming cages from seals with potential habitat exclusion in coastal areas due to ADD noise[12].
 Because of the lack of information needed to create species response curves to defined noise frequencies, in Ecospace, the level of impact of noise was inferred by distance from the noise source[13] [14], which were either static, e.g. wind and tidal turbines[15] [16][17] or dynamic, e.g. shipping[18] [19]. Porpoises might cease their feeding behavior at distances from 1 km[20] up to 7 km at which they no longer are seen to be affected[21]. In Serpetti et al.[22], sigmoid functions were used to build the response functions within the avoidance distances up to distances at which marine mammal species no longer are seen to be affected (Figure 1). The spatial modeling output revealed the species dislocation from the noise source (Figure 2). The map for harbour seals showed a trade-off between attraction and avoidance at different distances.
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 Figure 1 – Response functions of harbour porpoise and harbour seals[23].
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 	Figure 2 – The species dislocation from the noise source for harbour porpoises and harbour seals[24]. 
 	 	 
  
 The Ecospace modeling approach has shown high sensitivity to the impact of noise assessed by ecological responses to distances from noise sources[25] [26], however these studies also highlighted the necessity of improving our knowledge of species-specific response functions to noise, as well as long-term impacts of constant noise sources and potential species’ capability of acclimation and habituation to background noise[27] [28] [29].
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		Impact of invasive species

								

	
				Invasive alien species (IAS) have become an important driver of biodiversity change and can have severe impacts on marine ecosystems and food webs. The development of mechanistic modeling approaches to assess and predict their distributions and impacts, and evaluate management options, has increased substantially[1] [2]. Multispecies and ecosystem models are the main tool used to develop applications around the impact of IAS, and in most cases, the models include an additional stressor: mainly fisheries, climate change or nutrient loading. However, the number of Ecospace AIS applications is low and represents a future research venue[3].
 One of the main limitations is data availability, accessibility and quality related to the plausible roles of IAS in new ecosystems. There is a need for predictive methodologies to forecast existing, emerging and potential IAS and their impacts. Models that allow capturing the arrival, establishment and spread of IAS and assess their impacts in an integrated way are still unavailable and highlight a critical gap in IAS modeling despite recent developments.
 The development of spatial–temporal methodologies that integrate the arrival, establishment and spread of IAS and their impacts within an ecosystem context is needed to inform management advice and contribute to the analyses of future scenarios of global change. A recent example of novel approach to deal with IAS modeling was presented by Sadchatheeswaran et al.[4], where an Ecospace model was developed to study the spatiotemporal impacts of structural complexity created by alien ecosystem engineers in a rocky shore community. In a previous temporal dynamic Ecosim model[5], the authors modelled the successive arrivals by three alien ecosystem engineers on the rocky shore between 1980 and 2012 that led to substantial changes in species composition and diversity. The use of a non-spatial model concluded with the suggestion to add structural complexity and spatial zonation to add reality to the approach because the invasive species changed the physical environment between 1980 and 2015 substantially (Fig. 21).
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 Figure 1. Zonation of Marcus Island, Saldanha Bay as determined by dominant species in 1980 (pre-invasion), 2001 (post-invasion by Mytilus galloprovincialis in Zones 2– 6), 2012 (post-invasion by Balanus glandula in Zones 3a and 3b, as well as Semimytilus algosus in Zones 5–6), and 2014–2016 during quarterly biomonitoring. Zones are aligned with standard tidal terms: HWST (High Water Spring Tide), HWNT (High Water Neap Tide), MTL (Mid Tide Level), LWNT (Low Water Neap Tide), and LWST (Low Water Spring Tide). 
 The Ecospace simulations included a control simulation that restricted drivers to depth and habitat preferences; two simulations to account for structural complexity as a function of the biomass of alien ecosystem engineers – the first indirectly via mediation, and the second via a new plug-in Ecoengineer (see User Guide); and a final simulation that included wave action to replicate its effects. Only the simulation that included the Ecoengineer routine matched empirical observations of species diversity and the exclusion of the native mussel by the arriving IAS. Results emphasized that when analyzing benthic ecosystems with structural habitat complexity, an explicit representation of that complexity over time and space can be a promising approach. The EcoEngineer routine has been released with EwE version 6.6.
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		Modeling invasive species in a data-poor context

								

	
				Since first observed in the Barents Sea in 1996, the invasive snow crab Chionoecetes opilio population has been increasing strongly in numbers and spreading westward toward Svalbard and northward. As C. Opilio is an opportunistic predator feeding on a wide array of benthic prey, and have no natural predators, it could have important impacts on the local ecosystem and its fisheries potential. As such, Norwegian managers are interested to know:
 	where the crab originated from and how it may spread;
 	the carrying capacity of the crab in the local ecosystem and by when this carrying capacity may be reached; and
 	the ecological impacts of the crab invasion.
 
 Data for the crab is scarce, both in terms of ecology and in spatial distribution. Whilst awaiting the results of genetic analysis to determine where C. Opilio in the Barents Sea originates from, little is known regarding its life cycle and feeding habits. The only biomass estimates are for male crabs with a shield diameter of at least 10 cm. that are landed; all other caught crabs are discarded.
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 Figure 1.  Three simulations with different recruitment linkage configurations for snow crab: no linked recruitment (Left), female recruitment linked to the fished males (Center), and fished male recruitment linked to non-fished females (Right). Note that both juvenile groups are identically parameterized in this specific case, and therefore their biomass estimates exactly overlap in the Center and Right plots[1].
 An existing EwE model that featured the C. Opilio[2](Pedersen et al., 2021) was spatialized and refined by dividing the snow crab population in two multi-stanza groups, male and female snow crabs, which each consist of a juvenile and adult life stage. The male biomass observations were entered, and female adult biomasses were estimated based on mean size differences between males and females. The juvenile/adult relationships were parameterized for both multi-stanza groups based on empirical knowledge of known snow crab populations. This setup allowed the model to incorporate the impact of the entire snow crab population, even though only empirical data for male adult C. Opilio were available.
 To connect the dynamics between the male and female multi-stanza populations, a new capability was added to EwE to enable linked recruitment between two multi-stanza groups. This ensured that both multi-stanza groups produced the same numbers of recruits (Figure 1, see EwE User Guide), and that extensive fishing of only male snow crab would also affect the number of female recruits.
 The Ecospace model of the Barents Sea featured novel uses of Ecospace mechanisms. Monthly averaged trends in sea ice cover were used to impose time varying spatial fisheries restrictions, and the fishing fleets of present nationalities were spatially separated according to historical treaties.
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 Figure 2. The four groups of C. Opilio, spreading five years after their introduction at the presumed introduction location south of Nova Zemlya. Clockwise, from top-left: adult males, juvenile males, adult females and juvenile females. 
 In order to discover where the snow crab was first introduced, the habitat suitability of the four snow crab groups was limited to only a few map cells at the start of Ecospace simulations. Once the simulations reached January 1996, this limitation was lifted via the spatial temporal data framework, allowing the multi-stanza groups to disperse naturally from the seed locations. Ecospace was executed in the IBM modus (Figure 2). Several suspected introduction locations were explored under uncertainty assessments. Ecospace hindcasted evolving snow crab distributions and densities that best matched fisheries records when snow crab introduction points were placed at the north and south of Nova Zemlya. This underpins the most broadly accepted hypothesis how the crab entered the area, and can help identifying the native population of the crab, and any studies into their traits and behaviors, to more efficiently manage the invader in the Barents Sea.
 Future scenarios have not yet been performed due to lack of data; spatial temporal data at sufficient spatial scale for high-latitude ranges is hard to find for historical time periods, and does not seem to exist for future emission scenarios. The linked stanza feature will be released with EwE version 6.7.
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		Defining safe operating space

								

	
				The aim of the study of Ofir et al.[1] was to define a safe operating space (SOS)[2] to manage the commercially important mango tilapia fish Sarotherodon galilaeus (Linnaeus, 1758) in Lake Kinneret, Israel. This species depends on submerged littoral vegetation for spawning and nurseries, but annual water levels in the lake have been dropping during the past decades due to poor river inflow, evaporation and drinking water extraction, affecting availability and structure of submerged vegetation for S. galilaeus. Additionally, littoral vegetation cover and density has been gradually reduced to make room for human activities.
 EwE was used in novel ways: The Ecospace migration system was used to affect the distribution of multi-stanza S. galilaeus between the pelagic and littoral zones, in time with littoral spawning as defined in Ecosim. Habitat affinity with time-varying vegetation cover maps provided spawning areas that also provided essential habitat for juvenile life stages. Monthly varying lake levels were introduced as environmental drivers in the HCF model, where linear response functions to fraction water coverage implicitly limited access to submerged vegetation. Ecospace was executed in the relatively underexplored Individual Based Model (IBM) modus[3]. The fact that the lake lies approximately 210m below sea level caused some complications when integrating the impact of bathymetry in the model.
 To establish the bounds of the SOS, different Ecospace scenarios were executed on the validated model for the period of 2017 to 2060 to explore how to retain a minimum biomass of S. galilaeus of 250 tons. These scenarios combined fishing effort multipliers {0.1, 0.5, 1, 1.5, 2}, lake levels {low (2009), high {2005)}, and changes in density and area cover of vegetation {0.1, 0.5, 1, 1.5, 2}. Results were statistically analyzed for five time periods {2021-2025, 2026-2030, 2031-2040, 2041-2050, 2051-2060} to obtain a safe operation space for effort and vegetation cover under the two extreme water level scenarios in order to secure the desired biomass of S. galilaeus.
 See the original publication for details[4].
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		Environmental impact assessment

								

	
				EwE, notably Ecospace, was used extensively in preparation of the Environmental Impact Statement (EIS) for the proposed Roberts Bank Terminal 2 Project in Vancouver, British Columbia[1]. Ecospace added the capability of including environmental change as a spatial component in model simulations, and of providing output maps showing the change in biomass of all species in a food web in response to an impact and the difference between implementing the project and no action spatially (Figure 1). This provides a significant advancement from field studies and habitat description only, that are generally provided for environmental impacts statements.
  
 [image: ]
 Figure 1. Dungeness crab distributions without and with the Vancouver port extension, and the difference.
 The Ecospace modeling approach was also used to evaluate the environmental impact of the construction of an industrial area, a road, and a wind power generator on a Natura 2000 site in Germany[2]. Ecospace was deemed to be the ideal tool for this EIS because both short and long-term impacts could be evaluated, as well as cumulative impacts of habitat loss, noise, and light pollution. In addition to evaluating impact, alternatives were evaluated to identify a strategy with the least impact, and mitigating strategies were tested, all within Ecospace[3].
 Similarly, different flow regimes strategies and sediment diversion locations could be tested with the Mississippi River Delta model described in section 6.5[4], contributing to the scientific support of the decision to apply for permits of two large sediment diversions, and to put the construction of two others on hold. While Ecospace was used in the scientific studies investigating effects of coastal protection and restoration projects such as these large sediment diversions[5] [6], Ecopath with Ecosim (without Ecospace) was used to inform the official EIS[7] [8]. This decision was made because the longer history of use of Ecopath with Ecosim than Ecospace provides for a stronger case when faced with potential litigation.
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		Climate change in the global ocean

								

	
				Quantifying past and future trends of marine ecosystems caused by global change is critical to inform ongoing climate change and biodiversity assessments, and to guide feasible pathways towards achieving key policy objectives globally[1]. To predict the future of marine biodiversity and ecosystem services there is a need to adopt an integrated view of the ocean as a social-ecological system, encompassing the dynamics of commercial and non-commercial species and their interactions, the dynamics of resource users and their interactions, and how those are affected by changing environmental conditions and management interventions[2]. This understanding can only be attained with studies at multiple scales, where global studies are essential as environmental changes and socio-economic interactions are often coupled and cascading impacts of ecological disturbances affect human use of ecosystem services across vast distances through ocean currents, species movements and fishing fleet mobility[3] [4].
 The last decades have witnessed extensive development of modeling techniques at global scales both in terrestrial and marine domains[5][6]. Rapid development of atmospheric-ocean circulation models, including biogeochemical processes in Earth System Models (ESM), has improved the scientific capability to project the climate system, which in turn has helped inform the United Nation (UN) Intergovernmental Panel on Climate Change (IPCC, (Shukla et al., 2019). Ecosystem models have also shown a dramatic increase in their development, especially in the marine realm[7].
 These Marine Ecosystem Models (MEMs) are used to project changes in marine ecosystems at global scales, including the impacts of fishing and other human activities and stressors. They are now being synthesized into ensemble model projections, contributing towards extending the scientific capability to project what the future oceans may look like, how different scenarios may play out, and what the range of uncertainty is for different components and processes[8] [9]. This is important both for the IPCC but also for the IPBES international platforms[10].
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 Figure 1. Schematic structure of EcoOcean v2 modeling complex (reproduced from Coll et al., 2020)
 The EcoOcean model[11] [12] is a global modeling complex with a tropho-dynamic core that represents one of these initiatives with a global scope. EcoOcean is a spatially and temporally explicit mechanistic marine ecosystem model that unifies the consideration of spatial-temporal food-web dynamics ranging from primary producers to top predators with the impacts of environmental change and worldwide fisheries and cumulative impacts of anthropogenic activities. EcoOcean was built upon a heavily modified version of Ecospace, where EwE calculations were expanded or replaced to represent spatial heterogeneity in fishing and the behavior, growth and movement of functional groups across the worlds’ oceans (Figure 1). Applications of EcoOcean v2 include a global assessment of the impacts of climate change under different projected trajectories (Figure 2) and climate change and fisheries (Table 1), the effects of MPAs and fisheries management strategies, the assessment of uncertainties associated with climate change drivers’ responses and the analysis of global teleconnections[13] [14] [15]
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 Figure 2. Results of EcoOcean v2 regarding climate impacts under two contrasting scenarios of climate change (RCP 2.6 and 8.5) and two Earth System Models (GFDL and IPSL) —Relative temporal change of Total Consumers Biomass (%) by sub-regional oceans: (A) GFDL RCP2.6; (B) GFDL RCP8.5, (C) IPSL RCP2.6, and (D) IPSL RCP8.5 (reproduced from Coll et al., 2020).
  
 Table 1 – Results of EcoOcean v2 regarding climate impacts in comparison with climate and fishing impacts —Temporal Change (%) of biomass by functional groups (reproduced from Coll et al., 2020)
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		Ecospace limitations (edit)

								

	
				 While versatile, Ecospace has a number of conceptual and operational limitations. Conceptual limitations are related to the limits of the software. One conceptual limit stems from the fact that the spatially explicit model (Ecospace) is an expansion in space of a model that is not spatially explicit (Ecopath with Ecosim). The additional parameters and the initial conditions in Ecospace have a large influence on the spatial-temporal dynamics. The biomasses and catches, therefore, can be considerably different from Ecosim (Coll et al., 2016; Püts et al., 2020). In cases where spatial overlap of predator and prey is insufficiently to meet dietary needs, and where fishing effort or species foraging capacity are constrained to relatively small areas of the map, Ecospace might simulate over-depletion of the target species, which might not arise in a temporal (only) framework (Ecosim).
 A second conceptual limit is that Ecospace is not three-dimensional: the water column cannot be divided into explicit layers. Ways to overcome this limitation include considering depth implicitly, through the inclusion of drivers of depth, or of environmental drivers such as using surface and bottom temperature. An alternative strategy is to separate benthic and pelagic components of the system (i.e., groups), so that trophic groups are not available to one another (i.e., no or limited diet overlap), even if they are physically distributed in the same 2D area. This approach requires careful consideration of the species groupings, highlighting that planning of a model that is to be used in Ecospace should consider this from the start, at the model topology stage.
 Another conceptual limit is the fact that in Ecospace fishing effort is distributed over the map (excluding those closed to fishing) based on a gravity model, that accounts for profitability, which considers the catch portfolio, price, as well as fixed and variable (e.g. sailing) fishing cost (Walters et al., 1999). This causes the model to predict effort in areas that are most profitable. However, factors other than profitability influence effort distribution such as avoidance for by-catch species, fidelity to location, and expected or perceived economic revenues (Cabral et al., 2017; Collins et al., 2021; Poos et al., 2010; Poos and Rijnsdorp, 2007; van Putten et al., 2012). One workaround is to use preference as a weight factor of price, i.e., quantifying the fishing preference for a determinate species, and use this to drive the effort distribution. Another option could be to set the sailing cost map based on the (inverse of) existing effort patterns, rather than by distance to port, which if invoked is the default. In this way, the model will predict lower cost in areas where the fleets are historically observed and predict higher effort in these areas.
 Operational limits relate to the possible issues encountered in the parameterization and setup of an Ecospace model. For example, multi-stanza groups must be used with caution, and need to be carefully assessed. The spatial displacement between juvenile and adult stanzas with ontogenetic diet shifts can lead to an unrealistic increase or decrease in juveniles (if insufficient/excessive predation is present in the respective areas), leading to oscillatory patterns that may cascade through the system. These patterns need to be adjusted through careful consideration of vulnerability and diet inputs.
 Spatial resolution matters and the decision about cell size should be based on what type of questions the model will be used for, although most commonly it is driven by data availability. Higher resolution has computational demand and is not necessarily beneficial for all analyses. Coarse resolution, on the other hand, leads to simplification of topology, habitats, MPAs, and other features. Unexpected behavior can arise; instead of an intense but localized impact (e.g., noise, harmful algal blooms), Ecospace will smooth an impact across a few cells. This might be unsuitable for some applications: a preliminary analysis is needed to assess if the resolution can appropriately capture the expected scale of the impacts to be studied. Resolution also affects the representation of patchy habitats: for example, isolated cells and long and narrow strips of cells of a certain habitat can cause the biomass to get stuck, creating unrealistic patterns or biomass crashes. Finer resolution helps to reduce such issues. Specific plug-ins to overcome challenges related to spatial resolution issues have been implemented in the last years, such as the Biomass Emitter plug-in (Steenbeek et al., 2018; see 6.3) and the EcoEngineer plug-in (Steenbeek and Sadchatheeswaran, 2021; see 6.9).
 The temporal resolution is by default limited to monthly time steps; however, specific processes such as larval dispersal followed by settlement or tidal movement are not well captured at monthly time steps. While the advection module can help to capture larval dynamics, these are still driven by monthly dynamics that may or may not be resolved enough to capture spatiotemporal larval distribution realistically. The Ecospace IBM model moves stanza packets at sub-monthly time steps. In theory, as all units including time are only scaling factors within the EwE approach, input data can be scaled to daily averages, which will implicitly run EwE in daily time steps (Libralato and Solidoro, 2009). Note that this might cause differences in Ecosim results because of the integration at shorter time step and problems with the Ecospace advection logic and all multi-stanza logic that has hard-coded cycles of twelve based on annual patterns embedded within. When rescaling time units, this limitation needs to be kept in mind.
 As an example, the IBM model of Ecospace was used to model tidal dispersal of out-migrating salmon smolt in an estuary by one of the co-authors (unpublished). For this a model time-step of 12 hours was used so that rates were defined in the Ecopath model with the unit of per 12 hours, and each time step for runs in Ecospace was one hour allowing for modeling the impact of the tidal cycles.
 Ecopath biomasses are initially distributed over the spatial domain in accordance with proportions of the habitat forage use and response to environmental drivers. Fisheries effort is initially distributed according to biomass of the target species. These initial conditions, even in the absence of time varying environmental drivers, need to be adjusted and Ecospace biomass takes some simulated years before they can reach equilibrium. The length of this adjusting phase depends on the complexity of habitat definition and preferences, and on dispersal rate parameters and should not be confused with forced spatial dynamics. Therefore, it is good practice to set a burn-in period with no forcing or disturbances, i.e., the spin-up preceding the perturbed simulation. The number of spin-up years can be determined by running the model first without forcing functions and identifying the time needed to reach equilibrium, i.e. stable state. Notably the spin-up should also include no changes in Ecosim, in order to have steady distribution of species only due to spatial adjustments in Ecospace. Thereafter the model can be run with forcings, included after the spin-up years, and it can be assessed whether the spinoff period is robust enough. Forcing varying in time aiming to replicate spatiotemporal patterns should start after the spin-up time, as the model base year can be assumed to correspond to the end of the spin-up period. A build-in spin up period capability is available in the software under a professional license.
 Some of the limitations that have emerged in Ecosim have been gradually addressed through continuous model advancements: for example, explicit inclusion of uncertainty, or refinement of the fitting to time series with statistical advancements. In Ecospace, some of these aspects are still under development: at present, spatial-temporal fitting is under development, and uncertainty in parameters cannot be fully accounted for. Similarly, fisheries management tools that are well developed in Ecosim are not as advanced in Ecospace (e.g. Marine Strategy Evaluation, Optimization Routine, Maximum Sustainable Catch search, etc.). However, beyond the computational and financial issues, there are no substantial limitations for these extensions, some of which are already underway.
 1 https://www.un.org/bbnj/content/background
 2 https://iaac-aeic.gc.ca/050/evaluations/proj/80054
 3 https://ditto-oceandecade.org/
 4 https://marine.copernicus.eu/news/ocean-and-its-digital-twin-whats-copernicus-marine
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 Ecotracer is a useful tool within the Ecopath with Ecosim (EwE) modelling approach to track radioisotopes, contaminants, persistent pollutants, or stable isotopes through a food web model.  After achieving a mass‐balanced Ecopath model, Ecotracer can be used with the Ecosim (time dynamic) or Ecospace (spatial‐temporal dynamic) to track the flow of the pollutant through the modelled ecosystem.
 EwE uses a mass‐balance approach, and the flows of a contaminant due to predator/prey interactions are tracked within the underlying Ecopath model. However, Ecotracer also needs parameters for groups based on a kinetic toxicology approach to estimate initial conditions. However, similar to Ecopath, Ecotracer can become dynamic through either the use of Ecosim or Ecospace to follow the changes of a contaminant that has different temporal inputs or to variations in temporal spatial concentrations in the water column.
 The purpose of this manual is to give a full description of the Ecotracer approach including the dynamic equations that describe the basis for the input parameters, and to familiarize users with the various interfaces for the inputs and outputs. Simulation scenarios are also given to allow users to become more familiar with Ecotracer, and instructions are given on how to navigate through the different interfaces used.
 Introduction
 Ecotracer is a sub‐routine in the Ecopath with Ecosim (EwE) modeling framework[1] [2] that allows the modeller to follow a contaminant or stable isotope in modelled functional groups and the environment in a balanced Ecopath model.
 Many EwE models have been made that focus on fishery‐related questions, but here the focus is on how the Ecotracer routine is used within EwE to trace contaminants such as radionuclides through an aquatic ecosystem. EwE consists of three routines: Ecopath which is a mass balance interpretation of an ecosystem where, in essence, the production of a group in the model is equal to its consumption; Ecosim allows the user to build in time dynamics to the Ecopath model for events such as changes in contaminant loading to an ecosystem; and Ecospace which allows for the spatial‐temporal resolution for such events as the effects of change in loading on marine organisms that result from organisms inhabiting different spatial areas or habitat types that have different environmental concentrations through time.
 Typical applications of Ecotracer have been for contaminants such as mercury[3], 14C[4] [5], 137Cs[6] [7], and PCBs[8] that can have detrimental impacts on human and environmental health. The use of Ecotracer can help to estimate the amount of contaminant or concentration in a group/species of interest, spatial differences in concentration within the same functional groups if Ecospace is used, the fluxes between groups due to trophic interactions, and the importance of diet versus direct environmental uptake. It can also help to estimate functional groups’ concentrations when such data are lacking (i.e., have a starting value of zero) and make forward projections based on changing environmental concentrations. Concentration levels are an important aspect for environmental and human health as, in conjunction with consumption rates, they determine exposure levels that may have detrimental effects. Regulatory limits on the concentration in aquatic products destined for human consumption may also affect trade and fisheries opportunities.
 Ecotracer requires a balanced Ecopath model to follow the contaminant, radioisotopes or stable isotopes in the model groups, and environment (e.g., water concentration). Ecotracer when used with Ecosim can provide estimates to important ecotoxicological questions such as,
 	what could be the expected group concentrations if the environmental concentration did not change?
 	what could be the expected results in group concentrations if the environmental concentration changed through time? and
 	is there an effect on concentration levels as a result of changing underlying Ecopath parameters such as fishing mortality?
 
 The first question is useful if many functional groups in the model lack concentration data. The second question can be important to estimate resulting concentrations in biota if the input into the environment changes. The third can help to understand contaminant flows as a result of changes in the dynamics of the underlying structure of an ecosystem.
 Ecotracer when used with Ecospace can help to answer whether there are differences in the same species that occur over a large geographic area, and whether different environmental concentrations in different areas impact the resulting concentrations in organisms. In this case, a two‐dimensional representation of the model area is made which has a user defined spatial resolution (i.e., grid cells). Spatial environmental concentrations can be driven by effluents being released as a point source, or from atmospheric deposits that change over space and time. Effluents released from a point source would be affected by currents resulting in different spatial and temporal distributions, and atmospheric releases could be affected by different levels of releases due to industrial activity through time or accident scenarios as well as currents. In the case of large‐scale accidents, such as the Dai‐ichi nuclear accident at Fukushima, spatial differences can result from both point sources and differing atmospheric deposits both of which occurred through time.
 Ecotracer dynamics
 Ecotracer simulates the contaminant fluxes and resulting amounts and concentrations using a modified transfer contaminant model (e.g.,[9] [10]), and applies it to both the environment and biota. Resulting changes at any time step are dependent upon the gains and losses in functional groups and are described in Walters and Christensen[11] as,
 [image: \frac{dA_i(t)}{dt} = \alpha_i - \beta_i A_i(t)\tag{1}]
 where αi represents the gains (Bq∙year‐1) in each functional group i, βi represents the rate losses (year‐1) to each functional group, and Ai represents the amount (e.g., Bq) in each functional group i. This general formulation allows different measurement units of substances (e.g., Bq or µg) to be tracked in the modelled environment, and the resulting concentrations (e.g., Bq∙t‐1) are computed separately using the biomass output in Ecopath and Ecosim.
 The environmental compartment concentrations are also calculated by tracking the gains and losses in the cells representing the environment,
 [image: \frac{dC_o(t)}{dt} = \alpha_o - \beta_o C_o(t)\tag{2}]
 where Co represents the environmental concentration (e.g., Bq∙km‐2), αo, represents the gains and losses in each environmental cell o, and βo represents the rate losses (year‐1) in each cell.
 Environment
 Gains in the environment originate from the release of contaminants into the environment as a base inflow rate, and from the excretion from organisms. Losses originate from the direct uptake from the environment by organisms, physical decay rates, and base volume exchange. In Ecospace, the environment can be represented by multiple grid cells and thus the gains and losses can be considered to be for each environmental compartment o, such that,
 [image: \alpha_o = BI_o + \sum\limits_{i=1}^{n}m_iA_i\tag{3}]
 where BIo is the base inflow rate (Bq∙km‐2∙year‐1) to a grid cell, and miAi are the excretory products for each functional group within each grid cell.
 Losses from the environment are due to biological, physical decay processes, environmental volume changes, and direct uptake by organisms, such that,
 [image: \beta_o C_o=(d_i+V_i)C_o+\sum\limits_{i=1}^{n}u_iB_iC_o\tag{4}]
 where di represents the physical decay rate (year‐1), Vi represents the base volume exchange loss (year‐1), and the second term (uiBiCo) represents the total uptake rate by all functional groups (see below). Temporal changes to the environmental concentration (Co) can be made by applying a forcing function to the base inflow rate, through a contaminant concentration driver file (Table 1), or by current/advection fields.
 Biota
 In biota, intake amounts (e.g., Bq∙year‐1) result from direct uptake rates (i.e., respiration) the fraction retained from trophic interactions (i.e., diet), and immigration. i.e.,
 [image: \alpha_i=u_iB_iC_o+AE_i \sum\limits_{i=1}Q_{ij} \frac{A_j}{B_j}+c_iI_i\tag{5}]
 where, Co represents the environmental concentration (Bq∙km‐2), Bi is the biomass (t) of group i, ui represent the intake/biomass/environmental concentration/year (km2∙t‐1∙year‐1); AEi is the assimilation efficiency for each group, Qji is the consumption rate (t∙year‐1) of group j by group i, Aj is the amount of substance in a group (e.g., Bq), Bj is the prey biomass of each prey item j (Bq∙t‐1); ci is the group biomass concentration (Bq∙t‐1) and Ii is the immigrating biomass (t∙year‐1).
 The losses from a group (βiCi) are attributed to predation, fisheries, other mortality, excretion and decay, i.e.,
 [image: \beta_iC_i=(\sum\limits_{j=pred}(\frac{Q_{ij}}{B_i})+F_i+MO_i+E_i+m_i+d_i) C_i\tag{6}]
 where Qij is the rate of consumption (t∙year‐1) of group i due to predation by j, Fi is the fishing mortality rate (year‐1), MOi (year‐1) is other mortality rate (i.e., non‐predation mortality), Ei is the emigrating biomass rate (year‐1), mi (year‐1) is the excretion and/or metabolic rate, and di (year‐1) is the physical decay rate. These rates are multiplied by Ci the amount of contaminant (Bq) in each group i. Excretory products that are released from tissues to the environment are added to the environmental concentration.
 The solution for finding the equilibrium amount of contaminant in a primary producer with the resulting concentration only being due to direct uptake, losses to due predation, other mortality, metabolism, and decay is given as,
 [image: C_{i,eq}=\frac{u_iB_iC_o}{\sum\limits_{j=pred}(\frac{Q_{ij}}{B_i}) +MO_i+m_i+d_i}\tag{7}]
 whereas for other groups an additional term must be accounted for due to the group’s prey items; in these cases the equilibrium solution can be defined as,
 [image: C_{i,eq}=\frac{u_iB_iC_o+AE_i \frac{Q_{ji}}{B_i}}{\sum\limits_{j=pred}(\frac{Q_{ij}}{B_i}) +MO_i+m_i+d_i}\tag{8}]
 The Ecotracer approach is dynamic and extends the basic concentration ratio (CR) approach, but the CR approach is contained within it as,
 [image: CR_i=\frac{(A_i/B_i)}{C_o}=\frac{u_i+AE_i\frac{Q_{}ji}{B_i}CR_j}{Z_i+m_i}\tag{9}]
 The amount of contaminant in the detritus compartment originates from the unassimilated consumption resulting from predation, as well as non‐predation mortality. Thus, groups feeding on detritus will have exposure levels associated with the contributions from the fraction of unassimilated consumption from all groups. Initial concentrations in the biota and environment are also input parameters that can be used if data is available. For groups lacking contaminant data from field studies or literature data, the model is able to estimate concentration or burdens in the groups, leading to the ability to estimate risk through time and make comparisons to regulatory limits.
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		Ecotracer applications

								

	
				Ecotracer is the unofficial fourth module of the Ecopath with Ecosim software, designed for tracking persistent contaminants in food webs. Ecotracer requires a balanced Ecopath model to trace the contaminant in model groups/species of the model and in the environment (e.g., water concentration)[1] [2].
 After achieving a mass‐balanced Ecopath model of a specific ecosystem, Ecotracer simulates the flows of a contaminant due to predator/prey interactions following Ecopath parameters, the temporal changes of these flows through Ecosim and spatial‐temporal dynamic of the contaminant through Ecospace. Ecotracer requires contaminant specific parameters for the modelled functional groups based on a kinetic toxicology approach to estimate initial conditions.
 Typical applications of Ecotracer have been for contaminants that can have potential detrimental impacts on human and environmental health including bio-accumulating heavy metal such as mercury[3], radioisotopes and stable isotopes[4] [5] [6], polychlorinated biphenyls (PCBs)[7] and more recently microplastic[8] [9].
 Ecotracer estimates the concentration of a contaminant in modeled groups and computes temporal (Ecosim) and spatial (Ecospace) build-ups in concentration. Ecotracer simulates the contaminant fluxes and resulting concentrations in each group using a modified transfer contaminant model[10] [11] that applies to both the environment and biota. In practice, Ecotracer calculates the contaminant concentration as trade-off between “gains” and “losses” for the environment and all groups/species in the model (Table 1). The use of a food web modeling approach allows disentangling contaminant fluxes through groups considering their direct uptake from the environment as well as through trophic interactions. Ecotracer can also estimate functional groups’ contaminant concentrations when data of the initial conditions are lacking, and make forward projections based on changing environmental concentrations.
 Table 1 – Gains and losses that can be accounted for during contaminant tracing using Ecotracer
 	Environment (e.g., seawater) 
  	Gains 	Losses 
 	Contaminant inflow rate to environment 	Contaminant decay rates in the environment 
 	The sum of all contaminant excretory products from all the living groups/species 	Contaminant outflow rate 
 	 	The sum of all contaminant uptake rates by all groups/species 
 	For each group/species 
 	Gains 	Losses 
 	Direct contaminant uptake rates from the environment 	Contaminant decay rates in the group 
 	Indirect contaminant uptake rates from trophic interactions 	Contaminant excretion rates 
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				Plastic production in the EU has increased in the last 50 years. According to Penca,[1] 60-80% of total plastic-waste ends up in the oceans, suggesting that it will continue to grow if no waste management infrastructure improvements are put in place.[2] More than 90% of all plastic items (by number) found at sea belongs to microplastics (MP; items < 5 mm).[3]
 Plastic pollution of the oceans is a very high priority topic in the context of different EU legislations such as the Urban Waste Water Treatment Directive (2008), the Marine Strategy Framework Directive (MSFD, 2008), the Waste Framework Directive (2011), the Plastic Strategy (2020), the Biodiversity Strategy for 2030 (2021) and the Zero Pollution Action Plan (2022). All these policies constitute important milestones of the roadmap initiated by the European Commission to achieve the European Green Deal (EC, 2020) which aspires to “protect the health and well-being of citizens from environment-related risks and impacts” and establish a toxic and plastic-free environment, deliver healthy and sustainable diets, and protect biodiversity.
 For this, the European Commission (EC) Joint Research Centre (JRC) has developed an integrated modelling framework, called the Blue2 Modelling Framework (MF), to assess the impacts of diverse management strategies (including litter) on the status of EU freshwater and marine ecosystems. This framework incorporates models for freshwater quantity and quality, to recreate the conditions of EU rivers and lakes, as well as atmospheric forcing to capture atmospheric deposition of important chemical elements for marine ecosystems. At the core of the Blue2MF, there is an ocean model that consists of different modules. A hydrodynamic component, common for all European seas, a biogeochemical module and a high trophic level (HTL) module expertly customized for each EU marine region/ecosystem, and, a Lagrangian module used to simulate dispersion and accumulation patterns of floating litter (Figure 1). The Blue2MF can be integrated in different time-slices, from the 1970s to the present day, for hindcast simulations, and in forecasting mode (up to 2050), linked to the atmospheric conditions provided by IPCC-type global circulation models[4] The HTL module of the Blue2 MF is using the software EwE with all its components: Ecopath, Ecosim and Ecospace.
 [image: ]
 Figure 1. The Blue2 modelling framework used by EC-JRC for modelling environmental impacts and status.
 The Blue2MF has also used the Ecotracer module of EwE for the Black and Mediterranean seas ecosystems to simulate and analyze the uptake of MP through the food web.
 Among EU regional seas, these basins are particularly sensible to plastic pollution. In fact, their semi-enclosed nature, highly populated coasts,[5] large touristic and maritime activities, make them a concentration area from where floating litter could not escape.[6] MP ingestion by marine organisms is likely a major pathway for plastic in these ecosystems. Although MP are rapidly ingested and egested, the effects of MP ingestion in natural populations and their fate in marine food webs remain elusive. Without knowledge of retention and excretion rates of field populations, it is difficult to deduce ecological consequences[7] and assess the overall potential loss of energy when MP is consumed by the species of the food web.
 Ecotracer calculates the amount of MP per unit biomass of each species in the ecosystem. These concentrations are of course depending on the MP concentration in the environment and varies depending on their diet (MP concentration in their preys), species direct absorption from the environment and species excretion rates. Within the Blue2MF Ecotracer module, the initial conditions of MP in the environment (concentration and basin inflow/outflow) as well as functional groups excretion rates were estimated from bibliography. A global database of species/MP ingestion was constructed for this purpose[8] and the models were then calibrated against observations of MP in the diet of all the functional groups.[9]
 Results showed that, at steady state, in both ecosystems, primary consumers functional groups (benthic and pelagic) revealed the highest concentration of MP particles: they represented the species with the main MP pathways within the food web.[10] Future scenarios were run in Ecosim to simulate the impact of potential policies (10% and 50% reduction) aiming to reduce MP input in both basins, whilst Ecospace was used to identify hot-spots areas of co-occurrence between targeted sensitive species/functional groups, in terms of MP uptake, and floating particles, derived from the Blue2 Lagrangian module.[11]
 EwE and relative energy content of food
 We have recently added relative energy content to Ecopath input, which makes it possible to, e..g, have microplastics as a food item in an Ecopath model that may be eaten, but which will not provide any energy to the organism that eats it.
 The impact of this are considered in Ecosim and Ecospace (and hence also in Ecotracer), while mediation can be used to model indirect impacts of microplastics, e.g., through pollutant-loading that impacts productivity.
 Contact Villy if you’d like to test this
 February, 2025
 
  
 Attribution: This chapter is in part adapted from Duteil et al. (2023).[12]
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		Tutorial: Ecotracer ZPD

					William Walters

			

	
				This simulation tutorial is designed to give a basic introduction to the Ecotracer routine within the EwE modelling framework.  It represents a simple model with two living groups (phytoplankton and zooplankton) and a detritus group with all necessary data. The simulations are so simple that they can be solved numerically without the use of EwE.
 The tutorial is a simple Zooplankton-Phytoplankton-Detritus (ZPD) model with only three groups for which the Ecopath parameter parameters are given in Table 1. As for diets, zooplankton only eat phytoplankton.
 Table 1. Ecopath input data for a simple case simulation.
 Group                     Biomass (t km-2) P/B (year‐1)    Q/B (year‐1)
 Zooplankton               0.0001                 1.0                    5.0
 Phytoplankton           1.0                       2.0                      ‐
 Detritus                      1.0                         ‐                        ‐
 For Ecotracer, there is an initial environmental concentration, a direct absorption rate (DAR) for phytoplankton, an assimilation efficiency (AE) for zooplankton, and decay rates are lacking (Table 2).
 Table 2. Ecotracer input data for a simple case simulation.
 Group                  Initial conc.    DAR             AE
                               (Bq∙km‐2)   (km‐2∙t‐1∙year‐1) (fraction)
 	Environment
  	1.0
  	‐
  	‐
  
 	Zooplankton
  	‐
  	‐
  	0.8
  
 	Phytoplankton
  	‐
  	1 x 10‐5
  	‐
  
 	Detritus
  	‐
  	‐
  	‐
  
  
 The ‘>’ symbol below describes the direction path and what to click, whereas the ‘=’ needs to have data entered including such things as file names that need to be created. In this scenario, it is easy to find the numerical solutions for each group at equilibrium by equations 7 and 8 in the introductory Ecotracer chapter (link).
 ToolBar
 >File
 >New model
 =choose directory to save the new model and a file name
 Navigator panel
 >Ecopath
 >Input
 >Model parameters
 =fill in Model year and No. years (5 years)
 >Basic input
 >Define groups…
 =insert two groups and name (phytoplankton and zooplankton);
 set phytoplankton to producer.00 =ok and save changes
 =add data from table 2; save
 >Diet composition
 =put in diet fraction (zooplankton only eat phytoplankton so 1 for diet fraction)
 (Message regarding landings and discards, okay to ignore, there are no fisheries) > Output
 >Basic estimates
 >Tools
 >Ecotracer
 =Name new Ecosim scenario > create
 =Name new Ecotracer scenario > create
 >Ecotracer parameters
 =enable contaminant tracing for Ecosim
 >Ecosim
 >lnput
 >Ecosim parameters
 = Duration of simulation (years): 5
 (notice that the contaminant tracing box is checked)
 >Tools
 >Ecotracer
 >Ecotracer input
 =input data from table 3
 >Ecotracer output
 =choose: show data (concentration/biomass or concentration)
 =select all groups to display on graph
 > Run Ecosim (results show automatically on graph display)
 (note that the environment stays at 1.0, but all the other groups are near zero—there is a colored line along the x-axis; to check the functional group values, select them and they will appear on the graph without the environment concentration)
 Attribution 
 Will and/or Shawn?
 
	

			
			


		
	
		
			
	
		

		Tutorial: Caesium in Anchovy Bay

					William Walters

			

	
				This tutorial can be developed in an Excel spreadsheet to solve for the parameters needed for input into Ecotracer. The tutorial is based on a rather typical situation where there are not reported values for all parameters, and it is necessary to make estimates for missing parameters.
 The base Ecopath model is Anchovy Bay, in a version that you can download from this link (along with the spreadsheet than can be used as guidance for the tutorial, see details below. We advice though that you create your own spreadsheet and set up the needed calculations, as described).
 Concentration ratios are usually reported in the literature, or have to be derived from separately reported studies for water concentrations and for concentrations in biota. Typically, assuming no temperature, particles (salts), or pressure effects, 1 m3 of water is here assumed equal to 1 t (in reality, it is slightly more than 1 t because of notably dissolved salt). Measurements of the contaminant in biota need to be scaled to the biomass unit in Ecopath (t km-2, which when multiplied by area in km2 yields t) as they are usually reported per gram of tissue. Measurements of a contaminant in dry weight should be changed to wet weights using a conversion factor.
 Table 1. List of symbols used.
 	Elimination rates (Ke; day‐1)
 
 	Symbol  	Description  	Unit                    
 	Bi 	Biomass 	tonne 
 	P/Bi 	Production to biomass ratio 	year‐1 
 	TLi 	Trophic level 	unitless 
 	CRi 	Concentration ratio 	unitless 
 	CREwEi 	EwE concentration ratio 	unitless 
 	Ke mi
 	Elimination rates Excretion rate
 	day-1 year‐1
 
 	di 	Decay rate 	year‐1 
 	AEi 	Assimilation efficiency 	0 ‐ 1 
 	ui 	Direct absorption rate 	km2∙t∙year‐1 
 	Ai,eq 	Equilibrium amount 	g 
 	Ci,eq 	Equilibrium concentration 	g∙t‐1 
  
 Table 2. Starting data for an Ecotracer simulation of 137Cs with data concerning Ecopath parameters (B, TL, and P/B) from the Anchovy Bay model and data representative of what might be measured in field surveys or reported in the literature. The table is designed to replicate an Excel spreadsheet. Values needed to be transferred into the Ecotracer routine include the excretion rate (mi), physical decay rate (di), the amount not assimilated (1‐AE), amount of 137Cs (Ai). Methods need to be used to estimate missing values of mi, Ai, 1AE, and transforming the environmental concentration from a volume to spatial basis. Ui is solved by finding total gains (TGains) from consumption (Cons) and direct uptake (DU), and total losses (TLoss) from Losses and Ai.
  
 [image: ]
 Note: A spreadsheet with Table 2 (Ecotr-sprdsheet tab) is included in the zip file with the database. 
 Starting Information
 Ecotracer and all values can be done in a spreadsheet to find missing values. The intent of this scenario is to build a spreadsheet model for all the parameters to run in Ecotracer. The parameters for the Ecopath model (B, P/B, and TL) are taken from the Anchovy Bay model with additional ecotoxicological data being provided. For our purposes, we will arbitrarily consider Anchovy Bay to be 1000 m x 1000 m with an average depth of 250 m. 137Cs in Anchovy Bay has been found to have an activity of 2 Bq∙m‐3.
 The following represents a way to estimate the direct absorption rate for groups. Generally, for substances that bioaccumulate, the amount of a substance such as 137Cs in a group or species is more dependent on diet than direct uptake at higher trophic levels.However, the direct absorption rate is an important parameter to estimate throughout the food web. Lack of a direct absorption rate at lower trophic levels can lead to an overestimate on the importance of diet or to an error being amplified through the food web with higher trophic levels not reaching measured or likely concentration levels.
 	The average of 2 Bq∙m‐3 needs to be converted to Bq∙km‐2. The volume of the ocean is calculated as 250,000,000 m3 leading to 500,000,000 Bq∙km‐2.
 	Elimination rates (Ke; day‐1) need to be determined for groups that lack data. In this scenario log Ke is plotted against the TL of groups to estimate the Ke for groups that lack data (Figure 1). The resulting relationship is used to estimate the Ke for the groups that lacked data. The Ke is then used to estimate (Ke x 365) the excretion (= elimination) rate (mi; year‐1).
 	Loss rates in this example result from total mortality (P/B), physical decay rates (di), and elimination rates (mi) and these can be summed to be applied against the amount (Ai) of 137Cs in the groups.
 	Assimilation efficiencies for groups missing data need to be estimated. In this simulation, since all fish groups had an AE of 0.8, and given AEs range between 0.75 and 0.95 a value of 0.8 was used for fish and invertebrate groups without a reported AE. For marine mammals the AE is calculated from the total gains and total losses (i.e., AE = Total losses/Total gains).
 	Concentrations (Bq∙t‐1) are needed to estimate the direct absorption rate for all groups excluding marine mammals. In this scenario there are three groups without concentration data. Therefore, in this simulation a regression analysis is done plotting concentration against trophic level (Figure 2). The importance of estimating a direct absorption rate is for simulations done when there are changing environmental concentrations or changes to the underlying Ecopath input parameters.
 	Calculating the gains from consumption in order to solve for ui. Recall that at equilibrium when dCi(t)/dt = 0, that the gains are equal to the losses. We have set up the loss rate (step 3), and the gains, excluding marine mammals, are both due to the direct absorption rate (from step 5) and consumption gains. Consumption gains are estimated from AEi, Qi (consumption), and Aj/Bj (concentration in diet items of predator i). Unfortunately, the concentration of detritus is not known, but it is derived from all the unassimilated consumption from the Ecopath model. As a result, it is an iterative process that involves an estimate of what the concentration in detritus would be. Generally, a good guess is to start with phytoplankton as it is a large contributor to detritus; in Anchovy Bay, phytoplankton contribute approximately 70 % of the flow to detritus. Thus, starting detritus with the same concentration as phytoplankton to determine the ui for all groups, and then run Ecotracer to get the estimate of the concentration of 137Cs for detritus. Then re‐run with the new concentration for detritus.
 	Before the second iteration it is necessary to re‐calculate the gains from consumption; if the Excel spreadsheet is set up with formulas this will change the values of ui as well. This example started with a value of 16 Bq∙t‐1 for detritus, and after the first run Ecotracer estimated 22.4 Bq∙t‐1. Using this value for the second iteration and after changing the consumption values and ui for the groups the second iteration estimated a value of 21.92 Bq∙t‐1 (close enough!).
 
 [image: ]
 Figure 1. Relation between the elimination rate constant (Ke) and trophic level used to estimate the elimination rate (mi).
 [image: ]
 Figure 2. Relation between concentration in functional groups and trophic level used to estimate the direct adsorption rate.
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		Five-day introductory course

								

	
				This is an example plan for a one-week intensive training course in EwE. The course is fast-tracked in order to include advanced spatial modelling the two last days.
 Day 1
 	Session 	Topic  	EwE Textbook 	EwE User Guide 	Presentation (#) / activity 
 	09.00-09.15
  	Welcome, introductions 	 	 	00 Welcome 
 	09.15-10.00 	Introduction to EwE 	On modelling
 Your research question
 Define the system 	 	01 EwE Introduction 
 	10.00-11.00 	Ecopath introduction 	P/B Q/B Multi-stanza 	Ecopath input, 	Riley: Ecopath (YouTube)
 02 Model parameterization 
 	11.00-11.30 	Coffee/tea 	 
 	11.30-13.00 	Construct an ecosystem model 	 	 	Tutorial:Anchovy Bay model 
 	13.00-14.00
  	Lunch 	 
 	14.00-15.00
  	Balancing Ecopath models 	Energy balance
 mass balance 	 	03 Mass balance
 Tutorial: mass-balance 
 	15.00-15.30 	Coffee 	 
 	15.30-16.00 	Mass balance (cont.) 	 	 	 
 	16.00-17.00 	Ecopath output 	 	Ecopath output, 	04 Ecopath advanced 
  
 Day 2
 	Session 	Topic  	EwE Textbook 	EwE User Guide 	Presentation/activity 
 	09.00-09.15 	Recap, questions? 	 	 	 
 	09.00-10.00 	Ecosim introduction 	Lotka-Volterra
 Ecosim introduction
 Foraging arena theory
 Predicting consumption 	 	05 Ecosim introduction 
 	10.00-11.00 	Using Ecosim 	Read tutorial: Group info 	 	Tutorial: Food chain model 
 	11.00-11.30 	Coffe/tea 	 
 	11.30-13.00 	Mediation and environmental forcing 	Mediation and time forcing 	 	06 Non-trophic impacts
 Tutorial: Mediation 
 	13.00-14.00 	Lunch 	 
 	14.00-15.00 	Environmental forcing 	 	Environmental productivity 	Tutorial: Environmental forcing 
 	15.00-15.30 	Coffee/tea 
 	15.30-17.00 	 	 	 	Tutorials (cont.) 
  
 Day 3
 	Session 	Topic  	EwE Textbook 	EwE User Guide 	Presentation/activity 
 	09.00-09.15 	Recap, questions? 	 	 	 
 	09.15-11.00 	Ecosim fitting to time series 	Density-dependence
 Vulnerability and multipliers
 Statistical approaches 	Time series 	07 Ecosim fitting 
 	11.00-11.30 	Coffee/tea 
 	11.30-13.00 	Uncertainty in EwE 	Read tutorial: Uncertainty 	 	Tutorial: Time series fitting 
 	13.00-14.00 	Lunch 	 	 	 
 	14.00-15.00 	Your model questions 	 	Addressing uncertainty Ecosampler 	08 Uncertainty 
 	15.00-15.30 	Coffee/tea 	 	 	 
 	15.30-17.00 	Your model questions and wrap-up 	Your research question 	 	Discussion 
  
 Day 4
 	Session 	Topic  	EwE Textbook 	EwE User Guide 	Presentations/activity 
 	09.00-09.15 	Welcome, introductions, questions? 	 	 	 
 	09.15-10.00 	Ecospace general introduction, data needed 	Ecospace introduction 	Do you need Ecospace? 	09 Ecospace introduction 
 	10.00-11.00 	Ecospace & niche modelling 	Habitat capacity 	 	10 Ecospace advanced 
 	11.00-11.30 	Coffee/tea 
 	11.30-13.00 	Tutorial: Ecospace 	 	 	Tutorial: Spatial model 
 	13.00-14.00 	Lunch 
 	14.00-15.00 	Ecospace & fisheries 	Spatial fishery dynamics Predicting spatial effort 	Dispersal rates 	11 Ecospace fisheries, tutorial: MPAs in Anchovy Bay 
 	15.00-15.30 	Coffee/tea 
 	15.30-17.00 	Tutorial 	 	 	Tutorial: AIS in Anchovy Bay 
  
 Day 5
 	Session 	Topic  	EwE Textbook 	EwE User Guide 	Presentations/activity 
 	09.00-09.15 	Recap, questions? 	 	 	 
 	09.15-10.00 	Ecospace, spatial planning and impact assessment 	Spatial planning, human made structures EIA, Coastal restoration, noise, spatial optimization (needs edit) 	 	12 MSP Challenge
 13 Spatial planning 
 	10.00-11.00 	Tutorial 	 	 	Tutorial: Anchovy Bay optimization 
 	11.00-11.30 	Coffee/tea 
 	11.30-13.00 	Tutorial (continued)
 Ecospace output 	 	 	Ecospace R-scripts, tutorial: Ecospace maps 
 	13.00-14.00 	Lunch 
 	14.00-15.00 	Discussion, questions 	 	 	 
 	15.00-15.30 	Coffee/tea 
 	15.30-16.00 	Intro to spatial-temporal framework 	 	 	14 Temporal spatial 
 	16.00-17.00 	Discussion & wrap-up 	 	 	 
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		Versioning history

								

	
				We are continuously seeking to improve this open textbook. Please submit your suggestions, recommendations, and/or corrections by email to Villy Christensen (firstname.lastname at gmail).
 This page lists major changes to this book with major changes marked with a 1.0 increase in the version number and minor changes marked with a 0.1 increase.
 	Version 	Date 	Change 
  	1.0 	2024/05/01 	Published by the University of British Columbia, available at Open UBC, https://pressbooks.bccampus.ca/catalog/openubc 
 	1.0 	2024/06/01 	First Edition available for Print On Demand from booksellers (incl. Amazon) 
 	Online version 	2024/10 	Fishing policy chapter replaced with new with more extensive description.  
 	 	2024/10 	Added: (1) Risk-averse portfolio utility chapter; (2) Tutorial: Policy exploration procedure; (3) Primary production and nutrients chapter; 
 	 	2024/10 	Moved mediation chapters/tutorials to Environment section, and moved this section up after Ecosim Introduction section  
 	 	2024/10 	Added description of Fixed Selectivity Principle to Mass balance chapter 
 	 	2025/01 	Added new chapter on Environmental impacts 
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Table 1. Comparison of key characteristics between static (Ecopath) and time-dynamic (Ecosim)
models of the Irish Sea and Northwest Atlantic Continental Shelf NWACS-MICE).
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Time-period
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Table 2 - Example of an extreme arena structure where

all predators (k;) share a common foraging arena (a4),
i.e., compete fully for the same given prey

Arena Predator

Predator k4 Predatork, ... Predator kyy,
Arena a; 1.0 1.0 ... 1.0
Arena ap 0.0 0.0 0.0
Arena a, 0.0 0.0 ... 0.0

This will likely be an unstable situation with strong predator com-
petition effects.
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Table 1 - Matrix showing linkages in the arena structure

for a given prey with multiple predators (k; to ky)

Arena Predator

Predator £, Predator 4> o Predator &,
Arena a Pal.ki Pal k2 B Pal km
Arena a; Paz.kl Pa.i2 Pa2.m
Arena am Pam.kl Pam.k2 s Pam km

Each entry indicates the proportion (pg) of the activity for the given
predator-prey interaction occurring in the corresponding arena a;.
In the default arena structure each predator is assumed to occupy a
separate foraging arena indicated by the shaded cells on the diago-
nal. In such a case the diagonal will have a value of 1, and the other
cells a value of 0. Each column must sum to 1.
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